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Send Us Your Comments

Oracle Applications Upgrading Oracle Applications, Release 11i (11.5.10.2) 

Part No.  B19297-01

Oracle welcomes your comments and suggestions on the quality and usefulness of this 
publication. Your input is an important part of the information used for revision.

■ Did you find any errors?

■ Is the information clearly presented?

■ Do you need more information? If so, where?

■ Are the examples correct? Do you need more examples?

■ What features did you like most about this manual?

If you find any errors or have any other suggestions for improvement, please indicate 
the title and part number of the documentation and the chapter, section, and page 
number (if available). You can send comments to us at apps_relgrp_us@orace.com.

If you have problems with the software, please contact your local Oracle Support 
Services.
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Preface

Upgrading Oracle Applications describes necessary steps for preparing Applications 
products for an upgrade to Release 11i (11.5.10.2) and for performing post-upgrade 
steps after you run AutoUpgrade. It is intended for users who are upgrading from 
Oracle Applications Release 10.7 (character mode, NCA, and SmartClient) or Release 
11.0.

Intended Audience
This book is intended for use by anyone who is responsible for installing or upgrading 
Oracle Applications.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Standards will continue to evolve over 
time, and Oracle is actively engaged with other market-leading technology vendors to 
address technical obstacles so that our documentation can be accessible to all of our 

Note: An upgrade to 11.5.10.2 employs the latest version of Rapid 
Install (11.5.10.2), which includes the 11.5.10 Consolidated Update 2 
(CU2). You do not need to apply CU2 separately during or following 
the system upgrade.

Upgrade Role Description

Application Specialist Provides knowledge and guidance regarding 
application functionality.

Database Administrator Installs and configures the Oracle database and 
maintains database access controls.

System Administrator Responsible for administering systems.

Technical Specialist Responsible for designing, developing, unit testing, 
implementing, and maintaining the custom extensions 
for the Oracle Applications.

IS Manager Directs the client information systems organization 
within a business.
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customers. For additional information, visit the Oracle Accessibility Program Web site 
at 

http://www.oracle.com/accessibility

Accessibility of Code Examples in Documentation JAWS, a Windows screen reader, 
may not always correctly read the code examples in this document. The conventions 
for writing code require that closing braces should appear on an otherwise empty line; 
however, JAWS may not always read a line of text that consists solely of a bracket or 
brace.

Accessibility of Links to External Web Sites in Documentation This documentation 
may contain links to Web sites of other companies or organizations that Oracle does 
not own or control. Oracle neither evaluates nor makes any representations regarding 
the accessibility of these Web sites.

Structure
This book contains the following chapters:

■ Chapter 1 describes Category 1 steps. They do not require the new software. You 
can continue to use your existing Oracle Applications environment.

■ Chapter 2 describes Category 2 steps. They require the new software. You can 
continue to use your Oracle Applications products at the existing release level.

■ Chapter 3 describes Category 3 steps. These steps mark the beginning of the 
system downtime required to complete an upgrade.

■ Chapter 4 describes Category 4 steps. They assume you have already upgraded 
your products and your database. You must complete these steps before the Oracle 
Applications system can be made available to users.

■ Chapter 5 describes Category 5 steps. They affect specific products, which cannot 
be made available to users until the steps are complete.

■ Chapter 6 describes Category 6 steps. They affect specific product features, which 
cannot be made available to users until the steps are complete.

■ Chapter 7 describes tasks required to finish the upgrade and optional tasks that 
may apply to some systems.

Organization
This book is organized by upgrade category. There are three types of steps: 
pre-upgrade, post-grade, and finishing. Categories 1, 2, and 3 are pre-upgrade steps, 
which you perform before you run AutoUpgrade. Categories 4, 5, and 6 are post-upgrade 
steps, which you perform after you have run AutoUpgrade. You must complete all 
steps that apply to your installation before you begin the next category. 

After all Category 4, 5, and 6 steps have been completed, and after you have verified 
that the entire upgrade was successful, you must perform finishing steps to complete 
the upgrade. Some finishing steps are required, and some are optional.

Step Conditions
This book classifies steps based on certain conditions that may apply.
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Step Summaries
Below each numbered step heading you will find specific requirements for the step. 
For example:

In addition, the step summaries may provide other information such as a specific 
country and concurrent manager requirements.

Related Documents
This book was current as of the time it was initially published. It is included in the 
Oracle Applications Document Library, which is supplied in the Release 11i software 
bundle. Later versions of this and other documents that have changed sufficiently 
between releases to warrant re-publishing are made available at the following URL: 

http://www.oracle.com/technology/documentation/applications.html

You can also purchase hard-copy documentation from the Oracle Store at 
http://oraclestore.oracle.com. 

In addition to this book, we suggest you have the following additional references on 
hand.

If the step is marked... Then, it...

Required is necessary for a successful upgrade.

Conditionally required applies only under certain conditions. If the condition does not 
apply, you do not have to perform the step.

Recommended may be in your best interest to perform this step. For example, the 
step may reduce the time it takes to perform the upgrade.

Requirement Explanation

Reference manual? Multiple Reporting Currencies in Oracle Applications

Users must log off? Yes

TUMS Step Key? AP_MRC_EXCHANGE_RATES

If you are looking for... See these documents...

Additional information Oracle Applications Concepts
Installing Oracle Applications
Maintaining Oracle Applications Documentation Set:
     Oracle Applications Maintenance Utilities
     Oracle Applications Maintenance Procedures
Oracle Applications Installation Update Notes*
Oracle Applications Release Notes*
Oracle Applications NLS Release Notes*
Oracle Applications System Administrator’s Guide - Configuration
Oracle Applications System Administrator’s Guide - Maintenance
Oracle Applications System Administrator’s Guide - Security
Oracle Self-Service Web Applications Implementation Manual
Oracle Workflow Administrator’s Guide
Oracle Workflow Developer’s Guide
Oracle Application Object Library/Workflow Technical Reference Manual 

Information on new features in 
this release

Release Content Documents and Features Summary Matrices*
Oracle Applications DBA 11i+ Features Matrix*
Oracle Applications Product Update Notes
Electronic Technical Reference Manual (eTRM)*
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Update or patch readme files may contain additional information about new 
documentation that you can download.

Training and Support
Oracle offers a complete set of training courses and multi-level support services.

Training
You can attend training courses at any Oracle Education Center, arrange for trainers to 
teach at your facility, or use Oracle Learning Network (OLN) — Oracle University’s 
online education utility. Oracle training professionals can also develop custom courses 
using your organization structure, terminology, and data as examples.

Support
Your Oracle support team includes a Technical Representative and Account Manager. 
It also includes Oracle consultants and support specialists who have expertise in your 
business area, and in managing an Oracle database server and your hardware and 
software environment.

OracleMetaLink is a self-service, Web-based support connection, which is maintained 
by Oracle Support Services 24 hours a day, 7 days a week. Use it to obtain information 
and advice from technical libraries and forums, download patches, look at bug details, 
and create or update TARs. Register at http://metalink.oracle.com, and check for 
updates and information before you install or upgrade your Oracle Applications. The 
Start Here CD also contains links to the various resources on OracleMetaLink.

EMM Advantage
The EasiPath Migration Method (EMM Advantage) offers a methodology for 
upgrading Oracle Applications. Produced by Oracle Corporation, EMM Advantage 
helps you structure and manage your upgrade project.

A comprehensive migration toolkit, EMM Advantage is a tested framework for quality 
migrations. It includes the Oracle EasiPath Migration Method (EMM), a proven, 
structured approach used successfully worldwide by Oracle consultants, and Project 
Management Method (PJM), a standardized Oracle approach to project management. 
The EMM Advantage toolkit, in combination with your skills, experience, and 
business knowledge, will ensure a higher-quality migration and lead you to business 

Application-specific features Oracle Applications user guides
Oracle Applications implementation manuals
Customer Relationship Management implementation manuals
Multiple Organizations in Oracle Applications
Multiple Reporting Currencies in Oracle Applications

Information about custom 
development

Oracle Applications User Interface Standards for Forms-based Products
Oracle9i Applications Developers’ Guide

Database information Oracle9i Concepts
Oracle9i Backup and Recovery Concepts
Oracle9i Reference
Oracle9i Designing and Tuning for Performance
Oracle9i National Language Support Guide
Oracle9i Migration Guide

*Available only on OracleMetaLink

If you are looking for... See these documents...
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results faster. It is available from the Oracle Direct Marketing group in your country, or 
you can contact your local Oracle Sales Representative. 

Conventions
The following typographic conventions are used in this book:

Convention Meaning

UNIX:
Windows:

Indicates platform-specific information. This guide contains 
information for both UNIX and Windows platforms. Instructions 
for UNIX platforms also apply to Linux platforms, unless 
otherwise noted.

$ or C:\> Represents the platform-specific command prompt. Your 
prompt may differ.

Monospace text Represents command line text. Type this text exactly as shown.

< > Text enclosed in angle brackets represents a variable. Substitute 
a value for the variable text. Do not type the brackets.

[ ] Encloses optional items or indicate a function key. Do not type the 
brackets.

| Represents an or option among several options. You must enter 
only one of the options. Do not type the vertical bar.

\ In examples of commands you type online, a backslash at the 
end of a line signifies that you must type the entire command on 
one line. Do not type the backslash.

Special Notes Alert you about information within the body of the book. They 
include Additional Information, Note, and Caution.
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Overview and Requirements

This second Preface contains important overview information and system 
requirements that you should be familiar with before you begin the upgrade. If you 
are using Release 10.7 (NCA, SmartClient, or character-mode) or Release 11.0 of Oracle 
Applications, you may upgrade directly to Release 11i. You cannot upgrade to Release 11i 
directly from releases prior to 10.7.

In addition, pay special attention to the following information.

■ Oracle Applications Installation Update Notes, Oracle Applications Release Notes, and 
Oracle Applications NLS Release Notes are required reading before you upgrade. 
They contain important updates to the information in this book, and are available 
only on OracleMetaLink.

■ Product-specific implementation manuals contain important information about 
new products. Consult these references before you begin the upgrade. They are 
available on the Oracle Applications Documentation CD and on the virtual doc CD.

■ The instructions in this book apply to upgrades from character-mode Release 10.7 
installations. However, most navigation paths are based on GUI versions. The 
Oracle Applications Character Mode to GUI Menu Path Changes reference manual 
contains character-mode equivalents of GUI menu paths.

Overview of an Upgrade
An Oracle Applications upgrade employs several utilities designed to streamline the 
process. Rapid Install provides the most up-to-date, certified version of Oracle 
Applications, along with the required technology stack components. In an upgrade, it 
creates the new file systems for the application (middle) tier components and the new 
file system for the database, if it is on a platform that supports Oracle Applications on 
the application tier.

After you complete the pre-upgrade tasks, you run AutoUpgrade to upgrade products 
and update the database objects and code to Release 11i. Then, you run AutoPatch to 

Note: If you have already upgraded to an earlier version of 
Release 11i, follow the upgrade steps in the Oracle Applications 
Release 11.5.10.2 Maintenance Pack Installation Instructions. This 
document is available on OracleMetaLink (Doc ID: 259484.1).   

Note: Release 10.7 NCA and Release 10 SmartClient (10SC) 
Production 16.1 are interchangeable at the database level.
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apply the patches and run the drivers required to update the database to the most 
current release level (for example, 11.5.10). After you have completed the database 
upgrade, you run Rapid Install a second time to configure and start the servers and 
services.

For complete information about running these utilities, refer to Oracle Applications 
Maintenance Utilities.

Upgrade Tasks
In general, perform the following tasks to complete an upgrade:

■ Read the documentation associated with this release (see Related Documents in 
the Preface). All documentation is available either in the Oracle Applications 
Documentation Library, from OracleMetaLink, or from the OracleStore.

■ Download and run The Upgrade Manual Script (TUMS) from OracleMetaLink to 
generate the list of steps that do not apply to your system and can be omitted from 
the upgrade process. Then, review the remaining steps in this book to determine 
the most efficient way to upgrade your system.

■ Complete the Category 1 steps listed in this manual.

■ Begin performing the Category 2 steps. When instructed to do so, run Rapid 
Install to create the new file systems for the application tier components and the 
new ORACLE_HOME for the database. See Upgrading Your System in Installing 
Oracle Applications for information about running Rapid Install.

■ Use AutoPatch to apply the family consolidated upgrade patches, as directed in 
the latest Oracle Applications Release Notes and complete the remaining Category 2 
steps. 

■ Complete the Category 3 steps, which include running AutoUpgrade. Refer to 
Oracle Applications Maintenance Utilities for more information about AutoUpgrade. 

■ Begin the Category 4 steps. When instructed to do so, apply all patches and 
updates.

■ Run Rapid Install again to configure and start the server processes. See Upgrading 
Your System in Installing Oracle Applications for details.

■ Complete the remaining Category 4 steps.

■ Review the implementation and/or setup steps in the product-specific 
documentation. These steps activate some of the features added during the 
upgrade. The Oracle Applications Documentation CD and the virtual doc CD contain 
all product-specific documentation.

■ Complete the Category 5 and Category 6 steps, and any associated 
product-specific implementation steps.

■ Complete the tasks in the Finishing the Upgrade chapter in this manual.

Installed Components and System Requirements
This section lists the certified components supplied by Rapid Install, and the general 
system requirements for an upgrade. Note that requirements for CPU, memory, and 

Note: If you do not complete these tasks in the order listed, the 
upgrade is likely to fail.
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disk space (for log files and backups) are typically much larger during an upgrade 
than during normal operation.

Technology Stack Components
Rapid Install automatically installs and configures the required technology stack 
components for both the database tier and the application tier.

The database tier technology stack for a new Oracle Applications Release 11i 
installation consists of an Oracle9i version 9.2.0.6 (9.2.0 Oracle home) for both new 
installations and upgrades.

The Applications technology stack includes:

■ Oracle Internet Application Server iAS 1.0.2.2.2 — includes Oracle HTTP Server

■ RDBMS 8.0.6 (Oracle Home)

■ Oracle Developer6i (6.0.8.24):

■ Oracle Forms

■ Oracle Reports

■ Oracle Graphics

■ Discoverer (4.1.48)

■ JInitiator (1.3.1.18)

See the Certify web page for the latest certification information. You can access Certify 
from OracleMetaLink (Product Lifecycle > Certifications).

Software Requirements
Rapid Install sets up the required Java Development Kit (JDK) for UNIX, Linux, and 
Windows platforms. If your system is on another platform, see Oracle Applications 
Installation Update Notes for specific information.

The following release maintenance tools must be installed on all nodes and in the 
PATH of the user account that runs the wizard in the PATH of the login accounts that 
will be assigned ownership of the database tier and the application tier file systems. 

Additional Information: Oracle Applications Installation Update Notes 
contain any requirements that are platform-specific.

Additional Information: See Frequently Asked Questions about 
Certify, OracleMetaLink Doc ID: 119139.1. See also Oracle Applications 
Concepts for the architectural layout of the components.

Operating System Required Maintenance Tools

Solaris (SPARC) ar, ld, make

Linux ar, gcc, g++, ld, ksh, make

Windows MSC ++, MKS Toolkit, GNU make, Perl 5.0053

HP-Tru64 ar, cc, ld, make

HP-UX ar, cc, acc, make

IBM AIX ar, ld, linkx1C, make
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CPU
The CPU requirements for an upgrade depend on many factors, including:

■ The size of the database

■ The amount of data in the primary product installation group (if you are 
converting to Multi-Org)

■ The number of operating units for which seed data is being replicated

■ The impact of the change from rule-based optimizer to cost-based optimizer (CBO) 
on customized code

■ The number and duration of long-running processes in Release 11i products

See Oracle Applications Maintenance Utilities for recommendations on the number of 
workers to use during the upgrade. See also Long-running processes in this chapter.

Memory
To calculate the memory requirements for the upgrade, consider:

■ Number of forms servers

■ Number of concurrent users

■ Infrastructure requirements for multi-tiered architecture 

Database Size
To estimate the increase in required disk space for upgrading, consider the number of 
languages being installed and the change in the data model — largely driven by Order 
Management, Marketing and Sales, and Services products.

Tablespace
Your database administrator should take into account the following types of 
tablespaces, which should be set up before you upgrade:

■ SYSTEM tablespace, largely affected by the number of packages and languages.

■ Rollback segments

■ Temporary tablespace (usually TEMP) 

Examine the system tablespace, temp tablespace, and rollback segment sizes during 
the upgrade test runs to determine the minimum space needed to create new 
Applications PL/SQL packages in the production upgrade. We recommend setting a 
minimum SYSTEM tablespace of 9 GB and a minimum TEMP tablespace of 2 GB, with 
an initial extent of 1 MG.

Additional Information: The Oracle Applications Installation Update 
Notes contain complete information on platform-specific requirements.

Additional Information: See the product-specific documentation 
for more information. See also Appendix A in Installing Oracle 
Applications.

Note: See Tablespace Model in this chapter for information about 
product tablespaces.
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Block Size
This release requires an ORACLE database block size of 8K. In addition to providing 
significant performance improvement, Oracle Applications has some indexes that 
require a minimum block size of 8K. If you use a 2K or 4K ORACLE blocksize, you 
must migrate the database to a block size of 8K before you run AutoUpgrade.

Batch Commit Size
Batch commit size determines the number of rows to commit at one time when certain 
scripts run. Starting with Release 11.0, many scripts that process potentially large 
quantities of data accept a parameter that specifies the batch commit size. This 
parameter is automatically passed by AutoUpgrade to the script.

AutoUpgrade prompts you to enter a batch commit size and displays a default value. 
We recommend that you accept the default.

Scheduling Time for the Upgrade
In an upgrade, critical system downtime refers to the period of time when users cannot 
use Oracle Applications. It includes the time to perform all the Category 3 and 4 
upgrade steps, plus the time for AutoUpgrade and AutoPatch to run. 

To provide a baseline for upgrade execution times and an opportunity to work out any 
upgrade issues ahead of time, perform a test upgrade of your existing system, using 
hardware similar to what you use for the production upgrade. A test upgrade is 
especially important if your system has been customized.

During a test upgrade, use the Release 11i Upgrade Assistant Spreadsheet to calculate 
critical system downtime, total upgrade time by category, and total upgrade time 
overall. The timing statistics gathered on the Upgrade Assistant Spreadsheet allow you 
to establish a benchmark for subsequent test upgrades and, finally, for the production 
upgrade. The spreadsheet is included in the Oracle Applications Documentation Library.

The Upgrade Manual Script
The Upgrade Manual Script (TUMS) examines the current configuration and creates a 
report that lists the upgrade steps that do not apply to your system. Because TUMS 
reports on a unique configuration, its output is relevant only to your upgrade. 
Omitting the steps listed in the TUMS report can significantly reduce the time it takes 
to perform the upgrade.

Run TUMS in Category 1, before you begin the upgrade process. For information on 
downloading and applying the TUMS patch, see Upgrade Manual Script (TUMS) Utility 
(Doc ID: 230538.1) on OracleMetaLink. 

Maintenance Wizard
The Maintenance Wizard (formerly known as the Upgrade Assistant), provided at no 
extra charge by Oracle Support Services, helps you plan and perform the upgrade, 
provides a patching strategy, and ensures a smooth upgrade project. It includes a 
utility called the E-Business 11i Upgrade Assistant, which consolidates the information 
in Upgrading Oracle Applications and other upgrade resources to take you through the 

Additional Information: See Creating Tablespaces in Oracle9i 
Database Administrator’s Guide.

Additional Information: See Database Initialization Parameters for 
Oracle Applications 11i (OracleMetaLink Doc ID: 216205.1).



xxii

upgrade in a methodical and repeatable sequence of steps. For more information about 
this tool, see OracleMetaLink document 215527.1.

Minimizing Downtime
Rapid Install creates the new file systems for the application tier components and the 
new file system for the database. This eliminates the need for many previously 
required tasks, such as re-linking application executables and generating form, report, 
and message files.

In addition to performing test upgrades and running TUMS, consider these tips for 
reducing downtime, you may find it beneficial to install the administration server on a 
separate node from the database, as the upgrade process is very CPU-intensive.

Migrating or Upgrading your Database
Migrating or upgrading your existing database to Oracle9i is a required pre-upgrade 
task. For migration or upgrade requirements, see the Database Upgrade Tasks section 
of Chapter 3.

Long-running processes
Certain changes in Release 11i have resulted in long-running processes, which may 
require tuning to optimize performance during the upgrade. To identify long-running 
processes, review $APPL_TOP/admin/<SID>/out/adt<session_id>.lst (UNIX) or 
%APPL_TOP%\admin\<SID>\out\adt<session_id>.lst (Windows). These reports are 
generated during the AutoUpgrade and AutoPatch sessions during the upgrade 
downtime window.

Long-running processes have been identified in the following areas:

■ conversion of database from rules-based optimization of SQL queries to cost-based 
optimization.

■ migration of existing date and non-integer data from character columns to date 
and number type columns. See Chapter 5, Global Accounting Engine Tasks.

■ certain Oracle Payables conversion scripts

Performance of some upgrade scripts can be significantly improved by changing the 
following database settings for the duration of the upgrade.

hash_area_size (init.ora parameter)
Controls the amount of memory that Oracle can use for hash join processing. Oracle 
recommends a value of 30 MB for the hash area size, provided that the database server 
has sufficient available memory. You can calculate the maximum amount of memory 
that can be used for this parameter by dividing the amount of available memory (after 
taking into consideration the size of the SGA and the user processes) by the value of 
the parallel_max_servers.

hash_join_enabled (init.ora parameter)
Set this parameter to true.

Additional Information: See Oracle9i Migration and Oracle9i 
Utilities.

Additional Information: See AD Job Timing Reports in Oracle 
Applications Maintenance Utilities.
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parallel_max_servers (init.ora parameter)
Controls the maximum number of parallel query server processes running in the 
database. Oracle recommends a value equal to 4 times the number of CPUs.

Temporary tablespace
This tablespace (usually TEMP) should be created as a locally managed tablespace 
using the temporary file option with a uniform allocation size. If the temporary 
tablespace is not defined in this way, drop the temporary tablespace and recreate it 
using the following example as a template:

SQL> drop tablespace TEMP;
SQL> create TEMPORARY tablespace TEMP
     tempfile ’ts_p_temp1.dbf’ size 2048M
     EXTENT MANAGEMENT LOCAL
     UNIFORM SIZE 1M;

To verify that the temporary tablespace has been created, execute the following: 

SQL> select CONTENTS,EXTENT_MANAGEMENT,ALLOCATION_TYPE 
     from dba_tablespaces 
     where tablespace_name=’TEMP’;

The query output should be:

CONTENTS      EXTENT_MANAGEMENT     ALLOCATION_TYPE
------------  -----------------     --------------- 
TEMPORARY     LOCAL                 UNIFORM

After the upgrade, change the hash_area_size and parallel_max_servers settings back 
to the defaults, and restore the previous storage parameters for the temporary 
tablespace. After the upgrade, lower the extent size for the temporary tablespace to a 
value that is less than 1 MB (for example, 128 K).

Important Upgrade Considerations
Some of the new Release 11i functionality may affect the way you use Applications 
products after the upgrade. For a list of changes and enhancements, refer to the Oracle 
Applications Product Update Notes, the About documents on OracleMetaLink, and the 
product implementation manuals and user’s guides.

Oracle Applications Product Update Notes is published with each major release, so the 
version available with this release documents only the changes between Release 11.0 
and 11.5.1. Enhancements made since that time are documented in the Release Content 
Documents (RCD). In addition, data model changes are available in the Electronic 
Technical Reference Manual (eTRM). Both documents are available on OracleMetaLink.

Other considerations topics are discussed in this section. The topics are arranged 
alphabetically.

10SC Global Demo Database
Data in Production 16 (10SC) Global Demo databases is not supported in Release 11i. 
See Oracle Common Modules Tasks in Chapter 3 for more information.

Additional Information: See Database Initialization Parameters in 
Oracle Applications (OracleMetaLink Doc ID: 216205.1).
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Architecture
Oracle Applications Concepts contains a complete discussion of the architecture in this 
release, including information about the Oracle Applications multi-tiered architecture, 
Release 11i enhancements, language support, file system structure, and the basic data 
model.

Character-mode Environments
If you are upgrading from a character-mode environment, there are significant 
infrastructure considerations. For example, you must understand which type of server 
requires an installation of each product. See Oracle Applications Concepts for more 
information.

Cost-based Optimization (CBO)
Optimization is the process of choosing the most efficient way to execute a SQL 
statement. Oracle Applications Release 11i uses cost-based, rather than rule-based 
optimization. Cost-based optimization dynamically determines the most efficient access 
paths and join methods for executing SQL statements by taking into account statistics 
such as the size of each table and the selectivity of each query condition.

Release 11i represents a transition from rule-based to cost-based optimization. Because 
CBO is enabled during the AutoUpgrade process, the pre-upgrade steps in this book 
are rule-based, while steps performed after you run AutoUpgrade (post-upgrade) are 
cost-based. You may want to evaluate the impact of CBO on custom code in the test 
system before you begin the upgrade.

Database Initialization Parameters
Initialization parameters required at each stage of the upgrade may vary depending on 
when you upgrade your database. You should review the requirements for these 
parameters before you begin the upgrade. See OracleMetaLink document Database 
Initialization Parameters for Oracle Applications (Doc ID: 216205.1).

Dropping Obsolete Columns
During the upgrade process, the Oracle RDBMS DROP COLUMN command marks 
Oracle Applications columns as unused in the data dictionary, making it possible for 
the database administrator to drop the columns and reclaim the associated space. It is 
a good idea to plan this reclamation ahead of time because the process locks the 
associated tables. Once the space is reclaimed, the upgraded data model looks more 
like a fresh install (except for customizations). Note that DROP COLUMN has no effect 
on custom columns.

Inactive or Partially Implemented Installed Products
You must perform upgrade steps for every installed product regardless of which 
products you actually use. For example, if you have Oracle Human Resources fully 
installed but only partially implemented, you must still perform the Oracle Human 
Resources upgrade steps.

You may also need to perform upgrade steps for some products installed as shared 
(dependent) products. To determine the dependent products you have installed, run 
$AD_TOP/sql/adutconf.sql (UNIX) or %AD_TOP%\sql\adutconf.sql (Windows). 

Additional Information: See Cost-based Optimization in Oracle 
Applications Concepts. See also Introduction to Optimization in 
Oracle8i Concepts.
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All products are installed in the database. Therefore, some steps, like dropping 
obsolete objects after the upgrade is complete, must be performed for all products.

Installed vs. Licensed Products
Rapid Install creates the Oracle Applications file system, and AutoUpgrade upgrades 
the objects associated with all products registered in your system. When maintaining 
Oracle Applications, AutoPatch copies only the files appropriate for the APPL_TOP 
configuration. For example, report files are not copied into an APPL_TOP that is 
configured as a forms server. In addition, to save time during patching, AutoPatch 
does not generate any files for products that are not registered.

Maintenance Mode
Maintenance mode is a new feature that provides a clear separation between normal 
runtime operation of Oracle Applications and system downtime for maintenance. It 
ensures optimal performance and reduces downtime during AutoPatch sessions.

You toggle maintenance mode from enabled to disabled from the Change Maintenance 
Mode menu in AD Administration. When enabled, maintenance mode shuts down the 
Workflow Business Events System and sets up function security so that no functions 
are available to users.

Multi-Org Installations
In a Multi-Org installation, you defined an Operating Unit and set the site-level AOL 
profile option MO:Operating Unit to use this new operating unit. Do not delete this 
profile option. If you do, you cannot complete the upgrade process successfully.

Multiple Reporting Currencies
Multiple Reporting Currencies has been incorporated into the APPS schema so the 
APPS_MRC schema is no longer required. This change, which is transparent to 
end-users, improves processing efficiency and reduces maintenance. Patches need be 
applied only once (in the APPS schema), making it unnecessary to synchronize objects 
between schemas.

The APPS schema is used for standard reports, inquiries, and programs for MRC 
currency data in MRC-enabled products. MRC data that retrieves custom code may 
need to be converted to use the database objects in the APPS schema.   

System Backup
We strongly recommend that you back up your entire system before you begin the 
upgrade as a safeguard against unexpected data loss and application upgrade errors.

Tablespace Model
This release introduces the Oracle Applications Tablespace Model (OATM). In prior 
releases, each Applications product was allocated two tablespaces, one for tables and 
one for indexes. OATM uses 12 locally managed tablespaces for all products, including 
the temporary tablespace, system tablespace, and system-managed undo (SMU). Each 
database object is mapped to a tablespace based on its input/output characteristics, 

Additional Information: See the sections on Changing Maintenance 
Mode and on Preparing your System for Patching — Maintenance 
Mode in Chapter 5 of Oracle Applications Maintenance Utilities.

Additional Information: See the Maintaining Multiple Currencies in 
Oracle Applications in OracleMetaLink.
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including object size, life span, access methods, and locking granularity. This allows 
for easier maintenance, reduces unnecessary space use, and introduces runtime 
performance gains.

You can migrate to OATM by using the OATM Migration Utility. This interactive, 
menu-based PERL program allows for migration of all schemas at once, or for 
migration of selected schemas. If you plan to convert to the new model, first perform a 
pre-upgrade step (Database Upgrade Tasks in Chapter 2), and then run OATM 
Migration Utility after the upgrade process is complete (System-specific Tasks in 
Chapter 7).

Windows Platforms
On Windows platforms, Release 11i application tier components (forms server, Web 
server, concurrent processing server, and administration server) must be installed on 
nodes that do not have existing Release 10.7 or Release 11.0 installations. If you install 
Oracle Applications 11i on a node that has existing Applications 10.7 or 11.0 
components, the registry settings will be changed and those components will no 
longer be usable.

Languages and Character Sets
This section discusses some important considerations for managing your languages 
and character sets during the upgrade.

Space for Languages
Additional space for each non-American English language will be required in the 
database to complete the upgrade. It is not possible to predict the amount of additional 
space your system will need because the space depends on factors such as the number 
of active non-American English languages and the database character set — and it 
depends largely on the volume of customer-created data in the system.

Note that the additional space for languages must be available throughout the 
upgrade process — while running AutoUpgrade, while applying the English 
maintenance pack, and while applying the translated maintenance packs.

Language Status
You must retain your existing Applications Release 10.7 or 11.0 language status until 
the entire upgrade process is complete — including the post-upgrade and finishing 
steps. The base language must also remain the same, and new languages cannot be 
activated.

Additional Information: For more information on the Oracle 
Applications Tablespace Migration, see OracleMetaLink document 
248857.1. 

Caution: The OATM utility does not support a reversal of the 
migration process — once an object is moved from the old tablespace, 
it cannot be moved back.

Note: For the recommended minimum space required for each active 
language in the APPL_TOP, see the Oracle Applications NLS Release 
Notes.
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After the upgrade process is complete, you can change your language status as 
required, and activate new languages. Refer to the Registering a Language and 
Selecting a New Base Language sections in Oracle Applications Maintenance Procedures 
for detailed information.

Character Sets during the Upgrade
If you need to change the character set of the Release 10.7 or 11.0 database, you must 
wait until after the upgrade process is complete to make the change.

On the Rapid Install wizard upgrade screens, you must select a character set to be 
used for the Release 11i APPL_TOP. The character set you select must be compatible 
with the character set of the database as it exists during the upgrade process. You can 
change the APPL_TOP character set from the one in your existing Release 10.7 or 11.0 
Applications system, but it must remain compatible with the database character set 
until the upgrade process is complete.

Customized Environments
Customized code may require special attention during an upgrade. The instructions in 
this book assume that you have followed the standards for customizing Oracle 
Applications exactly as described in the Oracle Applications Developer’s Guide and the 
Oracle Applications User Interface Standards for Forms-based Products. To preserve 
customizations and minimize the impact during the upgrade, you must:

■ Follow the Oracle Applications Developer’s Guide instructions

■ Read and understand the Oracle Applications Developer’s Guide information about 
upgrading customizations (Customization Standards chapter)

■ Maintain complete documentation for customizations

■ Back up customizations before the upgrade

Upgrades and Patches
Pay special attention to the Oracle Applications Upgrades and Patches section in the 
Oracle Applications Developer’s Guide. It contains important information about how the 
upgrade treats customizations.

Protecting Data in Renamed Files
Because files can be renamed by various people for a variety of reasons, it is a good 
idea to protect them during the upgrade. Therefore, if you have renamed files using 
the <filename>old, <filename>new, or any other generic designation, rename them 
before you begin the upgrade to prevent them from being accidentally overwritten.

Caution: If you change the character set in the APPL_TOP to one 
that is not compatible with the current database character set, the 
upgraded system will be unusable.

Caution: Customizing any concurrent program definitions, 
menus, value sets, or other seeded data provided by Oracle 
Applications is not supported. The upgrade process overwrites 
these customizations.
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Customized Reports and Forms
SQL*Report (RPT), the flexfield APIs FlexRpt, and FlexSQL are no longer supported. 
Rewrite any custom reports that use these programs with a tool such as Oracle Reports 
Developer.

Customized Help Files
The help files in this release are in HTML format, making them easy to modify using a 
commercial web browser/editor. You cannot reapply previously customized help files 
to Release 11i. Therefore, it is important that you save the pre-upgrade customized 
help files as a reference.

Product-specific Information
The information in this section applies to specific Applications products in this release. 
For more information, see Release Content Documents and Features Summary Matrices on 
OracleMetaLink.

Marketing & Sales and Service Product Families
If you have any products from the Marketing and Sales and the Service product 
families installed and your system is Oracle Applications Release 10.7, 11.0, or 3i, you 
can upgrade directly to Oracle Applications 11.5.10. Follow instructions in the 
appropriate upgrade categories in this book.

Public Sector/University 
The following new and redesigned Public Sector/University products are included in 
this release:

■ Oracle Public Sector Budgeting

■ Oracle Public Sector Financials (International)

■ Oracle Grants Proposal

■ Oracle Student System

■ Oracle U.S. Federal Financials

These products add functionality built on existing Oracle Applications products. Pay 
special attention to the manual upgrade steps in this book, as well as the 
implementation and/or setup steps in the product-specific documentation.

Additional Information: See Coding Oracle Reports Concurrent 
Programs in Oracle Applications Developer’s Guide. See also 
Upgrading Custom Forms to Release 11i in Oracle Applications 
Developer’s Guide.

Additional Information: See Customizing Oracle Applications 
Help in the Oracle Applications System Administrator’s Guide - 
Configuration.

Note: Oracle U.S. Federal Financials Version 2.0 applies to Oracle 
Applications Release 10.7, and Version 3.3 applies to Release 11.0.3.
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FlexBuilder/Account Generator
In Release 11.0, FlexBuilder was replaced by the Account Generator using Oracle 
Workflow.

If you used FlexBuilder in Release 10.7 to build Accounting Flexfield code 
combinations, you must have Oracle Workflow installed and set up to use the Account 
Generator. AutoUpgrade installs Oracle Workflow for you. However, you must 
complete some additional setup steps after the AutoUpgrade processing. If you plan to 
customize the Account Generator configuration, install the Oracle Workflow Builder 
on the desktop client.

Before the upgrade, review the way each product uses the Account Generator to 
generate Accounting Flexfield code combinations. Consider whether the default 
Account Generator processes are appropriate for each product, and appropriate for 
each set of books that uses a unique Accounting Flexfield structure. For each structure 
and set of books, you can choose to:

■ use the default Account Generator process

■ use the previously customized Release 10.7 FlexBuilder assignment created for 
Release 11i in the upgrade process

■ customize the default Account Generator process

This choice determines which post-upgrade steps you must perform.

Oracle Receivables and Oracle Projects
To interface draft invoices to Oracle Receivables, Oracle Projects pre-defines a context 
for the AR Transaction flexfield, and also pre-seeds a batch source, transaction types, 
and grouping and ordering rules for Projects invoices in Receivables. The following 
changes were made in Release 11.0 to the Oracle Projects seed data in Oracle 
Receivables.

In new installations, you see only the new data. In upgrades from Release 10.7, these 
seed data changes do not apply. However, you continue to see the new values 

Additional Information: See Overview of the Account Generator 
in Oracle Applications Flexfields Guide. See also Oracle Workflow 
Administrator’s Guide and Oracle Workflow Developer’s Guide.

Note: References to FlexBuilder apply to Oracle Projects only with 
respect to project transactions that interface with Oracle Payables 
and Oracle Purchasing. For other purposes, Oracle Projects 
continues to use AutoAccounting.

Seed Data Type Old Name New Name

Transaction Flexfield Context PA INVOICES PROJECTS INVOICES

Batch Source PA INVOICES PROJECTS INVOICES

Transaction Type PA Invoice Projects Invoice

Transaction Type PA Credit Memo Projects Credit Memo

Grouping Rules PA Grouping Rule Projects Grouping Rule

Ordering Rules PA Ordering Rule Projects Ordering Rule
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(PROJECTS) as well as the old values (PA). Continue to use only the old values. New 
data is replicated for the new operating units created in this release.

Oracle Quality
Collection elements Available Quantity, Completed Quantity, and Ship To Location are 
pre-defined and seeded in Oracle Quality. Existing user-defined collection elements 
with these names are renamed with the prefix @ during the upgrade. For example, 
Available Quantity becomes @Available Quantity. 

As a result, after the upgrade you have two collection elements with similar names. 
When you create collection plans or run reports and queries, consider which collection 
element to use: the Quality-defined collection element or the renamed user-defined 
collection element.
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1
Category 1 — Before You Receive the

Software

This chapter describes the Category 1 steps — they require nothing from the new 
software. After you complete them, you can continue to use current Oracle 
Applications environment. We recommend that you perform these steps as soon as 
you know that you will be upgrading to Release 11i of Oracle Applications.

The following upgrade tasks are discussed in this chapter:

Database Upgrade Tasks on page 1-1
System Administration Tasks on page 1-3
Application Object Library Tasks on page 1-4
Oracle Alert Tasks on page 1-5
Oracle Workflow Tasks on page 1-5
Oracle Cash Management Tasks on page 1-6
Oracle Payables Tasks on page 1-6
Oracle Receivables Tasks on page 1-7
Oracle Financials for Latin America Tasks on page 1-8
Oracle Projects Tasks on page 1-10
Oracle Human Resources Tasks on page 1-12
Oracle Payroll (U.S.) Tasks on page 1-14
Oracle Labor Distribution Tasks on page 1-15
Oracle Work in Process Tasks on page 1-16
Oracle Public Sector Financials (International) Tasks on page 1-16

Database
You must complete the tasks in this section before you perform the Applications 
Technology steps or the product-specific steps.

Database Upgrade Tasks
Before you begin these tasks, you should take advantage of The Upgrade Manual Script 
(TUMS). It creates a report that lists the upgrade steps that do not apply to your 
system. You can safely omit from the upgrade any step on the list. For information on 
creating the TUMS report, see Upgrade Manual Script (TUMS) Utility (Doc ID: 230538.1) 
on OracleMetaLink.

Task List Status Responsibility

1. Back up the Oracle Applications database Recommended Database Administrator

2. Maintain multilingual tables Conditionally Required System Administrator
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1-2 Oracle Applications Upgrading Oracle Applications

Step 1  Back up the Oracle Applications database
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Make a cold backup of the Oracle Applications database. Use it to restore the database 
if you encounter problems during the upgrade process.

Step 2  Maintain multilingual tables 
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If your system has active languages other than American English, ensure the validity 
and accuracy of the multilingual tables by running the "Maintain multi-lingual tables" 
task from the Maintain Applications Database Objects menu in AD Administration. 
There should be no ORACLE errors.

Release 10.7:
The log file is in $APPL_TOP/install/log (UNIX) or %APPL_TOP%\install\log 
(Windows).

Release 11.0:
The log file is in $APPL_TOP/admin/<SID>/log (UNIX) or %APPL_
TOP%\admin\<SID>\log (Windows), where <SID> is the name of the database 
against which you ran AD Administration. 

Step 3  Verify operating system login
This step is Required. It applies to Release 10.7 or 11.0 upgrades.

3. Verify operating system login Required System Administrator

4. Rename custom database objects with Applications prefixes Conditionally Required Database Administrator

5. Back up Oracle Applications and customizations Conditionally Required Database Administrator

Requirement Explanation

Reference manual? Oracle Backup and Recovery Guide

Users must log off? Yes

Caution: Shut down the database with the NORMAL option. You 
may not be able to restore the database from the backup if you use 
the IMMEDIATE or ABORT option.

Requirement Explanation

Reference manual? Oracle Applications Installation, Release 10.7 or 11.0

Users must log off? No

Requirement Explanation

Reference manual? Installing Oracle Applications

Users must log off? No

Task List Status Responsibility
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You need one main operating system login (typically applmgr) to run AutoUpgrade 
and to manage Oracle Applications product files. Because you are upgrading, the 
Applications login has already been created. Be sure that you can log in to all the 
machines in the environments that are affected by the upgrade process.

Step 4  Rename custom database objects with Applications prefixes
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

In order to upgrade custom database objects, you should be aware of these important 
considerations:

■ The Oracle Applications Developer’s Guide contains extensive instructions about 
naming standards and issues related to upgrading custom database objects. You 
should be completely familiar with this information before you begin the upgrade.

■ Before you actually run the upgrade, you should run several test upgrades and 
track their impact on your custom database objects.

Step 5  Back up Oracle Applications and customizations
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Back up existing Oracle Applications product files, product customizations, 
customized help files (in HTML), and the Oracle Applications database before you 
begin to unload the Oracle Applications software.

Applications Technology
This portion of the upgrade applies to all users. Complete these tasks before you 
perform the product-specific steps. 

System Administration Tasks
Perform the following tasks for System Administration.

Additional Information: See Creating Login Accounts in Installing 
Oracle Applications.

Requirement Explanation

Reference manual? Oracle Applications Developer’s Guide

Users must log off? No

Caution: Failure to test the impact on custom database objects 
before the upgrade can result in a loss of functionality

Requirement Explanation

Reference manual? Oracle Backup and Recovery Guide

Users must log off? Yes

Task List Status Responsibility

1. Determine attachment file upload directory Conditionally required System Administrator

2. Preserve the CUSTOM library Recommended System Administrator
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1-4 Oracle Applications Upgrading Oracle Applications

Step 1  Determine attachment file upload directory
This step is Conditionally Required. It applies to Release 10.7NCA or 11.0 upgrades.

In Releases 10.7NCA and 11.0, you could attach file-type documents to any application 
entity with Oracle Applications Attachments. The files were stored in a directory on 
the application tier, with its location stored in the Attachment File Directory profile 
option. In Release 11i, file-type attachments are stored in the database. In this step, 
determine the location of existing attachment files so that you can load them into the 
database in the System Administration Tasks in Chapter 4.

1. As the system administrator, choose Profile > System. 

2. In the Find System Profile Values window, type Attachment File Directory in the 
Profile field. Press Find. 

3. If a profile option has been set, write down its current directory path. If there is no 
profile option, there are no attachment files to be upgraded. 

4. In the operating system on the application server, verify that there are files in the 
directory specified by the profile option setting. 

Step 2  Preserve the CUSTOM library 
This step is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Make a backup of the CUSTOM library (CUSTOM.pll) to use when you migrate the 
library to Release 11i in Step 10 of the System Administration Tasks in Chapter 4.

Application Object Library Tasks
Perform the following tasks for Application Object Library.

Step 1  Transition custom forms to Oracle Forms Developer 6i
This step is Conditionally Required. It applies to Release 10.7, 11.0, or 10SC 
(SmartClient) upgrades.

Requirement Explanation

Reference manual? Oracle Application Object Library/Workflow Technical Reference Manual, Oracle 
System Administrator’s Guide - Maintenance

Users must log off? No

Requirement Explanation

Reference manual? Oracle Applications Developer’s Guide

Users must log off? No

Additional Information: See Using the CUSTOM Library in Oracle 
Applications Developer’s Guide.

Task List Status Responsibility

1. Transition custom forms to Oracle Forms Developer 6i Conditionally Required Technical Specialist

Requirement Explanation

Reference manual? Oracle Applications Developer’s Guide, Oracle Applications User Interface Standards

Users must log off? No
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If you are upgrading from the Release 10.7 character-mode SQL*Forms 2.3, rewrite 
custom forms in Oracle Forms 6i. If you are upgrading from Release 10SC 
(SmartClient), Release 10.7, or Release 11.0, and the forms are already in Oracle Forms 
4.5, upgrade them now.

Oracle Alert Tasks
Perform the following tasks for Oracle Alert.

Step 1  Purge Alert and Action Set Check alerts
This step is Recommended. It applies to Release 10.7 or 11.0 upgrades.

For the best upgrade performance, it’s a good idea to keep the ALR_ACTION_
HISTORY table small (20,000 rows or less). To selectively purge alerts in this table:

For 10.7:
Download and apply patch 451137. Then, from the AOL (APPLSYS) schema, run 
al451137.sql (located in $ALR_TOP/patchsc/107/sql). The script prompts for numdays 
(the age of the history to be deleted). History older than the number of days entered 
will be deleted.

For 11.0:
Download and apply patch 451137. Then, as the Alert Manager, perform these steps:

1. Navigate to the Alerts window (Alerts > Define) and choose Query > Enter.

2. Type Purge% in the Name field and choose Query > Run.

3. Click Enable and save the screen. The default for Numdays is 30 and for 
Application is ALL. If you leave these fields blank, Alert Checks older than 30 
days will be deleted for all applications.

4. Choose Request > Check to run Purge Alert and Action Set Checks. Enter "Oracle 
Alert" in the Application field, and "Purge" in the Alert Parameter field.

Oracle Workflow Tasks
Perform the following tasks for Oracle Workflow.

Step 1  Upgrade to Oracle Workflow 2.0.3
This step is Required. It applies to Release 10.7 upgrades.

Additional Information: See Customization Standards in Oracle 
Applications Developer’s Guide.

Task List Status Responsibility

1. Purge Alert and Action Set Check alerts Recommended Database Administrator

Requirement Explanation

Reference manual? No

Users must log off? No

Task List Status Responsibility

1. Upgrade to Oracle Workflow 2.0.3 Required System Administrator
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To complete the upgrade to Release 11i, you must be using version 2.0.3 of Oracle 
Workflow. Use SQL*Plus to determine your current version:

select text from wf_resources where name = ’WF_VERSION’;

If this command returns the version "2.0.3", no further action is necessary. If the 
version is not 2.0.3, apply patch 668409 before you continue with the Release 11i 
upgrade. The patch is available on OracleMetaLink.

Financials
Review this section and complete only the tasks for the Oracle Financials products you 
have installed. 

Oracle Cash Management Tasks
Perform the following tasks for Oracle Cash Management.

Step 1  Back up custom Reconciliation Open Interface objects 
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you have implemented the Reconciliation Open Interface and customized it to work 
in your environment, back up CE_999_INTERFACE_V (view) and CE_999_PKG 
(package) to the APPS account, or write a script to recreate them after the upgrade. 
You will reinstall them in Step 1 of the Oracle Cash Management Tasks in Chapter 6.

Oracle Payables Tasks
Perform the following tasks for Oracle Payables.

Step 1  Complete outstanding payment batches 
This step is Required. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? Oracle Applications Installation, Release 10.7 or 11.0

Users must log off? No

Task List Status Responsibility

1. Back up custom Reconciliation Open Interface objects Conditionally Required Technical Specialist

Requirement Explanation

Reference manual? Reconciliation Open Interface (Oracle Cash Management User’s Guide)

Users must log off? No

TUMS Step Key? CE_999_BACKUP

Task List Status Responsibility

1. Complete outstanding payment batches Required Application Specialist (Payables)
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In character-mode, navigate to the Cancel Payment Batch form (\Navigate Controls 
Payment ResetPaymentBatch) to see if there are any outstanding payment batches and 
to confirm or cancel a payment batch.

In GUI, as the Payables Manager, choose Payments > Entry > Payment Batches. Query 
for in-process payment batches. Complete or cancel batches by choosing the Actions 
button and using the Actions window. 

Oracle Receivables Tasks
Perform the following tasks for Oracle Receivables.

Step 1  Rename custom tax structure 
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you have created a customized Sales Tax Location Flexfield structure, rename the 
customized structures so AutoUpgrade does not overwrite them. AutoUpgrade 
creates the following default structures: Province, Province.City, City, State.City, 
State.County.City, No Validation - Country.

Step 2  Save custom tax vendor extension views 
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? Cancel Payment Batch and Confirm Payment Batch (Payables Reference 
Manual, Release 10.7); (Payables User’s Guide, Release 10.7 or 11)

Users must log off? No

TUMS Step Key? AP_COMPLETE_OUTSTANDING_PAYMENTS

Task List Status Responsibility

1. Rename custom tax structure Conditionally Required System Administrator

2. Save custom tax vendor extension views Conditionally Required Database Administrator

3. Verify realized gains, realized losses, and rounding accounts Conditionally Required Application Specialist 
(Receivables)

4. Migrate customers as persons Conditionally Required System Administrator

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? AR_RENAME_CUSTOM_TAX

Note: Name the customized Sales Tax Location Flexfield structure 
something other than one of the six default structures.

Requirement Explanation

Reference manual? Oracle Receivables Tax Manual

Users must log off? No

TUMS Step Key? AR_SAVE_TAX_VENDOR_VIEW
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If you have implemented the Tax Vendor Extension and customized the Tax Vendor 
Extension views, save the customized copies or write a script to recreate them. You 
will reinstall these views in Step 2 of the Oracle Receivables Tasks in Chapter 5. Once 
you complete this step, do not add any more customized views until after you run 
AutoUpgrade.

Step 3  Verify realized gains, realized losses, and rounding accounts
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

For each organization where you have defined a Realized Gains, Realized Losses, or 
Cross Currency Rounding account, verify that each account is enabled and valid as of 
the date you perform the upgrade.

Step 4  Migrate customers as persons
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Customer records migrated to Oracle Receivables are brought in, by default, as 
organizations (companies). To migrate a particular customer (or set of customers) as 
persons, set the CUSTOMER_CATEGORY_CODE in the RA_CUSTOMERS table to 
CONSUMER for each such customer.

Oracle Financials for Latin America Tasks
Perform the following tasks for Oracle Financials for Latin America.

Note: Software to integrate Taxware (previously known as AVP) 
and Vertex is included in Receivables Release 11 and 11i. If you 
previously integrated Receivables Release 10 with Taxware or 
Vertex using software supplied by the Oracle Design and Migration 
Services (DMS), see Implementing Oracle Receivables with Vertex 
Quantum Release 11i or Implementing Oracle Receivables with Taxware 
Sales/Use System Release 11i.

Requirement Explanation

Reference manual? Oracle Receivables User’s Guide

Users must log off? No

TUMS Step Key? AR_VERIFY_GAINS_LOSSES_ACCOUNTS

Requirement Explanation

Reference manual? Oracle Receivables User’s Guide

Users must log off? No

TUMS Step Key? AR_MIGRATE_CUSTOMERS

Task List Status Country/Responsibility

1. Import outstanding bank collection documents Required Brazil/Application Specialist (Payables)

2. Restore all archived technical appraisals and adjustments Recommended Colombia/Application Specialist

3. Print all completed transactions Required Argentina, Brazil, Colombia/System 
Administrator
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Step 1  Import outstanding bank collection documents
This step is Required. It applies to Release 11.0 upgrades (Brazil).

Import all bank collection documents from the Bank Collection Documents interface 
tables. From the Brazilian Payables responsibility, run the Import Bank Collection 
Documents program from the Standard Request Submission windows (Other > 
Requests > Run). Use the Imported Collection Documents window (Collection 
Documents > Imported > Collection Docs) to review and fix all rejected bank collection 
documents.

Step 2  Restore all archived technical appraisals and adjustments
This step is Recommended. It applies to Release 11.0 upgrades (Colombia).

With Oracle Assets for Colombia, you can run a technical appraisal against multiple 
depreciation books. Restoring archived technical appraisals and adjustments ensures 
that data created in Release 11 is upgraded to meet Release 11i standards.

Step 3  Print all completed transactions
This step is Required. It applies to Release 10.7 or 11.0 upgrades (Argentina, Brazil, 
Colombia).

Requirement Explanation

Reference manual? Oracle Financials for Brazil User’s Guide

Users must log off? No

Requires Concurrent Manager? Yes

TUMS Step Key? JL_IMPORT_OUTSTANDING_BANK

Additional Information: See Entering and Associating Collection 
Documents in Oracle Financials for Brazil User’s Guide. 

Requirement Explanation

Reference manual? Oracle Financials for Colombia User’s Guide

Users must log off? No

Requires Concurrent Manager? Yes

TUMS Step Key? JL_RESTORE_ARCH_APPRAISALS

Note: If you omit this step, the technical appraisal data archived 
in Release 11 is not upgraded to the Release 11i format, and you 
cannot restore it after the upgrade. Also, you could unknowingly 
revalue a technical appraisal against a book in which the appraisal 
was already revalued in Release 11.

Additional Information: See Archiving, Purging, and Restoring 
Technical Appraisals in Oracle Financials for Colombia User’s Guide. 

Requirement Explanation

Reference manual? Oracle Financials Common Country Features User’s Guide

Users must log off? No

TUMS Step Key? JL_PRINT_ALL_COMPLETED_TRX
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You must successfully print all completed transactions before upgrading to Release 11i. 
Incidents such as printing errors can cause a mismatch between an invoice transaction 
number and the number on a pre-numbered form. In such cases, use the Regional 
Receivables Copy and Void process to maintain accurate audit information. You can 
copy and void only those transactions that have not been transferred to General 
Ledger.

Projects
Review this section and complete only the tasks for the Oracle Projects products you 
have installed. 

Oracle Projects Tasks
Perform the following tasks for Oracle Projects.

Step 1  Complete transfer and tieback of cost, revenue, and invoices
This step is Required. It applies to Release 10.7 (except character mode) or 11.0 
upgrades.

Complete the transfer and tieback processes for all cost and revenue transactions and 
invoices during the normal processing cycle.

To run a process, choose Other > Requests > Run. In the Submit Request window, 
enter the process name and submit the request. Run each process again just before you 
run AutoUpgrade to ensure that all data in the interface tables is processed.

Caution: If you print completed transactions after the upgrade, 
printing errors could irreparably corrupt the audit trail for 
transactions you have already transferred to General Ledger.

Task List Status Responsibility

1. Complete transfer and tieback of cost, revenue, and 
invoices

Required Application Specialist (Projects)

2. Clear Transaction Interface table Conditionally Required Technical Specialist/
Application Specialist (Projects)

3. Transfer asset lines and post mass additions Conditionally Required Application Specialist (Projects)

4. Upgrade to the new summarization model Conditionally Required Technical Specialist/
Application Specialist (Projects)

Requirement Explanation

Reference manual? No

Users must log off? No

Requires Concurrent Manager? Yes

Process Name Process Name

PRC: Tieback Expense Reports from Payables PRC: Tieback Invoices from Receivables

PRC: Tieback Labor Costs from General Ledger PRC: Tieback Revenues from General Ledger

PRC: Tieback Total Burdened Cost from GL PRC: Tieback Usage Costs from GL
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Step 2  Clear Transaction Interface table 
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform only if you have any pending transactions in the transaction interface table 
(PA_TRANSACTION_INTERFACE_ALL).

Import all pending transactions from the transaction interface table into Oracle 
Projects. Choose Other > Requests > Run. In the Submit Request window, enter PRC: 
Transaction Import and submit the request. Enter a Transaction Source at the prompt. 

To be certain that the table is cleared, run the Transaction Import process for each 
Transaction Source. If the process rejects any records, fix them and run the Transaction 
Import process again, or delete the records from the table. 

Run this process again just before you run AutoUpgrade to ensure that all data in the 
interface tables is processed.

Step 3  Transfer asset lines and post mass additions 
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you use the Capital Projects feature in Oracle Projects, complete the transfer of asset 
lines to Oracle Assets as part of the normal processing cycle. 

■ To transfer asset lines, choose Other > Requests > Run. In the Submit Request 
window, enter PRC: Interface Assets and submit the request. 

■ To create assets from the assets lines you transferred, run the Post Mass Additions 
program in Oracle Assets. From the Fixed Assets Manager responsibility, choose 
Mass Additions > Post Mass Additions.

Run these processes again just before you run AutoUpgrade to ensure that all data in 
the interface tables is processed.

Step 4  Upgrade to the new summarization model 
This step is Conditionally Required. It applies to Release 10.7 upgrades.

Requirement Explanation

Reference manual? No

Users must log off? No

Requires Concurrent Manager? Yes

TUMS Step Key? PA_CLEAR_TRANS_INTERFACE_TBL

Requirement Explanation

Reference manual? No

Users must log off? No

Requires Concurrent Manager? Yes

TUMS Step Key? PA_TRANSFER_ASSET_LINES

Requirement Explanation

Reference manual? No

Users must log off? No

Requires Concurrent Manager? Yes

TUMS Step Key? PA_UPGRADE_TO_SUMMARIZATION_MODEL
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If you are using the pre-Release 10.7 accumulation model, upgrade to the new 
summarization model. Choose Requests > Run. In the Submit Request window, enter 
PRC: Update Project Summary Amounts and submit the request. Run this process for 
all projects.

Human Resources
Review this section and complete only the tasks for the Oracle Human Resources 
products you have installed.

Oracle Human Resources Tasks
Perform the following tasks for Oracle Human Resources.

Step 1  Update custom code that references obsolete synonyms 
This step is Conditionally Required. It applies to Release 10.7 upgrades.

AutoUpgrade drops certain synonyms that existed in Release 10.7 for compatibility 
with Release 9. If you have custom code that references one of the following Release 9 
names, replace it with the associated Release 10.7 name.

Step 2  Update custom reports that reference HRV_ and OTV_
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Task List Status Responsibility

1. Update custom code that references obsolete synonyms Conditionally Required System Administrator

2. Update custom reports that reference HRV_ and OTV_ Conditionally Required System Administrator

3. Note location of custom script for Salary Proposal view Conditionally Required Database Administrator

4. Update custom code for positions Conditionally Required System Administrator

5. Update user-defined FastFormula definitions Conditionally Required System Administrator

6. Update Vertex geocodes data Conditionally Required Database Administrator

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? PER_UPDATE_CUSTOM_CODE

Release 9 Name Release 10.7 Name

PER_LETTER_GENERATION_STATUSES PER_LETTER_GEN_STATUSES

PER_ABSENCE_ATTENDANCE_REASONS PER_ABS_ATTENDANCE_REASONS

PER_CONTACTS PER_CONTACT_RELATIONSHIPS

PER_CLASSIFICATIONS PER_SPECIAL_INFO_TYPES

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? PER_UPDATE_CUSTOM_REPORTS
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AutoUpgrade drops views that begin HRV_ and OTV_. If you have custom reports 
that contain these prefixes, amend them to reflect the new HRMS Intelligence views.

Step 3  Note location of custom script for Salary Proposal view 
This step is Conditionally Required. It applies to Release 10.7 upgrades.

The Salary Proposals view (formerly PER_SALARY_PROPOSALS_HRV) is renamed to 
HRU_SALARY_PROPOSALS to make its name consistent with other views that can be 
customized. Run peupl01v.sql from $PER_TOP/admin/sql (UNIX) or %PER_
TOP%\admin\sql (Windows) to create the view. If you have previously customized 
this script, reapply the changes to the newly delivered script using a text editor. Check 
the absolute location of the customized script before the upgrade since PER_TOP points 
to the new code tree after upgrade.

Step 4  Update custom code for positions
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Before Release 11i, position information was stored in the PER_ALL_POSITIONS table 
in: PER_POSITIONS and PER_POSITIONS_V1. Now, position information has been 
datetracked, and the information stored in the HR_ALL_POSITIONS_F table. New 
views, HR_POSITIONS_V and other standard datetracked views, support datetracked 
positions. If you have created custom code that references the old position tables or 
views, update it to reference the new datetracked ones.

Step 5  Update user-defined FastFormula definitions
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

In VARCHAR columns, dates are stored in canonical format (YYYY/MM/DD 
HH24:MI:SS format, instead of DD-MON-YYYY), and decimal numbers are stored 
using the decimal place character ("."), even for countries where a different character is 
standard (for example, France uses a comma). 

With Oracle FastFormula, you can define database items or functions for use in any 
formula. If you have previously defined your own database items, change the item 
definitions and PL/SQL route definitions to reflect these changes. 

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? PER_CHECK_SALARY_PROP_VIEW

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? PER_UPDATE_CUSTOM_POSITIONS

Requirement Explanation

Reference manual? No

Users must log off? Yes

TUMS Step Key? PER_UPDATE_FF_DEFINITIONS
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To change database item definitions:
On any VARCHAR columns used to store numbers or dates, change ff_database_
items.definition_text as follows: use fnd_number.canonical_to_number (instead of to_
number) and fnd_date.canonical_to-date (instead of to_date). For example, a database 
item with definition text "to_number (EEV.screen_entry_value)" should be changed to 
"fnd_number.canonical_to_number (EEV.screen_entry_value)".

To change a route definition:
Remove to_date (and DD-MON-YYYY) from any date context in ff_routes.text. For 
example, a route with text containing "and to_date(\&B1, ’DD-MON-YYYY’) between 
EE.effective_start_date and EE.effective_end_date" should be changed to read "and 
\&B1 between EE.effective_start_date and EE.effective_end_date".

Step 6  Update Vertex geocodes data 
This step is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Each patch requires that you have applied the previous year’s patch, released in July. 
AutoUpgrade automatically upgrades the system to the latest Geocode data, if you 
have applied the prerequisite patch. For example, for an upgrade in April 2003, you 
must have applied (at least) the Geocode patch for 2002 (released in July 2002). For an 
upgrade in October 2003, you must have applied the Geocode patch for 2003 (released 
in July 2003). 

Oracle Payroll (U.S.) Tasks
Perform the following tasks for Oracle Payroll (U.S.).

Step 1  Update custom code for U.S. tax information (W4) changes
This step is Conditionally Required. It applies to Release 10.7 upgrades.

If you have built custom code that references old tables or views, update it to reference 
the new datetracked ones.

Before Release 11, tax information was stored in descriptive flexfields in PER_
ASSIGNMENT_EXTRA_INFO. There were three views: PAY_EMP_FED_TAX_V1, 

Requirement Explanation

Reference manual? No

Users must log off? Yes

TUMS Step Key? PER_UPDATE_VERTEX

Task List Status Responsibility

1. Update custom code for U.S. tax information (W4) 
changes

Conditionally Required System Administrator

2. Complete all Multiple Worksite reporting Required Technical Specialist

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? PAY_UPDATE_CUSTOM_W4
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PAY_EMP_STATE_TAX_V1, and PAY_EMP_LOCAL_TAX_V1. In Release 11i, the W4 
information has been datetracked. There are four new tables:

PAY_US_EMP_FED_TAX_RULES_F
PAY_US_EMP_COUNTY_TAX_RULES_F
PAY_US_EMP_STATE_TAX_RULES_F
PAY_US_EMP_CITY_TAX_RULES_F

The following new views have been created to support datetracked W4:

PAY_US_EMP_FED_TAX_RULES_V
PAY_US_EMP_COUNTY_TAX_RULES_V
PAY_US_EMP_TIME_IN_STATE_V
PAY_US_EMP_TIME_IN_CITY_V
PAY_US_EMP_STATE_TAX_RULES_V
PAY_US_EMP_CITY_TAX_RULES_V
PAY_US_EMP_TIME_IN_COUNTY_V

Step 2  Complete all Multiple Worksite reporting 
This step is Required. It applies to Release 10.7 upgrades.

The Multiple Worksite report uses a new generic hierarchy mechanism, which alters 
the way you represent the enterprise for the Multiple Worksite report. This feature 
requires additional setup for Release 10.7 users. Complete all Multiple Worksite 
reporting based on your previous setup.

Oracle Labor Distribution Tasks
Perform the following tasks for Oracle Labor Distribution.

Step 1  Ensure that transactions are summarized and transferred
This step is Required. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? Oracle Applications Online Help

Users must log off? No

TUMS Step Key? PAY_MULTI_WORKSITE

Caution: It is critical that you complete this step as the new 
reporting structure is the only one supported in Release 11i.

Additional Information: See Creating an Establishment Hierarchy 
in Oracle Applications Online Help. 

Task List Status Responsibility

1. Ensure that transactions are summarized and transferred Required Application Specialist

Requirement Explanation

Reference manual? Oracle Labor Distribution User’s Guide

Users must log off? No

Requires Concurrent Manager? Yes
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Summarize and transfer all transactions. See Chapter 11, Summarize and Transfer 
Payroll Distributions Procedures, Oracle Labor Distribution User’s Guide.

Manufacturing
Review this section and complete only the tasks for the Oracle Manufacturing products 
you have installed.

Oracle Work in Process Tasks
Perform the following tasks for Oracle Work in Process.

Step 1  Close discrete jobs and purge unneeded data – WIP   
This step is Recommended. It applies to Release 10.7 or 11.0 upgrades.

To make the upgrade process run faster, close all discrete jobs that you are no longer 
transacting and that you are prepared to close, and purge all unneeded discrete jobs 
and repetitive schedules.

To close discrete jobs:
As the Manufacturing and Distribution Manager, choose the WIP function. Then 
navigate to Discrete Jobs > Close discrete jobs > Close discrete jobs.

To purge unneeded discrete jobs and repetitive schedules:
As the Manufacturing and Distribution Manager, choose the WIP function. To purge 
discrete data, navigate to Discrete Jobs > Purge Discrete jobs > Purge Discrete jobs. To 
purge repetitive data, navigate to Repetitive > Purge Repetitive Schedules > Purge 
Repetitive Schedules.

Public Sector
Review this section and complete only the tasks for the Oracle Public Sector products 
you have installed.

Oracle Public Sector Financials (International) Tasks
Perform the following tasks for Oracle Public Sector Financials (International).

Task List Status Menu Responsibility > Function / Responsibility

1. Close discrete jobs and purge unneeded 
data – WIP

Recommended Manufacturing and Distribution Manager > WIP/
Application Specialist (WIP)

Requirement Explanation

Reference manual? Oracle Work in Process Reference Manual, Release 10.7

Oracle Work in Process User’s Guide, Release 11.0

Users must log off? No

Requires Concurrent Manager? Yes

Additional Information: See Discrete Job Close, Discrete Job Purge 
and Repetitive Schedule Purge in Oracle Work in Process Reference 
Manual, Release 10.7. See also Discrete Manufacturing, Discrete Job 
Close in Oracle Work in Process User’s Guide, Release 11. 
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Step 1  Verify patch set level
This task is Required. It applies to Release 11.0 upgrades.

Before you upgrade to Release 11i, your system must be on Public Sector Financials 
International V3.3 Patch Set G (1987816). If you have not yet applied this patch set, you 
must do so now.

Task List Status Responsibility

1. Verify patch set level Required System Administrator

Requirement Explanation

Reference manual? No

Users must log off? No
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2
Category 2 — After You Receive the Software

This chapter describes Category 2 steps — they require unloading new files, but do not 
affect the use of Applications products at the existing release level. Unless otherwise 
noted, perform the steps that require a form from the "old" APPL_TOP, and steps that 
require a SQL*Plus script from the "new" APPL_TOP.

The following upgrade tasks are discussed in this chapter:

Environment Preparation Tasks on page 2-1
Database Upgrade Tasks on page 2-3
System Administration Tasks on page 2-5
Oracle FlexBuilder/Account Generator Tasks on page 2-6
Oracle General Ledger Tasks on page 2-7
Global Accounting Engine Tasks on page 2-9
Oracle Payables Tasks on page 2-12
Oracle iPayment Tasks on page 2-15
Oracle Financials for Asia/Pacific Tasks on page 2-15
Oracle Financials for Europe Tasks on page 2-20
Oracle Financials for Latin America Tasks on page 2-21
Oracle Projects Tasks on page 2-22
Oracle Inventory Tasks on page 2-31
Oracle Order Management Tasks on page 2-32
Oracle Purchasing Tasks on page 2-38
Oracle Public Sector Financials (International) Tasks on page 2-40

Environment
All users must complete this portion of the upgrade. Complete these tasks before you 
perform the Database Upgrade, the Applications Technology, or the product-specific 
steps.

Environment Preparation Tasks
Perform the following tasks to prepare your environment for the upgrade.

Note: On Windows platforms, Release 11i application tier 
components (forms server, Web server, concurrent processing 
server, and administration server) must be installed on nodes that 
do not have existing Release 10.7 or Release 11.0 installations. If you 
install Oracle Applications 11i on a node that has existing 
Applications 10.7 or 11.0 components, the registry settings will be 
changed and those components will no longer be usable.
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Step 1  Run Rapid Install
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Rapid Install sets up the technology stack, creates all necessary file systems for the 
application tier components (APPL_TOP and Applications technology stack 
ORACLE_HOME), and creates the new ORACLE_HOME for the Applications 
database. There is no need to relink executables or generate forms, reports, and 
message files.

Go to Chapter 1 of Installing Oracle Applications and follow the instructions. Then, go to 
Chapter 4 and follow the steps for upgrading with Rapid Install. When directed to do 
so, return to the tasks in this book and continue with the pre-upgrade steps. 

Step 2  Set environment variables and add custom settings
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Rapid Install creates APPS<CONTEXT_NAME>.env (UNIX) or APPS<CONTEXT_
NAME>.cmd (Windows) to set up the Applications environment, including the 
technology stack. Set the necessary environment variables before you run AutoPatch 
or any of the AD utilities. Log in as the default Applications user and from the new 
APPL_TOP, run:

UNIX (from a Bourne shell):
$. APPS<CONTEXT_NAME>.env

Windows:
C:\> APPS<CONTEXT_NAME>.cmd

Rapid Install also sets environment variables (such as JAVA_TOP, OA_JRE_TOP, 
CLASSPATH, OAH_TOP, and OAD_TOP) in $APPL_TOP/admin/adovars.env 
(UNIX), or in %APPL_TOP%\admin\adovars.cmd (Windows registry). If you have 
customized variables in adovars.env or adovars.cmd, you may need to edit this file for 
all servers (except the database server) to define these environment variables and add 
any other customized settings, including custom application basepath variables.

Task List Status Responsibility

1. Run Rapid Install Required Database Administrator/System Administrator

2. Set environment variables and add custom settings Required Database Administrator/System Administrator

3. Apply upgrade patches Required Database Administrator/System Administrator

Requirement Explanation

Reference manual? Installing Oracle Applications

Users must log off? No

Requirement Explanation

Reference manual? No

Users must log off? No

Additional Information: See Oracle Applications Concepts. See also 
Oracle Applications Maintenance Utilities.
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Step 3  Apply upgrade patches
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Using AutoPatch in pre-install mode, apply any family consolidated upgrade patches 
listed in the most current Oracle Applications Release Notes. Do not apply the AD 
minipack at this time.

Database
All users must complete this portion of the upgrade. Complete these tasks before you 
perform the Applications Technology steps or the product-specific steps.

Database Upgrade Tasks
Perform the following tasks to prepare your database for the upgrade.

Step 1  Validate APPS schema(s)
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Follow the instructions in this step to generate a list of invalid objects (<APPS schema 
name>.lst) in the database.

If you are upgrading from Release 10.7:
Run the following script. 

UNIX:
$ cd $APPL_TOP/admin/<SID>/out
$ sqlplus <SYSTEM username>/<SYSTEM password> \
@$APPL_TOP/admin/preupg/advrf107.sql <APPS username> <AOL username>

Note: Settings in adovars.env or adovars.cmd affect all 
Applications product groups using this APPL_TOP. If you wish to 
define database-specific customizations, add logic to ensure the 
settings are executed only for the relevant product group. UNIX 
users can also add the logic to the end of the main environment file, 
after the call to adovars.env. However, this logic must be re-applied 
any time the main environment file is regenerated.

Requirement Explanation

Reference manual? AutoPatch (Oracle Applications Maintenance Utilities)

Users must log off? No

Task List Status Responsibility

1. Validate APPS schema(s) Recommended Database Administrator/System Administrator

2. Verify custom index privileges Conditionally Required Database Administrator

Requirement Explanation

Reference manual? AD Administration (Oracle Applications Maintenance Utilities)

Users must log off? No
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Windows:
C:\> cd %APPL_TOP%\admin\<SID>\out
C:\> sqlplus <SYSTEM username>/<SYSTEM password> \
@%APPL_TOP%\admin\preupg\advrf107.sql <APPS username> <AOL username>

If you are upgrading from Release 11.0:
To create a list of invalid objects, run Validate APPS Schema(s) from the Maintain 
Database Objects menu in AD Administration from the old APPL_TOP.

For both releases:
Review the list and take corrective action as indicated. Then, run the Compile APPS 
schema(s) option from the Maintain Applications Database Objects menu in AD 
Administration to compile the invalid objects. Correct all problems in the report before 
you continue with the upgrade.

Step 2  Verify custom index privileges 
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If a schema owns a custom index on an Oracle Applications table, ensure that the 
schema has privileges to drop the custom indexes. ODF Comparison may try to drop 
custom indexes when it maintains Oracle Applications tables. Use the following 
command to identify schemas that may cause problems:

UNIX:
$ cd $APPL_TOP/admin/preupg  
$ sqlplus <APPS username>/<APPS password> @afindxpr.sql <APPLSYS>

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @afindxpr.sql <APPLSYS>

The afindxpr.sql script creates two files: afpregdi.lst and afpregdi.sql. The afpregdi.lst 
file lists custom indexes with a different owner. Use afpregdi.sql to grant DROP ANY 
INDEX privileges for any TABLE_OWNERs listed. If the file is empty, no further 
action is required. 

UNIX:
$ cd $APPL_TOP/admin/preupg  
$ sqlplus <SYSTEM username>/<SYSTEM password> @afpregdi.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <SYSTEM username>/<SYSTEM password> @afpregdi.sql

Additional Information: See AD Administration in Oracle 
Applications Maintenance Utilities.

Requirement Explanation

Reference manual? No

Users must log off? No
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Applications Technology Products
All users must complete this portion of the upgrade. Complete these tasks before you 
perform the product-specific steps.

System Administration Tasks
Perform the following tasks for System Administration.

Step 1  Restrict access to administration directory – all servers except database
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Some AutoUpgrade output, such as log and restart files, contains passwords to 
ORACLE accounts related to Oracle Applications, including the SYSTEM account. We 
recommend that you restrict access to the administration directory that contains these 
files. Typically, you need to do so only in cases where users require access to the 
servers for other reasons. Run this step from the new APPL_TOP. Repeat on all servers 
where you intend to run AutoUpgrade or AutoPatch. 

UNIX:
$ cd $APPL_TOP
$ chmod 700 admin

Windows:
C:\> cd %APPL_TOP%
C:\> attrib +R admin

Step 2  Purge old concurrent requests 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Task List Status Responsibility

1. Restrict access to administration directory – all 
servers except database

Recommended Database Administrator / System 
Administrator

2. Purge old concurrent requests Recommended System Administrator

Requirement Explanation

Reference manual? No

Users must log off? No

Note: Retain log and restart files online until you have 
implemented your products and tested them thoroughly. Oracle 
Support Services may need access to these files if you encounter 
problems implementing or using your system.

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Maintenance

Users must log off? No

Concurrent Manager? Yes
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To purge concurrent requests, run the Purge Concurrent Requests and/or Managers 
report (Requests > Run > Submit Request) from the old APPL_TOP in either AGE 
(number of days old) or COUNT (number of old requests to retain) mode.

Oracle FlexBuilder/Account Generator Tasks
Perform the following tasks for Oracle FlexBuilder/Account Generator.

Step 1  Indicate use of FlexBuilder process for Account Generator
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Perform this step to use the Generate Account Using FlexBuilder Rules process for a 
particular Workflow Account Generator item type. This process replicates the 
FlexBuilder customizations from Release 10.7.

AutoUpgrade scripts update the FlexBuilder rules. The Generate Account Using 
FlexBuilder Rules process contains the logic from the custom FlexBuilder rules. It 
contains a function that retrieves the necessary item attribute values (corresponding to 
raw parameters in FlexBuilder) and calls PL/SQL functions to create the code 
combination. Apply patch 1570300, then run afffcfb.sql to check for inconsistencies:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @afffcfb.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @afffcfb.sql

Review afffcfb.out for data inconsistencies. You may be able to use the UPDATE 
statement in afffcfb.sql to fix the data. Note the following codes and meanings:

Additional Information: See Purge Concurrent Request and/or 
Manager Data Program in Oracle Applications System Administrator’s 
Guide - Maintenance.

Task List Status Responsibility

1. Indicate use of FlexBuilder process for Account Generator Conditionally Required System Administrator

Requirement Explanation

Reference manual? Oracle Applications Flexfields Guide, Oracle Workflow Administrator’s Guide, 
Oracle Workflow Developer’s Guide

Users must log off? Yes

FB: FlexBuilder KFF: Key Flexfield

Form-F: FNDFBRFP form (FlexBuilder functions)

Responsibility: Application Developer

Navigation path: Flexfield > FlexBuilder > Function

Form-P: FNDFBMPA form (FlexBuilder parameters)

Responsibility: Application Developer

Navigation path: Flexfield > FlexBuilder > Parameter

Form-A: FNDFBMAS form (FlexBuilder assignments)

Responsibility: Application Developer

Navigation path: Flexfield > FlexBuilder > Assign

Form-K: FNDFFMIS form (FlexBuilder segments)

Responsibility: System Administrator

Navigation path: Application > Flexfield > Key > 
Segments
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Financials
Review this section and complete only the tasks for the Oracle Financials products you 
have installed.

Oracle General Ledger Tasks
Perform the following tasks for Oracle General Ledger.

Step 1  Review daily rates 
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Perform this step if you maintain daily rates for more than one set of books with the 
same functional currency in the same Release 10.7 Applications installation.

In this release, a single set of daily rates is maintained for each Applications instance. 
If you have set up multiple sets of books in a single Release 11i Applications 
installation, you must use the same set of daily rates for each set of books.

During the upgrade, AutoUpgrade analyzes the daily rates maintained in each set of 
books. For each date for which daily rates are maintained, it looks for rate conflicts — 
instances where the From Currency, To Currency, and Conversion Rate Type are the 
same in more than one set of books, but where the daily rate differs.

If there are no conflicts, all daily rates for that combination of From Currency, To 
Currency, and Conversion Rate Type from all of the sets of books are transferred into 
the new daily rate set. If conflicts are found, no rates are transferred. This process is 
repeated for each combination of From Currency, To Currency, and Conversion Rate 
Type for which you maintain daily rates in your sets of books.

In Step 1 of the Oracle General Ledger Tasks in Chapter 5, the migration script requires 
you to specify one of two options for handling conflicts.

Caution: The upgrade may fail if it contains data inconsistencies.

Task List Status Responsibility

1. Review daily rates Conditionally Required Application Specialist (GL) 
/ Database Administrator

2. Revise custom programs that automatically load daily rates Conditionally Required Technical Specialist

Requirement Explanation

Reference manual? Oracle General Ledger User’s Guide

Users must log off? No

TUMS Step Key?  GL_REVIEW_DAILY_RATES

Note: Descriptive flexfields defined for daily rates are not 
transferred during the upgrade. To retain descriptive flexfields, 
complete Step 1 of the Oracle General Ledger Tasks in Chapter 5.

Caution: Review the daily rates carefully before the upgrade so 
you can resolve conflicts after the upgrade.
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■ Choose daily rates from 1 set of books to use for all sets of books (Option 1)

For example, assume there are 2 sets of books in one Release 10.7 Applications 
installation. Each maintains daily rates for converting German marks to U.S. 
dollars (DM to USD), rate type Corporate. Assume the rates are:

You might choose to use the daily rates from Set of Books (SOB) 1 for both sets of 
books. If so, the installation converts German marks to U.S. dollars using these 
rates. The SOB 2 rates are not retained.

■ Migrate one set of rates to a new rate type (Option 2)

Using the same assumptions as the previous example, you can keep the daily rates 
from both sets of books by migrating one set of rates to a new rate type.

To review daily rates before the upgrade:
1. Run the Daily Rates Conflict report from your new APPL_TOP for summary 

information:

UNIX:

$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @glurtrpp.sql

Windows:

C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @glurtrpp.sql

2. Review any conflicting rates online in each set of books to identify the nature of 
the conflict. Alternatively, run the Daily Rates Listing for each set of books and 
compare the reports manually.

For example, you can instruct the post-upgrade script to migrate all the daily rates 
maintained in SOB 2 to a new rate type, Corp2. Then, you can instruct the script to 
migrate all daily rates maintained in SOB 1 to the rate type Corporate.

Step 2  Revise custom programs that automatically load daily rates
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Day Rate for Set of Books 1 Rate for Set of Books 2

01-DEC-1999 .5757 .576

02-DEC-1999 .5759 .576

03-DEC-1999 .5761 .576

04-DEC-1999 .5763 .576

05-DEC-1999 .5765 .577

Note: The script you run to produce the Daily Rates Conflict 
report after the upgrade is different from the script in this step.

Requirement Explanation

Reference manual? Oracle General Ledger User’s Guide

Users must log off? No
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Perform this step only if you currently use a custom process to load daily rates into 
Oracle General Ledger Release 10.7.

This release contains an open interface table (GL_DAILY_RATES_INTERFACE) for 
automatically loading daily rates. If you use a custom process to automatically 
populate the GL_DAILY_CONVERSION_RATES table, modify the process to use the 
new interface table. After the upgrade, test the customized loading process to ensure 
the daily conversion rates are being loaded correctly.

Global Accounting Engine Tasks
Perform the following tasks for Global Accounting Engine.

Step 1  Update accounting data model 
This task is Conditionally Required. It applies to Release 11.0 upgrades.

In prior releases, a single transaction in the primary set of books could contain 
multiple accounting sequence IDs. However, a transaction in the MRC reporting sets 
of books could contain only a single accounting sequence ID. Now, you can assign 
categories to the same event types for both the primary and MRC reporting sets of 
books, so that transactions in the MRC reporting sets of books can contain multiple 
accounting sequence IDs.

The upgrade provides complete functionality for this change. However, if you applied 
patch 1257205 (in patch set 11.0.AX.F, or later) in Release 11.0 to upgrade to the new 
accounting model, use AutoPatch in pre-install mode to apply patch 1746184 to update 
the Release 11.0 files.

To verify the status of the data model update, type this command:

sqlplus <APPS username>/<APPS password>
SQL> desc AX_SLE_LINES:

TUMS Step Key?  GL_REVISE_DAILY_RATES_LOAD

Caution: Loading daily rates directly into the GL_DAILY_RATES 
table can corrupt GL data.

Additional Information: See Entering Daily Rates in Oracle 
Applications General Ledger User’s Guide.

Task List Status Responsibility

1. Update accounting data model Conditionally Required Database Administrator

2. Ensure that transactions are translated Required Application Specialist (Payables and Receivables)

3. Calculate balances Conditionally Required Database Administrator

4. Close all accounting periods Required Application Specialist (Payables and Receivables)

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key?  AX_UPDATE_ACCOUNTING_DATAMODEL

Requirement Explanation
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If the application_id and set_of_books_id columns exist and are reported as NOT 
NULL columns, you have upgraded to the new 11.0 accounting data model. 

Step 2  Ensure that transactions are translated
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Submit the AX Posting Manager for all applications and sets of books. To check the 
concurrent log file for the Posting Manager for events that were not translated or that 
were translated in error, run axxpre01.sql from the new APPL_TOP. The output is 
ordered by application, set of books, translation status, event type, and transaction 
number.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @axxpre01.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @axxpre01.sql

Review the axxpre01.lst output file and verify that none of the untranslated events 
need to be translated.

Step 3  Calculate balances
This task is Conditionally Required. It applies to Release 10.7 upgrades.

If you applied the balance calculation update in Release 10.7, omit this step. If you did 
not, calculate the balances for all accounting lines now. 

Requirement Explanation

Reference manual? Oracle Applications Global Accounting Engine User’s Guide

Users must log off? Yes

Concurrent Manager? Yes

TUMS Step Key?  AX_ENSURE_TRANS_ARE_TRANS

Note: All Payables and Inventory events must be translated prior 
to the upgrade. All Receivables events with an accounting date less 
than or equal to the upgrade cutoff date must also be translated. 
However, Receivables events that are related to future-dated 
revenue recognition transactions may be translated as of their 
accounting date (NON_CASH_UPDATE event type).

Requirement Explanation

Reference manual? Oracle Applications Global Accounting Engine User’s Guide

Users must log off? No

Concurrent Manager? Yes

TUMS Step Key?  AX_CALCULATE_BALANCES
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Verify balance calculation update:
Run the following script from the new APPL_TOP.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @axxpre02.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @axxpre02.sql

If the script reports an upgraded balance calculation, no further action is required.

Calculate balances:
If the script reports that the balance calculation was not upgraded: 

1. Submit balance reports.

Submit balance reports for the latest period for each application and for each set of 
books that uses the Global Accounting Engine.

Note that in Release 10.7, balances can run for only one year at a time. All balances 
for the year are recalculated each time that you run the report. If new transactions 
were created for a prior year, run a balance calculation for that year and again for 
each subsequent year.

2. Update accounting lines.

Update the accounting lines after the upgrade. See Step 3 in the Global Accounting 
Engine Tasks in Chapter 5.

Step 4  Close all accounting periods
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

In sets of books using the Global Accounting Engine, close all prior periods in Oracle 
Payables, Receivables, and Inventory, and all current and future periods to prevent 
transactions during the upgrade. Perform this step from the old APPL_TOP. See Step 3 
of the Oracle Cost Management Tasks in Chapter 3.

Report Name Description

Supplier Balance by 
Account/Accounting Flexfield

Accounting Flexfield report (use AX Payables 
Supervisor responsibility)

Customer Balance by 
Account/Accounting Flexfield

Accounting Flexfield report (use AX Receivables 
Supervisor responsibility)

Organization Balance by 
Account/Accounting Flexfield

Accounting Flexfield report (use AX Inventory 
Supervisor responsibility)

Requirement Explanation

Reference manual? Oracle Payables User’s Guide, Oracle Receivables User’s Guide, Oracle Inventory 
User’s Guide

Users must log off? No

Concurrent Manager? Yes

TUMS Step Key?  AX_CLOSE_AP_PERIODS
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Oracle Payables Tasks
Perform the following tasks for Oracle Payables.

Step 1  Update supplier/supplier site bank data for multiple supplier banks 
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Complete this step only if you have existing supplier and supplier site remit-to bank 
information. 

AutoUpgrade transfers supplier bank data from PO_VENDORS and PO_VENDOR_
SITES_ALL tables to the AP_BANK_BRANCHES, AP_BANK_ACCOUNTS_ALL, and 
AP_BANK_ACCOUNT_USES_ALL tables. Identify bank data that must be added to 
the supplier records so that the upgrade can create corresponding records in the banks 
tables. Then, update the supplier records with the required data. 

Review existing supplier information:
Run apmsbrep.sql from the new AP_TOP in the database user you want to upgrade:

UNIX:
$ cd $AP_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @apmsbrep.sql

Windows:
C:\> cd %AP_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @apmsbrep.sql

The script produces a report (apmsbrep.lst) that shows what the upgrade is going to 
do, including the supplier bank information to be transferred, the bank records to be 
created, and the records that will not be transferred because required values are 
missing. Review the report to determine whether to update supplier bank information 
before it is transferred. If no rows are returned, no further action is necessary.

Additional Information: See Closing an Accounting Period and 
Opening and Closing Accounting Periods in Oracle Receivables 
User’s Guide. See also Maintaining Accounting Periods in Oracle 
Inventory User’s Guide. 

Task List Status Responsibility

1. Update supplier/supplier site bank data for multiple 
supplier banks

Conditionally Required Technical Specialist/
Application Specialist (Payables)

2. Choose payment method for future-dated payments Conditionally Required Technical Specialist/
Application Specialist (Payables)

3. Enable recoverable tax option Conditionally Required Technical Specialist/
Application Specialist (Payables)

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? AP_UPDATE_SUPPLIER_AND_BANK_SITE
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Update supplier bank information: 
Supplier bank information cannot be transferred without a value for the following 
required columns: bank, branch, and account number. Update the information for 
these columns from the application window or by running the b747306a script.

■ From the application window

Character-mode: use the Bank Accounts region of the Enter Vendor form 
(\Navigate Vendors Entry). 

GUI: choose Suppliers > Entry and use the Bank region of the Suppliers window. 
Then, choose Suppliers > Entry and click the Sites button. Use the Bank Accounts 
region of the Supplier Sites window to make the updates. After the upgrade, you 
cannot access bank information from the GUI Suppliers window.

■ Using 747306

If you have a large number of supplier records that have no value for bank 
number and/or branch number, you can request patch 747306. It contains 
b747306a (provides temporary values so the upgrade can transfer these records) 
and b747306b (runs after the upgrade to reset the values to null).

Step 2  Choose payment method for future-dated payments
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform only if you use future-dated payments or manual future-dated payments. 

Future Dated and Manual Future Dated payment method types have been replaced 
with the Check, EFT (Electronic), Wire, or Clearing payment types. The apboepre.sql 
script populates a temporary table that the upgrade uses to update the future payment 
method on existing invoices, payments, and payment formats. 

Enter the new payment method for the Future Payment method and for the Manual 
Future Dated payment method at the prompt. Run this script only once from the new 
APPL_TOP.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <AP username>/<AP password> @apboepre.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <AP username>/<AP password> @apboepre.sql

If you do not run this script, AutoUpgrade automatically replaces Future Dated with 
EFT (Electronic) and Manual Future Dated with Check.

Step 3  Enable recoverable tax option
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? No

Users must log off? Yes

TUMS Step Key? AP_CHOOSE_PAYMENT_METHOD
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If you have NO recoverable tax in ANY operating unit, omit this step.

In order to set up recoverable taxes in Step 3 of the Oracle Payables Tasks in Category 
6, set the Enable Recoverable Tax Financials flag to Y now. This option affects the way 
tax lines are flagged as recoverable or nonrecoverable, the way accounting entries are 
created during the upgrade, and the way data is populated in Recovery Rate.

Perform this task for any operating unit where tax has been considered recoverable 
(for example, VAT or GST) in the past, or will be in the future.

Add recoverable tax flag:
To add the NON_RECOVERABLE_TAX_FLAG column to the FINANCIALS_
SYSTEM_PARAMS_ALL table, run apaltfsp.sql from the new APPL_TOP. Run this 
script only once.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <AP username>/<AP password> @apaltfsp.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <AP username>/<AP password> @apaltfsp.sql

Enable recoverable tax option:
Choose the appropriate script to set the Enable Recoverable Tax Financials option to 
Yes. When you set up recoverable taxes in Step 3 of the Oracle Payables Tasks in 
Category 6, the tax codes are updated to be 100% recoverable and the TAX_
RECOVERABLE_FLAG for each of the existing tax lines is set to Y (100% recoverable).

For single operating units that use recoverable tax, or multiple operating units that 
ALL use recoverable tax, run the following script once to update all operating units:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <AP username>/<AP password> @apfspre2.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <AP username>/<AP password> @apfspre2.sql

For multiple operating units with different tax recovery structures, run the following 
script for each operating unit that uses recoverable tax:

Requirement Explanation

Reference manual? No

Users must log off? Yes

Caution: Set the Enable Recoverable Tax option to Y for all 
operating units that require recoverable tax. If you do not, 
accounting entries will be created incorrectly.
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UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <AP username>/<AP password> @apfspre1.sql <org_id>

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <AP username>/<AP password> @apfspre1.sql <org_id>

Oracle iPayment Tasks
Perform the following Oracle iPayment tasks.

Step 1  Configure payees and payment systems
This task is Required. It applies to Release 3i upgrades.

The upgrade migrates Release 3i transaction data for payees and payment systems that 
exist in Release 11i. Before the upgrade, the payees and payment systems must be 
configured in iPayment, according to the steps outlined in the Oracle iPayment Concepts 
and Procedures Guide. 

Your Release 11i payees should have a payee ID that is the same as the corresponding 
Release 3i merchant names to migrate the data. Release 11i payment systems should 
also have the same suffixes as the Release 3i vendors.

Oracle Financials for Asia/Pacific Tasks
Perform the following tasks for Oracle Financials for Asia/Pacific.

Step 1  Record truncated lookup codes or renamed meanings in custom 
modules
This task is Required. It applies to Release 10.7SC Production 16.1 (or higher) or 11.0 
upgrades (All Countries).

Task List Status Responsibility

1. Configure payees and payment systems Required Applications Specialist (iPayment)

Requirement Explanation

Reference manual? Oracle iPayment Concepts and Procedures Guide

Users must log off? No

Task List Status Country/Responsibility

1. Record truncated lookup codes or renamed meanings in 
custom modules

Required All/
System Administrator

2. Move government uniform invoice information for each 
organization

Required Taiwan/
System Administrator

3. Move supplier uniform numbers and tax registration 
numbers

Recommended Taiwan/
System Administrator

4. Record uniform numbers for your company Recommended Taiwan/
System Administrator

5. Record Canadian tax setup Conditionally Required Canada/
System Administrator

6. Print tax rebate and rule listings Recommended Canada/
Application Specialist
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During the upgrade, lookup codes longer than 30 bytes are truncated and duplicate 
lookup code meanings are renamed. No seeded codes are affected. If customized 
modules reference these lookup codes or lookup code meanings, you may need to 
modify the migrated lookups or the customized modules. See Step 1 of the Oracle 
Financials for Asia/Pacific Tasks in Category 4. 

Run this script from the new APPL_TOP to identify the affected lookup codes and 
lookup code meanings:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @jamlsmck.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jamlsmck.sql

Step 2  Move government uniform invoice information for each organization
This task is Required. It applies to Release 10.7 or 11.0 upgrades (Taiwan).

All previous Oracle Financials for Taiwan windows are now obsolete. During the 
upgrade, export certificate and other government uniform invoice information, except 
miscellaneous invoices, is moved to either globalization flexfields or Oracle 
Receivables windows. To record the existing government uniform invoice information, 
run jatwupg1.sql, and review the output (<Org ID>jatwupg1.lst).

To record existing government uniform invoice information:
Run jatwupg1.sql by typing:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @jatwupg1.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jatwupg1.sql

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? JA_RECORD_TRUNCATED_LOOKUPS

Note: The upgrade does not migrate obsolete lookups. Refer to 
the Product Update Notes for Oracle Financials for Asia/Pacific.

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? JA_MOVE_GOVT_INVOICE_INFO
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To move government uniform invoice information:
All government uniform invoice attributes are assigned to transactions. Use 
jatwupg2.sql to migrate invoice format data.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @jatwupg2.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jatwupg2.sql 

Review output in <Org ID>jatwupg2.log. The script performs the following actions:

■ Updates only complete transactions in closed periods. If there are incomplete 
transactions in a current open period after the upgrade, enter a transaction source 
in the Transaction window. 

■ Moves government uniform invoice information defined in the Define Uniform 
Invoices/Sales Receipts window to the Transactions window and its globalization 
flexfield. The following table shows the field mapping:

■ Moves export certificate information that was entered in the Define Zero-rate 
Uniform Invoices in Release 10.7 or 11.0 to the Transactions window globalization 
flexfield. The following table shows the field mapping:

Step 3  Move supplier uniform numbers and tax registration numbers
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades (Taiwan).

10.7 or 11.0 Field Name (Define 
Uniform Invoices/Sales Receipts) Release 11i Field Name (Transactions)

Invoice Format Invoice Format (hidden segment in globalization 
flexfield)

Uniform Invoice Word + Uniform 
Invoices/Sales No

Legacy Uniform Invoice (segment in the globalization 
flexfield)

Void Status (base product field in the More alternate name 
region)

Wine/Cigarette Wine/Cigarette (segment in the globalization 
flexfield)

Note: Because the transaction date is used as the government 
uniform invoice date, the uniform invoice date is not migrated.

Release 10.7 or 11.0 Field Name 
(Define Zero-Rate Uniform Invoices)

Release 11i Field Name
 (Transactions)

Number Export Certificate Number (segment in globalization flexfield)

Name Export Name (segment in the globalization flexfield)

Export Method Export Method (segment in the globalization flexfield)

Export Date Export Date (segment in the globalization flexfield)
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Previously, supplier uniform numbers (taxpayer IDs) were stored in the globalization 
flexfield of the Suppliers window. In Release 11i, the Suppliers window contains both 
Taxpayer ID and Tax Registration Number fields. Record existing supplier uniform 
numbers and tax registration numbers so you can redefine the numbers after the 
upgrade, and move the supplier uniform numbers from the Suppliers window 
globalization flexfield to the Suppliers window Taxpayer ID field.

Record existing supplier uniform numbers:
Run jatwupg5.sql as follows:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @jatwupg5.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jatwupg5.sql

Review output in jatwupg5.lst and keep the file for your records.

Move supplier uniform numbers and tax registration numbers:
Use the jatwupg6.sql script to transfer the supplier uniform numbers (taxpayer ID) 
from the Uniform Number globalization flexfield segment to the Taxpayer ID field of 
the Suppliers window. The script does not update the Taxpayer ID field unless it is 
blank, so make sure there is no data in this field.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @jatwupg6.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jatwupg6.sql

Step 4  Record uniform numbers for your company
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades (Taiwan).

In previous releases, uniform numbers (taxpayer IDs) were defined in the System 
Options window globalization flexfield. In Release 11i, they are defined in the 
Locations window (Human Resources). Run the following script to record these 

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? JA_MOVE_SUPPLIER_UNIFORM_NUM

Requirement Explanation

Reference manual? Oracle Financials for Taiwan

Users must log off? No

TUMS Step Key? JA_RECORD_COMPANY_UNIFORM_NUM
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numbers so that you can re-enter them in Step 1 of the Oracle Financials for 
Asia/Pacific Tasks in Category 6. The <SID> is the value of the $ORACLE_SID or 
$TWO_TASK (UNIX) or ORACLE_SID or LOCAL (Windows).

UNIX:
$ cd $APPL_TOP/admin/<SID>/out
$ sqlplus <APPS username>/<APPS password> @JA_TOP/admin/sql/jatwupg7.sql

Windows:
C:\> cd %APPL_TOP%\admin\<SID>\out
C:\> sqlplus <APPS username>/<APPS password> @%JA_TOP%\admin\sql\jatwupg7.sql

Review the output in jatwupg7.lst and keep the file to use after the upgrade. It is 
located in the current directory.

Step 5  Record Canadian tax setup 
This task is Conditionally Required. It applies to Release 10SC Production 16.1 with 
Multiple Tax Distribution (MTD) update applied or 11.0 upgrades (Canada).

Input Tax Groups (ITG) replaces Release 10.7/11 Multiple Tax Distributions (MTD) 
functionality. Run jacaupgr.sql to record tax setup information. Review jacaupgr.lst (in 
the current working directory) and use information to set up Input Tax Groups.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @jacaupgr.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jacaupgr.sql

Step 6  Print tax rebate and rule listings
This task is Recommended. It applies to Release 10SC Production 16.1 with Multiple 
Tax Distribution (MTD) update applied or 11.0 upgrades (Canada).

To help define recovery rules, run jacarmpr.sql to generate jacarmpr.lst, which displays 
tax rebate and recovery rules.

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? JA_RECORD_CANADIAN_TAX_SETUP

Additional Information:  See Upgrading to 11i in the Oracle 
Financials for Canada User's Guide.

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? JA_PRINT_TAX_REBATE
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UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @jacarmpr.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jacarmpr.sql

Oracle Financials for Europe Tasks
Perform the following tasks for Oracle Financials for Europe.

Step 1  Update Swedish EFT payment format information
This task is Required. It applies to Release 11.0 upgrades (Sweden).

If you have not done so already, apply patch 1658488. It updates payment format 
information and stores in new fields the information for bank accounts that are 
assigned to suppliers paid with Swedish payment formats and Swedish foreign 
payment formats.

If the version numbers of the formatting files are greater than, or equal to, those listed 
in the following table, do not apply the update.

Step 2  Pay Danish EFT invoices
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades 
(Denmark).

Task List Status Country/Responsibility

1. Update Swedish EFT payment format 
information

Required Sweden/
Database Administrator

2. Pay Danish EFT invoices Conditionally Required Denmark/
Application Specialist (Financials for Denmark)

Requirement Explanation

Reference manual? No

Users must log off? Yes

TUMS Step Key? JE_UPDATE_SWEDISH_EFT_PAYMENTS

Formatting File Version Number

JESEPBAI.sql 110.18

JESEPBSI.sql 110.11

JESEPBUT.sql 110.7

JESEPPOI.sql 110.15

JESEPPOU.sql 110.19

Caution: Follow the instructions in the readme file carefully. Do 
not perform the manual steps if you have previously applied the update — 
if you do, your data will be corrupted.
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Electronic Funds Transfer (EFT) has been replaced with Electronic Data Interchange 
(EDI). If you have invoices that must to be paid with EFT rather than EDI, pay them 
now. After the upgrade, only EDI is available.

Oracle Financials for Latin America Tasks
Perform the following tasks for Oracle Financials for Latin America.

Step 1  Upgrade Brazilian subledgers data structure
This task is Required. It applies to Release 11.0 upgrades (Brazil).

Run jlbrsusl.sql to identify fixes necessary for your system. View the results online or 
in jlbrsusl.lst. The file is in the current directory, where <SID> is the value of 
$ORACLE_SID or $TWO_TASK (UNIX) or ORACLE_SID or LOCAL (Windows).

UNIX:
$ cd $APPL_TOP/admin/<SID>/out
$ sqlplus <APPS username>/<APPS password> @JL_TOP/admin/sql/jlbrsusl.sql

Windows:
C:\> cd %APPL_TOP%\admin\<SID>\out
C:\> sqlplus <APPS username>/<APPS password> @%JL_TOP%\admin\sql\jlbrsusl.sql

Step 2  Identify and correct duplicate rows in JL_BR_LOOKUPS
This task is Required. It applies to Release 10.7 or 11.0 upgrades (Brazil).

The upgrade moves the data in JL_BR_LOOKUPS to the FND_LOOKUPS table. Row 
descriptions in the FND_LOOKUPS table must be unique up to the first 30 characters. 

Requirement Explanation

Reference manual? Oracle Payables User’s Guide, Oracle Financials for Denmark User’s Guide

Users must log off? No

TUMS Step Key? JE_PAY_DANISH_EFT_INVOICES

Task List Status Country/Responsibility

1. Upgrade Brazilian subledgers data structure Required Brazil/System Administrator/Application 
Specialist (Payables and Receivables)

2. Identify and correct duplicate rows in JL_BR_
LOOKUPS

Required Brazil/Application Specialist (Financials for 
Brazil)

Requirement Explanation

Reference manual? No

Users must log off? Yes

TUMS Step Key? JL_UPGRADE_BRAZILIAN_SUBLEDGERS

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key?  JL_BR_LOOKUPS_DUPLICATES
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During the upgrade, lookups are transferred and all descriptions are truncated. Run 
jlmlsmck.sql to check for rows that are not unique:

UNIX:
$ cd $APPL_TOP/admin/preupg 
$ sqlplus <APPS username>/<APPS password> @jlmlsmck.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jlmlsmck.sql

To correct duplicate descriptions in the JL_BR_LOOKUPS table, from the Brazilian 
General Information responsibility, navigate to General > Setup > QuickCodes. 

Projects
Review this section and complete only the tasks for the Oracle Projects products you 
have installed.

Oracle Projects Tasks
Perform the following tasks for Oracle Projects.

Step 1  Correct the week ending date and month ending date for MLS
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

You may receive a message while using the Copy Actuals function in the budget form 
that indicates the data contains an invalid month (ORA-01843). It occurs most often in 
an MLS environment because the WEEK_ENDING_DATE and MONTH_ENDING_
DATE columns in the PA_TXN_ACCUM table are VARCHAR2 datatypes, but they are 
used to store dates. In an MLS environment, the date stored in these columns may not 
be in the language used by the database instance as determined by NLS_DATE_

Task List Status Responsibility

1. Correct the week ending date and month ending date 
for MLS

Required Application Specialist (Projects)

2. Correct excess revenue amounts data for hard limit 
funded agreements

Conditionally Required Application Specialist (Projects)

3. Correct excess revenue accrued for non-adjusting 
negative amount expenditure items

Conditionally Required Application Specialist (Projects)

4. Correct credit memo invoice dates Conditionally Required Application Specialist (Projects)

5. Correct bill amount data stored on revenue 
distributions

Conditionally Required Application Specialist (Projects)

6. Correct billing hold data on reversing items Conditionally Required Application Specialist (Projects)

7. Correct billable flag data for reversing items Required Application Specialist (Projects)

8. Correct inconsistencies in Cost Budgets and Revenue 
Budgets

Conditionally Required Application Specialist (Projects)

Requirement Explanation

Reference manual? No

Users must log off? Yes
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LANGUAGE or NLS_LANGUAGE (if the NLS_DATE_LANGUAGE parameter is 
NULL).

To find the exceptions, run patxnerr.sql from the new APPL_TOP. It creates a 
temporary table PA_TXN_ACCUM_ERR to store the records that are in error.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <PA username>/<PA password> @patxnerr.sql <PA username> \
<PA password> <APPS username> <APPS password>

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <PA username>/<PA password> @patxnerr.sql <PA username> \
<PA password> <APPS username> <APPS password> 

Then, run patxnsql.sql. 

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @patxnsql.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @patxnsql.sql

The script produces txn_fix.lst, which is stored in the current working directory. The 
report has two sections:

Section 1 begins with this text: “The following records have been updated in PA_TXN_
ACCUM with the New_Week_Ending_Date and New_Month_Ending_Date." This 
section lists the records with the old and new values for the week_ending_date and 
month_ending_date columns.

Section 2 begins with the line “Please update the week_ending_date and month_
ending_date for the following records in PA_TXN_ACCUM." This section lists the 
records for which the WEEK_ENDING_DATE and MONTH_ENDING_DATE 
columns could not be updated. 

Update manually any records listed in Section 2. The month must be in the language 
of the database server instance. After making the corrections, run patxnsql.sql again to 
ensure that corrections have been made. Perform this step again just before you start 
the upgrade to correct any erroneous data that may have been created during normal 
processing.

Step 2  Correct excess revenue amounts data for hard limit funded agreements 
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform this step only if you have Project Billing installed. 

Requirement Explanation

Reference manual? No

Users must log off? Yes

TUMS Step Key? PA_CORRECT_EXCESS_REVENUE
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Run pa620118.sql to produce a list (pa620118.lst) of the project/tasks whose revenue 
has exceeded the hard limit funding amount. This script may take a long time to run. 
From the new APPL_TOP:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @pa620118.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @pa620118.sql

The pa620118.lst report lists the project and task number, agreement number, and the 
amount by which revenue has exceeded the funding limit. To correct the data, create a 
write-off revenue event for each excess revenue amount listed in the report.

Perform this step again just before you start the upgrade to correct any erroneous data 
that may have been created during normal processing. 

Step 3  Correct excess revenue accrued for non-adjusting negative amount 
expenditure items
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform this step only if you have Oracle Project Billing installed.

This step pertains to non-adjusting negative amount expenditure items accruing 
overstated revenue amounts during the Generate Draft Revenue process. Oracle 
Projects now generates the correct revenue amount. Run pa661335.sql from the new 
APPL_TOP to report existing overstated revenue.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @pa661335.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @pa661335.sql

At the prompt, enter Start Project Number and End Project Number to reduce 
processing time. The script produces pa661335.lst, which lists the project and task 
number, expenditure type, quantity, and accrued revenue for all expenditure items 
where revenue is accrued beyond the soft limit. To correct the data, from the old 
APPL_TOP, enter a Recalculate Revenue adjustment for each of the expenditure items 
listed in the report.

1. Choose Expenditures > Expenditure Inquiry and select Project or All to navigate to 
the Find Project Expenditure Items window.

2. Query for the expenditure items you want to correct.

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Users must log off? Yes

TUMS Step Key? PA_CORRECT_REVENUE_NEG_EXPENDITURE
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3. Choose Recalc Revenue from the Special menu.

4. Repeat this procedure for each of the listed expenditure items.

Enter Recalculate Revenue adjustments and run the Generate Draft Revenue process 
(Submit Request > Requests > Run) for each affected project.

Perform this step again just before you start the upgrade to correct any erroneous data 
that may have been created during normal processing.

Step 4  Correct credit memo invoice dates 
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform this step only if you have Oracle Project Billing installed.

In prior releases, Projects allowed the release of a credit memo with an AR invoice date 
earlier than the AR invoice date of the original invoice. Oracle Receivables rejects such 
credit memos during the AutoInvoice Process. Run pa652811.sql from the new APPL_
TOP to report existing credit memos with an AR invoice date earlier than the original 
AR invoice date.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @pa652811.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @pa652811.sql

The script prompts for Start Project Number and End Project Number. Enter a range of 
projects to reduce processing time. The script produces pa652811.lst, which lists the 
project number, credit invoice number, original invoice number, credit memo date, and 
the Receivables invoice number for all credit memos with an invoice date earlier than 
the original invoice date. To correct the data, update the AR Invoice Date for each 
credit memo listed. Perform the steps from the old APPL_TOP:

1. Navigate to the Find Invoice window (choose Billing > Invoice Review).

2. Query for the credit memo you want to correct.

3. Change the AR Invoice Date to a date on (or after) the date of the original invoice. 
Make this change in the Invoice Summary window or by opening the credit 
invoice. 

4. Repeat these steps for each credit memo.

Perform this step again just before you start the upgrade to correct any erroneous data 
that may have been created during normal processing.

Additional Information: See Expenditure Adjustments in Oracle 
Projects User’s Guide.

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Users must log off? Yes

TUMS Step Key? PA_CREDIT_MEMO_INVOICE
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Step 5  Correct bill amount data stored on revenue distributions 
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform this step only if you have Oracle Project Billing installed.

In prior releases, billing amounts were not stored in revenue distribution lines on 
“Accrue as work Occurs - Bill as work Occurs” projects. This resulted in the Oracle 
error “ORA-1400: cannot INSERT null value” during the Generate Draft Invoices 
process. Run pardlrpt.sql from the new APPL_TOP to report expenditure items that 
contain this error.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @pardlrpt.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @pardlrpt.sql

The script prompts for Start Project Number and End Project Number. Enter a range of 
projects to reduce processing time. It produces pardlrpt.lst, which lists the project 
name, task number, expenditure item ID, expenditure type, quantity, and amount for 
all expenditure items whose billing amounts should have been stored in the revenue 
distribution lines. If no exceptional expenditure items are reported, no further action is 
needed. Correct the data from the old APPL_TOP as follows: 

1. Recalculate revenue

Perform Recalculate Revenue adjustments on the listed expenditure items. Choose 
Expenditures > Expenditure Inquiry, and enter criteria to find the expenditure 
items you want to adjust.

After you adjust the expenditure items, run the Generate Draft Revenue process, 
from the Submit Request window (Requests > Run), for each affected project.

2. Re-run the Exception report

Run pardlrpt.sql again. If any expenditure items are reported, go back to the 
previous step. Repeat these two steps until no expenditure items are listed.

3. Create temporary table

Run pacrttab.sql to create temporary table pa_bug_644714. It stores the following 
audit information about the updated revenue distribution lines:

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Users must log off? Yes

TUMS Step Key? PA_BILL_AMOUNT_DATA_DISTRIBUTIONS

Audit Information Audit Information

expenditure_item_id line_num 

creation_date new_bill_amount 

old_draft_inv_num old_draft_inv_item_line_num
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From the new APPL_TOP:

UNIX:

$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @pacrttab.sql

Windows:

C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @pacrttab.sql

4. Correct the data

Run pardlupd.sql from the new APPL_TOP. It prompts for Start Project Number 
and End Project Number. Enter these values to run this script for a range of 
projects. Do not omit any projects.

UNIX:

$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @pardlupd.sql

Windows:

C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @pardlupd.sql

Perform this step again just before you start the upgrade to correct any erroneous data 
that may have been created during normal processing.

Step 6  Correct billing hold data on reversing items 
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform this step only if you have Oracle Project Billing installed.

This step pertains to manual reversals of expenditure items whose Bill Hold flag was 
set to Yes. Prior to this upgrade, these items were created with the Bill Hold flag set to 
No rather than Yes, and therefore the reversals could be invoiced. Run painv.sql from 
the new APPL_TOP to report expenditure items with this error.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @painv.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @painv.sql

Additional Information: See Expenditure Adjustments in Oracle 
Projects User’s Guide.

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Users must log off? Yes

TUMS Step Key? PA_BILLING_HOLDS_ON_REVERSING
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The script prompts for Start Project Number and an End Project Number. Enter these 
values to run this script for a range of projects. Do not omit any projects.

The script produces painv.lst, which has two sections:

■ List of Projects Against Released Invoices. Lists project/top task bill amounts that 
are incorrectly invoiced, where the incorrect invoices are already released. 

■ List of Projects Against Unreleased Invoices. Lists projects against which incorrect 
invoices exist, where the invoices are not yet released. 

To correct the released invoices, create top task-level events in the amounts shown in 
the report for the specified project/tasks. From the old APPL_TOP:

1. Choose Billing > Events select either Project or All to navigate to the Find Project 
Events window. Query for the project that you want to correct.

2. Choose New to display the Event Details window.

3. Enter the Task Number of the top task listed in the report.

4. Select an Event Type that has an event classification of Write-On.

5. In the Bill Amount field, enter the amount listed in painv.lst for the project and 
task.

6. Complete the Event Date, Organization, and Description fields. Save your work.

7. Repeat these steps for each overstated amount on the report.

After you create the events, run the Generate Draft Invoices process for the affected 
projects. 

To correct the unreleased invoices, run the datafix script pa858651.sql. This script sets 
the “bill hold” flag for the reversed expenditure items to Yes and regenerates the 
invoices for the projects listed. Run the script from the new APPL_TOP.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @pa858651.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @pa858651.sql

Perform this step again just before you start the upgrade to correct any erroneous data 
that may have been created during normal processing.

Step 7  Correct billable flag data for reversing items
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

This step pertains to expenditure items that were adjusted from billable to non-billable 
or vice versa. Prior to this upgrade, when these expenditure items were reversed, the 

Additional Information: See Events in Oracle Projects User’s Guide.

Requirement Explanation

Reference manual? No

Users must log off? Yes
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reversing expenditure items were created with the Billable flag set to the original 
value, rather than the adjusted value.

To correct the flag settings, run pacstrev.sql. This script reports projects that have 
associated expenditure items in error and indicates which processes you need to run 
after you run the datafix script (pa882573.sql). Be sure that you run pacstrev.sql before 
you run pa882573.sql, so you know which processes to run after you correct the data.

To run the reporting script:
Type the following commands from the new APPL_TOP:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @pacstrev.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @pacstrev.sql

The script produces pacstrev.lst, which contains two sections:

■ Cost Distribution needs to be run for the following projects. Lists projects for 
which you must run the cost distribution processes after you run the datafix script.

■ Revenue Distribution/Asset Accumulation needs to be run for the following 
projects. Lists projects for which you must run the Generate Draft Revenue process 
or the Generate Asset Lines process after you run the datafix script. 

The report lists each project and the associated project type.

■ If the project type indicates that the project is a contract project, run the Generate 
Draft Revenue process for the project after you correct the data.

■ If the project type indicates that the project is a capital project, run the Generate 
Asset Lines process for the project after you correct the data.

To correct the data, run the datafix script pa882573.sql. Enter starting and ending 
project numbers when the script prompts for these values. 

This script corrects the Billable flag for the reversed expenditure items that are in error, 
and marks the items for cost recalculation (sets the COST_DISTRIBUTED_FLAG to N). 
The script also sets the REVENUE_DISTRIBUTED_FLAG to No if either of the 
following conditions is true: 

■ The expenditure item is charged to a capital project.

■ The expenditure item is charged to a contract project with a revenue accrual 
method or invoicing method of Work, AND the original item was non-billable and 
has not been revenue distributed, AND the billable reversing item has been 
revenue distributed.

To run the datafix script:
From the new APPL_TOP:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @pa882573.sql
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Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @pa882573.sql

After you run this script, run the required cost distribution, revenue distribution, and 
asset line generation processes according to the exception report (pacstrev.lst). Use the 
Submit Request window (Requests > Run). 

For the projects that require cost distribution and/or revenue distribution processes, 
run the Update Project Summary Amounts process. Use the Project Status Inquiry 
windows to verify the corrected amounts.

Perform this step again just before you start the upgrade to correct any erroneous data 
that may have been created during normal processing.

Step 8  Correct inconsistencies in Cost Budgets and Revenue Budgets
This task is Conditionally Required. It applies to Release 10.7 upgrades.

To correct inconsistencies in the revenue amount attributes for Cost Budgets and cost 
amount attributes for Revenue Budgets and correct resource-related data that was not 
properly ungraded, run the scripts as described in this task.

To fix revenue amounts and cost amounts:

UNIX:
$ cd $PA_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @a1418823.sql \
  <APPS username>/<APPS password>

Windows:
C:\> cd %PA_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @a1418823.sql \
     <APPS username>/<APPS password>

To correct resource data from previous upgrades:

UNIX:
$ cd $PA_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @a1418828.sql \
  <APPS username>/<APPS password>

Windows:
C:\> cd %PA_TOP%\patch\115\sql

Note: The new billable and non-billable summary amounts 
generated after this datafix are displayed in the earliest open 
period. This period may be different from the period in which the 
original expenditure item was reversed.

Requirement Explanation

Reference manual? Oracle Projects Reference Manual

Users must log off? No

TUMS Step Key? PA_RUN_DATA_FIX_SCRIPT
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C:\> sqlplus <APPS username>/<APPS password> @a1418828.sql \
     <APPS username>/<APPS password>

Logistics
Review this section and complete only the tasks for the Oracle Logistics products you 
have installed.

Oracle Inventory Tasks
Perform the following tasks for Oracle Inventory.

Step 1  Purge unwanted transaction history - INV 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

To purge unwanted transaction data, run the following script from the new APPL_
TOP.

UNIX:
$ cd $INV_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @invtxnpg.sql <purge cutoff date> \
  <organization code> <rows per commit>

Windows:
C:\> cd %INV_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @invtxnpg.sql <purge cutoff date> \
     <organization code> <rows per commit>

The script requires three arguments:

Task List Status
Menu Responsibility > Function/
Responsibility

1. Purge unwanted transaction history - 
INV

Recommended Manufacturing and Distribution Manager > Inventory/
Application Specialist (Inventory)

Requirement Explanation

Reference manual? No

Users must log off? No

Caution: Purged transactions do not appear on the Accrual 
Reconciliation report.

Argument Description

purge cutoff date Only transactions before this date are purged. The date must be in 
YYYY-MM-DD format. For example, 1992-01-29.

organization code Transactions for this organization are purged. If you do not enter a 
code, the script deletes transaction history for all organizations.

rows per commit Depending on the size of rollback segments, you can vary the 
number of rows that are deleted per commit. The larger this number, 
the faster the purge, and the larger the rollback segment required.
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This script is potentially long-running.

Order Management
Review this section and complete only the tasks for the Oracle Order Management 
products you have installed.

Oracle Order Management Tasks
Perform the following tasks for Oracle Order Management.

Step 1  Run Order Import program
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

The Order Import Interface tables must be empty before the Order Management 
upgrade. Select Orders, Returns > Import Orders from the menu.

Step 2  Run Order Entry Interface programs 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Task List Status Responsibility

1. Run Order Import program Required Application Specialist (Order Entry/Shipping)

2. Run Order Entry Interface programs Required Application Specialist (Order Entry/Shipping)

3. Close eligible orders Required Application Specialist (Order Entry/Shipping)

4. Run AutoCreate Install Base program for Service Required Application Specialist (Order Entry/Shipping)

5. Make sure orders are in a supported status Required Application Specialist (Order Entry/Shipping)

6. Close open pick slips/picking batches or open 
deliveries/departures

Required Application Specialist (Order Entry/Shipping)

7. Run the Shipping Interface programs Required Application Specialist (Order Entry/Shipping)

8. Review Item Validation Org settings Required Application Specialist (Order Entry/Shipping)

9. Validate inventory organization data Required Application Specialist (Order Entry/Shipping)

10. Review cycles that may not be upgraded Required Application Specialist (Order Entry/Shipping)

11. Selectively upgrade active transactions Recommended Application Specialist (Order Entry/Shipping

Note: Run the Order Entry Purge program to remove all old data. 
(This program does not affect Order Management queries.) Do not 
purge any Order Entry tables after the upgrade. Order Management 
looks at Order Entry for information on upgraded orders/lines. 
Make sure there is no unprocessed data in RMA Interface tables.

Requirement Explanation

Reference manual? Oracle Order Entry/Shipping User’s Guide

Users must log off? No

Requirement Explanation

Reference manual? Oracle Order Entry/Shipping Reference Manual, Release 10; Oracle Order 
Entry/Shipping Release 11 User’s Guide

Users must log off? No
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All Order Entry interface tables must be empty before you upgrade to Order 
Management. To prepare the tables, run the following programs in the order listed:

■ RMA Interface (Orders, Returns > Returns > RMA Interface)

■ Receivables Interface (Orders, Returns > Receivables Interface)

■ Inventory Interface (Shipping > Interfaces). Enter Inventory interface in the Name 
field.

■ Demand Interface (Orders, Returns > Schedule > Place Demand via SRS)

■ Service Interface (Orders, Returns > Service Interface)

If you are running Pick Slip Shipping and are prompted to enter a warehouse, do not 
do so. Have the system administrator change the mandatory parameter to an optional 
one. From the System Administration Responsibility, choose Concurrent > Programs > 
Define. Query the program Inventory Interface (OEVINV) and click Parameters. 
Uncheck the Required check box and save the change.

Step 3  Close eligible orders
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

To speed the upgrade, close all orders that are eligible for closing (even though the 
Close Eligible status is supported by the Order Management upgrade). Select Orders, 
Returns > Close Orders from the menu.

Step 4  Run AutoCreate Install Base program for Service
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

To ensure that all data has been transferred out of the Order Entry Service Details 
Interface tables, change the responsibility to Service. Then, select Install Base > 
AutoCreate Install Base and run AutoCreate Install Base.

Step 5  Make sure orders are in a supported status
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Additional Information: Oracle Order Entry Reference Manual, 
Release 10 (Vol. 1, pp. 6-20 to 6-23); Oracle Order Entry/Shipping 
Release 11 User’s Guide, (Vol. 2, pp. 7-11 to 7-14)

Requirement Explanation

Reference manual? Oracle Order Entry/Shipping User’s Guide

Users must log off? No

Requirement Explanation

Reference manual? Oracle Order Entry/Shipping User’s Guide

Users must log off? No

Requirement Explanation

Reference manual? Oracle Order Entry/Shipping User’s Guide

Users must log off? No
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Make sure Orders Headers and Order Lines are in a status that is supported by Order 
Management. Workflow history is not created for closed lines or orders.

Run ontexc07.sql to get a list (ontexc07.lst) of Order Entry Orders and Order Lines that 
are in cycle states that are not supported. These orders are not upgraded.

UNIX:
$ cd $ONT_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @ontexc07.sql

Windows:
C:\> cd %ONT_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @ontexc07.sql

Seeded Action
Allowed Status (other than NULL and 
Not Applicable)

Status Not 
Allowed Suggest Action

The following information applies to Orders:

Booking All None None

Cancel Orders 11- Complete 18 - Eligible *

Close/Complete 18 - Eligible None None

The following information applies to Order Lines:

Pick Release 4 - Released, 5 - Partial, 18 - Eligible None None

Back Order Release 4 - Released, 5 - Partial, 18 - Eligible None None

Ship Confirm 5 - Partial, 6 - Confirmed, 7 - Back-ordered 
Completed, 22 - Back-ordered Partial

18 - Eligible Ship Confirm the 
Line

Receivables Interface 5 - Partial, 9 - Interfaced to AR, 18 - Eligible None None

Close/Complete 18 - Eligible None None

Inventory Interface 5 - Partially Interfaced, 14 - Interfaced 13 - Interface Error Fix errors and run 
Interface program

Inventory Interface None 18 - Eligible Run Inventory 
Interface program

Cancel Line 5 - Partial, 11- Complete 18 - Eligible *

Service Interface 14 - Interfaced 18 - Eligible Run the Service 
Interface program

Purchase Release 5 - Partial, 6 - Confirmed, 14 - Interfaced, 
18 - Eligible

None None

Manufacturing Release 18 - Eligible 4 - Released Run the Auto-create 
config program

Manufacturing Release 19 - Work Order Completed 20 - WO partially 
completed

Complete work order

Manufacturing Release None 21 - WO created Complete work order

Manufacturing Release None 23 - Configuration 
created

Run Auto-create 
Work Order program

Demand Interface 14 - Interfaced, 18 - Eligible None None

RMA Interface 14 - Interfaced, 16 - Partially Accepted, 
17 - Completely Accepted, 18 - Eligible

None None

* Order Entry DOES NOT support defining cycles that include Cancel Action. It DOES NOT provide a program or a form to 
automatically process orders or lines that are eligible for the Cancel Action. Use the Cancel Orders form to manually cancel 
orders or lines that are eligible for the Cancel Action.
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Step 6  Close open pick slips/picking batches or open deliveries/departures
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

1. Choose the heading that describes the release level that applies to your system and 
complete the actions listed. 

For 10.7 character mode:

Back order or ship confirm all open pick slips and picking batches. Navigate > 
Shipping > Confirm.

For 10.7 SmartClient and NCA:

For pick slip-based Shipping customers, back order or ship confirm all open pick 
slips and picking batches. Select Shipping > Confirm Shipments > Pick Slip.

For delivery-based Shipping customers, back order or ship confirm all open 
deliveries and departures. Select Shipping > Confirm Shipments > Ship Confirm 
Deliveries.

For 11.0:

Back order or ship confirm all open deliveries and departures. Select Shipping > 
Confirm Shipments > Ship Confirm Deliveries.

2. Once you have completed the appropriate action, run wshbdord.sql and follow 
the instructions in the file output.

UNIX:

$ cd $WSH_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @wshbdord.sql

Windows:

C:\> cd %WSH_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @wshbdord.sql

Step 7  Run the Shipping Interface programs
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

All Order Entry data must be processed from the interface tables before you upgrade. 
Run the Shipping Interface programs listed in this section in the order listed. Use the 
appropriate menu path to access each program.

For 10.7 character mode:
Complete these steps for the following Shipping Interface programs in this order 
listed: Update Shipping Information, Inventory Interface, Receivables Interface. As 
you complete each set of steps, enter the appropriate program name in the Report 
Name field.

Requirement Explanation

Reference manual? Oracle Order Entry/Shipping User’s Guide

Users must log off? No

Requirement Explanation

Reference manual? Oracle Order Entry/Shipping User’s Guide

Users must log off? No
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1. Choose Navigate > Run (or use quickpick) 

2. In the Type field, enter report, and in the Report Name field, enter the <Shipping 
Interface Program name> (or use quickpick).

3. Tab through the report parameters, and save your work.

For 10.7 SmartClient and NCA and 11.0:
Run the following Shipping Interface programs in the order listed. Use the appropriate 
menu path to access each program.

Step 8  Review Item Validation Org settings
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

When more than one responsibility is attached to an organization (Operating Unit), all 
those responsibilities must have the same item validation org settings. Run 
ontexc05.sql to produce a listing (ontexc05.lst) of the item validation org settings. Use 
this list to determine which settings need to be changed. If the valid item validation 
org is set at the user level, these values will not be upgraded.

UNIX:
$ cd $ONT_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @ontexc05.sql

Windows:
C:\> cd %ONT_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @ontexc05.sql

Program Name Menu Path

Delivery-based Ship Confirm 
Open Interface

Shipping > Interfaces > (Enter Delivery-based Ship Confirm 
Open Interface in the Name field.)

Update Shipping Shipping > Confirm Shipments > Update Shipping

Inventory Interface Shipping > Interfaces > (Enter Inventory Interface in the 
Name field)

Receivables Interface Shipping > Interfaces > (Enter Receivables Interface in the 
Name field)

Note: If the profile option OE:Immediate Inventory Update is set 
to Yes, the Delivery-based Ship Confirm Open Interface program 
may close some deliveries and departures by running the Update 
Shipping and Inventory Interface concurrent processes 
automatically. However, you should still run these concurrent 
processes manually as instructed in this step to ensure that all 
interface records are processed.

Requirement Explanation

Reference manual? Oracle Order Entry/Shipping User’s Guide

Users must log off? No

Additional Information: See Oracle Order Entry/Shipping User’s 
Guide.
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Step 9  Validate inventory organization data 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

The wshpre00.sql script validates the following data for inventory organizations:

■ All organizations in shipping parameters are defined and valid. They must also 
have an enabled subinventory.

■ All organizations are assigned to locations.

To run this script, type the following:

UNIX:
$ cd $WSH_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @wshpre00.sql

Windows:
C:\> cd %WSH_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @wshpre00.sql

Review wshpre00.lst. Purge shipping parameters records without valid organizations. 
Have the application specialist assign a quantity-tracked subinventory to any record 
that does not have at least one. In addition, define and assign an internal (HR) location 
for each inventory organization defined in your system that does not already have 
one.

Step 10  Review cycles that may not be upgraded
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Order Entry cycles referenced by open orders are upgraded to workflow processes 
during the upgrade. Some cycles may not be upgraded successfully because:

■ the cycle definition is corrupt

■ the cycle definition is not supported in Order Entry

■ the cycle definition is extremely complex

■ there is no exact functional equivalent in Order Management

Run ontexc08.sql to create ontexc08.lst, which lists cycles that cannot be upgraded and 
suggested actions. If a cycle is not upgraded to Workflow, open orders referencing that 
cycle are not upgraded.

To run ontexc08.sql:

Requirement Explanation

Reference manual? SQL*Plus User’s Guide

Users must log off? No

Requirement Explanation

Reference manual? Oracle Order Entry User’s Guide

Users must log off? No

Additional Information: See OracleMetaLink (Doc ID: 150511.1).
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UNIX:
$ cd $ONT_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @ontexc08.sql

Windows:
C:\> cd %ONT_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @ontexc08.sql

Step 11  Selectively upgrade active transactions
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

You can select some active transactions for upgrade and defer the upgrade of the 
remaining transactions to a future date. This is a two-phase process. If you want to 
take advantage of this feature, perform Phase I now. Refer to Order Management 
Upgrade Instructions (OracleMetaLink Doc ID 121200.1).

Procurement
Review this section and complete only the tasks for the Oracle Procurement products 
you have installed.

Oracle Purchasing Tasks
Perform the following tasks for Oracle Purchasing.

Step 1  Clear open interface tables   
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Clear any unprocessed records in the Requisitions Open Interface, Purchasing 
Documents Open Interface, and Receiving Open Interface tables by importing the data 
into Purchasing. First, check to see whether data exists in the open interface tables. 
Then, clear the affected tables as necessary.

Determine whether data exists in the open interface tables:
Complete these steps to examine the open interface tables.

1. Log in to SQL*Plus.

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key?  ONT_BIFURCATION

Task List Status Responsibility

1. Clear open interface tables Required Application Specialist (Purchasing) / System Administrator

Requirement Explanation

Reference manual? No

Users must log off? No

Concurrent Manager? Yes
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UNIX:

$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @<script name> 

Windows:

C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @<script name>

2. Run each of the following scripts:

■ Requisitions Open Interface (pocntreq.sql)

■ Purchasing Documents Open Interface (pocntpoh.sql)

■ Receiving Open Interface (pocntrcv.sql)

If a script returns a number greater than 0, then you have data in that open 
interface. The following instructions tell you how to clear the data. If the script 
returns 0, no action is necessary. 

Clear rows in the Requisitions Open Interface tables:
Complete these steps to clear Requisitions Open Interface table rows.

1. In the Purchasing responsibility, choose Reports > Run and submit the Requisition 
Import program. To make sure you process all data, you can leave the Import 
Source and Import Batch Identification fields blank.

2. Choose Reports > Run and submit the Requisition Import Exceptions report. Use 
this report to see if errors occurred while running Requisition Import. Correct 
errors and re-run Requisition Import until no more errors occur.

Clear rows in the Purchasing Documents Open Interface tables:
Complete these steps to clear Purchasing Documents Open Interface table rows.

1. In the Purchasing responsibility, choose Reports > Run and submit the Purchasing 
Documents Open Interface program. Choose Reports > Run again and submit the 
Purchasing Interface Errors Report.

2. Review the Purchasing Interface Errors report and correct any errors. Re-run the 
Purchasing Documents Open Interface program until no more errors occur. If you 
are upgrading from Release 11.0.3, you can submit the Purge Purchasing Open 
Interface Processed Data program to remove all processed data in the Purchasing 
Documents Open Interface tables. This program does not remove data that is 
pending.

Clear rows in the Receiving Open Interface tables:
Complete these steps to clear Receiving open Interface table rows.

1. In the Purchasing responsibility, choose Reports > Run and submit the Receiving 
Transaction Processor. Then, submit the Receiving Interface Errors report.

Additional Information: See Requisition Import Process and 
Requisition Import Exceptions Report in Oracle Purchasing User’s 
Guide.

Additional Information: See Purchasing Documents Open 
Interface and Purchasing Interface Errors Report in Oracle 
Purchasing User’s Guide.
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2. Review the Receiving Interface Errors report and correct any errors. Re-run the 
Receiving Transaction Processor until no more errors occur.

3. If you have Advance Shipment Notices with billing information (ASBNs) in the 
Receiving Open Interface, choose Reports > Run in the Purchasing responsibility 
to submit the Purchasing Interface Errors report.

In the Parameters window, select Receiving Open Interface in the Source Program 
field. Use this report to see what errors occurred. Correct any errors and re-run the 
Receiving Transaction Processor until no more errors occur.

Public Sector
Review this section and complete only the tasks for the Oracle Public Sector products 
you have installed.

Oracle Public Sector Financials (International) Tasks
Perform the following tasks for Oracle Public Sector Financials (International).

Step 1  Drop obsolete seed data
This task is Required. It applies to Release 12, 3.1, or 3.3 upgrades.

To delete obsolete seed data, run the following script from the new APPL_TOP:

UNIX:

$ cd $IGI_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @igipreu.sql

Windows:

C:\> cd %IGI_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @igipreu.sql

Step 2  Complete current Internal Trading charges
This task is Conditionally Required. It applies to Release 12, 3.1, or 3.3 upgrades.

Additional Information: See Receiving Transaction Processor and 
Receiving Interface Errors Report and Purchasing Interface Errors 
Report in Oracle Purchasing User’s Guide.

Note: If you cannot fix an error, examine the affected data. If it is 
old or obsolete, you can ignore the error and continue upgrading.

Task List Status Responsibility

1. Drop obsolete seed data Required Application Specialist

2. Complete current Internal Trading charges Conditionally Required Application Specialist

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? IGI_REMOVE_OLD_SEED_DATA
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If you are currently using the Internal Trading feature, ensure that all current charges 
are complete (with a status of Approved, Canceled, or Rejected) before you apply 
Oracle Public Sector Financials (International) patch sets.

To list all open charges, run the following script from the new APPL_TOP. The output 
file is itr_open_charges.lst.

UNIX:

$ cd $IGI_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @igiitrbu.sql

Windows:

C:\> cd %IGI_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @igiitrbu.sql

To approve cross charges, navigate to OPSF (I) General Ledger > Internal Trading > 
Approve Cross Charges. To reject or cancel cross charges, navigate to OPSF (I) General 
Ledger > Internal Trading > Charge Summary.

Requirement Explanation

Reference manual? Oracle Public Sector Financials (International) User’s Guide

Users must log off? No

TUMS Step Key? IGI_ITR_COMPLETE_CHARGE
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3
Category 3 — Performing the Upgrade

This chapter describes Category 3 steps — once you begin these tasks, you cannot use 
Oracle Applications until after you have successfully run AutoUpgrade and 
completed the Category 4 steps.

The following upgrade tasks are discussed in this chapter:

Oracle Alert Tasks on page 3-1
Oracle Common Modules Tasks on page 3-2
Oracle Workflow Tasks on page 3-3
Oracle Payables Tasks on page 3-4
Oracle Receivables Tasks on page 3-8
Oracle Financials Common Country Tasks on page 3-10
Oracle Projects Tasks on page 3-11
Oracle Grants Accounting Tasks on page 3-14
Oracle Cost Management Tasks on page 3-15
Oracle Inventory Tasks on page 3-17
Oracle Order Management Tasks on page 3-19
Oracle Purchasing Tasks on page 3-19
Oracle U.S. Federal Financials Tasks on page 3-20
Oracle Sales/Oracle Sales Compensation Tasks on page 3-21
Oracle Service Tasks on page 3-24
System Administration Tasks on page 3-30
Database Upgrade Tasks on page 3-31

Applications Technology
Complete this portion of the upgrade before you perform the product-specific steps.

Oracle Alert Tasks
Perform the following tasks for Oracle Alert.

Step 1  Drop event alert triggers in custom schemas
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Task List Status Responsibility

1. Drop event alert triggers in custom schemas Conditionally Required Database Administrator

Requirement Explanation

Reference manual? No
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To drop all event alert database triggers in custom schemas, run alrdtrig.sql from the 
new APPL_TOP. Re-create the triggers in Step 2 of the Oracle Alert Tasks in Chapter 6.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @alrdtrig.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @alrdtrig.sql

The script displays the following message and then exits SQL*Plus:

"Rerun alrdtrig.sql, which is located in the preupg subdirectory of the admin 
directory under APPL_TOP, for each custom schema.  If alrdtrig.sql has been run 
for all custom schemas, then open each [schema].sql (created by this script), 
which can be found in the current directory, and manually delete the drop trigger 
statements which do not belong.  Then run the following statement for each schema: 
sqlplus apps_username/password @[schema].sql"

Review the resulting [schema].sql files in the current directory and delete any drop 
trigger statements that do not belong. Log in to SQL*Plus and run each [schema].sql 
file to drop the triggers. 

Oracle Common Modules Tasks
Perform the following tasks for Oracle Common Modules.

Step 1  Fix invalid AK data in non-Global Demo databases 
This task is Conditionally Required. It applies to Release 10SC Production 16.1 (or 
higher) or 11.0 upgrades.

In this step, you first check for invalid AK data, then you fix the data.

For a non-Global Demo database (10.7 and Production 16.1 or higher):
Run the following script from the new APPL_TOP:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @akchkp16.sql

Users must log off? Yes

Task List Status Responsibility

1. Fix invalid AK data in non-Global Demo databases Conditionally Required Application Specialist

Requirement Explanation

Reference manual? No

Users must log off? No

Requirement Explanation



Applications Technology

Category 3 — Performing the Upgrade 3-3

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @akchkp16.sql

Review the output (akchkp16.rpt) for invalid data. If the report indicates a problem, 
use the appropriate Oracle Application forms to correct the problem. (You can run 
scripts akfxmrp1.sql and akfxmrp2.sql to correct specific problems as described in 
OracleMetaLink Doc 184261.1). Continue to run the scripts (from the new APPL_TOP) 
and make corrections until there is no invalid data.

For a Release 11.0 database:
Run the following script from the new APPL_TOP:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @akchkr11.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @akchkr11.sql

Check the output (akchkr11.rpt) for invalid data. Use the appropriate Oracle 
Applications forms to make corrections. Continue to run the script (from the new 
APPL_TOP) and make corrections until there is no invalid data.

Oracle Workflow Tasks
Perform the following tasks for Oracle Workflow.

Step 1  Update protection and customization levels of seeded item types
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

If you customized seeded item types in prior versions of Oracle Workflow, the new 
seed data may not load properly when you use the Workflow Definitions Loader. To 
see a list of item types, type the following at any prompt:

sqlplus <APPS username>/<APPS password>
SQL> select ITEM_TYPE from WF_LOOKUP_TYPES

 For every item type currently seeded in the database, choose one of the following 
actions:

Task List Status Responsibility

1. Update protection and customization levels of seeded 
item types

Recommended System Administrator / 
Application Specialist (Workflow)

Requirement Explanation

Reference manual? Oracle Workflow Administrator’s Guide; Oracle Workflow Developer’s Guide

Users must log off? Yes
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No Action
If you do nothing, you preserve the existing protection and customization levels of 
seeded objects and guarantee that any customizations made to the seed data (and 
preserved) are not overwritten.

Run wfprotrst.sql
Running wfprotrst.sql for selected seeded item types resets the protection and 
customization level for the selected item type, guaranteeing that the upgrade loads. 
Prior customizations to the seeded item type are lost, but new data added is preserved. 
To run the script, type the following from the new APPL_TOP:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @wfprotrst <item_type>

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @wfprotrst <item_type>

Run wfrmitt.sql
Running wfrmitt.sql for selected seed item types completely deletes the item type and 
any associated customizations from the database, so that the corresponding seed item 
type looks like a new installation. Consider this option only if you have never used the 
item type in a production environment. Type the following from the new APPL_TOP:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @wfrmitt.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @wfrmitt.sql

Financials
Review this section and complete only the tasks for the Oracle Financials products you 
have installed.

Oracle Payables Tasks
Perform the following tasks for Oracle Payables.

Additional Information: See Workflow Administration Scripts, 
Oracle Workflow Access Protection, and Using the Workflow 
Definitions Loader sections in Oracle Workflow Administrator’s Guide.

Task List Status Responsibility

1. Determine exchange rates (MRC) Conditionally Required Application Specialist (Payables)

2. Import and purge Payables Open Interface invoices Required Application Specialist (Payables)

3. Import and purge Invoice Import Interface expense 
reports and invoices

Required Application Specialist (Payables)

4. Transfer all data to General Ledger Required Application Specialist (Payables)
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Step 1  Determine exchange rates (MRC)
This task is Conditionally Required. It applies to Release 11.0 upgrades.

To determine exchange rates needed to upgrade existing AP/MRC, run apumccur.sql. 
Running this script has no effect on Receivables, as it gets Payables exchange rates 
only for exchange rate fields that did not exist before the upgrade. Run this script for 
each APPS schema (from the new APPL_TOP). The instructions in the script indicate 
which daily rates combinations must be defined.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @apumccur.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @apumccur.sql

Define the rates from the GL responsibility. Navigate to Setup > Currencies > Rates > 
Daily. Rerun the script and enter missing rates until no more are reported.

Step 2  Import and purge Payables Open Interface invoices
This task is Required. It applies to Release 11.0 upgrades.

Import and purge all invoices that are in the Payables Open Interface tables.

1. As the Payables Manager, choose Invoices > Entry > Open Interface Invoices.

2. Query all invoices. Import the ones that have a null value in the Status field.

3. To submit the Payables Open Interface Import program, choose Requests > Run. 
Select Single Request and choose OK. Type Payables Open Interface Import in the 
Request Name field. Enter each source in the Parameters window, choose Yes for 
the Purge parameter, and click Submit Request.

5. Calculate space requirements for new accounting 
tables

Recommended Application Specialist (Payables) / 
Database Administrator

Requirement Explanation

Reference manual? Multiple Reporting Currencies in Oracle Applications; Oracle Applications General 
Ledger User’s Guide

Users must log off? Yes

TUMS Step Key? AP_MRC_EXCHANGE_RATES

Additional Information: See Entering Daily Rates in Oracle 
Applications General Ledger User’s Guide.

Requirement Explanation

Reference manual? Open Interface Import (Oracle Payables User’s Guide, Release 11 or 11i)

Users must log off? No

TUMS Step Key? AP_IMPORT_AND_PURGE_INVOICES

Task List Status Responsibility
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4. For each completed import process, Payables automatically produces the Payables 
Open Interface report. Review each report, resolve any outstanding exceptions, 
and resubmit the import program until you have imported all outstanding 
invoices.

5. To purge invoice data imported successfully but remaining in the tables, choose 
Requests > Run, select Single Request, and choose OK. Type Payables Open 
Interface Purge in the Request Name field. Click Submit Request.

Step 3  Import and purge Invoice Import Interface expense reports and invoices 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Import and purge all invoice and expense report records that are in the Payables 
Invoice Import interface tables.

From the new APPL_TOP, run the following script:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @apuinimp.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @apuinimp.sql

The script produces apuinimp.lst, which lists for each operating unit any sources for 
which you must import records and the number of records that must be imported. If 
there are no records listed, this step is complete. 

If there are records listed, follow these steps to import them:

1. In Payables, import the records for each operating unit.

■ If you are upgrading from character-mode, navigate to the Submit Invoice 
Import form in the old APPL_TOP. For each source, submit import and enter 
the current date as the purge date.

■ If you are upgrading from GUI, choose Other > Requests > Run in the old 
APPL_TOP. In the Submit Request window, select Single Request and choose 
OK. Submit the Payables Invoice Import program for each source, and enter 
the current date as the purge date.

2. For each completed import process, Payables automatically produces the Payables 
Invoice Import Exceptions report. Review each report, resolve any outstanding 
exceptions, and resubmit the Payables Invoice Import program until you have 
imported all outstanding records.

3. Purge any remaining records imported successfully but remaining in the tables. 
Perform these steps from the old APPL_TOP.

■ If you are upgrading from character-mode, navigate to the Submit Invoice 
Import form. Enter the current date as the purge date. 

Requirement Explanation

Reference manual? Submit Invoice Import, (Oracle Payables User’s Guide, Release 10.7); Payables 
Invoice Import Program, (Oracle Payables User’s Guide, Release 11)

Users must log off? No

TUMS Step Key? AP_IMPORT_AND_PURGE_EXPENSE_REPORTS
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■ If you are upgrading from GUI, submit Payables Invoice Import with a purge 
date and a user-defined source. Payables automatically purges all successfully 
imported records, regardless of source.

Step 4  Transfer all data to General Ledger 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

All data in Oracle Payables must be transferred to the General Ledger. If you are using 
MRC, all reporting sets of books data must be transferred as well. Choose Other > 
Requests > Run. Choose "Payable Transfer to General Ledger" concurrent program.

Step 5  Calculate space requirements for new accounting tables
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

The upgrade creates accounting entries for all Payables transactions (invoices and 
payments). Use the following formulas to estimate the maximum number of rows that 
the upgrade creates in each of the new accounting tables. Doing so reduces the chances 
of running into space issues during the upgrade. Once you know the number of rows 
to expect, you can calculate the space requirements for the tables and their indexes by 
multiplying by average record length.

These calculations provide an estimated size for these tables after the upgrade. Have 
the database administrator ensure that the tablespace(s) that include these tables are 
sized to handle the calculated size. Failure to do so could cause upgrade failures, and 
require you to modify tablespaces and restart the upgrade.

Requirement Explanation

Reference manual? Oracle Payables (or Government Payables) Reference Manual, Release 10.7

Users must log off? No

TUMS Step Key? AP_TRANS_ALL_DATA_TO_GL

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? AP_SPACE_REQ_NEW_ACCT_TABLES

Table Name Calculation Formula

AP_ACCOUNTING_EVENTS_ALL 2 * (number of rows in AP_INVOICES_ALL) + 3 * 
(number of rows in AP_CHECKS_ALL)

AP_AE_HEADERS_ALL #_of_SOB * (number of rows in AP_ACCOUNTING_
EVENTS_ALL calculated above), where #_of_SOB is the 
total number of reporting currencies plus 1

Note: If you use combined basis accounting, multiply the 
total number of reporting currencies by 2.

AP_AE_LINES_ALL 2 * (number of rows in AP_INVOICE_DISTRIBUTIONS_
ALL + number of rows in AP_PAYMENT_
DISTRIBUTIONS_ALL + number of rows in AP_
RECON_DISTRIBUTIONS_ALL) * #_of_SOB
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Oracle Receivables Tasks
Perform the following tasks for Oracle Receivables.

Step 1  Diagnose and correct pre-existing database problems
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Inconsistent Receivables data may cause some Receivables upgrade scripts to fail. This 
step explains how to diagnose problems in the data and fix inconsistencies.

Diagnose problems in the data:
Run ar115chk.sql. It lists inconsistencies, without affecting the data in any way.

UNIX: 
$ cd $AR_TOP/patch/115/sql 
$ sqlplus <APPS username>/<APPS password> @ar115chk.sql

Windows: 
C:\> cd %AR_TOP%\patch\115\sql 
C:\> sqlplus <APPS username>/<APPS password> @ar115chk.sql

Review ar115chk.log in the directory where you ran the script. It lists the following 
types of inconsistencies, as well as suggested actions: 

■ Applications that have Earned Discounts but do not have an Earned Discount 
account. 

■ Applications that have Unearned Discounts but do not have an Unearned 
Discount account. 

■ Applications that have a Receivable Account that does not exist in Receivables but 
is required to create the Gain, Loss, or Currency Round accounting. 

■ Approved Adjustments for which the corresponding Transactions do not exist.

Fix inconsistent data:
You have two options: 

■ Manually fix inconsistent data listed in the script output files.

■ Run ar115upd.sql to automatically update the missing (null) discount accounts 
with temporary accounts having a -1 code combination. This script also accurately 
derives the Receivable accounts needed for Gain, Loss, or Cross Currency 
Rounding accounting creation, if they are missing. This derivation comes from the 

Task List Status Responsibility

1. Diagnose and correct pre-existing database problems Recommended System Administrator / Application 
Specialist (Receivables)

2. Reconcile Receivables tax transactions Required Application Specialist (Receivables)

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? AR_DIAGNOSE_DB_PROBLEMS
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original transaction's Receivable account. The input parameter is the value of utl_
file_dir. The output is written to utl_file_dir/ar115upd.log.

UNIX: 

$ cd $AR_TOP/patch/115/sql 
$ sqlplus <APPS username>/<APPS password> @ar115upd.sql

Windows: 

C:\> cd %AR_TOP%\patch\115\sql 
C:\> sqlplus <APPS username>/<APPS password> @ar115upd.sql

Identify changed records (optional):
After you run ar115upd.sql, run ar115vrf.sql to create a list of the changed records.

UNIX: 
$ cd $AR_TOP/patch/115/sql 
$ sqlplus <APPS username>/<APPS password> @ar115vrf.sql

Windows: 
C:\> cd %AR_TOP%\patch\115\sql 
C:\> sqlplus <APPS username>/<APPS password> @ar115vrf.sql

Step 2  Reconcile Receivables tax transactions
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

In this release, tax accounting is available for adjustments, discounts, finance charges, 
and miscellaneous receipts. However, the upgraded version of the VAT Reconciliation 
report (renamed Tax Reconciliation during the upgrade) does not show the tax 
accounting for any receipt applications, discounts, finance charges, and miscellaneous 
receipts that were created prior to the upgrade, because tax accounting was not 
available for these transaction classes before Release 11i.

Print the VAT Reconciliation report for the period up to the date of the upgrade, and 
use this report to reconcile, for a given period, the tax amounts for a particular tax 
code with the GL balance of the tax liability account. 

Run the report from the A/R responsibility. If you are upgrading from 10.7, run the 
report from Navigate > Reports > Accounting. If you are upgrading from 11.0, run the 
report from Reports > Accounting or from Control > Requests > Run.

Caution: Do not proceed until you have addressed all inconsistent 
data either manually, or by using ar115upd.sql. All inconsistent 
data is fixed when ar115upd.log is blank.

Requirement Explanation

Reference manual? Oracle Receivables Tax Manual

Users must log off? Yes

Additional Information: See Tax Reconciliation Report in Oracle 
Receivables Tax Manual.
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Oracle Financials Common Country Tasks

Step 1  Partition EFT system formats information by operating unit
This step is Conditionally Required. It applies to Release 10.7 upgrades (Germany, 
Netherlands, Norway, Sweden, and Switzerland).

Perform this step only if you are already using Multi-Org functionality. 

Add the ORG_ID column to the JG_ZZ_SYSTEM_FORMATS table and partition the 
table before it is converted to Multi-Org. The partition is created by assigning existing 
data to an appropriate operating unit so that it is accessible. Perform both steps for each 
installation of Oracle Payables. 

To add the ORG_ID column:
Run jgzzper1.sql as follows:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <AP username>/<AP password> @jgzzper1.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jgzzper1.sql

To partition the existing data by operating unit:
Run jgzzper2.sql once for every combination of country code and EFT type that exists 
in the database until each entry is assigned to an operating unit.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <AP username>/<AP password> @jgzzper2.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jgzzper2.sql

Projects
Review this section and complete only the tasks for the Oracle Projects products you 
have installed.

Task List Status Country/Responsibility

1. Partition EFT system formats 
information by operating unit

Conditionally Required Germany, Netherlands, Norway, Sweden, 
Switzerland /Database Administrator

Requirement Explanation

Reference manual? No

Users must log off? Yes

TUMS Step Key? JG_PARTITION_EFT_SYSTEM_FORMATS
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Oracle Projects Tasks
Perform the following tasks for Oracle Projects.

Step 1  Submit and obtain approval for all timecards entered in PTE or Project 
Time and Expense
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

PTE and Project Time and Expense are no longer supported. Timecard entry is now 
performed in the Self-Service Time application (implemented in Step 1 of the Oracle 
Projects Tasks in Chapter 6). If you used Personal Time and Expense (PTE) in Release 
10.7 or Project Time and Expense in Release 11.0 to enter timecard information, submit 
all timecards entered in the existing application and obtain approval for each one. Do 
not enter any new timecards until after the upgrade.

Step 2  Correct excess revenue accrued for negative amount events
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Perform this step only if Oracle Project Billing is installed, and all the following 
conditions are true: you have not applied patch set D (Release 10.7), you have not 
upgraded to Release 11.0.2 (or later), and you have not applied patch 634580.

Projects now generates the correct revenue amounts during the Generate Draft 
Revenue process. Run pa634580.sql from the new APPL_TOP to report existing 
overstated revenue.

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @pa634580.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @pa634580.sql

Task List Status Responsibility

1. Submit and obtain approval for all timecards entered in 
PTE or Project Time and Expense

Conditionally Required Application Specialist (Projects)

2. Correct excess revenue accrued for negative amount 
events

Conditionally Required Application Specialist (Projects)

3. Back up custom client extension packages and views Conditionally Required Technical Specialist

Requirement Explanation

Reference manual? Oracle Personal Time and Expense System Administrator’s Guide; Oracle Project 
Time and Expense User’s Guide

Users must log off? Yes

TUMS Step Key?  PA_TIMECARD_APPROVAL

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Users must log off? Yes
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At the prompt, enter Start Project Number and End Project Number to reduce 
processing time. The script produces a report (pa634580.lst), which lists the project and 
task number, event number, and the event amount for all events where revenue is 
accrued beyond the soft limit. To correct the data, create a revenue write-off event for 
each overstated amount. From the old APPL_TOP:

1. Choose Billing > Events and select either Project or All to navigate to the Find 
Project Events window.

2. Query for the project you want to correct.

3. Choose New to display the Event Details window.

4. Enter the Task Number (if you want to create a task level event).

5. Select an Event Type that has an event classification of Write-Off.

6. In the Revenue Amount field, enter the amount listed in pa634580.lst for the 
project and task.

7. Complete the Event Date, Organization, and Description fields and save your 
work.

8. Repeat these steps for each overstated amount on the report.

After you create the required revenue write-off events, run the Generate Draft 
Revenue process from the Submit Request (Requests > Run) window for each affected 
project.

Step 3  Back up custom client extension packages and views
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Back up any custom client extension packages and views you have created. Reinstall 
them in Step 12 of Oracle Projects Tasks in Category 5. Run the backup from the old 
APPL_TOP. The list of objects that you can customize includes:

Additional Information: See Events in Oracle Projects User’s Guide.

Requirement Explanation

Reference manual? Oracle Applications Developer’s Guide

Users must log off? Yes

File Name Package Name

PAXPTRXS.pls and PAXPTRXB.pls PA_Client_Extn_Inv_Transfer

PAXPIACS.pls and PAXPIACB.pls PA_Client_Extn_Inv_Actions

PAXIBCXS.pls and PAXIBCXB.pls PA_Client_Extn_Bill_Cycle

PAXITMPS.pls and PAXITMPB.pls MyPackageName

PAXICOSS.pls and PAXICOSB.pls PA_Rev_CA

PAICPCAS.pls and PAICPCAB.pls PA_CC_CA

PAXICTMS.pls and PAXICTMB.pls PA_Client_Extn_Billing

PAXPOTXS.pls and PAXPOTXB.pls PA_Client_Extn_Output_Tax

PAXPCTS.pls and PAXPCTB.pls PA_Bill_Pct

PAPARICS.pls and PAPARICB.pls PA_Override_AR_Inst
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PAXTGTCS.pls and PAXTGTCB.pls PAGTCX

PAPSSTCS.pls and PAPSSTCB.pls PA_TIME_CLIENT_EXTN

PAPSSDFS.pls and PAPSSDFB.pls PA_CLIENT_EXTN_SST_DFF

PAXPTEES.pls and PAXPTEEB.pls PA_CLIENT_EXTN_PTE

PAXTRT1S.pls and PAXTRT1B.pls PA_CLIENT_EXTN_RTE

PAXTTCXS.pls and PAXTTCXB.pls PATCX

PAXTRTES.pls and PAXTRTEB.pls PAROUTINGX

PAXBSGCS.pls and PAXBSGCB.pls pa_client_extn_burden_summary

PAXCCECS.pls and PAXCCECB.pls PA_Client_Extn_Costing

PAXDLCOS.pls and PAXDLCOB.pls PA_CALC_OVERTIME

PAXCCEBS.pls and PAXCCEBB.pls PA_CLIENT_EXTN_BURDEN

PAXCCETS.pls and PAXCCETB.pls PA_Client_Extn_Txn

PAPDFFCS.pls and PAPDFFCB.pls PA_CLIENT_EXTN_DFFTRANS

PACCIXTS.pls and PACCIXTB.pls PA_CC_IDENT_CLIENT_EXTN

PAPAALCS.pls and PAPAALCB.pls PA_Client_Extn_autoalloc_pkg

PAPALCCS.pls and PAPALCCB.pls PA_Client_Extn_alloc

PAPGALCS.pls and PAPGALCB.pls PA_client_extn_gen_asset_lines

PAPMCECS.pls and PAPMCECB.pls PA_multi_curr_client_extn

PAPTPRCS.pls and PAPTPRCB.pls PA_CC_TP_client_extn

PAXGCES.pls and PAXGCEB.pls PA_client_extn_cip_grouping

PAXORCES.pls and PAXORCEB.pls PA_ORG_client_extn

PAPMGCES.pls and PAPMGCEB.pls PA_client_extn_PM

PAWFPCES.pls and PAWFPCEB.pls PA_client_extn_project_wf

PAXPCECS.pls and PAXCECB.pls PA_client_extn_proj_status

PAXVPS2S.pls and PAXVPS2B.pls PA_client_extn_proj_status

PARCWFCS.pls and PARCWFCB.pls PA_CLIENT_EXTN_CAND_WF

PAXBCECS.pls and PAXBCECB.pls PA_Client_Extn_Budget

PAWFBCES.pls and PAWFBCEB.pls PA_client_extn_budget_wf

PACECMTS.pls and PACECMTB.pls PA_client_extn_check_cmt

PAXVPS2S.pls and PAXVPS2B.pls PA_client_extn_status

PARAAPCS.pls and PARAAPCB.pls PA_CLIENT_EXTN_ASGMT_APPRVL

PARAWFCS.pls and PARAWFCB.pls PA_CLIENT_EXTN_ASGMT_WF

File Name Workflow

patch/115/import/US/PAAPINVW.wft PAAPINVW

patch/115/import/US/PAAPWEBX.wft PAAPWEBX

patch/115/import/US/PARCANDD.wft

File Name Package Name
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Oracle Grants Accounting Tasks
Perform the following tasks for Oracle Grants Accounting.

Step 1  Verify that all awards have a current, baselined budget
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

A current baselined award budget is required for every award that has transactions 
charged to it. If a current baselined budget does not exist for such awards, the award 
budget balances and the transactions charged to it will NOT be upgraded.

From the new APPL_TOP, run the following script:

UNIX:
$ cd $GMS_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @gmsupaud.sql

Windows:
C:\> cd %GMS_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @gmsupaud.sql

The script produces a report file (gms_upgrade_no_budgets.lst), which lists award and 
project combinations that do not have a current, baselined budget. Re-baseline and/or 
establish a current baselined budget for any awards listed in the report.

Complete and rerun this step until no awards are listed in the report before you 
proceed with the remaining Grants Accounting upgrade steps in this section.

patch/115/import/US/PARASGMT.wft PAWFAAPB

Views that can be customized Views that can be customized

pa_exp_ovrrde_approver_v pa_online_projects_v

pa_online_tasks_v pa_online_expenditure_types_v

PA_CDL_BURDEN_SUMMARY_V PA_COMMITMNET_TXNS_V

Task List Status Responsibility

1. Verify that all awards have a current, baselined budget Required Applications Specialist (Grants)

2. Run costing and funds check procedures Required Applications Specialist (Grants)

3. Run the Distribute Burden process Required Applications Specialist (Grants)

Requirement Explanation

Reference manual? Oracle Grants Accounting User’s Guide

Users must log off? Yes

TUMS Step Key? GMS_AWARD_BASEBUDGET_EXISTS

Additional Information: For more information, see Budget Entry 
Procedures in the Oracle Grants Accounting User’s Guide.

File Name Workflow
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Step 2  Run costing and funds check procedures
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Run the GMS costing and funds check procedures for expense reports, straight time 
labor, and usage. For more information, see the following sections in Chapter 33, 
Processes and Reports Procedures, Oracle Grants Accounting User’s Guide.

■ GMS: Costing and Funds Check on Expense Reports Expenditure Items Procedure

■ GMS: Costing and Funds Check on Straight Time Labor Procedure

■ GMS: Costing and Funds Check on Usages and Miscellaneous Costs Procedure

■ GMS: Distribute Supplier Invoice Adjustment Costs and Funds check

Step 3  Run the Distribute Burden process
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

See the following references to run this process:

Release 10.7:
See GMS: Create Summarized Burden Expenditure Items, Chapter 33, Processes and 
Reports, Oracle Grants Management User’s Guide.

Release 11.0:
See PRC: Create and Distribute Burden Transactions, Chapter 36, Processes and 
Reports Procedures, Oracle Grants Management User’s Guide.

Manufacturing
Review this section and complete only the tasks for the Oracle Manufacturing products 
you have installed.

Oracle Cost Management Tasks
Perform the following tasks for Oracle Cost Management.

Requirement Explanation

Reference manual? Oracle Grants Accounting User’s Guide

Users must log off? Yes

Concurrent Manager? Yes

TUMS Step Key? GMS_RUN_COSTING_AND_FUNDS_CHECK

Requirement Explanation

Reference manual? Oracle Grants Accounting User’s Guide

Users must log off? Yes

Concurrent Manager? Yes

TUMS Step Key? GMS_DISTRIBUTE_BURDEN

Task List Status Menu Responsibility > Function / Responsibility

1. Verify that no uncosted transactions exist – 
Standard and Average Costing

Required Manufacturing and Distribution Manager > 
Cost/Application Specialist (Cost Management)
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Step 1  Verify that no uncosted transactions exist – Standard and Average 
Costing
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

To verify that no uncosted transactions exist, check material inventory transactions 
and WIP pending resource transactions. 

If upgrading from Release 10.7 or 11.0:
As the Manufacturing and Distribution Manager, choose the Cost function. Navigate 
to View Transactions > MTL Transactions. Choose WIP and navigate to Pending 
Resource Transactions. Perform this step from the old APPL_TOP. 

If upgrading from Release 10.7 (character-mode) or 10.7NCA:
See View Transactions, Oracle Inventory Reference Manual, Release 10, or View Pending 
Transactions, Oracle Inventory Reference Manual, Release 10SC.

Step 2  Run WIP Value report – Standard and Average Costing
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

After you have completed the inventory and work in process transactions, run the 
WIP Value report for the latest accounting period. At a minimum, run this report for 
all jobs and repetitive schedules using the class sort and job/schedule sort. 

1. From the old APPL_TOP, as the Manufacturing and Distribution Manager, choose 
the Cost function. Navigate to Report > Value (WIP Value report).

2. Choose Single Request or a Request Set (the Submit Request window appears).

3. In the Name field, select WIP Value Report (the Parameters window appears).

4. Enter the report parameters and choose OK (returns to the Submit Request 
window). Choose Submit.

2. Run WIP Value report – Standard and 
Average Costing

Recommended Manufacturing and Distribution Manager > 
Cost/Application Specialist (Inventory or Cost 
Management)

3. Close all accounting periods – Standard 
and Average Costing

Required Manufacturing and Distribution Manager > 
Cost/Application Specialist (Inventory)

Requirement Explanation

Reference manual? Oracle Cost Management User’s Guide, Oracle Inventory User’s Guide, and Oracle 
Work in Process User’s Guide

Users must log off? Yes

Requirement Explanation

Reference manual? Oracle Cost Management User’s Guide; Oracle Inventory User’s Guide; Oracle 
Work in Process Reference Manual

Users must log off? Yes

Concurrent Manager? Yes

Additional Information: See WIP Value Report in Oracle Work in 
Process Reference Manual.

Task List Status Menu Responsibility > Function / Responsibility
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In Step 1 of the Oracle Cost Management Tasks in Category 5, run this report again 
and compare the Release 10.7 or Release 11.0 balances with the associated Release 11i 
balances. If you are upgrading from Oracle Work in Process, Release 10.7 10SC, see 
WIP Value Report in the Oracle Work in Process User’s Guide, Release 10SC.

Step 3  Close all accounting periods – Standard and Average Costing
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Closing accounting periods summarizes costs based on transactions. Closing periods is 
required for sets of books that use the Global Accounting Engine. And, it is highly 
recommended for all sets of books.

Logistics
Review this section and complete only the tasks for the Oracle Logistics products you 
have installed.

Oracle Inventory Tasks
Perform the following tasks for Oracle Inventory.

Step 1  Complete physical inventories in process - INV
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Follow the instructions in the Processing Physical Inventory Adjustments section of 
the Oracle Inventory User’s Guide to complete any physical inventories in process. Enter 
tag counts and perform adjustments for each unfinished process. Perform this step 
from the old APPL_TOP.

Requirement Explanation

Reference manual? Oracle Cost Management User’s Guide; Oracle Inventory User’s Guide

Users must log off? Yes

Concurrent Manager? Yes

TUMS Step Key? CST_CLOSE_ALL_ACC_PERIODS

Additional Information: See Step 4 of the Global Accounting 
Engine Tasks in Chapter 2.

Task List Status Menu Responsibility > Function / Responsibility

1. Complete physical inventories in process - 
INV

Recommended Manufacturing and Distribution Manager > 
Inventory/Application Specialist (Inventory)

2. Process data in temporary and interface 
tables - INV

Required Manufacturing and Distribution Manager > 
Inventory/Application Specialist (Inventory)

3. Run inventory valuation reports - INV Recommended Manufacturing and Distribution Manager > 
Cost/Application Specialist (Inventory)

Requirement Explanation

Reference manual? Oracle Inventory User’s Guide

Users must log off? Yes
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Step 2  Process data in temporary and interface tables - INV 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Before you perform this step, make sure the background processor is running.

1. Navigate to Inventory > Setup > Transactions > Interface Managers. (For character 
mode users, the path is: NAV/INQUIRY/TRANS/INTERFACE.)

2. From the Special menu, choose Launch Managers for each manager.

Complete transactions so that no information remains in the temporary (MTL_
MATERIAL_TRANSACTIONS_TEMP) table or in the interface tables (MTL_
TRANSACTIONS_INTERFACE and MTL_DEMAND_INTERFACE). Run these steps 
from the old APPL_TOP.

To view pending transactions:
1. As the Manufacturing and Distribution Manager, choose the Inventory function. 

Navigate to the Find Pending Transactions window (Transactions > Pending 
Transactions).

2. Enter search criteria for the pending transactions you want to view, and choose 
Find. You can view the results in the Pending Transactions window.

3. Select a tabbed region to display a type of information: Error, Location, Source, 
Intransit, or Other.

To resubmit transactions to the demand manager for processing:
In the Pending Transactions window, select Submit for each transaction you want to 
resubmit, or choose Resubmit All from the Special menu. Save your work.

Step 3  Run inventory valuation reports - INV 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

After you have completed the inventory transactions, run the Elemental Value report, 
the Subinventory Value report, and if you use intransit, the Intransit Value report. As 
the Manufacturing and Distribution Manager, choose the Cost responsibility under the 
old APPL_TOP. Navigate to Reports > Value. At a minimum, run these reports sorted 
by item and by subinventory. In Step 2 of the Oracle Inventory Tasks in Category 5, 
run these reports again and validate the Release 10.7 or Release 11 inventory balances 
against the Release 11i balances.

As the Manufacturing and Distribution Manager, choose the Cost function. Navigate 
to Accounting Close Cycle > Inventory Accounting Periods. If you are upgrading from 
Release 10.7 10SC, see Period Close, Oracle Cost Management User’s Guide, Release 10SC.

Requirement Explanation

Reference manual? Oracle Inventory User’s Guide

Users must log off? Yes

Additional Information: See Overview of Inventory Transactions 
in Oracle Inventory User’s Guide.

Requirement Explanation

Reference manual? Oracle Cost Management User’s Guide, Release 10SC

Users must log off? Yes
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Order Management
Review this section and complete only the tasks for the Oracle Order Management 
products you have installed.

Oracle Order Management Tasks
Perform the following tasks for Oracle Order Management.

Step 1  Repeat Category 2 steps 1 – 10
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you have not yet performed the Order Management Category 2 steps, or if you have 
processed new transactions since you completed the steps, perform the Category 2 
steps now.

Procurement
Review this section and complete only the tasks for the Oracle Procurement products 
you have installed.

Oracle Purchasing Tasks
Perform the following tasks for Oracle Purchasing.

Step 1  Modify default MRP profile options
This task is Conditionally Required. It applies to Release 10.7NCA or 10SC upgrades.

If you did not use AutoSource Rules in Release 10.7, do not perform this step. If you 
used AutoSource Rules in Release 10.7 character-mode, the Sourcing Rule/Bill of 
Distribution Assignments window is available after the upgrade. Set these profile 
options at that time (Step 3 of the Oracle Purchasing Tasks in Category 5).

Task List Status Responsibility

1. Repeat Category 2 steps 1 – 10 Conditionally Required Application Specialist (Order Entry/Shipping

Requirement Explanation

Reference manual? Oracle Order Entry/Shipping User’s Guide

Users must log off? No

Additional Information: See Oracle Order Management Tasks in 
Chapter 2.

Task List Status Responsibility

1. Modify default MRP profile options Conditionally Required Application Specialist (Purchasing)/
System Administrator

Requirement Explanation

Reference manual? Oracle Applications Purchasing User’s Guide

Users must log off? Yes
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To accommodate the enhanced sourcing rules and Approved Supplier List (ASL) 
entries, AutoUpgrade assigns default profile option values for MRP:Default Sourcing 
Assignment Set and MRP:Sourcing Rule Category Set. You may want to modify these 
defaults to suit your business needs. 

Navigate to the System Profile Values window in the System Administrator 
responsibility (from the old APPL_TOP). Query for MRP: Sourcing Rule Category Set 
and MRP: Default Sourcing Assignment Set to make sure that values are provided at 
the Site level.

To modify MRP:Sourcing Rule Category Set:

You can set the MRP:Sourcing Rule Category Set profile option to the name of the 
category set used by Purchasing, or to any other category set. From the Purchasing 
responsibility, choose Setup > Items > Categories > Default Category Sets. Use the 
Category set name that appears next to the Purchasing Functional area.

To modify MRP:Default Sourcing Rule Assignment Set:

You can set the MRP:Default Sourcing Assignment Set profile option to the assignment 
set used by Purchasing. If you already have a sourcing rule assignment set, you can 
choose it for this profile option value. If you do not, use the Sourcing Rule/Bill of 
Distribution Assignments window to create one. From the Purchasing responsibility, 
choose Supply Base > Assign Sourcing Rules. Create an assignment set name and save 
it. Then choose this name in the MRP:Default Sourcing Assignment Set profile option.

Public Sector
Review this section and complete only the tasks for the Oracle Public Sector products 
you have installed.

Oracle U.S. Federal Financials Tasks
Perform the following tasks for Oracle U.S. Federal Financials.

To upgrade from Version 3.3 of Oracle U.S. Federal Financials, users must apply Patch 
Set F or higher.

Step 1  Drop obsolete objects
This task is Required. It applies to Release 2.0 or 3.3 upgrades.

Note: Purchasing uses just one assignment set — the one 
indicated in this profile option. Therefore, AutoUpgrade assigns all 
newly created sourcing rules to this assignment set name. 

Additional Information: See Automatic Sourcing in Oracle 
Applications Purchasing User’s Guide.

Task List Status Responsibility

1. Drop obsolete objects Required Technical Specialist

Requirement Explanation

Reference manual? No

Users must log off? Yes
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For version 2.0 and 3.3, drop all seed data, obsolete database objects, and indexes. 
Check the log file fvdrpobj.log for errors.

For version 2.0:
Run the following script.

UNIX:
$ cd $FV_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @fv107obj.sql

Windows:
C:\> cd %FV_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @fv107obj.sql

For version 3.3:
Run the following script.

UNIX:
$ cd $FV_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @fv110obj.sql

Windows:
C:\> cd %FV_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @fv110obj.sql

Marketing and Sales
Review this section and complete only the tasks for the Oracle Marketing and Sales 
products you have installed.

Oracle Sales/Oracle Sales Compensation Tasks
Perform the following tasks for Oracle Sales/Oracle Sales Compensation.

Step 1  Apply pre-upgrade patch
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

TUMS Step Key? FV_DROP_OBJECTS

Task List Status Responsibility

1. Apply pre-upgrade patch Required Technical Specialist

2. Set profile options Required Technical Specialist

3. Run setup data verification scripts Required Technical Specialist

Requirement Explanation

Reference manual? No

Users must log off? Yes

Requirement Explanation
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Use the following table to determine the correct patch for your system. Then apply the 
patch from the old APPL_TOP.

Step 2  Set profile options
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

You must set the following profile options before you continue with the upgrade:

Step 3  Run setup data verification scripts
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

If your are upgrading from... Apply this patch...

Release 10.7 3262062

Release 11.0.x 3262064

Release 3i 3262067

Note: These patches and subsequent steps may write output files 
to utl_file_dir. Before you continue, ensure that the utl_file_dir 
parameter is correctly set in the init.ora file. When more than one 
directory is listed in utl_file_dir, the first directory listed will be 
used for all output.

Requirement Explanation

Reference manual? No

Users must log off? No

Profile Mandatory Default Description

OSM:Forecast Sales 
Credit Type

No Quota Sales 
Credit

For Opportunity Sales Credits

OSM:Compensation 
Sales Credit Type

No Non-quota Sales 
Credit

For Opportunity Sales Credits

OSM:Default Channel No DIRECT For Opportunity

OSM:Default 
Opportunity Status

No PRELIMINARY For Opportunity

OSM:Default Close 
Date Days

No 150 To close an Opportunity

OSM:Default 
Opportunity Sales Stage

No 1 For Opportunity

OSM:Default 
Opportunity Win 
Probability

No 10 For Opportunity

OSM:Interest Type 
Master Org ID

No 0 For the MO interest type migration script, 
which migrates Interest_type/Interest_
code/Win_prob/Sales_stage from different 
orgs to the master org.

OSM:Currency Code No USD Valid currency code. Site-level default is USD.

Requirement Explanation

Reference manual? No
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In order to verify that your setup data is ready for the upgrade, you must run data 
verification scripts against your installation. Download and run the appropriate patch.

Each patch creates reports in the first directory listed in the utl_file_dir parameter. 
These reports may indicate problem data. If so, the report will describe a remedy for 
the problem. Re-run the patch after making corrections until no errors are reported. 
The reports in the following table are generated only if issues are found.

As an alternative to viewing the output of each report individually, you can view the 
concatenated output of each report in the AutoPatch log file. 

Service
Review this section and complete only the tasks for the Oracle Service products you 
have installed.

Users must log off? Yes

If you are upgrading from... Apply this patch...

Release 10.7 3510628

11.0.x 3510630

3i 3394567

Release 10.7 Report Name Purpose

asxtdtkc.sql.lst Identify corrupt data for Tasks migration.

asxtditc.sql.lst Identify corrupt data for Interactions migration.

asxterrc.lst Identify corrupt data for Territories migration.

cnupgchk.log Verify completion of Sales Compensation processes.

Release 11.0.x Report Name Purpose

asxtdtkc.sql.lst Identify corrupt data for Tasks migration.

asxtditc.sql.lst Identify corrupt data for Interactions migration.

asxterrc.lst Identify corrupt data for Territories migration.

asxclen1.sql.lst Sales Migration Code report.

cnupgchk.log Verify completion of Sales Compensation processes.

Release 3i Report Name Purpose

asxtdtkc.sql.lst Identify corrupt data for Tasks migration.

asxtditc.sql.lst Identify corrupt data for Interactions migration.

asxterrc.lst Identify corrupt data for Territories migration.

asxclen1.sql.lst Sales Migration Code report.

cnupgchk.log Verify completion of Sales Compensation processes.

Requirement Explanation
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Oracle Service Tasks
Perform the following tasks only for Oracle Service products that you have installed.

Step 1  Apply pre-upgrade patch
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

Use the following table to determine the correct patch to apply to your system.

Step 2  Correct issues in Install Base data
This task is Conditionally Required. It applies to Release 10.7, 11.0, or 3i upgrades.

Caution: If you are upgrading Oracle Service products, you 
cannot use the Order Management selective upgrade (bifurcation) 
option. See Selectively upgrade active transactions on page 2-38.

Task List Status Responsibility

1. Apply pre-upgrade patch Required Technical Specialist

2. Correct issues in Install Base data Conditionally Required Technical Specialist

3. Clear Oracle Order Entry Service Interface data Required Technical Specialist

4. Set profile options Required Technical Specialist

5. Process data in interface tables for Depot Repair Conditionally Required Technical Specialist

6. Process data in interface tables for Contracts Conditionally Required Technical Specialist

7. Remove multiple counter groups Conditionally Required Technical Specialist

8. Estimate additional tablespace for Oracle Install Base Required Technical Specialist

9. Run setup data verification scripts Required Technical Specialist

Note: If you have previously applied this patch for Oracle Sales, 
you can omit this task.

Requirement Explanation

Reference manual? No

Users must log off? Yes

If your are upgrading from... Apply this patch...

Release 10.7 3262062

Release 11.0.x 3262064

Release 3i 3262067

Note: The steps in this section may write output files to your utl_
file_dir. Before you continue, ensure that the utl_file_dir parameter 
is correctly set in the init.ora file. If more than one directory is listed 
in this parameter, the first directory listed will be used for all 
output.
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The pre-upgrade patch that you ran in the previous step created a report called CS_
BAD_DATA_REPORT.lst in the utl_file_dir directory. This report shows any Install 
Base data that requires action before you continue the upgrade. It contains the 
following columns:

The error messages suggest SQL commands necessary to correct the problem. You can 
either fix the data using the suggested SQL or use the appropriate forms in Oracle 
Applications.

When you have fixed all data identified in the report, re-run the pre-upgrade patch 
that created the report in Step 1 and review the report contents again. When the report 
contains no records, the Install Base data in Oracle Service is ready for upgrade.

Step 3  Clear Oracle Order Entry Service Interface data
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

To ensure that all data has been transferred out of the Order Entry Service Details 
Interface table, change your responsibility to Service. Then, select Install Base > 
AutoCreate Install Base and run AutoCreate Install Base.

Step 4  Set profile options
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

You must set the following profile options before you continue with the upgrade.

Requirement Explanation

Reference manual? No

Users must log off: Yes

Column Name Description

Source Table The Oracle Service table that contains the bad data.

Source ID The primary key ID of the row.

Error Messages The error message and a suggestion on how to fix the data.

Requirement Explanation

Reference manual? No

Users must log off? No

Additional Information: See Run AutoCreate Install Base program 
for Service in Chapter 2.

Requirement Explanation

Reference manual? No

Users must log off? No

Profile Option Mandatory Default Description

Service:UPG Bill to Country 
Code

Yes N/A Used for Bill to address of non-verified customers 
in Service Requests module.
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Service:UPG Ship to Country 
Code

Yes N/A Used for Ship to address of non-verified 
customers in Service Requests module.

Service:UPG Install Country 
Code

Yes N/A Used for Install address of non-verified 
customers in Service Requests module.

Service:UPG 3i Installation Date Yes
(if upgrade 
from 3i or 
11.0.x)

N/A Determines the location of Service data, which 
depends on whether it was entered using 11.0.x 
or 3i.

Service:UPG Default Employee 
for Interactions

Yes
(if upgrade 
from 3i)

N/A Provides a default value for employee 
information that became mandatory in the 11i 
Interaction History module.

Service:UPG Service Request 
Type

Yes N/A Required for creating new service requests to 
associate with repair records that do not currently 
have an associated service request.

Service:UPG Service Request 
Severity

Yes N/A Required for creating new service requests to 
associate with repair records that do not currently 
have an associated service request.

Service:UPG Service Request 
Status

Yes N/A Required for creating new service requests to 
associate with repair records that do not currently 
have an associated service request.

Service:UPG Service Request 
Owner

Yes N/A Required for creating new service requests to 
associate with repair records that do not currently 
have an associated service request.

Service:UPG Business Process Yes N/A Required for creating new charge lines linked to 
repair lines in order to associate RMA 
information with repair lines.

Service:UPG Transaction Type Yes N/A Required for creating new charge lines linker to 
repair lines in order to associate RMA 
information with repair lines.

Service:UPG Time Zone for 
Contracts

Yes
(if upgrade 
from 3i)

N/A Used for Contracts records that do not have a 
time zone value during coverage line or sub-lines 
creation.

Service:Repair Default Order 
Type for Repairs

Yes
(if upgrade 
from 10.7)

N/A Provides a default order type for all 10.7 depot 
repair estimates. Order type did not exist in 10.7 
and is optional in 11i.

Service:Time Unit of Measure 
Class

Yes N/A Used to define time.

Service:UPG Minute Unit of 
Measure

Yes N/A Used to specify unit of measure for minutes.

Service:UPG Hour Unit of 
Measure

Yes N/A Used to specify unit of measure for hours.

Service:UPG Default Service 
Request Contract

Yes N/A Required for associating a contract to an existing 
or new Service Request. The LOV is filtered for 
contact type EMPLOYEE.

Service:Inventory Validation 
Organization

Yes N/A Used to upgrade customer products that were 
manually created in Oracle Service. Set this to a 
master inventory organization.

Service:CS to CSI Migrate 
Customer Products Audit Data

No Yes Determines whether customer product audit data 
will be migrated to 11i.

Service: CS to CSI Migrate Party 
Audit Data

No Yes Determines whether contacts or resources audit 
data will be migrated to 11i.

Service:CS to CSI Migration 
Stage

Yes No Initially must be set to No, meaning that the data 
is not yet staged for upgrade.

Service:CS to CSI Continue 
Migration with Errors

Yes No Determines whether the 11.5.10 Maintenance 
pack will fail and stop if any Install Base data 
cannot be upgraded.

Profile Option Mandatory Default Description
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The Service:Migration Organization for Employee Service Requests profile option 
must be set to contain the name of the enterprise that you define in Trading 
Community Architecture (TCA) as an internal organization. It is used as the owner of 
the item instance when it is owned by your own enterprise. 

This setting is used only during the upgrade to populate the Party Name field in the 
Install Parameters form. After the upgrade is complete, all functionality refers to the 
value defined in the Party Name field, and not the profile option. For example, when 
you buy and receive an item in Oracle Receiving that creates an item instance, the 
process that creates it refers to the Party Name in the Install Parameters form to assign 
the owner for it.

Step 5  Process data in interface tables for Depot Repair
This task is Conditionally Required. It applies to Release 10.7, 11.0, or 3i upgrades.

Run the following concurrent programs in the order listed to ensure that all items 
received for repair have been interfaced to Depot Repair.

■ RMA Interface

■ Depot Repair Control

You must complete any partially completed WIP jobs created for Depot Repair orders.

Step 6  Process data in interface tables for Contracts
This task is Conditionally Required. It applies to Release 10.7, 11.0, or 3i upgrades.

Run the Service Termination concurrent program to ensure that all order lines 
containing services and any terminated services are processed. After the program has 
run, there should not be any rows in the CS_TERMINATION_INTERFACE_ALL table.

Step 7  Remove multiple counter groups
This task is Conditionally Required. It applies to Release 3i upgrades.

Service:CS to CSI Continue 
Migrate Systems All Audit Data

No Yes Determines whether systems audit data will be 
migrated to 11i.

Service:Execute Pre-11i 
Contracts Upgrade

Yes N/A Determines whether Warranty/Extended 
Warranty/Contracts (3i) data will be migrated to 
Service Contracts 11i.

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? CS_DEPOT_INTF_TABLES

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? CS_CONTRACTS_INTF_TABLES

Profile Option Mandatory Default Description
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In 3i (3.1.1), you could associate multiple counter groups with an installed base 
customer product or contract line. This feature is not supported in Release 11i. If 
multiple associations exist, you must remove them before you proceed with the 
upgrade. Complete the following steps to identify and remove multiple associations.

1. Run csxctrdu.sql. It creates two reports:

■ csxctodu.lst, which lists products in the installed base that have associated 
multiple counter groups.

■ csxctcdu.lst, which lists contract lines with associated multiple counter groups.

To run the script, type the following commands from the old APPL_TOP:

$ cd $APPL_TOP/admin/out
$ sqlplus <APPS username>/<APPS password> @$CS_TOP/patch/110/sql/csxctrdu.sql

2. Review the reports and decide which multiple counter groups to delete. If the 
reports contain no data, you can omit the remaining steps in this task.

3. For each group identified for deletion in Step 2, run csxctddu.sql:

$ cd $APPL_TOP/admin/out
$ sqlplus <APPS username>/<APPS password> @$CS_TOP/patch/110/sql/csxctddu.sql

4. Repeat Steps 1 – 3 until all multiple associations are deleted.

Step 8  Estimate additional tablespace for Oracle Install Base
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

You may need to add additional tablespace for Oracle Install Base. To estimate the 
additional tablespace, double the space used by the following Oracle Service tables:

■ CS_CUSTOMER_PRODUCTS_ALL

■ CS_CP_AUDIT

■ CS_CONTACTS

■ CS_CP_PARTIES_AUDIT

■ CS_CP_REVISIONS

■ CS_SYSTEMS_ALL_B

■ CS_SYSTEMS_ALL_TL

■ CS_SYSTEM_AUDIT

■ CS_CP_PARAMETERS

■ CS_LINE_INST_DETAILS

Requirement Explanation

Reference manual? No

Users must log off? Yes

TUMS Step Key? CS_REMOVE_MULTIPLE_COUNTER_GROUPS

Requirement Explanation

Reference manual? No

Users must log off? No
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■ CS_CUSTOMER_PRODUCT_STATUSES

■ CS_TRANSACTION_TYPES_B

In addition, double the space in the following Oracle Inventory tables and add it to the 
space you calculated for the Oracle Service tables: MTL_ONHAND_QUANTITIES and 
MTL_SERIAL_NUMBERS.

Step 9  Run setup data verification scripts
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

In order to verify that your setup data is ready for the upgrade, you must run data 
verification scripts against your installation. Download and run the appropriate patch.

Each patch creates reports in the first directory listed in the utl_file_dir parameter. 
These reports may indicate problem data. If so, the report will describe a remedy for 
the problem. Re-run the patch after making corrections until no errors are reported. 
Here are the reports that are generated.

Requirement Explanation

Reference manual? No

Users must log off? No

If you are upgrading from... Apply this patch...

Release 10.7 3510628

11.0.x 3510630

3i 3394567

Release 10.7 Report Name Purpose

cs11sver.lst Verification report for Service Request profiles and data.

CS11KCNT.lst Records that fail validation for upgrade.

CS11KRPT.lst Contracts Pre-upgrade Validation report.

cs00dval.lst Verifies that mandatory profile options for Depot Repair 
have been set.

csprpt10.lst Verifies that the mandatory profile options for Install Base 
have been set correctly.

csd11preur.lst Service Request report for Depot Repair.

Release 11.0.x Report Name Purpose

cs22sver.lst Verification report for Service Request profiles and data.

cs22GVER.lst Charges Pre-upgrade Validation report.

CS22KCNT.lst Records that fail validation for upgrade.

CS22KRPT.lst Contracts Pre-upgrade Validation report

cs00dval.lst Verifies that mandatory profile options for Depot Repair 
have been set.

csprpt11.lst Verifies that the mandatory profile options for Install Base 
have been set correctly.
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As an alternative to viewing the output of each report individually, you can view the 
concatenated output of each report in the AutoPatch log file.

Database and System Administration
All users must complete this portion of the upgrade after completing the 
product-specific tasks and before running AutoUpgrade.

System Administration Tasks
Perform the following tasks for System Administration.

Step 1  Identify potential ORACLE schema conflicts 
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you originally installed Oracle Applications with Release 9.3 or earlier, ensure that 
the IDs for existing ORACLE schemas do not conflict with ones necessary for new 
schemas created by AutoUpgrade. To identify potential conflicts, run the following 
script from the new APPL_TOP:

UNIX:
$ cd $APPL_TOP/admin/preupg

csd23preur.lst Service Request report for Depot Repair.

Release 3i Report Name Purpose

cs33sver.lst Verification report for Service Request profiles and data.

cs33GVER.lst Charges Pre-upgrade Validation report.

CS33KCNT.lst Records that fail validation for upgrade.

CS33KRPT.lst Contracts Pre-upgrade Validation report.

cs00dval.lst Verifies that mandatory profile options for Depot Repair 
have been set.

cs33ppbe.lst Customer Profile Verification report

cs33hrep.lst Interaction and Territories Validation report

csprpt3i.lst Verifies that the mandatory profile options for Install Base 
have been set correctly.

csd23preur.lst Service Request report for Depot Repair.

Task List Status Responsibility

1. Identify potential ORACLE schema conflicts Conditionally Required System Administrator

2. Enable SYSADMIN user and password Required System Administrator

Requirement Explanation

Reference manual? No

Users must log off? Yes

Release 11.0.x Report Name Purpose
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$ sqlplus <AOL username>/<AOL password> @adpuver.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @adpuver.sql

Any ORACLE ID values listed by the script that are not associated with an APPS 
schema are potential conflicts, and may result in problems during the upgrade.

Step 2  Enable SYSADMIN user and password
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Because AutoUpgrade must access the Oracle Application Object Library ORACLE 
username using the application user SYSADMIN, ensure that this application user 
exists and is enabled. SYSADMIN must also have access to the System Administrator 
responsibility. The name of this responsibility must be System Administrator and it 
must connect to the APPS schema for its data group. Set the password to SYSADMIN.

To verify this information, go to Security > User > Define and query for user name 
SYSADMIN. Perform the verification from the old APPL_TOP.

Database Upgrade Tasks
Perform the following tasks to prepare your database for the upgrade.

Note: If you determine there is a potential conflict, contact Oracle 
Support Services.

Requirement Explanation

Reference manual? No

Users must log off? Yes

Task List Status Responsibility

1. Shut down application tier listeners and concurrent 
managers

Required Database Administrator
/System Administrator

2. Migrate or upgrade database to Oracle9i Required Database Administrator

3. Set up tablespaces Required Database Administrator
/System Administrator

4. Set up Net Services – node where database is installed Conditionally Required Database Administrator
/System Administrator

5. Run preparatory scripts – node where the database is 
installed

Required Database Administrator
/System Administrator

6. Apply database patch Required Database Administrator
/System Administrator

7. Run preparatory script – administration node Required Database Administrator
/System Administrator

8. Gather database statistics for CBO Required Database Administrator
/System Administrator

9. Gather database information Recommended Database Administrator
/System Administrator

10. Check SQL*Plus options Required Database Administrator
/System Administrator
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Step 1  Shut down application tier listeners and concurrent managers
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Shut down forms listeners, web listeners, and the concurrent managers before you 
begin the upgrade. Do this from the old APPL_TOP.

Ensure all concurrent processes are complete:

Before you shut down the concurrent managers, check to see that all processes are 
complete. Navigate to Concurrent > Requests. In the Find Requests window, select All 
my requests. Click Find. Cancel Pending requests as necessary.

Shut down application tier listeners and concurrent managers:

As System Administrator, choose Administer Concurrent Managers. Navigate to the 
Control field and select Deactivate.

Step 2  Migrate or upgrade database to Oracle9i
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Follow the steps in this section to migrate or upgrade your database to Oracle9i. Use 
an 8K block size. See Block Size in Overview and Requirements for more information.

1. Using Oracle Universal Installer, install the latest certified database patch set in the 
ORACLE_HOME. Check the Certify section of OracleMetaLink for additional 
patches that may be available.

11. Verify rollback segment sizing Required Database Administrator
/System Administrator

12. Turn off automatic archive logging and Replication Required Database Administrator
/System Administrator

13. Disable custom triggers, constraints, and indexes Conditionally Required Database Administrator

14. Install XML Parser for PL/SQL Required Database Administrator

15. Back up the database Recommended Database Administrator

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Maintenance

Users must log off? Yes

Requirement Explanation

Reference manual? Oracle9i Migration

Users must log off? Yes

Note: Rapid Install has already created the ORACLE_HOME with 
the appropriate RDBMS updates for this release.

Note: Do not perform the database upgrade steps listed in the 
patch set release notes. All required database objects are created 
when you run the preparatory scripts later in this chapter.

Task List Status Responsibility
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2. Perform the migration or upgrade using the Oracle9i ORACLE_HOME created by 
Rapid Install. Follow the instructions in Oracle9i Migration to migrate the database.

3. Carefully review the information about initialization parameters in Database 
Initialization Parameters for Oracle Applications (OracleMetaLink Doc ID: 216205.1). 
Determine the appropriate parameters and set them in init.ora.

4. Restart the database so that the parameters take effect.

Step 3  Set up tablespaces 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Before you set up tablespaces, set the init.ora parameter for db_files=500. Then, 
perform the appropriate steps for both the existing tablespaces and the new product 
tablespaces.

1. Convert existing tablespaces to local extent management

We recommend using local extent management to increase performance. To 
convert all non-SYSTEM tablespaces from Data Dictionary extent management to 
local extent management, run the following script:

UNIX:

$ cd $APPL_TOP/admin/preupg
$ sqlplus <SYSTEM username>/<SYSTEM password> @adtbscnv.pls <SYSTEM password>

Windows:

$ cd $APPL_TOP\admin\preupg
$ sqlplus <SYSTEM username>/<SYSTEM password> @adtbscnv.pls <SYSTEM password>

This script lists problems and suggests manual fixes. Review the output 
(adtbscnv.lst), fix problems, and re-run the script until no issues are reported.

2. Create new product tablespaces and resize existing product tables

In this task, you determine your system’s tablespace requirements, and create (and 
resize) the product tablespace. You can choose to begin the conversion to the new 
Oracle Applications tablespace model, or continue to use the existing model.

■ Increase SYSTEM tablespace size

Verify that the SYSTEM tablespace size is at least 9 GB before you run the 
scripts in this task. Increase the tablespace size as needed.

■ Determine other tablespace requirements

Requirement Explanation

Reference manual? Oracle9i Administrator’s Guide

Users must log off? Yes

Additional Information: See Temporary tablespace in Overview 
and Requirements. See also Managing Tablespaces in Oracle9i 
Database Administrator’s Guide.

Additional Information: See Tablespace Model in Overview and 
Requirements for more information. See also OracleMetaLink 
document 248857.1.
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Run either adgncons.sql (if you want to use the new Oracle Applications 
tablespace model) or adgnofa.sql (if you want to continue to use the existing 
OFA-compliant model). 

To use the new tablespace model (OATM):

Run adgncons.sql as follows.

UNIX:

$ cd $AD_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @adgncons.sql \
  <APPS username> <APPS password> APPLSYS

Windows:

C:\> cd %AD_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @adgncons.sql \
     <APPS username> <APPS password> APPLSYS

To continue to use the existing tablespace model (OFA-compliant):

Run adgnofa.sql as follows. On the command line, indicate the <MODE> as 
NEW to create new product tablespaces (tablespaces for existing products are 
not affected), or ALL to create tablespaces for new products and resize existing 
product tablespaces.

UNIX:

$ cd $AD_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @adgnofa.sql <MODE>

Windows:

C:\> cd %AD_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @adgnofa.sql <MODE>

Running either of these scripts generates adcrtbsp.sql, which you run in the 
next step to create the product tablespaces. 

■ Create product tablespaces

Review the information in adcrtbsp.sql and specify the location of the data 
files. Then, run it from the database server as the SYSTEM user to add new 
product tablespaces and resize the existing product tablespaces (<MODE> = 
ALL for OFA-compliant systems). This action also automatically converts 
newly created tablespaces to local extent management. 

Step 4  Set up Net Services – node where database is installed
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Note: The upgrade process populates the new tablespaces with all 
Release 11i objects. After the upgrade is complete, you must finish the 
migration process by moving pre-Release 11i objects to the new 
tablespaces. See Run Tablespace Migration Utility in Chapter 7.

Requirement Explanation

Reference manual? Oracle Net8 Administrators' Guide

Users must log off? Yes
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Follow the instructions in Configuring Non-Oracle Database Services: Configuring 
Net8 for External Procedures, Oracle Net9 Administrator's Guide and the Oracle9i 
Enterprise Edition Release Notes.

Step 5  Run preparatory scripts – node where the database is installed
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

We provide scripts that create objects required by the RDBMS and other technology 
stack components on the database server. Each script creates one or more spool files 
and places them in the directory you ran the scripts from. Check the spool file for 
errors after you run each script. 

1. Create $ORACLE_HOME/appsutil/admin on the database server.

2. Copy addb920.sql, adsy920.sql, adjv920.sql, admsc920.sql, and adgrants.sql 
(UNIX) from $APPL_TOP/admin to $ORACLE_HOME/appsutil/admin. Or, on a 
Windows platform, copy the Windows versions from %APPL_TOP%\admin to 
%ORACLE_HOME%\appsutil\admin.

3. Set the environment to point to ORACLE_HOME on the database server. 

4.  Run the preparatory scripts in the following order:

UNIX:

$ sqlplus /nolog
SQL> connect SYSTEM/<SYSTEM password>
SQL> @addb920.sql

$ sqlplus /nolog
SQL> connect SYSTEM/<SYSTEM password>
SQL> @adsy920.sql

Requirement Explanation

Reference manual? No

Users must log off? Yes

Script (UNIX) Script (Windows) Description

addb920.sql addb920_nt.sql Sets up database SYS schema.

adsy920.sql adsy920_nt.sql Sets up database SYSTEM schema.

adjv920.sql adjv920_nt.sql Sets up database JAVA-related components. Do not run 
this script if you have already migrated Jserver, and 
installed the Java Virtual Machine (JVM). Running this 
script when JVM objects already exist will corrupt the 
database.

admsc920.sql admsc920_nt.sql Sets up other database components.

adgrants.sql adgrants_nt.sql Grants necessary privileges on selected SYS objects.

Note: Access the database server directly. Do not attempt to run 
any of these scripts using Net Services. 

Note: The addb920.sql script may take a long time to run.
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$ sqlplus /nolog
SQL> connect SYSTEM/<SYSTEM password>
SQL> @adjv920.sql

$ sqlplus /nolog
SQL> connect SYSTEM/<SYSTEM password>
SQL> @admsc920.sql <Remove Context> <Default Tablespace> \
     <Temporary Tablespace> <Intermedia Shared Library>

$ sqlplus / nolog
SQL> connect / as sysdba
SQL> @adgrants.sql <APPLSYS>

Windows:

$ sqlplus /nolog
SQL> connect SYSTEM/<SYSTEM password>
SQL> @addb920_nt.sql

$ sqlplus /nolog
SQL> connect SYSTEM/<SYSTEM password>
SQL> @adsy920_nt.sql

$ sqlplus /nolog
SQL> connect SYSTEM/<SYSTEM password>
SQL> @adjv920_nt.sql

$ sqlplus /nolog
SQL> connect SYSTEM/<SYSTEM password>
SQL> @admsc920_nt.sql <Remove Context> <Default Tablespace> \
     <Temporary Tablespace> <Intermedia Shared Library>

$ sqlplus / nolog
SQL> connect / as sysdba
SQL> @adgrants_nt.sql <APPLSYS>

Note: Ignore any instructions to run adsysapp2.sql at this time. 
You will run this script in Step 7 (on the administration server).

Caution: Do not run adjv920.sql if you have migrated Jserver, and 
installed the Java Virtual Machine (JVM). Running this script when 
JVM objects already exist will corrupt the database.

Note: The addb920_nt.sql script may take a long time to run.

Note: Ignore any instructions to run adsysapp2.sql at this time. 
You will run this script in Step 7 (on the administration server).

Caution: Do not run adjv920_nt.sql if you have migrated Jserver, 
and installed the Java Virtual Machine (JVM). Running this script 
when JVM objects already exist will corrupt the database.



Database and System Administration

Category 3 — Performing the Upgrade 3-37

The arguments for admsc920.sql and admsc920_nt.sql are:

Step 6  Apply database patch
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Before you continue with the upgrade, apply patch 3835781 to update/create 
necessary OWS packages.

1. Create subdirectory $ORACLE_HOME/appsutil/admin/OWS

2. Download patch 3835781 to any patch directory and unzip it.

3. Copy the following files from the directory where you downloaded the patch to 
the subdirectory you created in Step 1: patch.sql, modplsql/owa/pubmat.sql, 
modplsql/owa/privmat.sql.

4. Set the environment to point to ORACLE_HOME on the database server.

5. From the directory $ORACLE_HOME/appsutil/admin/OWS, execute the 
following commands:

$ sqlplus / nolog
SQL> connect / as sysdba
SQL> @patch.sql

Argument Description

Remove ConText If there is an existing installation of Oracle ConText, remove it by 
setting this parameter to TRUE. Otherwise, accept the default value 
(FALSE).

Default Tablespace Default tablespace for the Oracle interMedia schema (CTXSYS is 
recommended). If the CTXSYS tablespace does not exist, create it. 
The size required is 10 MB.

Temporary Tablespace Temporary tablespace for the Oracle interMedia schema (TEMP is 
recommended).

Intermedia Shared 
Library

Full path name of the Oracle interMedia shared library: 
$ORACLE_HOME/ctx/lib/libctxx9.so (UNIX), or 
%ORACLE_HOME%\bin\oractxx9.dll (Windows).

Note: If you run this script inside SQL*Plus instead of from the 
SQL*Plus command line, enter the full path name for the 
interMedia Shared Library parameter. SQL*Plus does not evaluate 
the ORACLE_HOME variable when used with a parameter.

Additional Information: See Oracle interMedia, Audio, Image, and 
Video User’s Guide and Reference: Oracle9i Database Migration.

Requirement Explanation

Reference manual? No

Users must log off? Yes

Caution: Ignore the instructions in the patch readme file. They do 
not pertain to this application of patch 3835781.
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Step 7  Run preparatory script – administration node
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Run this script from the admin directory under the new APPL_TOP. Make sure you 
have permission to write to that directory.

sqlplus <SYSTEM username>/<SYSTEM password> @adsysapp2.sql <SYSTEM password>

Check the spool file for errors. Invalid packages in the database are acceptable. They 
are validated when you run AutoUpgrade.

Step 8  Gather database statistics for CBO
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

This release requires the Cost-based Optimizer (CBO). Use the FND_STATS package 
(patch 1268797 for pre-upgrade use only) to gather database statistics. 

Download the update file from OracleMetaLink and apply it using AutoPatch. Then, 
generate CBO statistics by running the following script from your old APPL_TOP:

For 10.7 UNIX users:

$ cd $FND_TOP/patchsc/107/sql
$ sqlplus <APPS username>/<APPS password> @afstatrn.sql FALSE

For 10.7 Windows users:

C:\> cd %FND_TOP%\patchsc\107\sql
C:\> sqlplus <APPS username>/<APPS password> @afstatrn.sql FALSE

For 11.0 UNIX users:

$ cd $FND_TOP/patch/110/sql
$ sqlplus <APPS username>/<APPS password> @afstatrn.sql FALSE

For 11.0 Windows users:

C:\> cd %FND_TOP%\patch\110\sql
C:\> sqlplus <APPS username>/<APPS password> @afstatrn.sql FALSE

Step 9  Gather database information 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? No

Users must log off? Yes

Requirement Explanation

Reference manual? Oracle9i Concepts

Users must log off? Yes

Additional Information: See Cost-based Optimization (CBO) in 
Overview and Requirements.

Requirement Explanation

Reference manual? Oracle9i Database Administrator’s Guide
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The adupinfo.sql script generates a file called adupinfo.lst, which contains information 
you will need later in the upgrade. Run adupinfo.sql from the new APPL_TOP.

UNIX:

$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @adupinfo.sql

Windows:

C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @adupinfo.sql

Step 10  Check SQL*Plus options 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

You should have set the SQL*Plus PAUSE option OFF and the NEWPAGE option to a 
value other than 0 (zero). Use the adupinfo.lst file you created in Step 9 to verify these 
values.

Step 11  Verify rollback segment sizing 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Use the segment sizing information in the adupinfo.lst file created in Step 9 to verify 
that rollback segments are large enough to handle upgrade data volume. Configure 
segments to avoid a "Snapshot too old" error, typically, 1 segment per worker with an 
extent size of 1 MB and a minimum segment size of 60 MB.

Step 12  Turn off automatic archive logging and Replication
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Users must log off? Yes

Additional Information: See Analyzing the Database in Oracle 
Applications Maintenance Procedures.

Requirement Explanation

Reference manual? No

Users must log off? No

Requirement Explanation

Reference manual? Oracle9i Database Administrator’s Guide

Users must log off? Yes

Additional Information: See Temporary tablespace in Overview 
and Requirements.

Requirement Explanation

Reference manual? Oracle9i Database Administrator’s Guide

Users must log off? Yes

Requirement Explanation
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If you have set up an automatic archive redo for log files or if you use Replication, 
perform the following tasks:

Turn off archive logging:

Run adstoplg.sql to turn off archive logging. This reduces the amount of disk space 
and shortens the time required by the upgrade. If you need to recover to an earlier 
point, it is faster to restore the database backup and rerun AutoUpgrade.

1. Copy adstoplg.sql from $APPL_TOP/admin/preupg (UNIX) or %APPL_
TOP%\admin\preupg (Windows) to the admin subdirectory you created in Step 
5.

2. Set the environment to point to the ORACLE_HOME on the database server.

3. Go to the admin subdirectory and run the script:

UNIX:

$ sqlplus /nolog 
SQL> connect / as sysdba
SQL> @adstoplg.sql

Windows:

C:\apps\admin> sqlplus /nolog
SQL> connect / as sysdba
SQL> @adstoplg.sql

Disable Replication:

Before you run AutoUpgrade, turn off Replication. Refer to Disabling the Replication 
Feature in Oracle9i Advanced Replication for more information.

Step 13  Disable custom triggers, constraints, and indexes
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Disable custom triggers or constraints on Oracle Applications tables. Re-enable these 
triggers in Step 6 of the Database Upgrade Tasks in Category 4. If you have custom 
indexes on Applications tables, determine whether they can affect performance during 
the upgrade, and drop them if necessary. If you aren’t sure, it is best to drop the 
indexes and add them after the upgrade, if the new release has not created a similar 
index.

Step 14  Install XML Parser for PL/SQL
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Install XML Parser for PL/SQL (plxmlparser_v1_0_2.zip) and XML SQL Utility in the 
database.

Requirement Explanation

Reference manual? Oracle9i Database Administrator’s Guide, Oracle Applications Concepts

Users must log off? Yes

Requirement Explanation

Reference manual? Oracle9i XML Application Developer’s Kit Guide – XDK

Users must log off? Yes
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1. Create an ORACLE_HOME/appsutil/admin directory and an ORACLE_
HOME/appsutil/admin/xmlparser directory on the node where you have 
installed the database, if they do not already exist.

2. Copy plxmlparser_v1_0_2.zip from COMMON_TOP/util to ORACLE_
HOME/appsutil/admin/xmlparser and unzip it. This file creates several 
subdirectories in the current location.

3. Copy XSU12_ver1_2_1.zip from COMMON_TOP/util to ORACLE_
HOME/appsutil/admin and unzip it. This file creates a single subdirectory 
(OracleXSU12) and places everything under that directory.

4. Follow the installation instructions in the readme file for each product 
(xmlparser/lib/README for the XML Parser for PL/SQL, and 
OracleXSU12/lib/README for the XML SQL Utility. 

5. Update XML Parser for Java version to ensure consistency between the application 
tier and the database.

If the database server and the Applications servers are on the same node, change 
to the location of the JAVA_TOP and run the loadjava command. If they are not on 
the same node, copy xmlparserv2.zip from $JAVA_TOP on any Applications 
server node to a temporary location on the node where the database server is 
installed. Load it into the APPS schema using the following syntax:

@ loadjava -user <APPS username>/<APPS password> -r -v xmlparserv2.zip

Install all packages in the APPS schema.

Step 15  Back up the database
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Make a cold backup of the Oracle Applications database. If you encounter problems 
during the upgrade process, you can use this backup to restore your system to the 
same state as before you began the upgrade.

Run AutoUpgrade
You have now completed all the tasks necessary to prepare your Oracle Applications 
products for an upgrade. The next step is to run AutoUpgrade. 

1. Set the environment as described in Chapter 1 of Oracle Applications Maintenance 
Utilities. Details about running AutoUpgrade are in Chapter 2 of the same book.

Note: Be sure the Unzip program is in the PATH. A copy for most 
operating systems is in COMMON_TOP/util/unzip.

Requirement Explanation

Reference manual? Oracle9i Backup and Recovery Concepts

Users must log off? Yes

Caution: Shut down the database with the NORMAL option. You 
may not be able to restore the database from the backup if you use 
the IMMEDIATE or ABORT option.
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2. Start AutoUpgrade from the command line. 

To continue to use the OFA-compliant (old) tablespace model:

$ adaimgr consolidated_tablespace=N

To use the (new) OATM tablespace model:

$ adaimgr
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4
Category 4 — Before Using Oracle

Applications

This chapter describes Category 4 steps — they affect the entire Oracle Applications 
system. The steps assume that you have already run AutoUpgrade as the last step in 
Category 3. All users must be logged off the system and should not attempt to use any Oracle 
Applications product until these steps are complete.

Update and Patching Tasks on page 4-1
Environment Preparation Tasks on page 4-4
Database Upgrade Tasks on page 4-5
Multiple Reporting Currencies (MRC) Tasks on page 4-8
System Administration Tasks on page 4-8
Oracle FlexBuilder/Account Generator Tasks on page 4-15
Oracle Financials for Asia/Pacific Tasks on page 4-17
Oracle Financials Common Country Tasks on page 4-19
Oracle Grants Accounting Tasks on page 4-20
Oracle Service Tasks on page 4-20

Updates
These Category 4 tasks direct you to apply certain updates and patches, including 
database drivers, product-related updates. All these tasks require AutoPatch. Some 
may also require other utilities.

Update and Patching Tasks
Perform the following tasks to bring your system to the full 11i release level.

Additional Information: See Patching Your System in Oracle 
Applications Maintenance Procedures.

Task List Status Responsibility

1. Download and apply latest AD minipack (US version) Required Database Administrator

2. Update database to current Applications release level Required Database Administrator

3. Disable maintenance mode Required Database Administrator

4. Install translated software Conditionally Required Database Administrator

5. Update installed and licensed products Required Database Administrator

6. Install online help Conditionally Required Database Administrator

7. Comment out Events settings Required Database Administrator
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Step 1  Download and apply latest AD minipack (US version) 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

You must apply the latest AD minipack (US version) to update your database. 
Download it from OracleMetaLink and follow the instructions in the readme.

Step 2  Update database to current Applications release level
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

To bring the database to the full Oracle Applications Release 11i maintenance level, 
apply the unified patch driver u3140000.drv (US version) on the node where the 
administration server is located. The patch driver is located in $AU_
TOP/patch/115/driver (UNIX) or %AU_TOP%\patch\115\driver (Windows). Apply 
the patch by running AutoPatch with the following commands:

$ adpatch options=nocopyportion,nogenerateportion

Applying this patch is potentially a long-running process. The unified driver patch 
speeds up the application of a patch by running all portions of the patch automatically. 
Adding options=nocopyportion,nogenerateportion to the start command tells 
AutoPatch to run only the database portion of the unified driver. 

Step 3  Disable maintenance mode
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

During the application of the maintenance pack driver, the new Maintenance Mode 
feature was enabled to allow for better performance when applying a patch. Before 
you can log on to your system, you must disable maintenance mode using AD 
Administration.

Maintenance mode must be enabled before you apply other patches to your system. 
See the information in About Oracle Applications DBA Minipack 11i.AD.I 
(OracleMetaLink Note ID: 233044.1) and in the section on Preparing your System for 
Patching in Chapter 5 of Oracle Applications Maintenance Utilities for more information 
on this new feature.

Requirement Explanation

Reference manual? No

Note: If your system uses translated software, do not apply the 
translated version of the AD minipack at this time. You will be 
instructed to apply the appropriate NLS patch in a subsequent step.

Requirement Explanation

Reference manual? Oracle Applications Maintenance Utilities

Requirement Explanation

Reference manual? Oracle Applications Maintenance Utilities

Additional Information: See Changing Maintenance Mode in 
Oracle Applications Maintenance Utilities.
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Step 4  Install translated software 
This task is Conditionally Required. It applies to upgrades from Release 10.7 or 11.0 
with one or more non-American English active languages.

If American English is the only active language in your system, omit this step.

For each non-American English language that is active in your system, you must do 
the following:

■ Obtain and apply the NLS version of the AD minipack you applied in Step 1. 

■ Install the NLS software to bring your translations up to the full maintenance pack 
level for this release. The Oracle Applications NLS Release Notes contain complete 
instructions for installing translations.

Step 5  Update installed and licensed products
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Determine the latest product-specific patches. Then, download the patches for all 
active languages (American English and, if applicable, NLS translated languages) 
present in your system. Using AD Merge Patch merge the American English patches. 
Then, merge the NLS translated patches (if any). Apply the American English patch 
first, then apply the NLS patch.

Step 6  Install online help
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

The Finishing your Upgrade chapter of this book contains instructions for installing 
online help. If you want to install online help now so that you can reference it for the 

Caution: It is important that you read and understand the 
information about using maintenance mode before you continue 
with the upgrade.

Requirement Explanation

Reference manual? Oracle Applications NLS Release Notes

TUMS Step Key: AD_INSTALL_NLS

Caution: You must complete the tasks in the NLS Release Notes 
before using your Applications products in a language other than 
American English.

Requirement Explanation

Reference manual? No

Additional Information: See AD Merge Patch in Oracle Applications 
Maintenance Utilities. See also Applying Multiple Patches to an NLS 
Installation in Oracle Applications Maintenance Procedures.

Requirement Explanation

Reference manual? No
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remaining upgrade steps, see Step 7 of the System Maintenance Tasks in Chapter 7. 
Before you make the decision about when to install help, note that this process may 
take a considerable amount of time.

Step 7  Comment out Events settings
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Follow the instructions in Database Initialization Parameters for Oracle Applications on 
OracleMetaLink (Doc ID: 216205.1) and reset init.ora parameters as needed.

Environment
All users must complete this portion of the upgrade. Complete these tasks before you 
perform the Database Upgrade, the Applications Technology, or the product-specific 
tasks.

Environment Preparation Tasks
Complete the following tasks to complete the environment upgrade.

Step 1  Run Rapid Install to configure and start server processes
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

As a pre-upgrade step, you ran Rapid Install to set up the technology stack and create 
the file system. Now, run Rapid Install to configure and restart the server processes. 
Go to Chapter 4 in Installing Oracle Applications and follow the instructions beginning 
with the Configuring and Starting Server Processes section. When instructed to do so, 
complete the remaining Category 4 steps as outlined here.

Step 2  Configure Applications client software for forms applet
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Note: Enabling maintenance mode before you install online help 
is optional. However, it may take noticeable longer to install help 
files than in previous releases.

Requirement Explanation

Reference manual? No

Task List Status Responsibility

1. Run Rapid Install to configure and start server 
processes

Required Database Administrator / System 
Administrator

2. Configure Applications client software for forms 
applet

Conditionally Required Database Administrator / System 
Administrator

3. Reapply customizations Conditionally Required Database Administrator / System 
Administrator

Requirement Explanation

Reference manual? Installing Oracle Applications
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You must configure the client software to use the Oracle forms applet before you 
continue. See Configure Client Software to Use the Forms Applet in Installing Oracle 
Applications for instructions.

Step 3  Reapply customizations
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you customized Applications environment files (APPLSYS.env or devenv), 
re-integrate them in devenv.env, or in the adovars.env file ($APPL_TOP/admin for 
UNIX or %APPL_TOP%\admin for Windows). Restart the application server 
processes so that the changes take affect.

If your system includes customized forms, reports, programs, libraries, or other 
Applications files, reapply the changes that apply to the new release.

Database
All users must complete this portion of the upgrade. Complete these tasks before you 
perform the Applications Technology steps or the product-specific steps.

Database Upgrade Tasks
Complete the following steps to complete your database upgrade.

Step 1  Reset ORACLE schema passwords 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? No

Additional Information: See Complete Guide to JInitiator for Oracle’s 
E-Business Suite: Overview, Setup & Troubleshooting (OracleMetaLink 
Doc ID: 162488.1). See also Upgrading the JInitiator Version used with 
Oracle Applications 11i (OracleMetaLink Doc ID: 232200.1).

Requirement Explanation

Reference manual? No

Additional Information: See Managing Server Processes in 
Chapter 1 of Oracle Applications Maintenance Procedures.

Task List Status Responsibility

1. Reset ORACLE schema passwords Recommended Database Administrator / System Administrator

2. Gather database statistics for CBO Required Database Administrator / System Administrator

3. Set rollback segments for normal use Required Database Administrator

4. Validate and compile APPS schema Required Database Administrator / System Administrator

5. Integrate custom objects and schemas Conditionally Required Database Administrator / System Administrator

6. Re-enable custom triggers, constraints, 
and indexes

Conditionally Required Database Administrator / System Administrator

7. Back up Oracle Applications Recommended Database Administrator / System Administrator
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During the upgrade, Rapid Install preserves the passwords that you set previously for 
existing products. However, as it creates a schema for each new product installed, it 
sets up a default password derived from the product abbreviation (short name). To 
maintain product security, reset these default passwords now. Use the Oracle Users 
window from the System Administrator responsibility.

Step 2  Gather database statistics for CBO 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Use the Gather Schema Statistics concurrent program (System Administration > 
Submit Request) to gather database statistics. If the schema name is ALL, then all 
Applications-specific schema statistics (having an entry in the FND_PRODUCT_
INSTALLATIONS table) are gathered. In addition to gathering index and table-level 
statistics, the program gathers column-level histogram statistics for all columns listed 
in the FND_HISTOGRAM_COLS table. This program is potentially long-running.

Because it is important to have an up-to-date set, gather database statistics periodically 
to make sure the database queries are optimized.

Step 3  Set rollback segments for normal use
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Set the rollback segments for normal operation, typically, 1 for each 25 users, plus 1 for 
each concurrent manager. Make the extent size 1 MB, and the minimum segment size 
60 MB.

You also have the option of using the new Undo Management feature instead of 
rollback segments. For more information on setting Undo Management, see "Enabling 
System Managed Undo (SMU)" in the Oracle9i documentation set.

Step 4  Validate and compile APPS schema
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Security

Additional Information: See Oracle Applications Schema 
Password Change Utility in the Oracle Applications System 
Administrator’s Guide - Security.

Requirement Explanation

Reference manual? No

Concurrent Manager? Yes

Additional Information: See Cost-based Optimization in Oracle 
Applications in Oracle Applications System Administrator’s Guide - 
Configuration. See also Cost-based Optimization in Oracle 
Applications Concepts and Introduction to Optimization in Oracle9i 
Concepts.

Requirement Explanation

Reference manual? Oracle9i Database Administrator’s Guide
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Before you continue with the upgrade, fix invalid objects in the database.

1. Create list of invalid objects.

From the AD Administration main menu, select the Maintain Applications 
Database Objects menu. Run the "Validate APPS schema" task. Review the output 
and take corrective action as indicated in the report.

2. Compile objects in APPS schema.

From the Maintain Applications Database Objects menu, run the "Compile APPS 
schema" option to compile all the invalid objects in the APPS schema.

3. Re-generate list of invalid objects. Re-compile the invalid objects until the list 
contains only those that are considered acceptable. See the latest version of the 
Oracle Applications Release Notes for a list of acceptable invalid objects for this 
release.

Step 5  Integrate custom objects and schemas
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you previously created custom objects or have custom schemas that must be tightly 
integrated with Oracle Applications, follow the steps in Oracle Applications Developer’s 
Guide to re-integrate these customizations with the APPS schema.

Release 11i uses Invoker Rights for most PL/SQL packages. Executing these packages 
from custom schemas may require additional grants from, and synonyms to, APPS 
schema objects. We recommend you explicitly declare Invoker Rights or Definer Rights 
for custom PL/SQL packages. See the PL/SQL User’s Guide and Reference for more 
information. 

Custom database objects must follow the naming standards for custom object names 
to avoid conflict with Oracle Applications.

Step 6  Re-enable custom triggers, constraints, and indexes
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? Oracle Applications Maintenance Utilities

Additional Information: See AD Administration in Oracle 
Applications Maintenance Utilities.

Requirement Explanation

Reference manual? Oracle Applications Developer’s Guide

Caution: When naming database objects, use XX as a part of the 
short name. For example, you might define the custom application 
to use the short name XXGL, and database objects to begin with an 
XXGL_ prefix.

Additional Information: See Defining your Custom Applications 
in Oracle Applications Developer’s Guide.
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During the upgrade, custom triggers or constraints may have been modified. If you 
disabled these triggers and constraints in Step 13 of the Database Upgrade Tasks in 
Chapter 3, identify any data updates that must be made before you re-enable them. 

If you dropped any custom indexes in the same step, review the new data model to 
determine if the index is necessary before you redefine it.

Step 7  Back up Oracle Applications 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Have the system administrator back up the Oracle Applications product files. On a 
server or stand-alone machine, have the database administrator back up the Oracle 
Applications database.

Multiple Reporting Currencies (MRC) Tasks
Multiple Reporting Currencies has been incorporated into the APPS schema so the 
APPS_MRC schema is no longer required. This change, which is transparent to 
end-users, improves processing efficiency and reduces maintenance. Patches need be 
applied only once (in the APPS schema), making it unnecessary to synchronize objects 
between schemas.

The APPS schema is used for standard reports, inquiries, and programs for MRC 
currency data in MRC-enabled products. MRC data that retrieves custom code may 
need to be converted to use the database objects in the APPS schema.   

Applications Technology
All users must complete this portion of the upgrade. Complete these tasks before you 
perform the product-specific steps. 

System Administration Tasks
Complete the following System Administration tasks.

Requirement Explanation

Reference manual? Oracle Applications Developer’s Guide; Oracle9i Database Administrator’s Guide

Requirement Explanation

Reference manual? Oracle Applications Concepts; Oracle8i Backup and Recovery Guide

Note: You can drop the APPS_MRC schema. See Drop MRC 
schema in Chapter 7. For more information on MRC, see Multiple 
Reporting Currencies in Oracle Applications.

Task List Status Responsibility

1. Configure Java-based Workflow Notification Mailer Required System Administrator

2. Fix flexfields cross-validation rules Required Technical Specialist

3. Set profile options Required System Administrator

4. Convert flexfield Date and DateTime value sets Recommended Technical Specialist

5. Upgrade flexfield date and number data Required Technical Specialist
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Step 1  Configure Java-based Workflow Notification Mailer 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

If you use the Oracle Workflow Notification Mailer to send and receive e-mail 
notification messages, and you have not already upgraded to the new Java-based 
Workflow Notification Mailer, you must do so now. The previous C-based Notification 
Mailer concurrent program and Generic Service Management Notification Mailer are 
obsolete.

You configure the Java-based Workflow Notification Mailer through the notification 
mailer configuration wizard in Oracle Applications Manager. You run it using the 
Generic Service Management (GSM) feature of Oracle Applications concurrent 
processing. For more information, refer to Implementing Notification Mailers, Oracle 
Workflow Administrator's Guide, and to the Oracle Applications Manager online help.

Step 2  Fix flexfields cross-validation rules 
This task is Required. It applies to Release 10.7 upgrades.

To list flexfield cross-validation rules that have no lines and fix any invalid data, run 
the following script. It prompts as follows:

■ List all bad rule lines? (yes or no)

Type Yes to list the invalid lines without fixing the data. 

■ Delete all bad rule lines? (yes or no)

Type Yes to fix the invalid data. 

UNIX:
$ cd $FND_TOP/sql
$ sqlplus <APPS username>/<APPS password> @affixcvr.sql

Windows:
C:\> cd %FND_TOP%\sql

6. Set up electronic mail for concurrent managers Required System Administrator

7. Reconnect spawned concurrent programs Conditionally Required Technical Specialist

8. Update/verify custom responsibilities Conditionally Required System Administrator

9. Copy and re-customize previously modified scripts or 
reports

Conditionally Required Technical Specialist

10. Migrate the CUSTOM library Recommended System Administrator

11. Copy existing custom start scripts Conditionally Required System Administrator

12. Restrict access to concurrent processing servers Required System Administrator

13. Load attachment files into database Conditionally Required System Administrator

Requirement Explanation

Reference manual? Oracle Workflow Administrator’s Guide

Requirement Explanation

Reference manual? No

Task List Status Responsibility
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C:\> sqlplus <APPS username>/<APPS password> @affixcvr.sql

Step 3  Set profile options 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

To see instructions for setting profile options and a list of required options, refer to the 
product-specific implementation documentation and OracleMetaLink.

Step 4  Convert flexfield Date and DateTime value sets     
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Convert flexfield segments or report parameters that use the format type Date or 
DateTime to use the format type Standard Date or Standard DateTime. Use the 
Flexfields List Date or DateTime Set Usages concurrent program to view a list of the 
value set usages.

Review value set usages:
Log in as the system administrator and choose Requests > Run. Run the Flexfields List 
Date or DateTime Set Usages concurrent program, and review the log file. Old-type 
value set usages that are seeded value sets can be replaced by seeded standard date 
value sets. If you have used custom value sets or pre-seeded standard value sets, use 
the clone feature.

Clone value sets:
If you have custom value sets, run the following concurrent program:

1. As the system administrator, choose Requests > Run. Run the Flexfields Clone a 
Date, or DateTime Value Set as Standard Date, or Standard DateTime Value Set 
program.

2. Enter old value set name as a parameter. The new value set name defaults to 
<old>_STANDARD.

3. Continue until all custom value sets are cloned.

Requirement Explanation

Reference manual? Product-specific implementation manuals; Oracle Applications System 
Administrator’s Guide - Maintenance

Additional Information: See Profile Options in Oracle Application 
Object Library in Oracle Applications System Administrator’s Guide - 
Maintenance.

Requirement Explanation

Reference manual? No

Note: Attributes of the value sets, such as independent and 
dependent values or hierarchy information, are not copied to the 
new value set.
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Replace old-type value set usages:
If you find old-type value sets, locate the flexfield segments and report parameters that 
use them, and update them to use the new ones. As the system administrator, you can 
update the following value sets:

■ For key flexfield segments, choose Application > Flexfield > Key > Segments.

■ For descriptive flexfield segments, choose Application > Flexfield > Descriptive > 
Segments.

■ For report parameters, choose Concurrent > Program > Define.

Step 5  Upgrade flexfield date and number data
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

To support multiple formats, all flexfield date and number data is stored in a canonical 
form. To upgrade the transaction data in the date and number value sets to reflect this 
canonical form, you can use the following concurrent programs:

■ Flexfields Upgrade All Standard Date and Standard DateTime Value Sets

■ Flexfields Upgrade One Standard Date and Standard DateTime Value Set

■ Flexfields Upgrade All Number Value Sets

■ Flexfields Upgrade One Number Value Set

Run the All Standard and All Number value sets programs now:

1. As the system administrator, choose Requests > Run.

2. Run both the Flexfields Upgrade All Standard Date and Standard DateTime Value 
Sets and the Flexfields Upgrade All Number Value Sets concurrent programs.

At any time in the future, you can upgrade a single value set. Choose the Flexfields 
Upgrade One Standard Date and Standard DateTime Value Set or the Flexfields 
Upgrade One Number Value Set. Supply the name of the value set when prompted.

Step 6  Set up electronic mail for concurrent managers
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

The concurrent managers send mail to the applmgr user if the Internal concurrent 
manager stops running. Set up the electronic mail for the applmgr user. The log file for 
the Internal concurrent manager shows an error if mail is not set up correctly.

Step 7  Reconnect spawned concurrent programs
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Additional Information: See Oracle Applications Flexfields Guide.

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Maintenance

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Configuration
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If you have developed shell script concurrent programs (that use the Host execution 
method), reconnect the programs to the concurrent manager interface. Copy the 
concurrent programs from the old PROD_TOP to the new one. Change the working 
directory to the directory that contains the concurrent program executable. Then, 
reconnect the concurrent program as follows: 

UNIX:
$ cd $<PROD>_TOP/bin 
$ ln -s $FND_TOP/bin/fndcpesr <program>

Windows:
C:\> cd %<PROD>_TOP%\bin
C:\> copy %FND_TOP%\bin\fndcpesr.exe <program>.exe 

Parameter descriptions are as follows:

■ <PROD> is the custom application product short name.

■ <program> is the name you used to define the concurrent program executable in 
Oracle Applications (without any filename extension).

Step 8  Update/verify custom responsibilities
This task is Conditionally Required. It applies to Release 10.7SC or 10.7NCA 
upgrades.

Verify that all custom responsibilities use the correct menu. From the System 
Administrator responsibility, navigate to Security > Responsibilities. Query each 
custom responsibility and update as necessary.

Step 9  Copy and re-customize previously modified scripts or reports 
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Copy custom shell scripts or reports that are part of Oracle Applications to the custom 
application directories and re-customize the copy as necessary.

Requirement Explanation

Reference manual? Oracle Application Object Library/Workflow Technical Reference Manual

Additional Information: See Implementing Concurrent Processing 
and Concurrent Processing and Product Customizations Standards 
in Oracle Application Object Library/Workflow Technical Reference 
Manual.

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Security

Requirement Explanation

Reference manual? Oracle Applications Developer’s Guide

Additional Information: See Product Customization Standards in 
Oracle Applications Developer’s Guide.
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Step 10  Migrate the CUSTOM library 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Before you copy custom code in the CUSTOM library to the new directory structure, 
refer to the backup you created in Step 2 of the System Administration Tasks in 
Category 1 and verify that the customizations are valid for the new version of Oracle 
Applications.

For valid customizations, place a copy of the new CUSTOM library (CUSTOM.pll) in a 
safe place. It is located under the new APPL_TOP in $AU_TOP/resource (UNIX), or 
%AU_TOP%\resource (Windows). Then, make a copy of the old Oracle Forms 
4.5-based CUSTOM library and place it in the new directory. Upgrade to Oracle Forms 
Developer6i by regenerating the library. Or, you can cut and paste the existing custom 
code into the new library, and then regenerate it.

Step 11  Copy existing custom start scripts 
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you have customized the concurrent manager startup script (startmgr), copy the 
script from the old environment to the new environment. Then, verify that the 
customizations are valid for the new environment.

Step 12  Restrict access to concurrent processing servers
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

You view log and output files on the desktop client using the Report Review Agent 
and the Web Report Review tools. So, it is not necessary to have direct access to the 
concurrent processing servers to view these files. 

To ensure the security of Oracle Applications log and output files, limit user access to 
the concurrent processing servers. If users must have direct access to the concurrent 
processing servers for other reasons, follow the steps in this section to restrict access to 
the log and output directories.

1. Create a UNIX Edition group for directory users.

Requirement Explanation

Reference manual? Oracle Applications Developer’s Guide

Additional Information: See Using the CUSTOM Library in Oracle 
Applications Developer’s Guide.

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Configuration

Note: The default location in UNIX for the startmgr script is 
$FND_TOP/bin. For more information, see Oracle Applications 
System Administrator’s Guide - Configuration.

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Configuration
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Create a UNIX Edition group consisting of applmgr and the users who need access 
to the directory. For example, you might create the group glusers for all users of 
Oracle General Ledger. Groups are defined in the group file of the /etc directory.

2. Change directory file protection.

From the applmgr account, change the file protection of a directory so that it has 
no global privileges:

$ chmod 770 <directory>

In the following example, the r and x shown in the system response indicate that 
there are global read and execute privileges for the directory:

$ cd $GL_TOP
$ ls -ldg out
drwxrwxr-x  2 applmgr  misappl   29423  Jan 12 10:27 out/
       ^ ^
After the directory privilege is changed, the system response lists three dashes for 
global privileges, indicating that all global privileges have been revoked:

$ chmod 770 out
$ ls -ldg out
drwxrwx---  2 applmgr  misappl   29423  Jan 12 10:27 out/
       ^ ^

3. Change directory group.

Change a directory’s group to the new UNIX Edition group:

$ chgrp <group> <directory>

Here is an example:

$ chgrp glusers out
$ ls -ldg out
drwxrwx---  2 applmgr  glusers   29423  Jan 12 10:27 out/

The system response indicates that the group has been changed from misappl to 
glusers.

4. Alter file privilege for concurrent manager files (optional).

The operating system user that starts the concurrent managers (applmgr) owns all 
log and output files created by the managers. Oracle Applications uses the UNIX 
command umask to remove write privilege to these files from all users except the 
owner. You can change privileges by changing the value of umask.

The startmgr script uses the umask value set by the environment variable 
$APPLMSK in fndenv. To change this value, modify $APPLMSK. For higher 
security, override the value of $APPLMSK in startmgr. If you are setting up 
parallel concurrent processing, do the same for dcpbatch. 

To modify the umask value in startmgr or dcpbatch, change to $FND_TOP/bin and 
display the script with the file editor of your choice. Find the following line:

umask ${APPLMSK-”022”}

This line indicates that if $APPLMSK is not set, the umask command uses the value 
022. Modify the alternate value by substituting a new one. For example: 

umask ${APPLMSK-”026”}

Use a 3-digit value as an argument to override $APPLMSK. For example: 
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umask 022

If you change umask values, remember to give the owner of a file read and write 
privilege.

5. Restrict access to scripts (optional).

To enhance security, give only the applmgr login write permission for startmgr 
and batchmgr. If you are using parallel concurrent processing, do the same for 
dcpstart and dcpbatch. Also change the restrictions on any custom scripts that call 
these files. The following commands prevent all users (except applmgr) from 
altering the scripts: 

$ cd $FND_TOP/bin 
$ chmod 700 startmgr batchmgr dcpstart dcpbatch

Step 13  Load attachment files into database
This task is Conditionally Required. It applies to Release 10.7NCA or 11.0 upgrades.

In Step 1 of the System Administration Tasks in Category 1, you determined the 
location of any existing attachment files. In this step, you load them into the database.

1. In the operating system on the application server, change to the directory you 
created in Category 1, Step 1. 

2. Type the following command on one line with a space between FND_ATTACH 
and PLS_CALLBACK, where <DB Connect String> is the 
username/password@Oracle SID of the APPS account (for example 
apps/apps@TEST) and * is a wildcard indicating that all files in the directory 
should be uploaded to the attachments tables in the database:

FNDGFU <DB Connect String> 0 Y UPLOAD PROGRAM_NAME=FND_ATTACH \
PLS_CALLBACK=FND_ATTACHMENT_UTIL_PKG.UPDATE_FILE_METADATA * 

3. Check the log file produced by FNDGFU (located in the same directory with the 
file name L<concurrent request ID>.log). Correct errors listed in the file. 

Oracle FlexBuilder/Account Generator Tasks
Complete the following FlexBuilder/Account Generator tasks.

Note: The UNIX man page for umask contains more information 
on the command and settings.

Requirement Explanation

Reference manual? No

Concurrent Manager? Yes

Task List Status Responsibility

1. Complete installation steps for Oracle Workflow Required System Administrator

2. Complete installation steps for Oracle Workflow 
Builder

Conditionally Required System Administrator

3. Update Account Generator process Conditionally Required Application Specialist / System 
Administrator
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Step 1  Complete installation steps for Oracle Workflow
This task is Required. It applies to Release 10.7 upgrades.

Oracle Workflow is installed by AutoUpgrade. See the Oracle Workflow Administrator’s 
Guide for manual setup steps required to complete the installation.

Step 2  Complete installation steps for Oracle Workflow Builder
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Oracle Workflow Builder (client-side) is installed using Oracle Installer. If you are 
customizing the default Account Generator process, see the Client Installation Notes on 
the Oracle Workflow Client CD.

Step 3  Update Account Generator process
This task is Conditionally Required. It applies to Release 10.7 upgrades.

If you customized the default Account Generator process, but did not change its name, 
omit this step. 

If you customized the Account Generator process for a particular Workflow Account 
Generator item type and assigned it a new name, upgrade the Account Generator. The 
following table shows the Account Generator item types and default processes that 
you can view and modify using Oracle Workflow.

The <product name> Account Generator sections in individual product user’s guides 
contain details.

4. Associate FlexBuilder rules for Accounting Flexfield 
structure and Workflow item type

Conditionally Required Application Specialist / System 
Administrator

Requirement Explanation

Reference manual? Oracle Workflow Administrator’s Guide

Requirement Explanation

Reference manual? Oracle Workflow Client Installation Notes

Requirement Explanation

Reference manual? Oracle Flexfields Guide

Product Item Type Default Process Name

Oracle Assets FA Account Generator Generate Default Account

Oracle Order Entry Generate Cost of Goods Sold Account Generate Default Account

Oracle Projects Project Expense Report Account 
Generator

Default Account Generator for 
Expense Reports

Oracle Projects Project Supplier Invoice Account 
Generator

Generate Default Account

Oracle Purchasing PO Account Generator Generate Default Accounts

Oracle Purchasing PO Requisition Account Generator Generate Default Accounts

Oracle Receivables AR Substitute Balancing Segment Replace Balancing Segment

Task List Status Responsibility
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There are three ways to upgrade the Account Generator. 

1. Do nothing. If they meet your accounting requirements, you can use the Account 
Generator default processes provided by each product that previously used 
FlexBuilder.

2. Associate FlexBuilder process to use customized FlexBuilder rules. If you used 
FlexBuilder in Release 10.7, and want to continue using the existing FlexBuilder 
customizations, migrate those business rules into the Account Generator. 

3. Develop a new default Account Generator process by creating a new process or 
copying the existing default and changing the name. Use the renamed process as a 
base for the changes.

Step 4  Associate FlexBuilder rules for Accounting Flexfield structure and 
Workflow item type
This task is Conditionally Required. It applies to Release 10.7 upgrades.

If your system uses customized flexfields, use the Account Generator Processes 
window to associate the Generate Account Using FlexBuilder Rules process with the 
appropriate Accounting Flexfield structure and Workflow item type.

Financials
Review this section and complete only the tasks for the Oracle Financials products you 
have installed.

Oracle Financials for Asia/Pacific Tasks
Complete the following Financials for Asia/Pacific tasks.

Step 1  Modify truncated lookup codes or renamed meanings in custom modules 
This task is Conditionally Required. It applies to Release 10SC Production 16.1 (or 
higher) or 11.0 upgrades.

Additional Information: See Account Generator in <product 
name>) in Oracle Assets User’s Guide, Oracle Order Entry/Shipping 
User’s Guide, Oracle Projects User’s Guide, Oracle Purchasing User’s 
Guide, and Oracle Receivables User’s Guide.

Additional Information:: See Customizing the Account Generator 
in Oracle Applications Flexfields Guide.

Requirement Explanation

Reference manual? Oracle Flexfields Guide

Additional Information: See Choosing the Process for a Flexfield 
Structure in Oracle Applications Flexfields Guide.

Task List Status Country/Responsibility

1. Modify truncated lookup codes or renamed meanings 
in custom modules

Conditionally Required All/System Administrator

2. Move customer uniform numbers and tax registration 
numbers

Recommended Taiwan/System Administrator
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After reviewing the results of the migration and the report you created in Step 1 of the 
Oracle Financials for Asia/Pacific Tasks in Category 2, you may need to modify 
migrated lookups and custom modules if they reference truncated lookup codes or 
renamed lookup meanings.

During the upgrade, the original JA lookup tables (JA_LOOKUP_TYPES and JA_
LOOKUPS) are renamed to JA_LOOKUP_TYPES_OLD and JA_LOOKUPS_OLD, 
respectively. Views with the original table names are created instead. These views are 
based on FND lookup tables to which JA lookups are migrated. The upgrade does not 
remove these _OLD tables. You can use them as a reference if you need to manually 
change the migrated lookups or customized modules.

If your customized modules reference obsolete lookups, you may need to manually 
migrate the obsolete lookups from the _OLD tables. (Release 11i Oracle Applications 
generic modules do not reference obsolete lookups.)

Step 2  Move customer uniform numbers and tax registration numbers
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades (Taiwan).

In Release 10.7 and 11.0, customer uniform numbers (taxpayer IDs) were stored in the 
Tax Registration Number field in the Customers window. In 11i, the Customers 
window has both a Taxpayer ID and a Tax Registration Number field. Use 
jatwupg4.sql to move the customer uniform number to the Taxpayer ID field, and 
jatwupg3.sql to record existing customer uniform numbers and tax registration 
numbers so you can redefine the numbers after the upgrade.

Record customer uniform numbers and tax registration numbers:
Run jatwupg3.sql by typing:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @jatwupg3.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jatwupg3.sql

Review the output in jatwupg3.lst and keep the file for your records.

Requirement Explanation

Reference manual? Oracle Applications Developer’s Guide

TUMS Step Key? JA_MODIFY_LOOKUPS

Additional Information: See Oracle Financials for Asia/Pacific in 
Oracle Applications Product Update Notes.

Requirement Explanation

Reference manual? No

Users must log off? No

TUMS Step Key? JA_MOVE_CUSTOMER_UNIFORM_NUM
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Move customer uniform numbers:
Run this script to move customer uniform numbers (taxpayer IDs) in the Tax 
Registration Number field to the Taxpayer ID field:

UNIX:
$ cd $APPL_TOP/admin/preupg
$ sqlplus <APPS username>/<APPS password> @jatwupg4.sql

Windows:
C:\> cd %APPL_TOP%\admin\preupg
C:\> sqlplus <APPS username>/<APPS password> @jatwupg4.sql

Review the jatwupg4.log file after the script finishes.

The jatwupg4.sql script overwrites the Taxpayer ID field in the Release 11i Customers 
window with data from the Release 10.7 or 11 Tax Registration Number field and 
makes the Tax Registration Number field blank.

Oracle Financials Common Country Tasks
Complete the following Financials Common Country tasks.

Step 1  Upgrade descriptive flexfield dates to use the new AOL date validation
This task is Conditionally Required. It applies to Release 10.7 upgrades.

The validation for date fields within globalization flexfields was changed so that you 
can correctly store and retrieve date information in globalization flexfield attribute 
columns, regardless of the language that was used when dates were entered. To 
upgrade date values in the flexfield columns:

UNIX:
$ cd $JG_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @jgzzupgd.sql

Windows:
C:\> cd %JG_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @jgzzupgd.sql

Caution: Do not run this script if you want to keep the existing 
data in the Taxpayer ID and Tax Registration Number fields. Do not 
run this script if multiple countries share the database, as it updates 
all customer taxpayer ID information regardless of whether the 
information is entered in a Taiwanese responsibility.

Task List Status Country/Responsibility

1. Upgrade descriptive flexfield dates to use the new AOL 
date validation

Conditionally Required All/Database Administrator, 
IS Manager

Requirement Explanation

Reference manual? No

TUMS Step Key?  JG_UPDATE_DFF_AOL_DATE_VALIDATION
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Because the language that you use determines the way dates are entered, run this 
script once for each language that is installed.

Projects
Review this section and complete only the tasks for the Oracle Projects products you 
have installed.

Oracle Grants Accounting Tasks
Complete the following Oracle Grants Accounting tasks.

Step 1  Run migration driver   
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Before you run the migration driver, verify and set values for the following profile 
options:

number of parallel threads (default = 10)
number of awards processed per commit (default = 500)
update open/close awards (default = All)

Apply the data migration driver (gmsup115.drv) using AutoPatch. It is located in 
$GMS_TOP/patch/115/driver (UNIX) or %GMS_TOP%\patch\115\driver 
(Windows). Refer to gmsup115.txt in the readme directory for more information. 
Review gms_upgrade_billing_verification.out and gms_upgrade_balances_
verification.out in the out directory.

Service
Review this section and complete only the tasks for the Oracle Service products you 
have installed.

Oracle Service Tasks
Perform the following tasks for Oracle Service.

Step 1  Migrate calendar dates
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Task List Status Responsibility

1. Run migration driver Required Database Administrator/Applications Specialist (Grants)

Requirement Explanation

Reference manual? No

Concurrent Manager Yes

TUMS Step Key?  GMS_RUN_MIGRATE_DRIVER

Task List Status Responsibility

1. Migrate calendar dates Required Technical Specialist
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To use calendar views effectively, migrate calendar dates by performing the following 
steps:

1. Set the Task Manager:JTF Tasks Default Date Selected profile option to Planned, 
Scheduled or Actual.

2. Run the jtftkmts.sql script to populate the CALENDAR_START_DATE, 
CALENDAR_END_DATE, and DATE_SELECTED fields.

$ cd $APPL_TOP/admin/out
$ sqlplus <APPS username>/<APPS password>
@JTF_TOP/patch/115/sql/jtftkmts.sql

Requirement Explanation

Reference manual? No

Users must log off? No
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5
Category 5 — Before Using Your Products

This chapter describes Category 5 steps — they affect only specific products, making 
them unavailable until the steps are complete.

Implementation and Setup Tasks on page 5-1
Oracle General Ledger Tasks on page 5-2
Global Accounting Engine Tasks on page 5-4
Oracle Payables Tasks on page 5-6
Oracle Receivables Tasks on page 5-8
Oracle Financials Common Country Tasks on page 5-14
Oracle Financials for Asia/Pacific Tasks on page 5-15
Oracle Financials for Europe Tasks on page 5-15
Oracle Financials for Latin America Tasks on page 5-16
Oracle Projects Tasks on page 5-23
Oracle Grants Accounting Tasks on page 5-32
Oracle Payroll Tasks on page 5-33
Oracle Time and Labor Tasks on page 5-35
Oracle Learning Management Tasks on page 5-36
Oracle Labor Distribution Tasks on page 5-35
Oracle Cost Management Tasks on page 5-36
Oracle MRP/Supply Chain Planning Tasks on page 5-37
Oracle Inventory Tasks on page 5-38
Oracle Order Management Tasks on page 5-39
Oracle Purchasing Tasks on page 5-44
Oracle Public Sector Financials Tasks on page 5-49
Oracle U.S. Federal Financials Tasks on page 5-50
Oracle Sales/Oracle Sales Compensation Tasks on page 5-50
Oracle Service Tasks on page 5-52
Oracle Install Base Tasks on page 5-53

All Products
Product-specific implementation or setup steps are an integral part of the upgrade. 
These steps may be needed to "turn on" new functionality added during the upgrade 
process or set up new product features. 

Implementation and Setup Tasks
Complete all implementation and setup steps to ensure the success of your system 
upgrade.
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Step 1  Review product-specific documentation 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Before you begin the Category 5 steps, review the product-specific documentation and 
associated OracleMetaLink notes for the products you have installed to see if there are 
any implementation or setup steps that must be performed to "turn on" or implement 
new features of products that were added during the upgrade process.

1. Determine which products you have installed.

2. Make sure you have the product documentation for each product.

3. Review the implementation and/or setup information in the product guides.

4. Perform these steps as appropriate for your system.

Financials
Review this section and complete only the tasks for the Oracle Financials products you 
have installed.

Oracle General Ledger Tasks
Perform the following Oracle General Ledger tasks.

Step 1  Migrate conflicting daily rates 
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Perform this step if you:

■ maintain daily rates for more than one set of books in the same Release 10.7 
Applications installation. 

■ want to retain descriptive flexfield information associated with daily rates. 

Task List Status Responsibility

1. Review product-specific documentation Required Application Specialists

Requirement Explanation

Reference manual? Product-specific user’s guides

Do before using? All Oracle products

Task List Status Responsibility

1. Migrate conflicting daily rates Conditionally Required Database Administrator/Application Specialist (GL)

Requirement Explanation

Reference manual? Oracle General Ledger User’s Guide

Do before using? Oracle General Ledger

TUMS Step Key? GL_MIGRATE_CONFLICTING_DAILY_RATES
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To migrate conflicting daily rates:
1. Run the Daily Rates Conflict report:

UNIX:

$ cd $GL_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @glurtrpt.sql

Windows:

C:\> cd %GL_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @glurtrpt.sql

2. Review the report. If no daily rates conflicts exist, and you do not want to retain 
any descriptive flexfields associated with the daily rates, no further action is 
required.

3. If conflicting rates exist, or if you want to retain descriptive flexfields, run the 
following script to migrate the rates:

UNIX:

$ cd $GL_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @glurtmrt.sql

Windows:

C:\> cd %GL_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @glurtmrt.sql

The script requires the following parameters:

Note: Even though users should not log on before you complete 
this step, the person performing the upgrade can log on to check 
the upgrade success or failure, examine upgraded daily rates, or 
define new conversion types.

For this parameter... Enter the following...

Set of Books Name the name of the set of books from which you want to transfer 
rates.

From Conversion Type the conversion type of the rates to be transferred.

From Currency the From currency of the rates to be transferred. Or, enter ALL to 
transfer rates for all From currencies.

From Date the starting date (DD-MON-YYYY) in the range of dates for 
which daily rates should be transferred. Or, enter ALL to 
transfer rates starting with the earliest date for which daily rates 
are defined. 

To Date the ending date (DD-MON-YYYY) in the range of dates for 
which daily rates should be transferred. Or, enter ALL to 
transfer all rates starting with the From Date up to and including 
the most recent date for which daily rates are defined. 

Destination Conversion 
Type

the conversion type to assign to the rate after it has been 
transferred. This conversion type must already exist in your 
system.

Override Flag Y if you want to replace rates that already exist in the rate set; N 
if you only want to add new rates to the rate set.
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4. To retain descriptive flexfield information for daily rates, use the Descriptive 
Flexfield Segments window to redefine the flexfields used in Release 10.7.

Global Accounting Engine Tasks
Perform the following Global Accounting Engine tasks.

Step 1  Perform Multiple Reporting Currencies tasks
This task is Conditionally Required. It applies to Release 11.0 upgrades.

If you are using Multiple Reporting Currencies in Payables or Receivables, you must 
complete the associated MRC steps for each of these products before you continue 
with the remaining Global Accounting tasks in this section. These actions are required 
to ensure data integrity. 

The associated steps are in this chapter. For Payables, complete the instructions in 
Payables, Step 3 on page 5-7. For Receivables, complete the instructions in Receivables 
Step 5 on page 5-14.

Step 2  Migrate existing date and non-integer data
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Use the scripts in this step to migrate date and non-integer data (that was previously 
stored in character columns) to the date and number columns. Before you run the 
scripts:

Note: Do not use leading or trailing spaces when entering these 
parameters. Also note that the parameters are case-sensitive.

Note: Define the descriptive flexfields in the new GL_DAILY_
RATES table. The Release 10.7 definitions are not transferred from 
the GL_DAILY_ CONVERSION_RATES table.

Task List Status Responsibility

1. Perform Multiple Reporting Currencies tasks Conditionally Required Database Administrator/Application Specialist

2. Migrate existing date and non-integer data Required Database Administrator/Application Specialist

3. Populate tax information for accounting lines Required System Administrator

Requirement Explanation

Reference Manual? No

Do before using? Global Accounting Engine

Requirement Explanation

Reference manual? Oracle Applications Product Update Notes, Oracle Applications Global Accounting 
Engine User’s Guide, Oracle Application Object Library/Workflow Technical 
Reference Manual

Do before using? Global Accounting Engine, Oracle Receivables, Oracle Payables, or Oracle 
Inventory

TUMS Step Key? AX_MIGRATE_NON_INTEGER_DATA



Financials

Category 5 — Before Using Your Products 5-5

1. Set the NLS_DATE_FORMAT environment variable to DD-MON-RR.

2. Ensure that NLS_LANG is set to the same language used prior to upgrading.

3. Ensure that NLS_NUMERIC_CHARACTERS is set to the same format used prior 
to upgrading.

These scripts were designed to migrate data originally created in one language, one 
numeric character format, and a date format of either DD-MON-RR or 
YYYY/MM/DD. An error message appears if more than one language or numeric 
character format was used, or if a date format other than DD-MON-RR or 
YYYY/MM/DD was used to store the date in the character column. If you get this 
error message, update the character column values to use the same format, and re-run 
the scripts. Use a batchsize that is appropriate for your environment.

To migrate data for the AX_SLE_LINES table:

UNIX:

$ cd $AX_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @axxpos01.sql <batchsize>

Windows:

C:\> cd %AX_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @axxpos01.sql <batchsize>

To migrate data for the AX_DOCUMENT_STATUSES table:

UNIX:

$ cd $AX_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @axxpos02.sql <batchsize>

Windows:

C:\> cd %AX_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @axxpos02.sql <batchsize>

Step 3  Populate tax information for accounting lines
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

The upgrade adds new columns to the AX_SLE_LINES table to support tax reporting. 
Run axxpos06.sql to populate these columns with tax information for the upgraded 
accounting lines. Use a batchsize that is appropriate for your environment. 

UNIX:
$ cd $AX_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @axxpos06.sql <batchsize>

Windows:
C:\> cd %AX_TOP%\patch\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @axxpos06.sql <batchsize>

Requirement Explanation

Reference manual? No

Do before using? Global Accounting Engine

TUMS Step Key? AX_POPULATE_TAX_INFO
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Oracle Payables Tasks
Perform the following Oracle Payables tasks.

Step 1  Replace modified payment formats
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Do not perform this step if both these conditions are true: 1) you are upgrading from an 
English-only installation, and 2) you have never renamed or modified the attributes of 
a Payables seeded payment format. If these conditions are not true, you MUST perform 
this step for all Latin American countries that have country-specific Payment Formats 
(Argentina, Brazil, Chile, and Colombia). This applies to Release 10.7 and Release 11.0. 

In Release 11, we enhanced the architecture of each of the seeded payment formats. If 
you modified Release 10.7 payment formats, replace them with the Release 11/11i 
formats. A payment format may have been modified as follows:

■ You renamed it in the Payment Formats window.

■ You changed its attributes in the Payment Formats window.

■ Oracle translated the name for a non-English version of Payables.

Perform this step to ensure all Release 11i payment formats use the same names and 
attributes as the payment formats you used before the upgrade. This provides 
continued support of the Payables seeded payment formats in future releases.

During the upgrade, the system identifies each Payables seeded payment format that 
requires this step and adds a @ symbol to the beginning of its name. Run the following 
script to create a list of all modified payment formats assigned to payment documents:

UNIX:
$ cd $AP_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @apucfrpt.sql

Windows:
C:\> cd %AP_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @apucfrpt.sql

This script produces apucfrpt.lst, which lists the following values for each modified 
payment format that you have assigned to a payment document: Bank, Branch, 
Account, Payment Document, and Payment Format.

For each payment format on the report, perform the following steps.

Task List Status Responsibility

1. Replace modified payment formats Conditionally Required Application Specialist (Payables)

2. Set up prepayment payment terms Recommended Application Specialist (Payables)

3. Create or modify data for data model changes for MRC Conditionally Required Database Administrator

Requirement Explanation

Reference manual? Setting Up Custom Formats, Payment Formats, and Defining and 
Maintaining Payables Payment Documents (Oracle Payables User’s Guide)

Do before using? Oracle Payables

TUMS Step Key? AP_REMODIFY_PAYMENT_FORMATS
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1. In the Payment Formats window, query the name of the seeded (unmodified) 
payment format you used to create the modified payment format.

2. Duplicate the attributes and name of the modified payment format.

3. Save your work.

4. Open the Payment Documents window of the Banks form and query the payment 
document to which you had assigned the modified payment format.

5. In the Payment Format field, delete the @ from the payment format name so that it 
matches the new Release 11i-based payment format name.

6. Save your work.

Step 2  Set up prepayment payment terms
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

The prepayment functionality has changed. In order to get the same default behavior 
(payment terms of Immediate when entering a prepayment-type invoice), set up 
default payment terms for the Prepayment invoice types. For example, you may want 
to default Immediate payment terms to all prepayments.

1. For each operating unit, choose Setup > Invoice > Payment Terms. 

2. In the Payment Terms window, define the payment terms that you want to use as 
the default for all prepayments. Save your work.

3. For each operating unit, navigate to the Payables Options window (Setup > 
Options > Payables).

4. Select the Invoice tabbed region. In the Prepayment Payment Terms field, enter the 
default payment terms. Save your work.

Step 3  Create or modify data for data model changes for MRC
This task is Conditionally Required. It applies to Release 11.0 upgrades.

Perform this step if you have implemented Multiple Reporting Currencies (MRC).

To maintain compatibility, data model changes made to Oracle Payables require 
changes to the AP/MRC data model. Apply the data model upgrade driver 
dapmc115.drv using AutoPatch. The driver is located in 
$AP_TOP/patch/115/driver (UNIX) or %AP_TOP%\patch\115\driver (Windows). 
Refer to apmc115r.txt in the readme directory for more information.

Requirement Explanation

Reference manual? Payment Terms (Oracle Payables User’s Guide)

Do before using? Oracle Payables

TUMS Step Key? AP_SETUP_PREPAYMENT_TERMS

Requirement Explanation

Reference manual? No

Do before using? Oracle Payables

TUMS Step Key? AP_MRC_DATAMODEL_UPG
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Oracle Receivables Tasks
Perform the following Oracle Receivables tasks.

Step 1  Create indexes on transaction flexfield columns 
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform this step only if you use AutoInvoice. 

Create indexes on the transaction flexfield columns so you can query transaction 
flexfield information in the invoice headers and lines and speed up validation. 

Define non-unique, concatenated indexes on the following tables and columns that you 
use for the Line Transaction Flexfield and the Transaction Flexfield:

To find columns used for the Line Transaction Flexfield, navigate to the Descriptive 
Flexfield Segments window (Setup > Financials > Flexfields > Descriptive > Segments) 
and query the Line Transaction Flexfield. Note each context and which segments are 
enabled using interface line attribute columns from the RA_INTERFACE_LINES_ALL 
table. 

Then, create non-unique, concatenated indexes for the same interface line attribute 
columns in the RA_CUSTOMER_TRX_LINES_ALL and RA_INTERFACE_LINES_ALL 
tables and for the same interface header attribute columns in the RA_CUSTOMER_
TRX_ALL tables.

Note: You must have successfully completed Step 1 of the Oracle 
Payables Tasks in Chapter 3, before you apply this driver. It uses 
the exchange rates to upgrade the MRC data.

Task List Status Responsibility

1. Create indexes on transaction flexfield columns Conditionally Required Database Administrator

2. Recreate custom tax vendor extension views Conditionally Required Database Administrator

3. Update tax vendor descriptive flexfield information Required System Administrator

4. Create contexts and segments for new flexfields Required System Administrator

5. Create or modify data for data model changes for MRC Conditionally Required Database Administrator

Requirement Explanation

Reference manual? No

Do before using? Oracle Receivables

TUMS Step Key? AR_CREATE_INDEXES_ON_TRANS_COL

Table Columns

RA_CUSTOMER_TRX_LINES_ALL interface_line_attribute1-15
interface_line_context

RA_INTERFACE_LINES_ALL interface_line_attribute1-15
interface_line_context

RA_CUSTOMER_TRX_ALL interface_header_attribute1-15 
interface_header_context
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If you are importing sales credit and accounting information, create indexes for the 
same interface line attribute columns in the RA_INTERFACE_SALESCREDITS_ALL 
and RA_INTERFACE_DISTRIBUTIONS_ALL tables. Create these indexes only if you 
are using these tables to import sales credit and accounting information.

If you have only one context defined, create only one index for each table in the list. 
However, if you have multiple contexts defined, you may want to create multiple 
indexes per table, according to your needs. For example, suppose the Line Transaction 
Flexfield has three contexts set up as follows:

You could create three indexes per table, one for each context, like this:

Or, you could create two indexes — one for context3 and another for context2. 
Context1 uses the index for context2 because context2 has the same first two attribute 
columns as context1, like this:

Additional Information: See Transaction Flexfields in Oracle 
Receivables User’s Guide.

Flexfield Context Attribute Columns assigned to Enabled Segments

Context1 Interface_line_attribute1

Context1 Interface_line_attribute2

Context2 Interface_line_attribute1

Context2 Interface_line_attribute2

Context2 Interface_line_attribute3

Context3 Interface_line_attribute3

Context3 Interface_line_attribute9

Index Table Columns

RA_INTERFACE_LINES_LTF1 (unique) RA_INTERFACE_LINES_ALL interface_line_attribute1-2
interface_line_context

RA_INTERFACE_LINES_LTF2 (unique) RA_INTERFACE_LINES_ALL interface_line_attribute1-3
interface_line_context

RA_INTERFACE_LINES_LTF3 (unique) RA_INTERFACE_LINES_ALL interface_line_attribute3, 9
interface_line_context

RA_CUSTOMER_TRX_LINES_LFT1 RA_CUSTOMER_TRX_LINES_ALL interface_line_attribute1-2
interface_line_context

RA_CUSTOMER_TRX_LINES_LFT2 RA_CUSTOMER_TRX_LINES_ALL interface_line_attribute1-3
interface_line_context

RA_CUSTOMER_TRX_LINES_LFT3 RA_CUSTOMER_TRX_LINES_ALL interface_line_attribute3, 9
interface_line_context

Index Table Columns

RA_INTERFACE_LINES_LTF1 (unique) RA_INTERFACE_LINES_ALL interface_line_attribute1-3
interface_line_context

RA_INTERFACE_LINES_LTF2 (unique) RA_INTERFACE_LINES_ALL interface_line_attribute3, 9
interface_line_context

RA_CUSTOMER_TRX_LINES_LFT1 RA_CUSTOMER_TRX_LINES_ALL interface_line_attribute1-3
interface_line_context

RA_CUSTOMER_TRX_LINES_LFT2 RA_CUSTOMER_TRX_LINES_ALL interface_line_attribute3, 9
interface_line_context
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Oracle Projects and Oracle Order Management use specific seeded contexts and 
enabled segments. Create a unique index for each combination of enabled segments. 
The number of segments differs based on the release level. These indexes assist in the 
lookups for those products.

If you have licensed Oracle Projects:
If users query transactions based on project numbers, create an index RA_
CUSTOMER_TRX_PA1 on the following two columns in table RA_CUSTOMER_TRX_
ALL: interface_header_context and interface_header_attribute1.

If you have licensed Oracle Order Management:
Create an index RA_CUSTOMER_TRX_LINES_OE1 on the following two columns in 
table RA_CUSTOMER_TRX_LINES_ALL:

■ interface_line_attribute 1

■ interface_line_attribute2

Create an index RA_CUSTOMER_TRX_LINES_OE2 on the interface_line_attribute6 
column in table RA_CUSTOMER_TRX_LINES_ALL.

Step 2  Recreate custom tax vendor extension views   
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Complete this step if you implemented the Tax Vendor Extension and customized any 
of the following Oracle Tax Vendor Extension views:

For example, you created a file called custom1.sql, which contains the script for 
customizing the view TAX_LINES_CREATE_V. Recreate the view by typing the 
following, where <directory> is the location of custom1 script and <file> is the name 
of the custom file.

Additional Information: See Importing Transactions Using 
AutoInvoice in Oracle Receivables User’s Guide.

Requirement Explanation

Reference manual? Oracle Receivables User’s Guide

Do before using? Oracle Receivables

TUMS Step Key? AR_RECREATE_CUSTOM_TAX_VIEWS

View View

TAX_LINES_INVOICE_IMPORT_V TAX_LINES_RECURR_INVOICE_V 

TAX_LINES_CREATE_V TAX_LINES_DELETE_V

 TAX_ADJUSTMENTS_V

Note: If your tax vendor is Taxware® Sales/Use Tax System or 
Vertex® Quantum, and you have implemented descriptive 
flexfields, you must perform an additional step, as described in 
Integrating Oracle Receivables with Vertex Quantum Release 11i or 
Integrating Oracle Receivables with Taxware Sales/Use Tax System.
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sqlplus <APPS username>/<APPS password> @<directory>/<file>

Add new columns to views:
In Step 2 of the Oracle Receivables Tasks in Category 1, you made copies of 
customized views or created a script to reinstall them. Before reinstalling these views, 
add the additional columns created in Release 11i. To see how the new views are 
written, execute the following command:

sqlplus <APPS username>/<APPS password>

To look at the new view, execute the following commands:

SQL> set long 1000000
SQL> spool view
SQL> select text from user_views where view_name=’TAX_LINES_CREATE_V’;
SQL> exit

This creates a file called view.lst that contains the definition of the predefined view. To 
view the definition, type the following, where <CUSTOM_VIEW> is the name of the 
customized view:

SQL> set long 1000000
SQL> spool customview
SQL> select text from user_views where view_name=’<CUSTOM_VIEW>’;
SQL> exit

This creates a file called customview.lst. Compare its contents with the contents of 
view.lst to see which columns and conditions to add. The structure of the customized 
view must be exactly the same as the view shipped with Oracle Receivables. For 
example, the number, order, and data type of each column must be the same as the 
TAX_LINES_CREATE_V view.

Rename customized views:
To reduce the number of steps in future upgrades and so that installations with 
multiple organizations can control which users call an installed third-party application 
for tax calculations, Oracle Receivables uses a naming structure to group views into 
sets.

To rename a customized view, execute the following commands:

UNIX:
$ sqlplus <APPS username>/<APPS password> 
SQL> rename <CUSTOM_VIEW_NAME> to <NEW_VIEW_NAME>

Windows:
C:\> sqlplus <APPS username>/<APPS password> 
SQL> rename <CUSTOM_VIEW_NAME> to <NEW_VIEW_NAME>

The value for <CUSTOM_VIEW_NAME> is the name of the customized view. The 
value for <NEW_VIEW_NAME> uses the new naming standard as follows:

Note: Rename all customized views to meet the new naming 
standard.
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For example, the TAX_LINES_INVOICE_IMPORT_V view has the following naming 
structure:

Step 3  Update tax vendor descriptive flexfield information
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Complete this step if your tax vendor is either Taxware Sales/Use Tax System or 
Vertex Quantum. In this release, the point of order acceptance, point of order origin, 
ship-to, ship-from, and tax exemption information must be entered in the Receivables 
Salesforce, Organization, and System Options windows. Run ar115vdr.sql to copy 
existing information in the descriptive flexfields to the new Release 11i columns. The 
script header describes the necessary parameters:

UNIX: 
$ cd $AR_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @ar115vdr.sql

Windows: 
C:\> cd %AR_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @ar115vdr.sql

View Name Standard

For Oracle (no additional naming structure)

For TaxWare(AVP) _A added to the view name

For Vertex _V added to the view name

For Custom 1 _1 added to the view name

For Custom 2 _2 added to the view name

For Custom 3 _3 added to the view name

For Custom 4 _4 added to the view name

For Custom 5 _5 added to the view name

View Name Standard

For Oracle TAX_LINES_INVOICE_IMPORT_V

For Taxware TAX_LINES_INVOICE_IMPORT_V_A

For Vertex TAX_LINES_INVOICE_IMPORT_V_V

For Custom 1 TAX_LINES_INVOICE_IMPORT_V_1

Requirement Explanation

Reference manual? Implementing Oracle Receivables with Taxware Sales/Use Tax System or 
Implementing Oracle Receivables with Vertex Quantum

Do before using? Oracle Receivables

TUMS Step Key? AR_UPDATE_TAX_VENDOR_DES_FLEX

Additional Information: See Implementing Oracle Receivables with 
Taxware Sales/Use Tax System. See also Implementing Oracle 
Receivables with Vertex Quantum.
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Step 4  Create contexts and segments for new flexfields
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

The upgrade changes the names of some of the tables containing customer information 
and also installs new flexfields that refer to the new tables. (After you have completed 
the installation, the letters OLD are appended to the obsolete flexfields.) In this step, 
you copy the Context Field Values and the values in the Segments Summary from the 
old flexfields to the new ones.

The following table lists the new flexfields.

1. Navigate to the Descriptive Flexfields Segments window. From the system 
administrator responsibility, choose Application > Flexfield > Descriptive > 
Segments.

2. Query the first new flexfield; for example, Customer Information. After you run 
the query, the Customer Information flexfield appears, without context 
information.

3. Without closing the first Descriptive Flexfields Segment window, open a new 
instance of the same window.

4. Query the old flexfield; for example, Customer Information OLD. 

5. Copy the values of the old Context Field Values region into the Context Field 
Values region of the new flexfield and save your work.

6. Choose the Segments button to open the Segments Summary window for the old 
flexfield.

7. Copy and paste the values in the old Segments Summary window into the new 
Segments Summary window.

Requirement Explanation

Reference manual? Oracle Applications Flexfields Guide

Do before using? Customer enhancements

TUMS Step Key? AR_CREATE_CONTEXTS_AND_SEGMENTS

Obsolete Flexfield New Flexfield

Customer Information OLD Customer Information 

Address Information OLD Address Information 

Site Use Information OLD Site Use Information 

Customer Credit Profile Information OLD Customer Credit Profile Information 

Customer Profile Amounts OLD Customer Profile Amounts 

Telephone Number Information OLD Telephone Number Information 

Contact Role Information OLD Contact Role Information 

Customer Relationship Information OLD Customer Relationship Information 

Remit Address OLD Remit Address 

Credit Profile Class Information OLD Credit Profile Class Information 

Customer Profile Class Amounts OLD Customer Profile Class Amounts 

Contact Information OLD Contact Information 
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8. Save your work.

9. Repeat this procedure for each of the remaining new flexfields.

Step 5  Create or modify data for data model changes for MRC
This task is Conditionally Required. It applies to Release 11.0 upgrades.

Perform this step if you have implemented Multiple Reporting Currencies (MRC).

To maintain compatibility, data model changes made to Oracle Receivables require 
changes to the AR/MRC data model. To upgrade the data model, complete the 
following steps. 

Gain/Loss/Rounding (GLR) accounts can exist in one or more reporting sets of books 
without being defined in the primary set of books. For the data model upgrade driver 
to succeed, however, GLR accounts must first be defined for all sets of books.

1. Run the missing Gain/Loss/Rounding (GLR) accounts report:

UNIX:

$ cd $AR_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @armcchk1.sql

Windows:

C:\> cd %AR_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @armcchk1.sql

2. Review the report output in file armcchk1.lst. If the output shows missing GLR 
accounts for sets of books, have an Application Specialist define the missing GLR 
accounts before you proceed.

3. Apply the data model upgrade driver darmc115.drv using AutoPatch. 

The driver is located in $AR_TOP/patch/115/driver (UNIX) or in
%AR_TOP%\patch\115\driver (Windows). Refer to armc115r.txt in the readme 
directory for more information.

Oracle Financials Common Country Tasks
Perform the following Oracle Financials Common Country tasks.

Step 1  Update customized menus that use JG submenus
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? Oracle Receivables User’s Guide

Do before using? Oracle Receivables

TUMS Step Key? AR_MRC_DATAMODEL_UPG

Additional Information: See Setting Up > Defining Receivables 
System Options > Accounting System Options in Oracle Receivables 
User Guide.

Task List Status Country/Responsibility

1. Update customized menus that use JG submenus Conditionally Required All /System Administrator
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Oracle Financials Common Country Features now includes a separate, seeded menu 
for each application within each country, instead of a single, seeded menu for all 
countries. If you have custom menus that use old menus as submenus, update the 
custom menus to use the new JG menus instead.

For information on defining menus, refer to Menus Window, Oracle Applications System 
Administrator’s Guide - Security. For details about the JG menus that are seeded in 
Release 11i, refer to Oracle Financials Common Country Features, Oracle Applications 
Product Update Notes.

Oracle Financials for Asia/Pacific Tasks
Perform the following Oracle Financials for Asia/Pacific tasks.

Step 1  Correct existing data before reporting tax information
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Before you enter any new transactions in Oracle Payables and Receivables, complete 
the setup as outlined in the Release 11i Oracle Financials for Korea User Guide. You may 
also want to perform this setup if you want to report on transactions, such as invoices, 
payments, receipts, withholding and VAT distributions, that existed before the upgrade.

Note that since the overall setup, logic, and calculation process that generated the 
current withholdings and VAT distribution lines may differ from the new functionality, 
extract and report data used by the Korean Withholding and VAT reports for 
transactions that were entered prior to the upgrade may show calculations that are not 
consistent with calculations on transactions that are entered after the upgrade.

Therefore, you may prefer to report withholdings and VAT only for transactions and 
respective account distributions that are entered after the upgrade date. You can 
accomplish this by using the GL Date range parameter in the reports.

You may also want to install the online help update 1338864.

Oracle Financials for Europe Tasks
Perform the following Oracle Financials for Europe tasks.

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Security, Oracle Applications 
Product Update Notes

Do before using? Oracle Financials Common Country Features

TUMS Step Key? JG_UPDATE_CUST_MENUS

Task List Status Country/Responsibility

1. Correct existing data before reporting tax information Required Korea /Application Specialist 
(Payables and Receivables)

Requirement Explanation

Reference manual? Oracle Financials for Korea User Guide

Do before using? Oracle Financials for Asia/Pacific

TUMS Step Key? JA_CORRECT_TAX_INFO
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Step 1  Update customized menus that use JE submenus
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Oracle Financials for Europe now includes a separate, seeded menu for each 
application within each country, instead of a single, seeded menu for all countries. If 
you have custom menus that use the old menus as submenus, update the custom 
menus to use the new JE menus instead.

For details about defining menus, see Menus Window, Oracle Applications System 
Administrator’s Guide - Security. For details about the JE menus that are seeded in 
Release 11i, see Oracle Financials for Europe, Oracle Applications Product Update Notes.

Oracle Financials for Latin America Tasks
Perform the following Oracle Financials for Latin America tasks.

Step 1  Create new lookup codes
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades 
(Argentina and Colombia).

Task List Status Country/Responsibility

1. Update customized menus that use JE submenus Conditionally Required All /System Administrator

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Security, Oracle Applications 
Product Update Notes

Do before using? Oracle Financials for Europe

TUMS Step Key? JE_UPDATE_CUST_MENUS

Task List Status Country/Responsibility

1. Create new lookup codes Conditionally Required Argentina, Colombia/Application 
Specialist (Receivables)

2. Set tax system options Conditionally Required Argentina, Colombia/Application 
Specialist (Receivables)

3. Update sales orders and invoices Conditionally Required Argentina, Colombia/Application 
Specialist (Receivables)

4. Add warehouse name information Conditionally Required Argentina, Brazil, Colombia/System 
Administrator

5. Associate tax information for each inventory 
organization location

Conditionally Required Brazil/Application Specialist 
(Receivables)

6. Associate tax groups and tax categories Conditionally Required Argentina, Brazil, Colombia 
/Application Specialist (Receivables)

7. Cancel and re-enter all unapproved and unposted 
invoices

Conditionally Required Argentina, Colombia/Application 
Specialist (Payables)

8. Archive restored technical appraisals Conditionally Required Colombia/Application Specialist 
(Assets)

Requirement Explanation

Reference manual? Oracle Applications User’s Guide

Do before using? Oracle Financials for Latin America

TUMS Step Key? JL_CREATE_NEW_LOOKUP_CODES
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From the Application Developers responsibility, use the Application Object Library 
Lookups window (Application > Lookups > Application Object Library) to create the 
following lookup codes. Do not enter values in the Start Date Active and End Date 
Active fields. Check the Enabled check box.

Creating these lookup codes, you can view old transactions.

Step 2  Set tax system options
This task is Conditionally Required. It applies to Release 10.7 upgrades (Argentina 
and Colombia).

Set tax system options as part of the Latin Tax Engine upgrade. If you are using the 
multi-organization functionality, repeat this step for each organization. 

1. Navigate to the System Options window (Argentine Receivables > Standard AR > 
Setup > System > System Options) or (Colombian Receivables > Oracle 
Receivables > Setup > System > System Options).

2. In the Tax alternate name region, check the Inclusive Tax Used check box and 
make sure that the Compound Taxes check box is unchecked.

3. In the Miscellaneous alternate name region, open the globalization flexfield.

4. Enter values in the Country Code, Use Legal Messages, and Tax Rule Set fields.

Lookup Code Lookup Type Notes

OBS-TC JLZZ_AR_TX_CATEGRY Create only if you are upgrading from Release 
11.0 and have not applied update 839884.

Assign existing tax codes to this obsolete tax 
category so that you can successfully query 
previous tax codes. 

OBS-COND TRANSACTION_
ATTRIBUTE

Create only if upgrading from Release 10.7.

You can view pre-upgrade transactions that 
did not fail mandatory validations.

OBS-VALUE JLZZ_AR_TX_ATTR_
VALUE

Create only if upgrading from Release 10.7.

You can view pre-upgrade transactions that 
did not fail mandatory validations.

Additional Information: See Application Utilities Lookups and 
Application Object Library Lookups in Oracle Applications User’s 
Guide.

Requirement Explanation

Reference manual? Oracle Financials Common Country Features User’s Guide; Oracle Receivables 
User’s Guide

Do before using? Oracle Financials for Latin America

TUMS Step Key? JL_SET_TAX_SYSTEM_OPTIONS

Additional Information: See Define System Options in Oracle 
Financials Common Country Features User’s Guide. See also Defining 
Receivables System Options in Oracle Receivables User’s Guide.
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Step 3  Update sales orders and invoices
This task is Conditionally Required. It applies to Release 10.7 upgrades (Argentina 
and Colombia).

This step is a part of the Latin Tax Engine upgrade. If you are using multi-organization 
functionality, repeat this step for each organization. 

Before you update sales orders and invoices, create obsolete tax codes, categories, and 
classes for previous transactions and associate the obsolete tax categories with 
condition and values so that you can view previously created transactions.

To create obsolete tax codes, categories, and classes for previous 
transactions:
Use the Argentine Receivables or Colombian Receivables responsibility for this step.

1. Create a tax category.

In the Latin Tax Categories window (Argentine /or Colombian Localization > 
Setup > Latin Tax > Categories), create a tax category.

2. Create a tax code.

In the Tax Codes and Rates window (Argentina—Standard AR > Setup > Tax > 
Codes, or Colombia—Oracle Receivables > Setup > Tax > Codes), create a tax code.

Requirement Explanation

Reference manual? No

Do before using? Oracle Financials for Latin America

TUMS Step Key? JL_UPDATE_SALES_ORDERS

In this field... Enter this value...

Tax Code OBS-TC

Effective From 01-JAN-1951

Effective To 31-DEC-4712

Threshold Check Level Line

Grouping Condition Type Line

Grouping Condition Line

Additional Information: See Define Tax Categories in Oracle 
Financials Common Country Features User’s Guide.

In this field/check box... Enter this value...

Tax Code OBS-TAX-CODE

Tax Type Value Added Tax (VAT)

Taxable Basis Before Discount

Tax Rate % 0.00

Effective Dates - From 01-JAN-1951

Effective Dates - To <Leave blank>
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3. Create a fiscal classification code.

In the Latin Fiscal Classifications window (Argentine /or Colombian Localization 
> Setup > Latin Tax > Fiscal Classifications), create a fiscal classification code.

4. Create a transaction class.

In the Latin Tax Condition Classes window (Argentine /or Colombian 
Localization > Setup > Latin Tax > Condition Classes), create a transaction class.

Enabled Checked

Displayed Checked

Tax Category (in Globalization 
Flexfield)

OBS-TC

Additional Information: See Define Tax Codes and Rates in Oracle 
Receivables Tax User’s Guide.

In this field/check box... Enter this value...

Fiscal Classification Code OBS-FISCAL

Displayed Value OBS-FISCAL

Description OBS-FISCAL

Start Date Active 01-JAN-1951

End Date Active 31-DEC-4712

Tax Category OBS-TC

From Date 01-JAN-1951

To Date 31-DEC-4712

Tax Code OBS-TAX-CODE

Enabled Checked

Additional Information: See Define Fiscal Classifications in Oracle 
Financials Common Country Features User’s Guide.

In this field/check box... Enter this value...

Class Type Transaction Class

Class Code OBS-TRANS-CLASS

Description OBS-TRANS-CLASS

Start Date Active 01-JAN-1951

End Date Active 31-DEC-4712

Tax Category OBS-TC

Condition Code OBS-COND

Value Code OBS-VALUE

Enabled Checked

In this field/check box... Enter this value...
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To associate obsolete tax category with condition and values:
In the Associate Latin Tax Category with Conditions and Values window (Argentine 
/or Colombian Localization > Setup > Latin Tax > Conditions and Values), associate 
tax category OBS-TC with OBS-COND condition and OBS-VALUE value.

To update sales orders and invoices:
Run the following scripts to fill in the Tax Code, Fiscal Classification Code, and 
Transaction Condition Class fields with default values for all order lines and invoice 
lines. The script populates the Tax Code field only if it is blank. Specify the value for 
Country Code: AR (Argentina) or CO (Colombia).

To update sales orders, run jlzztu01.sql. Use jlzztu01.lst to review the results.

UNIX:
$ cd $JL_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @jlzztu01.sql <Country Code> \
  OBS-FISCAL OBS-TRANS_CLASS

Windows:
C:\> cd %JL_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @jlzztu01.sql <Country Code> \
  OBS-FISCAL OBS-TRANS_CLASS

To update invoices, run jlzztu02. Use jlzztu02.lst to review the results.

UNIX:
$ cd $JL_TOP/admin/sql

Additional Information: See Define Tax Condition Classes for 
Transactions in Oracle Financials Common Country Features User’s 
Guide.

In this field/check box... Enter this value...

Tax Category OBS-TC

Condition Type Transaction Condition

Condition Name OBS-COND

Mandatory In Class Checked

Determining Factor Checked

Grouping Attribute Checked

Value OBS-VALUE

Default To Class Checked

Additional Information: See Associate Tax Categories with Tax 
Conditions and Values in Oracle Financials Common Country Features 
User’s Guide.

Note: These are potentially long-running. Plan your upgrade 
schedule accordingly.
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$ sqlplus <APPS username>/<APPS password> @jlzztu02.sql <Country Code> \
  OBS-FISCAL OBS-TRANS_CLASS

Windows:
C:\> cd %JL_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @jlzztu02.sql <Country Code> \
     OBS-FISCAL OBS-TRANS_CLASS

Step 4  Add warehouse name information
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades 
(Argentina, Brazil, and Colombia).

Warehouse information is mandatory for a transaction if the invoice line is an item 
line, and you selected Latin Tax Handling as the tax method in the Define System 
Options window. If you want to modify upgraded transactions, enter the warehouse in 
the Warehouse Name field on the Transactions workbench. The warehouse that you 
enter defines an item validation organization for the ship-from location for this item 
line.

Step 5  Associate tax information for each inventory organization location
This task is Conditionally Required. It applies to Release 11.0 upgrades (Brazil).

Perform this step only if you have not applied update 786842 (Inventory org update). 
This step is part of the Latin Tax Engine upgrade.

From the Brazilian Receivables responsibility, enter a valid value for the Organization 
Class field in the globalization flexfield of the Location window (Standard AR > Setup 
> System > Organizations > Location). Perform this step for each inventory 
organization location, if you are using multi-org functionality.

Step 6  Associate tax groups and tax categories
This task is Conditionally Required. It applies to Release 11.0 upgrades (Argentina, 
Brazil, and Colombia).

Additional Information: See Entering Transactions in Oracle 
Receivables User’s Guide. See also Oracle Financials for Argentina 
User’s Guide and Oracle Financials for Colombia User’s Guide.

Requirement Explanation

Reference manual? Oracle Financials for Argentina User’s Guide, Oracle Financials for Brazil User’s 
Guide, Oracle Financials for Colombia User’s Guide

Do before using? Oracle Financials for Latin America

TUMS Step Key?  JL_ADD_WAREHOUSE_INFO

Requirement Explanation

Reference manual? Oracle Financials Common Country Features User’s Guide

Do before using? Oracle Financials for Latin America

TUMS Step Key? JL_ASSOCIATE_TAX_INFO

Additional Information: See Assign Tax Condition Classes to 
Organizations, Setting Up Globalization Flexfields in Oracle 
Financials Common Country Features User’s Guide.
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As a part of the Latin Tax Engine upgrade, perform this step if you have not previously 
applied update 839884. 

From the Brazilian Receivables responsibility, use the Latin Tax Groups window 
(Brazilian Localization > Setup > Latin Tax > Groups) to set up this association. Ensure 
that all tax groups have at least one tax category.

Step 7  Cancel and re-enter all unapproved and unposted invoices
This task is Conditionally Required. It applies to Release 11.0 upgrades (Argentina 
and Colombia).

Complete this step only if you did not install Latin American country-specific 
functionality in Release 11. You must re-enter all invoices that were/are to be 
transferred from the previous period to the new period so that they have the 
withholding applicability, or the additional information to make the Extended 
Withholding feature to function correctly.

To activate the Extended Withholding applicability, complete the setup steps described 
in the Oracle Payables chapter of the Oracle Financials for Argentina/Colombia User’s 
Guide.

Step 8  Archive restored technical appraisals
This task is Conditionally Required. It applies to Release 11.0 upgrades (Colombia).

Re-archive technical appraisals that you restored in Step 2 of the Oracle Financials for 
Latin America Tasks in Chapter 1.

Requirement Explanation

Reference manual? Oracle Financials Common Country Features User’s Guide

Do before using? Oracle Financials for Latin America

TUMS Step Key? JL_ASSOCIATE_TAX_GROUPS

Additional Information: See Define Tax Group in Oracle Financials 
Common Country Features User’s Guide.

Requirement Explanation

Reference manual? Oracle Payables User’s Guide

Do before using? Oracle Financials for Latin America

TUMS Step Key? JL_CANCEL_UNAPPROVED_INVOICES

Additional Information: See Cancelling Invoices and Entering 
Invoices in Oracle Payables User’s Guide.

Requirement Explanation

Reference manual? Oracle Financials for Colombia User’s Guide

Do before using? Oracle Financials for Latin America

Concurrent Manager? Yes

TUMS Step Key? JL_ARCHIVE_RESTORED_APPRAISALS 

Additional Information: See Archiving, Purging, and Restoring 
Technical Appraisals in Oracle Financials for Colombia User’s Guide.
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Projects
Review this section and complete only the tasks for the Oracle Projects products you 
have installed.

Oracle Projects Tasks
Perform the following Oracle Projects tasks.

Step 1  Review organization hierarchies and uses of organizations
This task is Required. It applies to Release 10.7 upgrades.

In Release 10.7 and earlier, you could control which organizations were used as Project 
Task Owning/Invoice Organizations by Operating Unit. That is, the same organization 
could be a Project/Task Owning/Invoice Organization in one operating unit but not in 
a different one. This could happen if you had specified different Project Organization 
Types for the operating units in the PA implementations option.

In Release 11.0 and later, the Project Organization type is not used to identify the 
organizations that own project/tasks or invoices. Instead, the organization 
classifications Project/Task Owning Organization and Invoice Organization specified 
at the organization level are used for this purpose. (Organizations are shared among 
operating units in a business group). Therefore, after the upgrade, you might have 
organizations in some operating units that you did not intend to use as Project/Task 

Task List Status Responsibility

1. Review organization hierarchies and uses of 
organizations

Required Technical Specialist / Application 
Specialist (Projects)

2. Update project status values Required Application Specialist (Projects)

3. Update customized billing extensions Conditionally Required Technical Specialist

4. Review and update billing cycle names Conditionally Required Application Specialist (Projects)

5. Convert custom overtime calculation program to 
PL/SQL

Conditionally Required Technical Specialist / Application 
Specialist (Projects)

6. Populate billing title for employee assignments Conditionally Required Technical Specialist / Application 
Specialist (Projects)

7. Set up the invoice rounding account Conditionally Required Technical Specialist / Application 
Specialist (Projects)

8. Add new parameters to custom invoice-related client 
extensions

Conditionally Required Technical Specialist / Application 
Specialist (Projects)

9. Add new parameters to custom transaction control 
extension

Conditionally Required Technical Specialist

10. Add new currencies and non-recoverable tax amounts 
to commitment views

Conditionally Required Technical Specialist

11. Update custom code that populates the Transaction 
Interface table

Conditionally Required Technical Specialist

12. Reinstall custom client extension packages and views Conditionally Required Technical Specialist

13. Correct FIFO marking of expenditure items Conditionally Required Application Specialist (Projects)

Requirement Explanation

Reference manual?  Oracle Projects User’s Guide

Do before using? Oracle Projects

TUMS Step Key? PA_REVIEW_ORG_HIERARCHIES
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Owning or Invoice Organizations. Run the following script to determine the 
organizations that were upgraded under this condition:

UNIX:
$ cd $PA_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @paupgor2.sql

Windows:
C:\> cd %PA_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @paupgor2.sql

The script paupgor2.sql creates paxupor2.lst in $PA_TOP/admin/sql (UNIX) or %PA_
TOP%/admin/sql (Windows). It shows the organizations for each operating unit that 
you designated in Release 10.7 or earlier as project or invoice organizations. 

If the report contains any data, define a new organization hierarchy for each related 
operating unit that does not contain the listed organizations. Then, assign the new 
organization hierarchy as the new Project/Task Owning or Invoice Organization in the 
PA Implementation Options.

To build an organization hierarchy:

1. Navigate to the Organization Hierarchy window (Setup > Human Resources > 
Organizations > Hierarchies).

2. Enter a new organization hierarchy, or copy an organization hierarchy from an 
existing one and modify it.

3. Save your work.

To assign the new organization hierarchy as the new Project/Task Owning or Invoice 
Organization:

1. Navigate to the Implementation Options window (Setup > System > 
Implementation Options).

2. Select the Project Setup tab.

3. Enter the new organization hierarchy you created in the appropriate Organization 
Hierarchy field - Project/Task owning or Invoice.

Step 2  Update project status values 
This task is Required. It applies to Release 10.7 upgrades.

You can now enter values for the System Status field in the Project Status window. 
During the upgrade, Oracle Projects populated each of the user-defined project 
statuses with the System Status of Upgraded. Update each of these statuses with the 
appropriate System Status value.

Additional Information: See Organizations in Oracle Projects, 
Organization Hierarchy, and Implementation Options in Oracle 
Projects User’s Guide.

Requirement Explanation

Reference manual?  Oracle Projects User’s Guide

Do before using? Oracle Projects

TUMS Step Key? PA_UPDATE_PROJ_STATUS_VALUES
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1. Navigate to the Project Statuses window (choose Setup > Projects > Statuses).

2. Query all the records with a System Status of Upgraded.

3. For each of the project statuses displayed, select the appropriate System Status 
from the list of values. You can also change the status controls (actions allowed for 
each project status), which were set to default values during the upgrade.

4. Save your changes.

5. Run the query until there are no records with a System Status of Upgraded.

Step 3  Update customized billing extensions
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Perform this step only if you have installed Project Billing and use predefined public 
procedures in billing extensions.

Oracle Projects provides public procedures to be used in billing extensions. The names 
of these procedures have been changed to comply with Oracle Applications naming 
standards. If your company uses any of the Oracle Projects predefined public 
procedures in your billing extensions, modify the extensions to use the new procedure 
names.

In addition, new parameters have been added to the procedures. If your company uses 
any of the Oracle Projects predefined public procedures in the billing extensions, then 
add these new parameters to the billing extensions. The new parameters that have 
been added to the public procedures are:

Additional Information: See Project Statuses in Oracle Projects 
User’s Guide.

Requirement Explanation

Reference manual?  Oracle Projects User’s Guide

Do before using? Oracle Projects

TUMS Step Key? PA_UPDATE_CUSTOMIZED_BILLING_EXT

Old Name: package.procedure New Name: package.procedure

pb_public.insert_event pa_billing_pub.insert_event

pb_public.insert_message pa_billing_pub.insert_message

pb_public.get_budget_amount pa_billing_pub.get_budget_amount

Package.Procedure New Parameters

pa_billing_pub.insert_event x_audit_amount(1-10)

x_audit_cost_budget_type_code

x_audit_rev_budget_type_code

x_error_message

x_status

pa_billing_pub.insert_message x_error_message

x_status
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Step 4  Review and update billing cycle names 
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Perform this step only if you have installed Project Billing. 

The project billing cycle data has been upgraded to the enhanced billing cycle model. 
Billing cycles were created, based on existing projects, as follows:

Each project was associated with the new billing cycle name.You can change them if 
necessary:

1. Navigate to the Billing Cycles window (Setup > Billing > Billing Cycle). It displays 
the Name, Type, Value, and Effective Dates for all billing cycles created during the 
upgrade.

2. Review the upgraded billing cycle names and change as appropriate. Save your 
work.

Step 5  Convert custom overtime calculation program to PL/SQL 
This task is Conditionally Required. It applies to Release 10.7 upgrades.

pa_billing_pub.get_budget_amount p_cost_budget_type_code

p_rev_budget_type_code

x_cost_budget_type_code

x_rev_budget_type_code

x_error_message

x_status

Additional Information: See Billing Extensions in Oracle Projects 
User’s Guide.

Requirement Explanation

Reference manual?  Oracle Projects User’s Guide

Do before using? Oracle Projects

TUMS Step Key? PA_REVIEW_CYCLE_NAMES

Billing Cycle Field Value

Name Billing Cycle Days: n (n = the value of Bill Cycle Days)

Type Bill Cycle Days

Bill Cycle Days The value of Billing Cycle for a project

Additional Information: See Billing Cycles in Oracle Projects User’s 
Guide.

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Do before using? Oracle Projects

TUMS Step Key? PA_CONVER T_CUSTOM_CALC

Package.Procedure New Parameters
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Perform this step only if you have implemented Projects Overtime Calculation. 

The overtime calculation process was converted to the Overtime Calculation 
Extension, a PL/SQL procedure in PAXDLCOS.pls and PAXDLCOB.pls, located in the 
admin/sql directory. If you have customized PAXDLCOT.rpt, rewrite the 
customizations in the new files.

Step 6  Populate billing title for employee assignments 
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Perform this step only if you have installed Project Billing and implemented employee 
billing titles for invoice formats.

Oracle Projects now looks for an employee billing title in the TITLE column of the 
PER_ASSIGNMENTS_F table, instead of in the descriptive flexfield column (ASS_
ATTRIBUTE1) of the same table. You must populate the billing title on the employee 
assignments in the new column. A sample script populates the TITLE column with the 
contents of the ASS_ATTRIBUTE1 column and sets the ASS_ATTRIBUTE1 column to 
null. If the flexfield has been set up, modify this script appropriately. To run the script:

UNIX:
$ cd $PA_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @pa11u506.sql

Windows:
C:\> cd %PA_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @pa11u506.sql

Step 7  Set up the invoice rounding account
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you have Project Billing installed, set up the Rounding AutoAccounting Function 
Transaction for the function Transfer Revenue and Invoice Account, regardless of 
whether you plan to bill customers in currencies other than the project functional 
currency.

Additional Information: See Overtime Calculation Extension in 
Oracle Projects User’s Guide.

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Do before using? Oracle Projects

TUMS Step Key? PA_POPULATE_BILLING_TITLES

Additional Information: See Employees and Employee 
Assignments in Oracle Projects User’s Guide.

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Do before using? Oracle Projects

TUMS Step Key? PA_SETUP_INVOICE_ROUNDING_ACCT
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1. Navigate to the Assign AutoAccounting Rules window (choose Setup > 
AutoAccounting > Assign Rules). 

2. In the Function Name field, select Revenue and Invoice Accounts, then choose 
Find. The function transactions for Revenue and Invoice Accounts are displayed in 
the Function Transactions region.

3. Check the Enabled check box to enable the Rounding Account. Enter segment rule 
pairings to set up the account. Save your work.

Step 8  Add new parameters to custom invoice-related client extensions 
This task is Conditionally Required. It applies to Release 11.0 upgrades.

Complete this step only if you have Project Billing installed and have customized the 
Automatic Invoice Approve/Release client extension or the AR Transaction Types 
client extension.

The following table lists procedures and the file where each is located. If your 
company uses any of these client extensions, add the new parameters to the client 
extensions. The files are located in $PA_TOP/admin/sql (UNIX) or %PA_
TOP%\admin\sql (Windows).

The following parameters have been added to these client extensions:

Additional Information: See AutoAccounting in Oracle Projects 
User’s Guide.

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Do before using? Oracle Projects

TUMS Step Key? PA_ADD_NEW_PARA_CUST_CLIENT_EXT

Client Extension Procedure Name File

AR Transaction Types PA_Client_Extn_Inv_Transfer.Get_AR_Trx_
Type

PAXPTRXB.pls

Automatic Invoice 
Approve/Release

PA_Client_Extn_Inv_Actions.Approve_
Invoice

PAXPIACB.pls

Automatic Invoice 
Approve/Release

PA_Client_Extn_Inv_Actions.Release_
Invoice

PAXPIACB.pls

Parameter Name Description

p_project_currency_code project currency code

p_project_amount project currency amount

p_inv_currency_code invoice currency code

p_invoice_amount invoice currency amounts

Additional Information: See AR Transaction Types Extension and 
Automatic Invoice Approval/Release Extension in Oracle Projects 
User’s Guide.
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Step 9  Add new parameters to custom transaction control extension
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you have customized any of the following Transaction Control extensions in Project 
Costing, add the associated parameter to the customized extension.

Step 10  Add new currencies and non-recoverable tax amounts to commitment 
views
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

For the PA_COMMITMENT_TXNS_V table, add these new columns.

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Do before using? Oracle Projects

Parameter Name Description

x_denom_currency_code transaction currency code

x_denom_raw_cost transaction currency raw cost amount

x_acct_currency_code functional currency code

x_acct_raw_cost functional currency raw cost amount

x_acct_rate_type exchange rate type used to derive the functional currency raw 
cost amount

x_acct_rate_date exchange rate date used to derive the functional currency raw 
cost amount

x_acct_exchange_rate exchange rate used to derive the functional currency raw cost 
amount

x_attribute11 descriptive flexfield segment 11

x_attribute15 descriptive flexfield segment 15

x_vendor_id supplier identifier for supplier invoice transactions

x_msg_application application identifier for the out message

x_msg_type type of message (error or warning)

x_token1 token for display with message

x_token2 token for display with message

x_token3 token for display with message

Additional Information: See Client Extensions in Oracle Projects 
User’s Guide.

Requirement Explanation

Reference manual? Oracle Projects User’s Guide, Oracle Cost Management User’s Guide, and Oracle 
Project Management User’s Guide

Do before using? Oracle Projects
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These columns have been deleted: tot_cmt_raw_cost, tot_cmt_burdened_cost, 
amount_delivered.

For the PA_PROJ_REQ_DISTRIBUTIONS and the PA_PROJ_PO DISTRIBUTIONS 
tables add the following columns. The AMOUNT column has been changed to include 
non-recoverable taxes.

For the PA_PROJ_AP_INV_DISTRIBUTIONS add the following columns. This table is 
updated to include rows for non-recoverable tax invoice lines.

New Column Description

denom_currency_code transaction currency code

denom_raw_cost transaction currency raw cost amount

denom_burdened_cost transaction currency burdened cost amount

acct_currency_code functional currency code

acct_raw_cost functional currency raw cost amount

acct_burdened_cost functional currency burdened cost amount

acct_rate_date exchange rate date used to derive the functional currency raw cost 
amount

acct_rate_type exchange rate type used to derive the functional currency raw cost 
amount

acct_exchange_rate exchange rate used to derive the functional currency raw cost 
amount

receipt_currency_code receipt currency code

receipt_currency_
amount

receipt currency amount

receipt_exchange_rate receipt currency exchange rate

New Column Description

denom_currency_code transaction currency code

denom_amount transaction currency amount (including non-recoverable tax 
amount)

acct_currency_code functional currency code

acct_rate_date exchange rate date used to derive the functional currency raw cost 
amount

acct_rate_type exchange rate type used to derive the functional currency raw cost 
amount

acct_exchange_rate exchange rate used to derive the functional currency raw cost 
amount

New Column Description

denom_currency_code transaction currency code

denom_amount transaction currency amount (including non-recoverable tax 
amount)

acct_currency_code functional currency code
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The following views in other applications have also been updated to include foreign 
currency columns and non-recoverable tax amounts:

■ CST_PROMFG_CMT_VIEW

■ PJM_REQ_COMMITMENTS_V

■ PJM_PO_COMMITMENTS_V

Step 11  Update custom code that populates the Transaction Interface table
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform this step only if you use the Transaction Import program in Project Costing.

New columns have been added to the Transaction Interface table (PA_
TRANSACTION_INTERFACE_ALL) to support multi-currency transactions and 
supplier invoices import. If you use the Transaction Import program to import costed 
transactions, update all custom programs that populate this table. For costed 
transactions, insert raw cost into the denom_raw_cost column, and burdened cost into 
the denom_burdened_cost column. The list of new columns is on Page 25-26 of Oracle 
Applications Product Update Notes.

Step 12  Reinstall custom client extension packages and views
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

You backed up custom client extensions or commitment views in Step 3 of the Oracle 
Projects Tasks in Chapter 3. Reinstall the customized client extension packages and 
views in the APPS account.

acct_rate_date exchange rate date used to derive the functional currency raw cost 
amount

acct_rate_type exchange rate type used to derive the functional currency raw cost 
amount

acct_exchange_rate exchange rate used to derive the functional currency raw cost 
amount

receipt_currency_code receipt currency code

receipt_currency_amount receipt currency amount

receipt_exchange_rate receipt currency exchange rate

Additional Information: See Commitments in Oracle Projects User’s 
Guide. See also Oracle Cost Management User’s Guide and Oracle 
Project Management User’s Guide.

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Do before using? Oracle Projects

Requirement Explanation

Reference manual? Oracle Projects User’s Guide

Do before using? Oracle Projects

New Column Description
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Step 13  Correct FIFO marking of expenditure items
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform this step only if you have Oracle Project Billing installed.

This step pertains to FIFO marking of expenditure items with scheduled payment 
events in the Generate Draft Invoices process, for projects using the revenue accrual 
method Cost or Event. Prior to this upgrade, the Generate Draft Invoices process 
marked as “billed” all the expenditure items with an expenditure item date earlier 
than the bill through date of the process. Projects now marks expenditure items for 
scheduled payment events as “billed”, only up to the event amount.

Run pa630505.sql from the new APPL_TOP to correct the Billed flag for expenditure 
items that were incorrectly marked for scheduled payment events.

UNIX:
$ cd $PA_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @pa630505.sql

Windows:
C:\> cd %PA_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @pa630505.sql

The script prompts for Start Project Number and End Project Number. 

To reduce processing time, a Start Project Number and an End Project Number to run 
the script for a range of projects. Make sure that you run the script for all projects.

Oracle Grants Accounting Tasks
Perform the following Oracle Grants Accounting tasks.

Step 1  Verify AutoAccounting rules
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Additional Information: See Client Extensions in Oracle Projects 
User’s Guide.

Requirement Explanation

Reference manual? No

Do before using? Oracle Projects

TUMS Step Key? PA_CORRECT_FIFO

Task List Status Responsibility

1. Verify AutoAccounting rules Conditionally 
Required

Technical Specialist / Applications Specialist (Grants Accounting)

2. Set up AutoAccounting for 
Burden transactions

Required Technical Specialist / Applications Specialist (Grants Accounting)

Requirement Explanation

Reference manual? Oracle Grants Accounting User’s Guide

Do before using? Grants Accounting

TUMS Step Key? GMS_VERIFY_ACCTG_RULES_AWARD_INFO_SQL
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Grants Accounting (formerly known as Grants Management), Award ID is now stored 
in a separate table (GMS_AWARD_DISTRIBUTIONS), and no longer in the 
ATRIBUTE1 column in the PA_EXPENDITURE_ITEMS_ALL table. If you referred to 
the ATTRIBUE1 column from PA_EXPENDITURE_ITEMS_ALL in any of the 
AutoAccounting Rules SQL statements, change the SQL to reference the AWARD_ID 
column in the GMS_AWARD_DISTRIBUTIONS table instead.

Step 2  Set up AutoAccounting for Burden transactions
This task is Required. It applies to Release 10.7 upgrades.

Set up the AutoAccounting rules for the Burden Cost account and Burden Cost 
Clearing account:

1. Navigate to the Assign AutoAccounting Rules window (Setup > AutoAccounting 
> Assign Rules).

2. In the Function Name field, select Burden Cost Account, and choose Find. View 
the associated function transactions in the Function Transactions region.

3. Check the Enabled check box to enable the appropriate function transaction 
names. Enter segment rule pairings to set up the account. Save your work.

4. Repeat these steps for the Burden Cost Clearing function.

Human Resources
Review this section and complete only the tasks for the Oracle Human Resources 
products you have installed.

Oracle Payroll Tasks
Perform the following Oracle Payroll tasks.

Step 1  Run the exchange rate migration script    
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Note: See Grants Accounting eTRM (Electronic Technical Reference 
Manual) for more information.

Requirement Explanation

Reference manual? Oracle Grants Accounting User’s Guide; Oracle Projects User’s Guide

Do before using? Grants Accounting

TUMS Step Key? GMS_SETUP_AUTOACCTG_BURDEN_TXACTS

Note: For information on legislation data, see Post-install Steps, 
Implementing Oracle HRMS or the HRMS online help.

Task List Status Responsibility

1. Run the exchange rate migration script Conditionally Required Database Administrator

2. Associate a set of books with an organizational payment 
method

Conditionally Required Application Specialist (HR)
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In prior releases, exchange rates were stored in the Oracle Payroll exchange rates table 
(PAY_EXCHANGE_RATES_F). They are now stored in the Oracle General Ledger (GL) 
exchange rates system.

If you use exchange rates, migrate the existing exchange rates from Payroll to General 
Ledger by running the following script:

UNIX:
$ cd $PAY_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @pyrtmig.sql

Windows:
C:\> cd %PAY_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @pyrtmig.sql

From the list of Business Groups, select one to migrate and enter its ID. From the list of 
payrolls for which exchange rates exist, select the master payroll for this Business 
Group. To exit, leave blank and press Enter. 

An exchange rate for a given date may exist on different payrolls. To prevent this 
occurrence in GL, existing rates for a given date are overwritten by the new rate. The 
master payroll is the last payroll rate to be migrated, so the master rate takes 
precedence for rates on different payrolls. 

Select a Conversion Type for the rates to be created. You cannot select the standard GL 
types, such as Corporate or Spot, to avoid conflict with rates created by other 
applications. The Conversion Type must begin with HR. If the name you enter does 
not exist, a new Conversion Type is created.

Enter Y to continue. The system reports the number of rows processed, and the error 
and rate details of rows that failed.

Step 2  Associate a set of books with an organizational payment method
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

This step is required only if your payroll implementation has Cash Management 
installed. For more information, see Accounting Reference Information for Cash 
Management Integration, Implementing Oracle HRMS.

Requirement Explanation

Reference manual? No

Do before using? Oracle Human Resources

TUMS Step Key? PER_RUN_EXCHNGE_RATE_MIGRATION

Note: You do not need Oracle GL in order to make use of the new 
exchange rate entry form. 

Requirement Explanation

Reference manual? Using Oracle HRMS: The Fundamentals

Do before using? Oracle Human Resources

TUMS Step Key? PER_ASS_SOB_ORG_PAYMENT
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Oracle Time and Labor Tasks
Perform the following Oracle Time and Labor tasks.

Step 1  Determine corrective actions for Time and Labor 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Run the OTLR Business Group Update report to determine if further actions are 
necessary to use Oracle Time and Labor functionality. Business decisions about which 
actions are necessary must be made at this time before you can correctly update the 
data.

 From the Oracle Time and Labor responsibility, run the report from the Processes and 
Reports menu. The messages in the report are further explained in Output Sample For 
the OTLR Business Group Update Report on OracleMetaLink (Doc ID 235050.1). Some 
report messages are informational, and some require action. If an action is indicated, 
perform it as described, then re-run the report. Repeat this cycle until no corrective 
action messages are reported. 

Oracle Labor Distribution Tasks
Perform the following tasks for Oracle Labor Distribution.

Step 1  Determine corrective actions
This step is Required. It applies to Release 10.7 or 11.0 upgrades.

Run the Labor Distribution Upgrade Invalid Objects report to determine any Labor 
Distribution tables that have invalid HRMS business group IDs or GL Sets of Books 
IDs after the upgrade.

The report output lists the Labor Distribution tables where the HRMS business group 
or GL Sets of Books could not be upgraded, and have been assigned a value of -999. 
Data that corresponds to these records will not be accessible through the application.

Run the report from Processes and Reports menu using the Labor Distribution 
Superuser responsibility. Data issues can be caused by inconsistent data prior to 
running the 11.5.10 upgrade. If there are issues, examine them individually to 
determine whether corrective action is required. The messages in the report are further 

Task List Status Responsibility

1. Determine corrective actions for Time and Labor Required Applications Specialist

Requirement Explanation

Reference manual? No

Do before using? Oracle Time and Labor

Task List Status Responsibility

1. Determine corrective actions Required Application Specialist

Requirement Explanation

Reference manual? No

Do before using? Oracle Labor Distribution
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explained in Output Sample for Labor Distribution Upgrade Invalid Objects report on 
OracleMetaLink (Doc ID 270447.1).

After you complete the required actions, re-run the report. Repeat the cycle until no 
more corrective action messages are reported.

Oracle Learning Management Tasks
Perform the following tasks for Oracle Learning Management.

Step 1  Verify Data Migration Error Log report
This step is Required. It applies to Release 10.7 or 11.0 upgrades.

The Learning Management upgrade requires data migration. The Upgrade Error Log 
report is automatically submitted during the upgrade and must be reviewed to 
determine if further actions are required.

Any actions identified require a business decision to correctly upgrade the data. 
Follow the instructions in the Guide to the OTA Classic Upgrade Report  on 
OracleMetaLink (Doc ID 269571.1) to successfully complete the upgrade.

Manufacturing
Review this section and complete only the tasks for the Oracle Manufacturing products 
you have installed.

Oracle Cost Management Tasks
Perform the following Oracle Cost Management tasks.

Step 1  Verify balances in WIP Value reports
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Task List Status Responsibility

1. Verify Data Migration Error Log report Required Application Specialist

Requirement Explanation

Reference manual? No

Do before using? Oracle Learning Management

Note: Oracle Learning Management was known as Oracle 
Training Administration in previous releases.

Task List Status Menu Responsibility > Function / Responsibility

1. Verify balances in WIP Value 
reports

Recommended Manufacturing/Distribution Manager > Cost/Application 
Specialist (Cost Management and/or Inventory)

2. Define default material 
subelement – Average Costing

Conditionally Required Manufacturing/Distribution Manager > Cost/Application 
Specialist (Inventory or Cost Management)

3. Define Average Rates cost 
type – Average Costing

Conditionally Required Manufacturing/Distribution Manager > Cost/Application 
Specialist (Inventory or Cost Management)
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Follow the instructions in Step 2 of the Oracle Cost Management Tasks in Category 3 
to run this report. Compare the balances from this report with the balances from the 
Category 3 report.

Step 2  Define default material subelement – Average Costing
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you have defined this subelement previously, omit this step. If you are using Oracle 
Project Management, as the Manufacturing and Distribution Manager, choose Cost. 
Navigate to the Material Subelements window (Setup > Subelements > Material).

Step 3  Define Average Rates cost type – Average Costing
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you have previously defined average rates cost types, you can omit this step. This 
cost type supports material overhead and WIP resources. To define Average Rates 
costs types, navigate to Setup > Cost Types.

Oracle MRP/Supply Chain Planning Tasks
Perform the following Oracle MRP/Supply Chain Planning tasks.

Step 1  Define sales orders history cutoff date
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? Oracle Cost Management User’s Guide; Oracle Inventory User’s Guide

Do before using? Oracle Cost Management, Inventory, or WIP

Requirement Explanation

Reference manual? Oracle Cost Management User’s Guide; Oracle Inventory User’s Guide

Do before using? Oracle Cost Management

TUMS Step Key? CST_DEFINE_AVERAGE_COSTING

Additional Information: See Defining Subelements in Oracle Cost 
Management User’s Guide.

Requirement Explanation

Reference manual? Oracle Cost Management User’s Guide; Oracle Inventory User’s Guide

Do before using? Oracle Cost Management

TUMS Step Key? CST_DEFINE_AVERAGE_RATES

Additional Information: See Defining Cost Types in Oracle Cost 
Management User’s Guide.

Task List Status Responsibility

1. Define sales orders history cutoff date Conditionally Required Application Specialist (Master Scheduling/MRP 
and Supply Chain Planning)

2. Start the Planning Manager Required Application Specialist (Master Scheduling/MRP 
and Supply Chain Planning)
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Set the MRP:Old Sales Orders Cutoff Days profile option to specify a previous date to 
be used as a cutoff for sales orders history. The system creates history from the current 
date back to the date you specify. If you do not provide a value for this profile option, 
the system uses 9999 — sales history is reported from the current date back 9999 days.

Then, run MRPCLNUP.sql to bring up data from Order Management to Master 
Scheduling/MRP and Supply Chain Planning for forecast consumption and planning 
of sales order demand based on the MRP:Old Sales Orders Cutoff Days.

UNIX:
$ cd $MRP_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @MRPCLNUP.sql

Windows:
C:\> cd %MRP_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @MRPCLNUP.sql

Step 2  Start the Planning Manager
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

The Planning Manager performs many tasks that require processing rows in an 
interface table, such as forecast consumption, master production schedule 
consumption, forecast interface load, schedule interface load, and master demand 
schedule relief. After the upgrade, rerun the MPS, MRP, and DRP plans in order to 
review planning information.

1. Navigate to the Planning Manager window (Setup > Planning Manager).

2. Enter the processing interval for the Planning Manager and click Start.

Logistics
Review this section and complete only the tasks for the Oracle Logistics products you 
have installed.

Oracle Inventory Tasks
Perform the following Oracle Inventory tasks.

Requirement Explanation

Reference manual? Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide

Do before using? Master Scheduling/MRP and Supply Chain Planning

Requirement Explanation

Reference manual? Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide

Do before using? Master Scheduling/MRP and Supply Chain Planning

Additional Information: See Starting the Planning Manager and 
Planning Manager in Oracle Master Scheduling/MRP and Oracle 
Supply Chain Planning.
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Step 1  Review and correct organization default accounts - INV   
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Review and correct, as necessary, organization default accounts — sales and expense.

1. As the Manufacturing and Distribution Manager, choose Inventory. Navigate to 
the Organization Parameters window (Setup > Organizations > Parameters) and 
select the Costing Information tabbed region.

2. Update default account information and save your work.

Step 2  Verify totals in inventory valuation reports - INV  
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Run the same inventory valuation reports that you ran in Step 3 of the Oracle 
Inventory Tasks in Chapter 3 (Elemental Value, Subinventory Value, and if you use 
intransit, the Intransit Value), using the same sort options with the default Release 11i 
parameters. 

The totals by subinventory, subinventory account, cost element, and report totals 
should match. If they do not, compare the reports for any quantity or value 
differences, and proceed accordingly. Contact Oracle Support Services if you are 
unable to balance the reports.

Order Management
Review this section and complete only the tasks for the Oracle Order Management 
products you have installed.

Oracle Order Management Tasks
Perform the following Oracle Order Management tasks.

Task List Status
Menu Responsibility > Function / 
Responsibility

1. Review and correct organization 
default accounts - INV

Recommended Manufacturing and Distribution Manager > 
Inventory/Application Specialist (Inventory)

2. Verify totals in inventory valuation 
reports - INV

Recommended Manufacturing and Distribution Manager > 
Cost/Application Specialist (Inventory) 

Requirement Explanation

Reference manual? Oracle Inventory User’s Guide

Do before using? Oracle Inventory

Additional Information: See Organization Parameters Window in 
Oracle Inventory User’s Guide.

Requirement Explanation

Reference manual? Oracle Inventory User’s Guide

Do before using? Oracle Inventory
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Step 1  Set up responsibilities for order creation/manipulation
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

AutoUpgrade creates ontupg48.lst. It lists the FND_USER(created_by)/Org 
combinations on all open headers and lines. The list is located in $APPL_
TOP/admin/<SID>/out (UNIX) or %APPL_TOP%\admin\<SID>\out (Windows), 
where <SID> is the value of the ORACLE_SID or TWO_TASK.

Creating the list manually:
If you cannot find this file, run ontupg48.sql manually. The list file (ontupg48.lst) is 
created in the current directory.

UNIX:
$ cd $ONT_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @ontupg48.sql

Windows:
C:\> cd %ONT_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @ontupg48.sql

Then, follow these steps:

1. Set up one (or more) OM (or non-OM) responsibilities for order 
creation/manipulation for every organization. At a minimum, set the ORG_
ID(MO: Operating Unit) profile on these responsibilities (in a multi-org 
environment). From the System Administrator responsibility, choose Profile > 
System. 

2. Assign appropriate responsibilities to each FND_USER based on the listing in 
ontupg48.lst. From the System Administrator responsibility, choose Security > 
User > Define. If, for a given FND_USER, there is more than one responsibility 
pointing to the same organization, set the OM:Context Responsibility for 
Upgraded Orders profile option to Yes on only one responsibility. This responsibility, 
the application tied to it, and the User (who created the Order or line), are used to 
set application context for Upgraded Orders and Lines as they are processed (in 
the background).

Task List Status Responsibility

1. Set up responsibilities for order 
creation/manipulation

Required Applications Specialist (Order Management/Shipping)

2. Review upgraded transaction types Required Applications Specialist (Order Management)

3. Set up processing constraints Required Applications Specialist (Order Management)

4. Set up flexfield definitions Required System Administrator

5. Set up Workflow Notification approver 
and update Workflow item attributes

Required Applications Specialist (Order Management/Shipping)

6. Generate and review upgrade error 
report

Recommended System Administrator/Applications Specialist (Order 
Management)

7. Review Pricing upgrade errors Recommended System Administrator/Applications Specialist (Order 
Management)

Requirement Explanation

Reference manual? Oracle Order Entry/Shipping User’s Guide

Do before using? Order Entry/Shipping
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For example: There are 4 distinct users who have access to 3 distinct operating units in 
which they have created orders or lines.

You would create 3 new OM or non-OM responsibilities (if you plan to use a custom 
application on top of OM). Since this example is multi-org, set the MO: Operating Unit 
profile option to the appropriate value on each of these new responsibilities. And, set 
the OM:Context Responsibility for Upgraded Orders to Yes to flag each one for use in 
the cycle history upgrade. Assign these new responsibilities appropriately to the 4 
users so that they have access to the same organizations that they did in the previous 
release. This results in only one flagged responsibility per Operating Unit for each of 
those 4 users. This responsibility, and the application tied to it, are used to set 
application context for Upgraded Orders and Lines.

3. Validate the responsibilities settings for the user/org combinations you created. 

UNIX:

$ cd $ONT_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @ontupg49.sql

Windows:

C:\> cd %ONT_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @ontupg49.sql

If you find errors in the report (ontupg49.lst), correct the settings and re-run the 
script to make sure the settings are correct.

Step 2  Review upgraded transaction types 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

1. Review the upgraded order and line types. Select Setup > Transaction Types > 
Define. Because the upgraded assignments cannot be used for new orders or lines, 
you must create new flow assignments.

2. Review document sequences that were upgraded (based on order number sources 
in the old release). Select Setup > Documents > Define.

User ID Name Org ID Organization

1894 NDSMITH 498 Vision ADB

1894 NDSMITH 204 **US** Vision Operations US

1737 ECLARKE 600 Vision Project Manufacturing

1001 VISION 204 **US** Vision Operations JS

2501 DMARTIN 600 Vision Project Manufacturing

Note: You must correct errors in ontupg49.lst before you complete 
the next step in order to process affected orders/lines.

Requirement Explanation

Reference manual? Oracle Order Management User’s Guide

Do before using? Order Management
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3. Review the document categories that were upgraded (based on order types in the 
old release). Select Setup > Documents > Categories.

4. Review the document sequence assignments that were upgraded (based on the 
order number source assignments in the old release). Select Setup > Documents > 
Assign.

Step 3  Set up processing constraints 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

To set up processing constraints required for the OM entities, select Setup > Rules > 
Security > Processing Constraints.

Step 4  Set up flexfield definitions
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

The upgrade automatically moves data from descriptive flexfield segments defined in 
the Order Entry tables to new tables in Order Management and registers new flexfields 
under Order Management for the new tables. To use this descriptive flexfield data, 
define and enable the flexfields according to your business needs. Select Application > 
Flexfield > Descriptive > Segments.

Step 5  Set up Workflow Notification approver and update Workflow item 
attributes
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Oracle Order Management converts Approval Actions to workflow Notification 
Activities during the upgrade. The OM:Notification Approver profile option 
determines who receives these notifications. To set up this process:

Set OM:Notification Approver
Set the value at any level to the desired Application Responsibility or User workflow 
role. If Order Management cannot find a value for this profile option, it sends approval 
notifications to SYSADMIN.

Requirement Explanation

Reference manual? Oracle Order Management User’s Guide

Do before using? Order Management

Additional Information: See Oracle Order Management User’s Guide.

Requirement Explanation

Reference manual? Oracle Order Management User’s Guide

Do before using? Order Management

Requirement Explanation

Reference manual? Oracle Order Management User’s Guide

Do before using? Order Management
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Update Workflow Item attributes
Run ontup255.sql to update Workflow Item attributes. This script sets the following 
workflow item attributes for all open Order Headers and Lines: Responsibility ID, 
Application ID, Notification Approver.

UNIX:
$ cd $APPL_TOP/ont/11.5.0/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @ontup255.sql

Windows:
C:\> cd %APPL_TOP%\ont\11.5.0\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @ontup255.sql

The Notification Approver item attribute derives its value from the profile option 
OM:Notification Approver. When a deferred flow is processed, the Workflow 
Background Engine sets the application context using the Responsibility ID, 
Application ID, and User ID workflow item attributes. The User ID workflow attribute 
value is derived from the user who created the order or line.

Step 6  Generate and review upgrade error report
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Run the following script generate the upgrade error report:

UNIX:
$ cd $ONT_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @ontexc06.sql

Windows:
C:\> cd %ONT_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @ontexc06.sql

Review ontexc06.lst for errors and recommendations for correcting them.

Step 7  Review Pricing upgrade errors
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Note: If you have multiple Operating Units, set this profile at a 
Responsibility level to create different Approver Roles for different 
Operating Units, based on the responsibility you are currently 
assigned.

Requirement Explanation

Reference manual? Oracle Order Management User’s Guide, Oracle Shipping Execution User’s Guide

Do before using? Order Entry/ Shipping or Shipping Execution

Requirement Explanation

Reference manual? No

Do before using? Order Entry/ Shipping or Shipping Execution
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To query for a list of Pricing upgrade errors, use Setup > View Upgrade Errors. The 
query lists the modules and supplies a description of each error.

Procurement
Review this section and complete only the tasks for the Oracle Procurement products 
you have installed.

Oracle Purchasing Tasks
Perform the following Oracle Purchasing tasks.

Step 1  Activate transaction managers for Multi-Org
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

This step applies only to installations that have a Multi-Org setup.

Activate the PO Document Approval Manager and the Receiving Transaction Manager 
for each operating unit:

1. As System Administrator, navigate to the Administer Concurrent Managers 
window by choosing Concurrent > Manager > Administer.

2. Choose PO Document Approval Manager and then choose Activate. Choose 
Receiving Transaction Manager and then choose Activate. (If you don’t see an 
Activate button, then the transaction manager is already activated.)

Step 2  Upgrade notifications
This task is Conditionally Required. It applies to Release 10.7 (character-mode), 
NCA, or 10SC upgrades.

Task List Status Responsibility

1. Activate transaction managers for Multi-Org Conditionally Required System Administrator

2. Upgrade notifications Conditionally Required System Administrator

3. Set MRP profile options Conditionally Required Application Specialist (Purchasing) / System 
Administrator

4. Verify and modify sourcing rules Conditionally Required Application Specialist (Purchasing) / System 
Administrator

5. Verify date formats Required Application Specialist (Purchasing) / System 
Administrator

6. Verify RMA upgrade Conditionally Required Application Specialist (Purchasing) / System 
Administrator

Requirement Explanation

Reference manual? Oracle Purchasing User’s Guide

Do before using? Purchasing in a Multi-Org setup

Concurrent Manager? Yes

Additional Information: See Purchase Order Approval Workflow, 
Requisition Approval Workflow and Receiving Transaction 
Processor in Oracle Applications Purchasing User’s Guide. See also 
Multiple Organizations in Oracle Applications.
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The Notifications Summary window replaces the Notifications window, and all 
notifications are handled by Oracle Workflow technology. Workflow uses the approval 
controls and hierarchies you’ve already defined in Purchasing to route documents for 
approval. To upgrade notifications so that Release 11i recognizes existing notifications, 
run the Upgrade Notifications to Release 11 process after you set up Purchasing.

Upgrade existing notifications only if you currently have Purchasing documents from 
Release 10.7 that are pending approval.

Before you upgrade notifications:

Be sure to:

■ Submit workflow-related processes and verify that all Purchasing documents are 
either Closed, Finally Closed, Approved, or Incomplete — there should be no In 
Process documents.

■ Reduce the number of existing notifications by responding to as many of them as 
you can. 

■ Decide whether to customize your workflow now. This upgrade updates 
notifications by routing them through whatever workflows you have now—for 
example, the default workflows included with this release of Oracle Purchasing. In 
general, only those documents that are submitted for approval after you customize 
an approval workflow are affected by that customized workflow. So, if you want 
the existing notifications to be routed according to a customized workflow, rather 
than the workflow that comes with this release of Purchasing, customize and test it 
before you perform these upgrade steps.

To upgrade existing notifications to Workflow notifications:

Complete the following steps for each operating unit.

1. Select Purchasing > Reports > Run.

2. In the Requests window, select Upgrade Notifications to Release 11 in the Request 
Name field and choose Submit Request.

3. After the process is complete (when it has changed from Pending to Completed in 
the Requests window), select it in the Requests window and choose View Output. 
If you see errors about workflow not being set up properly, see the Oracle Workflow 
Administrator’s Guide for instructions.

4. The workflow process notifies the appropriate people of errors in the upgrade. 
Document preparers and approvers can monitor these notifications in the 
Notifications Summary window and take action as necessary.

5. After all notifications are upgraded, you may want to disable the Upgrade 
Notifications to Release 11 process so that no one tries to use it later. As the System 
Administrator, uncheck the Enabled check box in the Concurrent Programs 
window.

Requirement Explanation

Reference manual? Oracle Purchasing User’s Guide

Do before using? Purchasing

TUMS Step Key? PO_UPGRADE_NOTIFICATIONS

Additional Information: See Viewing and Responding to 
Notifications and Approval Workflows in Oracle Applications 
Purchasing User’s Guide.
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Step 3  Set MRP profile options
This task is Conditionally Required. It applies to Release 10.7 character-mode 
upgrades.

In Step 1 of the Oracle Purchasing Tasks in Chapter 3, you could not modify the 
default profile option values for MRP:Default Sourcing Assignment Set and 
MRP:Sourcing Rule Category Set for a character-based system. Provide values for 
these profile options now, before you continue with the next step.

Step 4  Verify and modify sourcing rules
This task is Conditionally Required. It applies to Release 10.7 character-mode, NCA, 
or 10SC upgrades.

If you did not use AutoSource Rules in Release 10.7, omit this step. 

AutoUpgrade converted all existing AutoSource rules to the enhanced sourcing rules 
and Approved Supplier List (ASL) entries. Specifically, it:

■ Created sourcing rule entries in the Sourcing Rule window in Purchasing, using 
the percentage splits you previously defined in the AutoSource Rules window.

■ Created global ASL entries, using the previous AutoSource rules.

■ Assigned a supplier status of New to all suppliers in the Approved Supplier List 
window.

■ Upgraded source documents with current effective dates, as well as dates that 
don’t become effective until a future time.

To verify or modify sourcing rules:

Use any text editor to check the upgrade.out file for errors that might have occurred 
during the AutoUpgrade process. This file is located in $APPL_
TOP/admin/<SID>/out (UNIX), where <SID> is the value of the $ORACLE_SID or 
$TWO_TASK, in %APPL_TOP%\admin\<SID>\out (Windows), where <SID> is the 
value of the ORACLE_SID or LOCAL.

Fix errors as described in the file. Then, run the ASL Upgrade process in Purchasing. If 
there are no errors, proceed to the next step.

If you are upgrading from Release 10.7 character-mode:

Additional Information: See Concurrent Programs Window in 
Oracle Applications System Administrator’s Guide - Maintenance.

Requirement Explanation

Reference manual? No

Do before using? Purchasing

TUMS Step Key? PO_SET_MRP_PROFILE

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Maintenance

Do before using? Purchasing

TUMS Step Key? PO_VERIFY_SOURCING_RULES
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AutoUpgrade records an error in the upgrade.out file. Because the MRP profile 
options could not be set before the upgrade, run the ASL Upgrade process now. It 
performs the same upgrade of AutoSource rules as AutoUpgrade. 

1. In the Purchasing responsibility, navigate to Reports > Run and select ASL 
Upgrade in the Request Name field. In the Parameters window, enter a Supplier 
Status of New and an Upgrade Documents From option of Current and Future 
Rules. Then submit the request. New and Current and Future Rules are the only 
options supported by the ASL Upgrade process.

2. To verify that the AutoSource rules have been upgraded, open the Requisitions 
window in Purchasing and, in the Item field, enter an item number that previously 
had an AutoSource rule. Navigate to the Source Details tabbed region. If the 
correct Document Type, Document, Supplier and supplier Site appear as defaults, 
AutoSource rules have been successfully updated.

3. Disable the ASL Upgrade process. In the System Administrator responsibility, 
uncheck the Enabled check box in the Concurrent Programs window.

4. To make changes, additions, or enhancements to sourcing rules and ASL entries, 
use the Purchasing responsibility to navigate to the Define Supplier Statuses, 
Approved Supplier List, Sourcing Rule, and Sourcing Rule/Bill of Distribution 
Assignments windows.

Step 5  Verify date formats
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

During the upgrade, the REVISED_DATE column in the Purchasing tables was 
changed from a Varchar2 to a Date format, and existing date information was moved 
from the REVISED_DATE column to a temporary table TEMP_REVISED_DATE. After 
the column is converted to a Date format, the upgrade script copies the original dates 
from TEMP_REVISED_DATE back into the affected tables. The TEMP_REVISED 
DATE table still contains the original data as a backup. 

Before you run podold.sql (see Step 1 of the System Maintenance Tasks in Chapter 7), 
which drops unneeded database objects including the TEMP_REVISED_DATE table, 
review the following lists, located in $APPL_TOP/admin/<SID>/out (UNIX) or 
%APPL_TOP%\admin\<SID>\out (Windows):

po_headers_all.lst
po_headers_archive_all.lst
po_releases_all.lst
po_releases_archive_all.lst

Each file displays the format (data type) of the REVISED_DATE column and a list of 
dates in the affected table. Verify that the data type of REVISED_DATE is Date, and 
verify the dates themselves. Contact Oracle Support Services if you have problems.

Additional Information: See Concurrent Programs Window in 
Oracle Applications System Administrator’s Guide - Maintenance.

Additional Information: See Setting Up Automatic Sourcing in 
Oracle Purchasing User’s Guide.

Requirement Explanation

Reference manual? No

Do before using? Purchasing
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If the files have no output, you can create the lists manually. 

UNIX:

$ cd $APPL_TOP/admin/<SID>/out
$ sqlplus <APPS username>/<APPS password> @$PO_TOP/admin/sql/pockrvdt.sql \
  <PO username> <PO password>

Windows

C:\> cd %APP:_TOP%\admin\<SID>\out
C:\> sqlplus <APPS username>/<APPS password> @%PO_TOP%\admin\sql\pockrvdt.sql \
  <PO username> <PO password>

The output is located in $APPL_TOP/admin/<SID>/out (UNIX) or %APPL_
TOP%\admin\<SID>\out (Windows).

Step 6  Verify RMA upgrade
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you used return material authorizations (RMAs) in the previous release to authorize 
and receive customers’ returns using Oracle Order Entry and Oracle Inventory, 
complete these steps to verify the RMA upgrade.

Review status of processed transactions:

Review the following list files created during the upgrade. They are located in $APPL_
TOP/admin/<SID>/out (UNIX) or %APPL_TOP%\admin\<SID> \out (Windows).

rcv_rma_upgrade_errors.lst
rcv_rma_upgrade_success.lst

If the files contain no output, review these tables generated during the upgrade:

■ RCV_RMA_UPGRADE_SUCCESS: successfully processed transactions

■ RCV_RMA_UPGRADE_ERRORS: transactions that were not upgraded due to 
errors

The RCV_RMA_UPGRADE_SUCCESS table contains the following information:

The RCV_RMA_UPGRADE_ERRORS table contains the following information:

Requirement Explanation

Reference manual? No

Do before using? Receiving

Column Description

CREATION_DATE (DATE) Date the record was created

RUN_MODE (VARCHAR2) Indicator of whether the error was logged during the 
first upgrade (FIRST-RUN) or subsequently 
(RE-RUN)

RMA_INTERFACE_ID (NUMBER) Internal unique interface identifier from the MTL_SO_
RMA_INTERFACE table

SHIPMENT_HEADER_ID 
(NUMBER)

Shipment header identifier of the transaction 
generated in the Purchasing receiving tables
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The upgrade transfers RMA all receipt data from Inventory to Purchasing. It logs all 
errors and continues upgrading the rest of the transactions.

Fix errors:

Fix errors listed in RCV_RMA_UPGRADE_ERRORS, and re-run the RMA upgrade 
script. You can ignore errors about old or obsolete data.

UNIX:

$ cd $PO_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @rcvrmaup.sql

Windows:

C:\> cd %PO_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @rcvrmaup.sql

Public Sector
Review this section and complete only the tasks for the Oracle Public Sector products 
you have installed.

Oracle Public Sector Financials Tasks
Perform the following Oracle Public Sector Financials tasks.

Step 1  Switch to new responsibilities
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Column Description

CREATION_DATE (DATE) Date the record was created

RUN_MODE (VARCHAR2) Indicator of whether the error was logged during the 
first upgrade (FIRST-RUN) or subsequently 
(RE-RUN)

RMA_INTERFACE_ID (NUMBER) Internal unique interface identifier from the MTL_SO_
RMA_INTERFACE table

ERR_NUMBER (NUMBER)

ERR_MESSAGE (VARCHAR2)

Note: If the RCV_RMA_UPGRADE_ERRORS table or the RCV_
RMA_UPGRADE_SUCCESS table already exists (for example, if 
you re-ran the upgrade), the upgrade script assumes a re-run and 
processes only the transactions with errors from the RCV_RMA_
UPGRADE_ERRORS table.

Task List Status Responsibility

1. Switch to new responsibilities Conditionally Required Technical Specialist

Requirement Explanation

Reference manual? No
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If you use Government/Not for Profit functionality, assign all users to:

■ Public Sector General Ledger responsibilities

■ Public Sector Payables responsibilities

■ Public Sector Receivables responsibilities

Oracle U.S. Federal Financials Tasks
Perform the following Oracle U.S. Federal Financials tasks.

Step 1  Migrate data to new tables
This task is Required. It applies to Release 2.0 or 3.3 upgrades.

For Version 2.0 and 3.3, migrate U.S. Federal setup data to the new tables. Review 
fvupdata.log for errors.

UNIX:
$ cd $FV_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @fvupdata.sql

Windows:
C:\> cd %FV_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @fvupdata.sql

Marketing and Sales
Review this section and complete only the tasks for the Oracle Marketing and Sales 
products you have installed.

Oracle Sales/Oracle Sales Compensation Tasks
Perform the following tasks for Oracle Sales/Oracle Sales Compensation.

Do before using? Public Sector Financials

TUMS Step Key? PSA_ASSIGN_USER_RESPS

Task List Status Responsibility

1. Migrate data to new tables Required Technical Specialist

Requirement Explanation

Reference manual? No

Do before using? Federal Financials

TUMS Step Key? FV_MIGRATE_DATA

Task List Status Responsibility

1. Migrate FND responsibilities/profiles Required Technical Specialist

Requirement Explanation
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Step 1  Migrate FND responsibilities/profiles
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Oracle Marketing and Sales has been divided into three applications: Oracle Sales 
(OS), Oracle Sales Online (OSO), and Oracle TeleSales (OTS). If responsibilities are 
defined for product_id 279 in Release 10.7, Release 11.0.x, or Release 3i, and you want 
the users having these responsibilities to access Oracle Sales Online or Oracle 
TeleSales, you must migrate the responsibilities to the appropriate application.

The following OSM profiles are replace by new profiles. Set up the new profile options 
with the appropriate values.

Requirement Explanation

Reference manual? No

Users must log off? No

Old Profile Option New Profile Option

OSM:Access Privilege OS:Customer Access Privilege

OS:Opportunity Access Privilege

OS:Manager Update Access

OSM:Country For Promotions OSO:Default Country

OSM:Account Phone Type OSO:Default Organization Phone Type

OSM:Quote Automatic Numbering ASO:Automatic Numbering

OSM:Product Organization OM:Item Validation Organization (obsolete)*

OSM:Quote Conversion Type ASO:Quote Conversion Type

OSM:Quote Duration ASO:Quote Duration

OSM:Quote Order Entered State ASO:Default Order State

OSM:Quote Order Type ASO:Default Order Type

OSM:Debut OTS:Debug

OSM:Site Use OTS:Default Site Usage

OSM:Currency Code JTF_PROFILE_DEFAULT_CURRENCY

OSM:OFS Default Responsibility JTF_PROFILE_DEFAULT_RESPONSIBILITY

OSM:OFS Date Format ICX:Date format mask

OSM:To Do Default Priority OSO:Default Activity Priority

OSM: To Do Default Status OSO:Default Activity Status

OSM:OFS Number of Address Lines OSO:Default Address Lines

OSM:OFS Default Business Line OSO:Default Customer Category

OSM:Forecast Currency Code OSO:Default Forecast Currency

OSM:OFS Number of Rows per Worksheet OSO:Default forecast worksheet lines

OSM:OFS Forecast Calendar Default Months OSO:Forecast Calendar Month

*This profile option is obsolete. The organization now exists as a system parameter. From the 
Order Management responsibility, navigate to Setup > Parameters. Choose the organization 
from the list of values. See OracleMetaLink Doc ID 113386.1 for details. 
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Service
Review this section and complete only the tasks for the Oracle Service products you 
have installed.

Oracle Service Tasks
Perform the following tasks for Oracle Service.

Step 1  Update coverage transaction time zones
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

The actions for this task differ according to your system release level.

If you are upgrading from 3i:

Any coverage transaction group that does not have an associated time zone is 
migrated with the value in the Service:UPG Time Zone for Contracts profile. No 
further action is necessary.

If you are upgrading from 10.7 or 11.0:

Any coverage transaction group line that does not have an associated time zone 
defaults to America/Tijuana (PST). To update the time zone for these records:

1. Set up the profile option OKS:Default Time Zone with the desired value.

2. Run the following script to update the time zone profile option value:

$ cd $OKS_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @OKS00TZU.sql

Step 2  Update migrated contacts and service lines
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

During the upgrade, all contracts and service lines are migrated with seeded statuses. 
Those with a custom status are migrated with a status of ENTERED. To update these 
records to the correct status values, run the following script:

$ cd $OKS_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @OKS00STU.sql

Task List Status Responsibility

1. Update coverage transaction time zones Required Technical Specialist

2. Update migrated contacts and service lines Required Technical Specialist

3. Register Oracle Install Base Conditionally Required Technical Specialist

Requirement Explanation

Reference manual? No

Users must log off? No

Requirement Explanation

Reference manual? No

Users must log off? Yes
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Step 3  Register Oracle Install Base
This task is Conditionally Required. It applies to Release 10.7, 11.0, or 3i upgrades.

Oracle Service Install Base is now a separate product. If you used the Install Base 
features of Oracle Service before the upgrade, your data has been migrated to new 
tables under the Oracle Install Base product. Use OAM License Manager to register 
this new product so that it is recognized as active by maintenance  utilities. 

Oracle Install Base Tasks
Perform the following Oracle Install Base tasks.

Step 1  Set up the Action menu in Order Management
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

To set up Transaction Details and Maintain Systems windows as part of the Action 
menu, complete the following steps:

1. Log on to Oracle Applications with the System Administrator responsibility.

2. Choose Applications > Menu.

3. Choose View > Query by Example > Enter.

4. In the Menu field, enter the string ONT_SALES_ORDERS.

5. Choose View > Query by Example > Run. 

6. Go to the last record in the multi-record details block and choose File > New to 
create new records with the following Field Values:

■ Seq: Choose the next sequence.

■ Function: Select Install Base Transaction Details from the list of values.

Requirement Explanation

Reference manual? Oracle Applications Maintenance Procedures

Do before using? Oracle Service, Oracle Install Base, Oracle Order Management, Oracle 
Purchasing, Oracle Inventory, Oracle Work in Process, Oracle Assets, Oracle 
Field Service

Additional Information: See Registering Individual Products in 
Oracle Applications Maintenance Procedures.

Task List Status Responsibility

1. Set up the Action menu in Order Management Required Technical Specialist

2. Set up the Order Management workflow Required Technical Specialist

3. Confirm Service Fulfillment Manager Event Queue set up Required Technical Specialist

4. Create Agent users Required Technical Specialist

5. Create Business users Conditionally Required Technical Specialist

6. Schedule the Expire End Dated Instances concurrent program Required Technical Specialist

Requirement Explanation

Reference manual? Oracle Install Base Implementation Guide

Do before using? Oracle Order Management
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■ Seq: Choose the next sequence.

■ Function: Select IB Maintain Systems from the list of values

7. Save the record.

Step 2  Set up the Order Management workflow
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

To cause sales orders to interact with the Install Base for non-shippable items, run the 
background workflow in a specific sequence, or set up the sales order workflow.

To update the workflow in Workflow Builder for Fulfill-only workflows:

1. Log on to Oracle Workflow Builder on the client PC using the appsuser ID, 
password, and connect string to connect to the database.

2. Select Installed Base, OM Order Line from the Show Item Types window and 
move them to the Visible window. Click Open.

3. Select OM Order Line > Processes. Right-click the Order Line that you want to 
customize and choose Copy. Right-click again and choose Paste.

4. Enter a different internal name for the newly created process. Then, double-click 
the process to open it.

5. Click New Function on the Top icon bar.

6. Click the Item Type drop-down list, and choose Installed Base. Then, click the 
Internal Name drop-down list, and choose Install Base Interface.

7. Delete the line after the Fulfill function (the line going out from the Fulfill to the 
node after Fulfill).

8. Pull the Install Base Interface after the Fulfill function. Right-click Fulfill and drag 
it to the Install Base Interface.

9. Right-click Install Base Interface and drag it to the node after Fulfill. Choose Any 
for the option results.

10. Save the changes and exit.

To set up Order Management changes in Applications:

1. From Order Management Super User > Setups > Transaction Types, query the 
transaction type you plan to use on the sales orders.

2. Click Assign Work Flows.

3. End-date the current line type that used the seeded workflow.

4. In the Menu field, enter the string ONT_SALES_ORDERS.

5. Choose View > Query by Example > Run. 

6. Create another record with the same line type as the one that was expired, and tie 
the Customized Workflow process name created in Workflow to this line type.

Requirement Explanation

Reference manual? Oracle Install Base Implementation Guide

Do before using? Oracle Order Management
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Step 3  Confirm Service Fulfillment Manager Event Queue set up
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

Install Base is dependent on the Service Fulfillment Manager Event Manager Queue 
Service. For complete setup instructions, see Oracle Service Fulfillment Manager 
Implementation Guide. In general, the setup steps are as follows.

Installation and post-install steps (one-time only):

You must complete the Generic Service Management (GMS) post-install steps 
correctly. Otherwise, the SFM Event Manager Queue Service will not be activated. 
Contact Oracle Customer Support for a list of specific patch requirements. 

Perform manual installation step (one-time only):

SFM provides a Queue Console for the database administrator to use to see the events 
sitting in the Event Manager Queue Service. Because SFM is installed in Shared Mode 
for the Install Base, you must compile the Queue Console form manually. It is located 
in $XDP_TOP/forms/US/XDPADQCS.fmb.

Deactivate services that are not used (one-time only):

When the database administrator starts the Internal Concurrent Manager (ICM), it also 
starts SFM services registered with GSM. Because Install Base is using only the SFM 
Event Manager Queue Service, you can deactivate all other SFM services.

1. Log on to Oracle Applications with SFM System Administrator responsibility.

2. From the Navigator menu, choose Concurrent > Administer Manager.

3. Deactivate all services that appear, except for the SFM Event Manager Queue 
Service.

Ensure that transactions processed in Install Base can be serialized (one-time only):

Transactions originating from Inventory and Order Management can be processed 
concurrently in Install Base. To ensure they are processed serially:

1. Log on to Oracle Applications and navigate to System Administrator > Concurrent 
> Manager > Define.

2. Query for the Manager SFM Event Manager Queue Service.

3. Click Work Shifts, and change the processes to 1.

4. In the Parameter field, change the value of XDP_DQ_INIT_NUM_THREADS to 1 
(XDP_DQ_INIT_NUM_THREADS=1).

5. Stop and restart the SFM Event Manager Queue.

Monitor SFM Event Manager Queue Service (daily):

The database administrator can check to see if the Event Manager Queue Service is 
running from any of these locations:

■ The SFM Queue Console (provides status as well as queue size)

■ Concurrent Manager’s Administer Manager form (provides only status)

Requirement Explanation

Reference manual? Oracle Install Base Implementation Guide

Do before using? Oracle Order Management
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■ Oracle Application Manager (OAM) SFM page (HTML page used to view status 
and queue size)

Step 4  Create Agent users
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

Complete the following steps to create an agent user for an internal user with the CSI_
NORMAL_USER role and the responsibility of Oracle Install Base:

1. Log on to jtflogin as the SYSADMIN user.

2. From the Users tab, navigate to Users > Create User.

3. Select Individuals as the profile type, and enter personal information, enrollment 
information, and confirm registration.

4. Search for the user you just created and click the user name. Click Roles.

5. Using the single arrow button, move CSI_NORMAL_USER from the list box to the 
right-hand side. Click Update to assign the role to the user. 

6. Log in to Forms as the system administrator responsibility.

7. From the Navigator, select Security > User. Query for the user you created in Step 
2.

8. Add the Oracle Install Base User responsibility and any other responsibility this 
user might need.

9. Log in to jtflogin using the newly created user to set the default responsibility. You 
may also be prompted to change the password.

10. Once the first page is displayed, click Profile (above the menu bar).

11. Click Navigation Preference under Personalization in the sidebar menu.

12. Select Oracle Install Base User in the Current Responsibility drop-down list and 
again in the Default Responsibility drop-down list.

13. Click Update.

Step 5  Create Business users
This task is Conditionally Required. It applies to Release 10.7, 11.0, or 3i upgrades.

Oracle Install Base supports many permissions with specific access and update 
privileges. See Section 2.5.22, Create Business Users in the Oracle Install Base 
Implementation Guide for a complete list.

A role is a combination of permissions. Install Base ships with two pre-defined roles: 
CSI_END_USER for business users and CSI_NORMAL_USER for internal agent users. 

Requirement Explanation

Reference manual? Oracle Install Base Implementation Guide

Do before using? Oracle Order Management

Requirement Explanation

Reference manual? Oracle Install Base Implementation Guide

Do before using? Oracle Order Management
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Complete the following steps to create a business user and assign it the pre-defined 
CSI_END_USER role and the responsibility of Oracle Install Base customer.

1. Log on to jtflogin as the SYSADMIN user.

2. From the Users tab, navigate to Users > Create User.

3. Select Organization as the profile type. Enter organization information, personal 
information, enrollment selection, and confirm registration.

4. Click Pending Approvals, select the user you created in Step 2, and click Accept.

5. Click User Maintenance and query for the user you just approved. Click the 
username.

6. Click Accounts, and select all necessary accounts to be assigned to the user. Click 
Update, and then Click Roles.

7. Using the single arrow button, move CSI_END_USER from the list box to the 
right-hand side. Click Update to assign the role to the user. 

8. Log in to Forms, and switch to the system administrator responsibility.

9. From the Navigator, select Security > User. Query for the user you created in Step 
2.

10. Add the Oracle Install Base User responsibility and any other responsibilities this 
user might need.

11. Log in to jtflogin using the newly created user to set the default responsibility. You 
may be prompted to change the password.

12. Once the first page is displayed, click Profile (above the menu bar).

13. Click Navigation Preference under Personalization in the sidebar menu.

14. Select Oracle Install Base User in the Current Responsibility drop-down list and 
again in the Default Responsibility drop-down list.

15. Click Update.

Step 6  Schedule the Expire End Dated Instances concurrent program
This task is Required. It applies to Release 10.7, 11.0, or 3i upgrades.

To set instances to automatically expire (based on past due end dates), complete the 
following steps. It’s a good idea to run this program at least once a day.

1. Log on to Oracle Applications in the forms mode as the Oracle Install Base 
Administrator.

2. From the Navigator menu, choose Others > Requests to display the Submit a New 
Request window.

3. Select Single Request, and click OK. The Install Base Requests window appears.

4. From the Name list of values, select Expire End Dated Instances, and click OK.

5. In the At These Times region, click Schedule to display the Schedule window. 

Requirement Explanation

Reference manual? Oracle Install Base Implementation Guide

Do before using? Oracle Order Management
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6. Select the running schedule, and click OK. The Install Base Requests window 
appears.

7. Click Submit.
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6
Category 6 — Before Using Product Features

This chapter describes Category 6 steps — you can use the Oracle Applications 
products, but you cannot use certain features until you complete the appropriate steps. 
The feature(s) affected are listed in the summary lines following each step.

Implementation and Setup Tasks on page 6-1
System Administration Tasks on page 6-2
Application Object Library Tasks on page 6-2
Oracle Alert Tasks on page 6-5
Oracle Cash Management Tasks on page 6-6
Oracle General Ledger Tasks on page 6-7
Oracle Payables Tasks on page 6-11
Oracle Receivables Tasks on page 6-15
Oracle iPayment Tasks on page 6-16
Oracle Financials for Asia/Pacific Tasks on page 6-17
Oracle Financials Common Country Tasks on page 6-21
Oracle Financials for Europe Tasks on page 6-23
Oracle Financials for Latin America Tasks on page 6-27
Oracle Projects Tasks on page 6-27
Oracle Human Resources Tasks on page 6-28
Oracle Payroll (U.S.) Tasks on page 6-30
Oracle Inventory Tasks on page 6-31
Oracle Public Sector Financials (International) Tasks on page 6-33

All Products
Product-specific implementation or setup steps are an integral part of the upgrade. 
These steps may be needed to "turn on" new functionality added during the upgrade 
process or set up new product features. 

Implementation and Setup Tasks
Complete all implementation and setup steps to ensure the success of your system 
upgrade.

Step 1  Review product-specific documentation
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

Task List Status Responsibility

1. Review product-specific documentation Required Application Specialists
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Before you begin the Category 6 steps, review the product-specific documentation for 
the products you have installed to see if there are any implementation or setup steps 
that must be performed to "turn on" or implement new features of products that were 
added during the upgrade process.

1. Determine which products you have installed.

2. Make sure you have the product documentation for each product.

3. Review the implementation and/or setup information in the product guides.

4. Perform the steps that are appropriate for your system.

Applications Technology
All users must complete this portion of the upgrade. Complete these tasks before you 
perform the product-specific tasks.

System Administration Tasks
Complete the following System Administration tasks.

Step 1  Review user responsibility assignments 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Although user/responsibility assignments are preserved during the upgrade, the 
effective permissions granted by the seeded responsibilities, menus, functions, and 
report security groups may have changed. Use the information on the Forms or 
Security reports in the System Administrator responsibility to confirm that 
permissions granted by responsibilities continue to meet the requirements of the job 
roles (without granting more privileges than are necessary.)

Application Object Library Tasks
Complete the following Application Object Library tasks.

Requirement Explanation

Reference manual? Product-specific user’s guides

Do before using? All Oracle products

Task List Status Responsibility

1. Review user responsibility assignments Recommended System Administrator

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Security

Do before using? Reports

Additional Information: See Organizing Programs into Request 
Groups in Oracle Applications System Administrator’s Guide - Security.

Task List Status Responsibility

1. Update custom code using flexfield values in FND_
LOOKUPS

Conditionally Required Technical Specialist
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Step 1  Update custom code using flexfield values in FND_LOOKUPS    
This task is Conditionally Required. It applies to Release 10.7 upgrades.

During the upgrade, lowercase flexfield-related lookup codes in FND_LOOKUPS (and 
in the related flexfields columns in AOL tables) are replaced with new uppercase 
codes. If you have customizations that use these lookup codes (from FND_LOOKUPS 
or from the flexfield tables directly), change the customizations to use these new 
values. 

The following table shows the LOOKUP_TYPE used in FND_LOOKUPS, the 
corresponding flexfields table and columns that use the changed value, the old lookup 
value used in FND_LOOKUPS and the flexfield table, and the new value. Evaluate the 
custom code (scripts, APIs, reports, and so on) to assess whether it uses these values. 
Modify the code accordingly.

Step 2  Update custom calls to FND_DESCR_FLEX_CONTEXTS_TL
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Oracle Applications added the DESCRIPTIVE_FLEX_CONTEXT_NAME column to 
the FND_DESCR_FLEX_CONTEXTS_TL table to aid in the translation of context field 
values for descriptive flexfields. AutoUpgrade populates this column based on the 
codes in FND_DESCR_FLEX_CONTEXTS. Modify any custom code (scripts, APIs, 
reports, and so on) that accesses FND_DESCR_FLEX_CONTEXTS_TL or FND_
DESCR_FLEX_CONTEXTS to account for this new column and its values.

2. Update custom calls to FND_DESCR_FLEX_
CONTEXTS_TL

Conditionally Required Technical Specialist

3. Rename the srw directory Conditionally Required Technical Specialist

4. Copy custom forms libraries to AU_TOP Conditionally Required Technical Specialist

5. Copy custom .fmb files to AU_TOP Conditionally Required Technical Specialist

6. Convert messages for custom applications Conditionally Required Technical Specialist

7. Regenerate, recompile, and re-link custom concurrent 
program libraries

Conditionally Required Technical Specialist

Requirement Explanation

Reference manual? No

Do before using? Custom Flexfields-related code

Lookup Type Table Name Column Old Value New Value

FLEX_VALIDATION_EVENTS FND_FLEX_VALIDATION_EVENTS EVENT_CODE e O

FIELD_TYPE FND_FLEX_VALUE_SETS FORMAT_TYPE t I

FLEX_DEFAULT_TYPE FND_ID_FLEX_SEGMENTS DEFAULT_TYPE s A

FLEX_DEFAULT_TYPE FND_DESCR_FLEX_COLUMN_USAGES DEFAULT_TYPE s A

Requirement Explanation

Reference manual? Oracle Application Object Library/Workflow Technical Reference Manual

Do before using? Custom flexfields-related code

Task List Status Responsibility
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Step 3  Rename the srw directory
This task is Conditionally Required. It applies to Release 10.7 upgrades.

To accommodate the new report products used in Oracle Applications, change the 
name of the srw directory to reports for each custom application.

Step 4  Copy custom forms libraries to AU_TOP
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Copy custom forms libraries (.pll) to the resource directory under AU_TOP. Complete 
this step before regenerating custom forms.

Step 5  Copy custom .fmb files to AU_TOP
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Put copies of custom .fmb files in the $AU_TOP/forms/<language> (UNIX) or %AU_
TOP%\forms\<language> (Windows). Keep the original copies of the forms 
$COMMON_TOP/forms/<language> (UNIX) or %COMMON_TOP%\forms\ 
<language> (Windows) in a safe place.

Step 6  Convert messages for custom applications
This task is Conditionally Required. It applies to Release 10.7 character-mode 
upgrades.

If you defined custom Message Dictionary messages using a custom application name 
in the character-mode Define Messages form (because character-mode custom 
applications use Message Dictionary), convert them to GUI format to continue using 
messages.

The FNDMDCVT program copies all of the messages for the application in the FND_
MESSAGES table, concatenates the extended message text on the message text, and 
removes the special formatting codes in the old messages to produce plain text. It then 
inserts the new messages into the FND_NEW_MESSAGES table. If a message with 
that name, language, and application already exists in the FND_NEW_MESSAGES 

Requirement Explanation

Reference manual? No

Do before using? Custom applications

Requirement Explanation

Reference manual? No

Do before using? Custom applications

Requirement Explanation

Reference manual? No

Do before using? Custom applications

Requirement Explanation

Reference manual? No

Do before using? Custom applications
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table, the insert fails and the previously existing row is left alone. Only U.S. language 
messages are transferred by this converter.

To convert messages, follow these steps, where <APPL_SHORT_NAME> is the 
application short name for which you want messages converted. Run this script once 
for each custom application.

1. Make sure that FND_TOP/bin is in your PATH, and run FNDMDCVT from the 
command prompt:

FNDMDCVT <APPS username>/<APPS password> 0 Y <APPL_SHORT_NAME>

2. From the Application Developer responsibility, navigate to Application > 
Messages. Query the messages for the application and verify that they were 
converted successfully. Adjust special formatting, as necessary. For example, 
delete old formatting text that was incorrectly entered.

3. To generate the Message Dictionary runtime message file, run FNDMDGEN for 
each custom application, where LANG_SHORT_NAME is the language short 
name (such as US) and APPL_SHORT_NAME is the application short name for 
which you want the message file generated: 

FNDMDGEN <APPS username>/<APPS password> 0 Y <LANG_SHORT_NAME> \
  <APPL_SHORT_NAME> DB_TO_RUNTIME

Step 7  Regenerate, recompile, and re-link custom concurrent program libraries
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

To accommodate the new form of concurrent program libraries, regenerate, recompile, 
and re-link the customized concurrent program libraries. 

1. From the Application Developer responsibility, navigate to the Concurrent 
Program Libraries form (Concurrent > Library).

2. Query the custom library and press Generate.

This submits a concurrent request that creates a file named <libraryname>.c in the 
lib directory under the application product tree to which the program library 
belongs. For example, library CUSTLIBR, a custom program (CUSTLIBR.c) 
registered under application Custom Application with a basepath XXCST_TOP, is 
generated in the lib directory under XXCST_TOP.

3. Compile the file using $FND_TOP/usrxit/Makefile (UNIX) or %FND_
TOP%\usrxit\Makefile (Windows) and relink using adrelink.

4. Place the executable in the /bin directory for the appropriate product.

Oracle Alert Tasks
Complete the following Oracle Alert tasks.

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Maintenance

Do before using? Custom concurrent program libraries

Additional Information: See Concurrent Programs in Oracle 
Applications System Administrator’s Guide - Maintenance. See also 
Oracle Applications Developer’s Guide.
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Step 1  Associate organization names with custom Alert definitions 
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Manually update custom alerts that you want to assign to a particular organization:

1. As the Alerts Manager, navigate to the Alerts form (Alert > Define) and query the 
definition.

2. Choose Alert Details, then display the Installations tabbed region in the Alert 
Details window. 

3. Enter the ORACLE ID and organization name that you want to run this alert 
against. 

4. Make sure you check Enabled before you save your changes.

Step 2  Re-create event alert triggers in custom schemas
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Re-create custom alerts dropped in Step 1 of the Oracle Alert Tasks in Chapter 3.

Financial
Review this section and complete only the tasks for the Oracle Financial products you 
have installed.

Oracle Cash Management Tasks
Complete the following Oracle Cash Management tasks.

Step 1  Reinstall custom Reconciliation Open Interface objects
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Task List Status Responsibility

1. Associate organization names with custom Alert definitions Conditionally Required System Administrator

2. Re-create event alert triggers in custom schemas Conditionally Required Database Administrator

Requirement Explanation

Reference manual? Oracle Alert User’s Guide

Do before using? Alert definitions

Requirement Explanation

Reference manual? No

Do before using? Custom Alerts

Task List Status Responsibility

1. Reinstall custom Reconciliation Open Interface objects Conditionally Required Technical Specialist

Requirement Explanation

Reference manual? Financials Open Interface Reference, Oracle Cash Management User’s Guide

Do before using? Reconciliation Open Interface
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Perform this step only if you have implemented and customized the Reconciliation 
Open Interface. 

In Step 1 of the Oracle Cash Management Tasks in Chapter 1, you backed up the 
customized copies of CE_999_INTERFACE_V (view), and CE_999_PKG (package). 
Reinstall these customized copies to the database in the APPS account.

Oracle General Ledger Tasks
Complete the following Oracle General Ledger tasks.

Step 1  Preserve GL account combinations affected by the Segment Value 
Inheritance program 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

You can automatically replicate any changes you make to segment value attributes 
(Detailed Posting, Detailed Budgeting, Effective Date Ranges, and the Enabled flag) to 
all account combinations that contain that segment value by running the Segment 
Value Inheritance program. For example, if you disable a particular cost center in the 
chart of accounts, you can also require that all account combinations that contain that 
cost center be automatically disabled. 

To protect specific account combinations from being affected by this program:

1. In the GL Accounts window (Setup > Accounts > Combinations), find the account 
combinations you want to preserve.

2. Select the Preserved check box for all combinations that you want to save and save 
your work.

TUMS Step Key? CE_999_RESTORE

Task List Status Responsibility

1. Preserve GL account combinations affected by the Segment 
Value Inheritance program

Required Application Specialist (GL)

2. Ensure that account segment values use correct account type Conditionally Required Technical Specialist

3. Review period rates Conditionally Required Database Administrator/ 
Application Specialist (GL)

4. Review AutoPost criteria Conditionally Required Application Specialist (GL)

5. Define GIS conversion rates and rate types Conditionally Required Application Specialist (GL)

6. Verify program submission parameters for Mass Funds 
Check/Reservation

Conditionally Required Application Specialist (GL)

7. Set function security for journal posting and reversing 
functions

Recommended System Administrator/ 
Application Specialist (GL)

8. Set up Intercompany Balancing Recommended Application Specialist (GL)

Requirement Explanation

Reference manual? Oracle General Ledger User’s Guide

Do before using? Segment Value Inheritance program

TUMS Step Key? GL_PRESERVE_ACC_COMBINATIONS

Requirement Explanation
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Step 2  Ensure that account segment values use correct account type    
This task is Conditionally Required. It applies to Release 10.7 upgrades.

In Release 10.7, the natural account type for summary accounts was automatically set 
to Owners’ Equity. Now, summary accounts inherit the account type of their account 
segment value. You must ensure that all the account segment values—even parent 
values—have the correct account type. Otherwise, summary accounts will be 
incorrectly classified.

For example, if you define a parent account value (1999) — the total of all asset 
accounts — set the account type for the parent segment value 1999 to Asset. When you 
subsequently define a summary account using this segment value, the summary 
account is correctly defined as an asset.

Correctly setting the account type for account segment values ensures that the 
summary balances are displayed correctly if you choose to perform additional analysis 
using Oracle Financial Analyzer. To ensure that account segment values use the correct 
account type, complete the following steps.

1. In the Key Flexfields Segments window (Setup > Financials > Flexfields > Key > 
Segments), unfreeze all account structures that reference the account segment.

2. In the Value Sets window (Setup > Financials > Flexfields > Validation Sets), query 
the value set Name for the natural account segment. Optionally, query the 
segment values that you use for summary accounts. When you have entered the 
query values, choose Find. The Segment Values window appears.

3. Choose Hierarchy, Qualifiers from the pop list.

4. For each account segment value you use in the summary accounts, open the 
Segment Qualifiers window and review the setting for Account Type.

5. Change the account types and save your work.

6. Use the Key Flexfields Segments window to refreeze all account structures that 
reference the account segment.

7. Propagate the changes you made to Oracle General Ledger:

UNIX:

Requirement Explanation

Reference manual? Oracle General Ledger User’s Guide

Do before using? Summary Accounts, Financial Analyzer Integration

TUMS Step Key? GL_REVIEW_ACC_TYPES

Note: This step is required if you use summary accounts in General 
Ledger and use Oracle Financial Analyzer to analyze GL account 
information. This step is highly recommended if you use summary 
accounts but not Financial Analyzer.

Note: If the parent segment value is T, account type is not 
meaningful and does not need to be changed. If you use dependent 
account segments and have difficulty completing this step, contact 
Oracle Support Services.



Financial

Category 6 — Before Using Product Features 6-9

$ cd $GL_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @gluacsum.sql

Windows:

C:\> cd %GL_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @gluacsum.sql

Step 3  Review period rates    
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Run the Maintain Euro Period Rates program for each set of books that satisfies both of 
the following criteria:

■ The set of book’s functional currency is the euro or a currency participating in the 
Economic and Monetary Union, or period rates have been entered between the set 
of book’s functional currency and the euro.

■ The period containing January 1, 1999 is open or can be entered in the future for 
that set of books, or the budget year containing January 1, 1999 is open for a 
budget in that set of books.

From the General Ledger responsibility for a specific set of books:

1. Navigate to Reports > Request > Standard.

2. Choose to submit a single request. 

3. Select Program - Maintain Euro Period Rates and click Submit.

Step 4  Review AutoPost criteria
This task is Conditionally Required. It applies to Release 10.7 upgrades.

You use AutoPost criteria to automatically post journal batches that have specific 
combinations of journal source, period, and account type. In previous releases, you 
defined only one set of criteria for AutoPost, and you had to redefine it in order to 
change the priorities of the set of components. 

If you used AutoPost and defined criteria in Release 10.7, you can now define multiple 
AutoPost criteria per set of books, and then schedule AutoPost to run at different 
times and submission intervals for each criteria set you have defined.

Requirement Explanation

Reference manual? Oracle General Ledger User’s Guide

Do before using? Period Rates

TUMS Step Key? GL_REVIEW_PERIOD_RATES

Note: Do not perform this step if you have applied the minipacks 
for Release 11.02 or 11.03.

Requirement Explanation

Reference manual? Oracle General Ledger User’s Guide

Do before using? AutoPost

TUMS Step Key? GL_REVIEW_AUTOPOST_CRITERIA
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During the upgrade, the AutoPost criteria you have defined are grouped in a criteria 
set (called Standard) for each set of books. Review this criteria, and then submit and 
schedule the AutoPost runs using the Submit Request window. Provide the Criteria 
Set name as a run parameter.

Step 5  Define GIS conversion rates and rate types   
This task is Conditionally Required. It applies to Release 11.0 upgrades.

In earlier releases, GIS subsidiaries could use either period rates or daily rates when 
transferring foreign currency journals. Now, GIS subsidiaries use only daily rates. 
Therefore, you must specify conversion rate types and daily conversion rates for each 
of the subsidiaries.

To define conversion rate types:
1. In the Conversion Rate Types window (Setup > Currencies > Rates > Types), enter 

a Name and Description for the new conversion rate type.

2. Save your work.

To define conversion rates:
1. In the Daily Rates window (Setup > Currencies > Rates > Daily), enter the From 

Currency — the currency you want to convert from using the rates you enter. 
General Ledger automatically displays the functional currency for the set of books 
as the To Currency — the currency you want to convert to.

2. Enter the Conversion Date and Type.

3. Enter the conversion rate and save your work.

Step 6  Verify program submission parameters for Mass Funds 
Check/Reservation    
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Perform this step if you previously used Mass Approvals (renamed Mass Funds 
Check/Reservation in Release 11i) in Release 10.7.

Additional Information: See Posting Journal Batches 
Automatically in Oracle General Ledger User’s Guide.

Requirement Explanation

Reference manual? Oracle General Ledger User’s Guide

Do before using? Global Intercompany System (GIS)

TUMS Step Key? GL_DEFINE_GIS_RATES

Note: Set the profile option Daily Rates Window: Enforce Inverse 
Relationship During Entry to Yes to have the rates displayed in 
both columns to show the inverse relationship.

Requirement Explanation

Reference manual? Oracle General Ledger User’s Guide

Do before using? Mass Funds Check/Reservation program

TUMS Step Key? GL_VERIFY_MASS_FUNDS_SUBMISSION
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Use the Mass Funds Check/Reservation program to check or reserve funds for 
unposted journal batches. In Release 10.7, GL used the Automatic Posting options to 
prioritize the funds check and reservation. You must now specify the AutoPost criteria 
set as a parameter when you run Mass Funds Check/Reservation. If you have used 
Standard Request Submission to set the program to run at specific intervals, cancel this 
setting and create a new one. Enter new program parameters and specify an 
appropriate AutoPost criteria set.

Step 7  Set function security for journal posting and reversing functions    
This task is Recommended. It applies to Release 10.7 upgrades.

In Release 10.7, function security for journal posting in the Enter Journals and 
Encumbrances windows was enabled with the profile option Journals: Allow Posting 
During Journal Entry.

Use the Oracle Applications standard Function Security features in System 
Administration to restrict user access to journal posting and reversing functions. If you 
do not specifically exclude them from selected responsibilities, all users have access to 
Enter Journals: Post and Enter Journals: Reverse.

Step 8  Set up Intercompany Balancing 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

If you have previously designed your account structure with an additional segment 
that uses the Balancing Segment value set, you have a one-time opportunity to assign 
the Intercompany segment qualifier to this segment. 

For additional information, see: Accounting for Multiple Companies Using a Single Set 
of Books, Setting Up General Ledger > Designing Your Accounting Flexfield, Setting 
Up General Ledger > Defining Intercompany Accounts, Oracle General Ledger User’s 
Guide.

Oracle Payables Tasks
Complete the following Oracle Payables tasks.

Additional Information: See Running the Mass Funds 
Check/Reservation Program in Oracle General Ledger User’s Guide.

Requirement Explanation

Reference manual? Oracle General Ledger User’s Guide

Do before using? Enter Journals

TUMS Step Key? GL_SET_FUNCTION_SECURITY

Additional Information: See Overview of Function Security in 
Oracle Applications System Administrator’s Guide - Security.

Requirement Explanation

Reference manual? Oracle General Ledger User’s Guide

Do before using? Intercompany Balancing

TUMS Step Key? GL_SETUP_INTERCOMPANY_BALANCING
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Step 1  Set up Offset taxes
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform this step only if the previous installation had default Offset taxes set at the 
supplier site. Offset taxes do not default to new distributions unless you perform this 
step.

The default Offset tax is now associated with a Sales or User-defined tax. 
AutoUpgrade automatically enabled the new Use Offset Taxes check box for supplier 
sites with a default Offset tax assigned. This means when you enter a tax code with an 
active associated Offset Tax code, Payables automatically creates an Offset tax 
distribution.

Run apofftax.sql to create the Offset Tax Code Upgrade report. It lists for each 
organization all combinations of defaults for tax code and Offset tax code that you 
have set at the supplier site level and each supplier site that uses a combination.

Review the report to determine where to assign active Offset taxes to active Tax Codes. 
You may need to duplicate and rename a tax code if it is paired with more than one 
Offset tax. For example, supplier site A has Tax1 and Offset Tax1 set as defaults, and 
supplier site B has Tax1 and Offset Tax2 set as defaults. Duplicate and rename Tax1 so 
you can assign Offset Tax2 to it, and then assign the new tax to supplier site B.

1. Create the Offset Tax Code Upgrade report:

UNIX:

$ cd $AP_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @apofftax.sql

Windows:

C:\> cd %AP_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @apofftax.sql

2. Review the report and identify any tax codes you need to duplicate and rename, 
or identify the Offset taxes you need to associate with tax codes.

3. Navigate to the Tax Codes window (Setup > Taxes > Tax Codes).

4. If you had Sales or User-defined tax codes associated with more than one Offset 
tax, duplicate and rename them.

5. Query each Sales or User-defined tax code that you want to associate with an 
Offset tax code.

6. In the Offset Tax field, enter an active Offset tax code and save your work.

Task List Status Responsibility

1. Set up Offset taxes Conditionally Required Application Specialist (Payables)

2. Set up the future-dated payment account Conditionally Required Application Specialist (Payables)

3. Set up recoverable taxes Conditionally Required Application Specialist (Payables)

4. Link GL records and AP records Required Application Specialist (Payables)

Requirement Explanation

Reference manual? Tax Codes (Oracle Payables User’s Guide)

Do before using? Oracle Payables Offset Taxes

TUMS Step Key? AP_SETUP_OFFSET_TAXES
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7. Update supplier sites that had tax code defaults associated with more than one 
Offset tax. Navigate to each supplier site (Suppliers > Entry). Choose the Sites 
button). Change the default tax code to the duplicated and renamed tax code.

8. Save your work.

Step 2  Set up the future-dated payment account
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Perform this step only if you want to use future-dated payments in Release 11i.

Payables added fields for the future-dated payment account in the Financials Options, 
Suppliers (only if you do not use Multi-org), Supplier Sites, and Bank Accounts 
windows. It also renamed the field in the Payment Documents window. Perform this 
step to populate the new future-dated payment account fields.

If you previously used future-dated payments, the upgrade performs these actions for 
each payment document:

■ Defaults the account you had defined in the Cash Clearing field of the Payment 
Documents window to the Future Dated Payment (account) field in the Payment 
Documents window

■ Sets the Future Date Use option to Allowed in the Payment Documents window

In the Payables Options window, specify whether you want to use the supplier site or 
payment document account when Payables accounts for Future Dated Payments. If no 
value is set, AutoUpgrade automatically sets this parameter to Payment Document.

To populate the new fields:

1. In the Financials Options window (Setup > Options > Financials), for each 
organization, enter a value for the Future Dated Payment (account) and save your 
work.

2. Run the following script to populate the Future Dated Payment account field for 
Suppliers, Supplier Sites, and Bank Accounts. The script updates all organizations. 
It prompts for a batch size for the commit cycle.

UNIX:

$ cd $AP_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @apxfdp01.sql

Windows:

C:\> cd %AP_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @apxfdp01.sql

3. Reset any values for Future Dated Payment account in the Supplies, Supplier Sites, 
Bank Accounts, and Payment Document windows and save your work. See Oracle 
Payables User’s Guide for more information.

Step 3  Set up recoverable taxes
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? Future Dated Payments (Oracle Payables User’s Guide)

Do before using? Oracle Payables Future Dated Payments

TUMS Step Key? AP_SETUP_FUTURE_DATED_PAYMENT_ACCT
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This step is necessary only for those operating units where you have set the Enable 
Recoverable Tax Financials option to Yes (Step 3 of Oracle Payables Tasks in 
Chapter 2). Refer to Oracle Payables User’s Guide for details, but at a minimum, do the 
following.

1. Navigate to the Financials Options window (Setup > Options > Financials). In the 
Tax tabbed region, enter a value in the Default Recovery Rate field. For example, if 
you want taxes to be 100% recoverable, enter 100. You can override this value 
when you set up the tax codes.

2. To set up or review tax code recovery rate, navigate to the Tax Codes window 
(Setup > Tax > Codes). Review the recovery rate of each tax code and ensure that it 
is set correctly. For example, if you want a tax to be 100% recoverable, set the 
recovery rate to 100. If you want a tax to be non-recoverable (such as for U.S. state 
and local taxes), set the recovery rate to 0. 

3. Save your work.

Step 4  Link GL records and AP records 
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

When GL records and AP records are linked, you can drill down from GL journals to 
the applicable invoice or payment document through the corresponding subledger 
accounting entries in Payables. 

To link the records, run apallink.sql. The script takes two parameters: Start Date and 
End Date. It updates all accounting entry lines for invoices and checks in that date 
range. You can run it multiple times, for example, in small date ranges to manage 
system resources. We recommend you begin with the most recent data and work 
backwards until the entire pre-Release 11i date range has been updated. You cannot 
drill down between updated records and non-updated records. But, having 
non-updated records does not affect other functions, such as data entry. Enter dates as 
DD/MM/YYYY.

UNIX: 
$ cd $AP_TOP/patch/115/sql 
$ sqlplus <APPS username>/<APPS password> @apallink.sql 

Windows: 
C:\> cd %AP_TOP%\patch\115\sql 
C:\> sqlplus <APPS username>/<APPS password> @apallink.sql 

Requirement Explanation

Reference manual? Financials Options, Recoverable Tax (Oracle Payables User’s Guide)

Do before using? Recoverable Tax (in either Payables or Purchasing)

TUMS Step Key? AP_SETUP_RECOVERABLE_TAXES

Requirement Explanation

Reference manual? Accounting (Oracle Payables User’s Guide)

Do before using? Drill down functionality from GL to Payables

TUMS Step Key? AP_LINK_TO_GL
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Oracle Receivables Tasks
Complete the following Oracle Receivables tasks.

Step 1  Define GL tax assignments for Natural Account tax codes    
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

To use the Account Method for Value Added Tax (VAT) compliance, set up Receivables 
to use the tax code assigned to the Natural Account segment of the Revenue account 
when you manually enter transactions or import them using AutoInvoice.

Step 2  Link GL and AR records and set Gain, Loss, and Round accounting 
entries code combinations
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

When GL records and Receivables records are linked, you can drill down from GL 
journals to the applicable invoice or payment document through the corresponding 
subledger accounting entries in Receivables. You can also drill down from GL journal 
Gain, Loss, and Round accounting entries to the subledger. 

To link GL and Receivables records and set the code combinations of the Gain, Loss, 
and Round accounting entries to match the code combinations in the GL journal, use 
the following scripts:

■ argicind.sql. Creates an index on the gl_import_references table that enhances the 
performance of ar115gic.sql. It may take a long time to run, depending on the 
volume of data in gl_import_references. 

Task List Status Responsibility

1. Define GL tax assignments for Natural Account tax 
codes

Conditionally Required Application Specialist (Receivables)

2. Link GL and AR records and set Gain, Loss, and 
Round accounting entries code combinations

Required Application Specialist (Receivables)

Requirement Explanation

Reference manual? Oracle Receivables Tax Manual

Do before using? AutoInvoice or Transactions window

TUMS Step Key? AR_DEFINE_GL_TAX_ASSIGN_FOR_NATURAL

Additional Information: See Controlling Tax from your Revenue 
Account and Implementing Value Added Tax in Oracle Receivables 
Tax Manual.

Note: Do not perform this step if you have already completed it as 
part of the Oracle Payables or Oracle General Ledger upgrade. If 
you use multiple sets of books, perform this step for each organization.

Requirement Explanation

Reference manual? Oracle Receivables User’s Guide

Do before using? Drill down functionality from GL to Receivables

TUMS Step Key? AR_LINK_TO_GL
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■ ar115gic.sql. Takes one parameter, number of Bulk_fetch_rows. It then fetches and 
updates that number of rows at one time. A commit is issued once for every bulk 
fetch, so set the rollback segment size accordingly. You can run this script multiple 
times if necessary.

■ argidind.sql. Drops the index created by argicind.sql.

To complete this step, run the following scripts in the order listed:

UNIX:
$ cd $AR_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @argicind.sql
$ sqlplus <APPS username>/<APPS password> @ar115gic.sql
$ sqlplus <APPS username>/<APPS password> @argidind.sql

Windows:
C:\> cd %AR_TOP%\patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @argicind.sql
C:\> sqlplus <APPS username>/<APPS password> @ar115gic.sql
C:\> sqlplus <APPS username>/<APPS password> @argidind.sql  

Oracle iPayment Tasks
Perform the following Oracle iPayment tasks.

Step 1  Upgrade iPayment 3i transaction data
This task is Required. It applies to Release 3i upgrades.

To upgrade transactions from the Release 3i schema to the Release 11i schema, run 
ibyupgrd.sql, where <db_link_to_3i> identifies the iPayment 3i schema (such as ps_
master) and <log_file_pathname> is the path of the file that log messages are written 
to.

UNIX:

$ cd $IBY_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @ibyupgrd.sql <db_link_to_3i>

Windows:

C:>\ cd %IBY_TOP%\patch\115\sql
C:>\ sqlplus <APPS username>/<APPS password> @ibyupgrd.sql <db_link_to_3i>

Note: Enter the fetch size according to the volume of the AR data 
in the gl_import_references table. If you leave this parameter blank, 
the default is 10,000.

Task List Status Responsibility

1. Upgrade iPayment 3i transaction data Required System Administrator/Applications Specialist (iPayment)

Requirement Explanation

Reference Manual? No

Do before using? Charging credit cards

Users must log off? No
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Oracle Financials for Asia/Pacific Tasks
Complete the following Oracle Financials for Asia/Pacific tasks.

Step 1  Enter uniform numbers for your company
This task is Required. It applies to Release 10.7 or 11.0 upgrades (Taiwan).

In Step 4 of the Oracle Financials for Asia/Pacific Tasks in Chapter 2, you recorded 
uniform numbers (taxpayer IDs) for your company. Enter these numbers in the 
Taxpayer ID field in the Locations window (Human Resources) as part of defining 
additional company information.

Step 2  Enter GST registration information    
This task is Required. It applies to Release 11.0 upgrades (Singapore).

To enter GST registration information, first use the Locations window to enter 
additional information for a location, then define the location as a legal entity and 
enter the GST registration number in the Organization window. To complete this step, 
from the Singaporean AR responsibility, navigate to Setup > System > 
Organizations/Locations.

Task List Status Country/Responsibility

1. Enter uniform numbers for your company Required Taiwan/Product Manager

2. Enter GST registration information Required Singapore/Product Manager

3. Update tax types Recommended Singapore/System Administrator, Application 
Specialist (Payables and Receivables)

4. Modify existing globalization flexfields in 
Payables

Required Thailand/Application Specialist (Thai 
Payables and Receivables)

5. Update Thai Payables tax codes Required Thailand/Application Specialist (Thai 
Payables)

6. Update Thai Payables globalization 
flexfield attributes

Required Thailand/Database Administrator

7. Modify the attribute set for the Thai 
Output Tax Summary report

Recommended Thailand/Application Specialist (Thai 
Receivables)

Requirement Explanation

Reference manual? Oracle Financials Common Country Features User’s Guide

Do before using? Government uniform invoice

TUMS Step Key? JA_ENTER_UNIFORM_NUMBERS_TAIWAN

Additional Information: See Additional Company Information in 
Oracle Financials Common Country Features User’s Guide.

Requirement Explanation

Reference manual? Oracle Financials Common Country Features User’s Guide

Do before using? GST Reporting

TUMS Step Key? JA_ENTER_GST_REG_INFO_SINGAPORE

Additional Information: See Additional Company Information in 
Oracle Financials Common Country Features User’s Guide.
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Step 3  Update tax types 
This task is Recommended. It applies to Release 11.0 upgrades (Singapore).

To see historic transactions in the Singaporean GST F5 report, update the tax types for 
the historical transactions. Then, set up new tax types that correspond to the historical 
tax categories in the Payables and Receivables Lookups window and update the tax 
types associated with these transactions. 

1. Run jasgupg1.sql to check the tax categories/tax types used in Singapore Payables 
and Receivables for all organizations.

UNIX:

$ cd $JA_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @jasgupg1.sql

Windows:

C:\> cd %JA_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @jasgupg1.sql

Review the jasgupg1.lst output file (in the current working directory). If no rows 
are listed, no further action is required.

2. In the Payables Lookups (Singaporean Payables > Oracle Payables > Setup > 
Lookups > Payables) and Receivables Lookups (Singaporean AR > Setup > System 
> QuickCodes > Receivables) windows, define new tax types that correspond to 
the tax categories associated with tax codes in Release 11.

The Singaporean GST F5 report prefixes Payables tax types with the tax class 
associated with the tax code. Tax classes are new, and can be either input or 
output. The report lists transactions grouped by tax class and tax type. Do not 
include INPUT or OUTPUT in the lookup codes that you define for the new tax 
types. For example, if you had the tax category INPUT-STANDARD in Release 11, 
define the corresponding Payables tax type in Release 11i with the lookup code 
STANDARD.

3. Run jasgupg2.sql to update tax type fields in both Payables and Receivables Tax 
Codes windows for the tax codes that were associated with the tax category value 
in the globalization flexfield. This script updates all tax categories. 

UNIX:

$ cd $JA_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @jasgupg2.sql

Windows:

C:\> cd %JA_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @jasgupg2.sql

Requirement Explanation

Reference manual? Oracle Payables User’s Guide; Oracle Receivables User’s Guide

Do before using? GST Reporting

TUMS Step Key? JA_UPDATE_TAX_TYPES

Additional Information: See Lookups in Oracle Payables User’s 
Guide. See also Defining Receivables Lookups in Oracle Receivables 
User’s Guide.
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At the prompt, specify the new tax type for each tax category. The script does not 
update the tax type if you do not specify a value for the tax type parameter. Enter a 
value, or leave blank and press Return.

For example:

Updating Tax Category INPUT-STANDARD
Tax Type:

If you enter STANDARD for the Tax Type, the script checks if the tax type 
STANDARD is defined as a lookup code for the lookup type Tax Type in the Payables 
Lookups window. It updates the tax type field with the new tax type for all records 
that were saved with tax category INPUT-STANDARD.

4. Run jasgupg1.sql to list the tax categories/tax types after the update:

UNIX:

$ cd $JA_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @jasgupg1.sql

Windows:

C:\> cd %JA_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @jasgupg1.sql

Step 4  Modify existing globalization flexfields in Payables
This task is Required. It applies to Release 10.7 or 11.0 upgrades (Thailand).

Download and apply patch 1561962 to modify the existing globalization flexfields in 
Payables. It is available on OracleMetaLink.

Step 5  Update Thai Payables tax codes
This task is Required. It applies to Release 10.7 or 11.0 upgrades (Thailand).

You can use a globalization flexfield in the Tax Codes window to indicate when you 
want Payables to add tax invoice information to a transaction. If you want to enter tax 
information when you enter invoices, select Invoices from the list of values. If you 
want to enter tax information when you enter payments, select Payments. Update this 
globalization flexfield for every VAT tax code in the old system.

To update tax codes, query the existing tax codes and complete the steps in Setting Up 
Payables for the Thai VAT in the Oracle Financials for Thailand User’s Guide.

Requirement Explanation

Reference manual? Oracle Financials for Thailand User’s Guide

Do before using? Thai Input Tax Summary Report, Thai Output Tax Summary Report

TUMS Step Key? JA_MODIFY_AP_GDF

Requirement Explanation

Reference manual? Oracle Financials for Thailand User’s Guide

Do before using? Thai Input Tax Summary Report

TUMS Step Key?  JA_UPDATE_THAI_AP_TAX_CODES
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Step 6  Update Thai Payables globalization flexfield attributes
This task is Required. It applies to Release 10.7 or 11.0 upgrades (Thailand).

Globalization flexfield attributes that contain tax invoice information have been 
changed. Run jathpupg.sql to update these attributes.

UNIX:
$ cd $JA_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @jathpupg.sql

Windows:
C:\> cd $JA_TOP/patch\115\sql
C:\> sqlplus <APPS username>/<APPS password> @jathpupg.sql

Step 7  Modify the attribute set for the Thai Output Tax Summary report
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades (Thailand).

To print historical data with the Thai Output Tax Summary report, create a new 
attribute set and run the report using this new set.

To create a new attribute set:
1.  In the Report eXchange Designer responsibility, create a new attribute set for the 

RX-only: Thai Output Tax Summary Report as described in the Oracle Financials 
RXi Reports Administration Tool User Guide.

2. In the Register Columns window, select the Include in Attribute Set check box for 
GDF_RA_CUST_TRX_ATT2 (Tax Invoice Date in previous release) and for GDF_
RA_CUST_TRX_ATT3 (Tax Invoice in previous release).

3. Click OK.

4. Navigate to the Displayed Columns tabbed region in the Attribute Set window 
and move GDF_RA_CUST_TRX_ATT2 and GDF_RA_CUST_TRX_ATT3 from the 
Available window to the Displayed window.

5. Navigate to the Column Details window and modify the report column header 
name in the Attribute Name column for these two attributes.

To run a report with the new attribute set:
1. In the System Administrator responsibility, navigate to the Concurrent Programs 

window.

Requirement Explanation

Reference manual? Oracle Financials for Thailand User’s Guide; Oracle Applications Product Update 
Notes

Do before using? Thai Input Tax Summary Report

TUMS Step Key? JA_UPDATE_THAI_AP_GDF

Requirement Explanation

Reference manual? Oracle Financials for Thailand User’s Guide, Oracle Financials RXi Reports 
Administration Tool User’s Guide

Do before using? Thai Output Tax Summary Report

TUMS Step Key? JA_MODIFY_THAI_OUTPUT_TAX_SUM_ATTR_SET
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2. Query the Thai Output Tax Summary Report.

3. Select the Parameters button. The Concurrent Program Parameters window 
appears.

4. Select the Display check box to display the new attribute set. Save your work.

Oracle Financials Common Country Tasks
Complete the following Oracle Financials Common Country tasks.

Step 1  Set up Appreciation QuickCode 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades (Austria, 
Germany, and Switzerland).

The DACH Asset Summary report and DACH Depreciation Analysis report display 
appreciation separately from other types of unplanned depreciation. To distinguish 
between appreciation amounts when you run these reports, use the APPREC 
QuickCode for the unplanned depreciation type.

From the Oracle Assets responsibility use the QuickCodes window (Setup > Asset 
System > QuickCodes) to maintain unplanned depreciation types. Query the TYPE 
FOR UNPLANNED DEPRECIATION QuickCode type and specify APPREC in the 
Value field to set up a new unplanned depreciation type for appreciation transactions. 
Disable any other unplanned depreciation types that were previously used to record 
appreciation. 

Step 2  Upgrade Appreciation transactions
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades (Austria, 
Germany, and Switzerland).

Appreciation transactions that were previously entered using a different unplanned 
depreciation type are not shown correctly in the DACH Asset Summary report or the 
DACH Depreciation Analysis report. Run the jgzzfaap.sql script to specify the 
unplanned depreciation type that was previously used. 

Task List Status Country/Responsibility

1. Set up Appreciation QuickCode Recommended Austria, Germany, Switzerland/Database 
Administrator, Application Specialist

2. Upgrade Appreciation transactions Recommended Austria, Germany, Switzerland/Database 
Administrator, Application Specialist

3. Assign request groups to responsibilities Recommended Oracle Financials Users in Japan/System 
Administrator 

Requirement Explanation

Reference manual? Oracle Assets User’s Guide

Do before using? DACH Asset Summary report or DACH Depreciation Analysis report

TUMS Step Key? JG_SETUP_APPR_QUICKCODE

Requirement Explanation

Reference manual? Oracle Assets User’s Guide

Do before using? DACH Asset Summary report or DACH Depreciation Analysis report

TUMS Step Key? JG_UPGRADE_APPR_TRX
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After you run the script, use the APPREC QuickCode only as the unplanned 
depreciation type for appreciation transactions. Manually disable the unplanned 
depreciation type that was previously used for appreciations.

Run jgzzfaap.sql, where <type> is the unplanned depreciation type that was 
previously used. Consult an Oracle Assets user to see which unplanned depreciation 
type, if any, was previously used to record appreciation transactions.

UNIX:
$ cd $JG_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @jgzzfaap.sql <type>

Windows:
C:\> cd %JG_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @jgzzfaap.sql <type>
 
From the Oracle Assets responsibility, maintain unplanned depreciation types in the 
QuickCodes window (Setup > Asset System > QuickCodes). To see possible values for 
unplanned depreciation types, query the TYPE FOR UNPLANNED DEPRECIATION 
QuickCode type. 

For example, run this script to convert transactions with the OLDTYPE unplanned 
depreciation type to the APPREC QuickCode. The script updates the 
TRANSACTION_SUBTYPE column in FA_TRANSACTION_HEADERS:

$ sqlplus scott/tiger @jgzzfaap.sql OLDTYPE

Step 3  Assign request groups to responsibilities 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades (Japan).

Assign new request groups to the responsibilities to access these reports. Perform this 
step in the Standard Request Submission window from the System Administrator 
responsibility (Security > Responsibility > Define).

Additional Information: See Unplanned Depreciation in Oracle 
Assets User’s Guide.

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Security

Do before using? Reports

TUMS Step Key? JG_ASSIGN_REQUEST_GROUPS

Name Name

Customer Balances Detail Customer Balances Detail (180) 

Customer Balances Summary Customer Account Balance Detail

Customer Account Balance Detail 
(180)

Publish Tax Reconciliation by Taxable Account 

Supplier Balances Detail Supplier Balances Detail (180) 

Supplier Balances Summary Supplier Account Balance Detail

Supplier Account Balance Detail 
(180)

Subledger Balance Maintenance for Payables 
Accounting Periods 
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In the Responsibilities window, navigate to the Request Group region. Use the list of 
values in the Name field to assign request groups to the responsibilities.

Oracle Financials for Europe Tasks
Complete the following Oracle Financials for Europe tasks.

Step 1  Update Polish and Turkish journal line sequence numbers
This task is Conditionally Required. It applies to Release 11.0 upgrades (Poland and 
Turkey).

In Release 11, the journal line sequence numbers were stored in a descriptive flexfield 
(JG_ZZ_RECON_LINES) in the Journals window. In Release 11i, the journal line 
sequence numbers are stored in a globalization flexfield (JG_GL_JE_LINES_INFO) in 
the same window. Update the journal line sequence numbers to use the new flexfield:

1. As System Administrator, navigate to the System Profile Values window (Profile > 
System) and set the JG: Territory and GL Set of Books ID profile options at 
responsibility level for the GL Localizations responsibility (Polish GL Localizations 
or Turkish GL Localizations). Set the JG: Territory profile option to Poland for 
Polish GL Localizations or to Turkey for Turkish GL Localizations. Set the GL Set of 
Books profile option to the appropriate set of books for the responsibility.

Subledger Balance Maintenance for 
Receivables Accounting Periods

Assign this request group... To the...

JGJP + AP Reports Payables responsibilities

JGJP + AR Reports Receivables responsibilities

JGJP + GL Reports General Ledger responsibilities

Task List Status Country/Responsibility

1. Update Polish and Turkish journal line 
sequence numbers

Conditionally Required Poland, Turkey/Database Administrator

2. Update Danish EFT invoices to use EDI 
flexfield

Conditionally Required Denmark/Applications Specialist (Financials 
for Denmark

3. Update taxable amounts for custom bills 
and self invoices

Required Italy/Database Administrator, Applications 
Specialist

4. Update Hungarian VAT transactions Conditionally Required Hungary/Database Administrator

5. Enable the Additional Information for 
Hungary globalization flexfield

Conditionally Required Hungary/System Administrator

Requirement Explanation

Reference manual? Oracle Financials for Poland User’s Guide; Oracle Financials for Turkey User’s 
Guide

Do before using? General Ledger for Poland or Turkey

TUMS Step Key? JE_UPDATE_POLISH_TURK_SEQ_NUM

Name Name
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2. From the GL Localizations responsibility (Polish GL Localizations or Turkish GL 
Localizations), run the Journal Lines Global Descriptive Flexfield Synchronization 
program using the Standard Request Submission windows.

Step 2  Update Danish EFT invoices to use EDI flexfield
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades 
(Denmark).

Oracle Financials for Denmark has replaced the Electronic Funds Transfer (EFT) 
payment process with Electronic Data Interchange (EDI). Migrate the additional 
country-specific invoice information for the outstanding invoices from the old EFT 
flexfield to the new globalization flexfield for EDI.

1. Update additional invoice information for all open invoices with a payment 
method of Electronic.

Oracle Payables for Denmark places a hold on any invoice with incomplete 
information. Before you migrate the invoice information, update the additional 
invoice information in the old EFT flexfields for all open invoices that you want to 
upgrade with a payment method of Electronic.

2. Create a new hold code for the data migration script.

Create a new hold code for the data migration script to use when placing the 
holds. From the Invoice Approvals window (Danish AP > Setup > Invoice > 
Approvals), enter EFT_TO_EDI_DATA_MIGRATE in the Name field for the new 
hold code. In the Type field, select Invoice Hold Reason, and also Postable and 
Releaseable.

3. Migrate additional country-specific invoice information.

UNIX:

$ cd $JE_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @jedkediu.sql

Windows:

Note: If you use multiple sets of books, run the Journal Lines 
Global Descriptive Flexfield Synchronization program once for 
each set of books.

Additional Information: See Oracle Financials for Poland User’s 
Guide; Oracle Financials for Turkey User’s Guide.

Requirement Explanation

Reference manual? Oracle Payables User’s Guide, Oracle Financials for Denmark User’s Guide

Do before using? Danish EDI

TUMS Step Key?  JE_UPDATE_DANISH_EFT_INVOICES

Additional Information: See Invoice EFT Information in Oracle 
Financials for Denmark User’s Guide.

Additional Information: See Invoice Approvals in Oracle Payables 
User’s Guide.



Financial

Category 6 — Before Using Product Features 6-25

C:\> cd %JE_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @jedkediu.sql

4. Enter missing information for invoices placed on hold.

Oracle Payables for Denmark places a hold on any invoice with incomplete 
information using the hold code you previously defined. Enter any missing 
information for these invoices. When the information is complete, manually 
release the holds and approve the invoices for payment.

Step 3  Update taxable amounts for custom bills and self invoices
This task is Required. It applies to Release 10.7 or 11.0 upgrades (Italy).

Use the globalization flexfield in the Distributions window to record the taxable 
amounts for self invoices and custom bills. Self invoices and custom bills entered 
before the upgrade are not displayed on the Italian Payables Summary VAT Report, 
the Italian Purchase VAT Register, and the Italian Sales VAT Register (Self Invoice, EU 
VAT). 

To ensure that the VAT reports correctly display these amounts, run jeitapid.sql. It 
updates invoice distributions that have a tax type of Custom Bill or Self Invoice by 
updating the GLOBAL_ATTRIBUTE_CATEGORY and GLOBAL_ATTRIBUTE1 at the 
invoice distribution level (on the AP_INVOICE_DISTRIBUTIONS table).

UNIX:

$ cd $JE_TOP/patch/115/sql
$ sqlplus <APPS username>/<APPS password> @jeitapid.sql

Windows:

C:\> cd %JE_TOP%\patch\ll5\sql
C:\> sqlplus <APPS username>/<APPS password> @jeitapid.sq

Enter the Set of Books ID for the Italian organization at the prompt. If you have 
multiple Italian organizations, run the script once for each organization.

Step 4  Update Hungarian VAT transactions
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades 
(Hungary).

Additional Information: See Entering Invoices in Oracle Financials 
for Denmark.

Requirement Explanation

Reference manual? No

Do before using? Oracle Payables Summary VAT Report, Italian Purchase VAT Report, Italian 
Payables Sales VAT Register (Self Invoice, EU VAT)

TUMS Step Key?  JE_UPDATE_TAXABLE_AMOUNTS_FOR_CUST_BILLS

Additional Information: See Oracle Financials for Italy User’s Guide.

Requirement Explanation

Reference manual? No

Do before using? ECE Payables VAT Register or ECE Receivables VAT Register for Hungary

TUMS Step Key?  JE_UPDATE_HUNGARIAN_VAT
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VAT transactions that were already reported on the final version of the now obsolete 
Hungarian Purchases VAT Register and Hungarian Sales VAT Register reports must be 
marked so that they can be excluded from the new ECE Payables VAT Register and 
ECE Receivables VAT Register reports for Hungary.

To mark the transactions to be excluded, run the following script for each Hungarian 
organization ID:

UNIX:

$ cd $JE_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @jehurvat.sql

Windows:

C:\> cd %JE_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @jehurvat.sql

The script lists all organization IDs and names available in the database. When the 
system administrator enters the organization ID for Hungary, the script updates the 
transactions by inserting additional information in the global attribute columns on the 
AP_INVOICE_DISTRIBUTIONS table for Payables transactions, or the RA_
CUSTOMER_TRX_LINES table for Receivables transactions. Update the VAT 
transactions marked by this script so that they are included the next time you run the 
reports. 

Step 5  Enable the Additional Information for Hungary globalization flexfield
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades 
(Hungary).

The Hungarian Receivables Open Items Revaluation report revalues all outstanding 
receivables accounts at a particular date, with regard to a stated reporting period, to 
reflect foreign exchange rate fluctuations since the original transaction date.

Not all transaction types of open items are revalued. You designate which transaction 
types are revalued in the Additional Information for Hungary globalization flexfield 
on the Transaction Types window (Hungarian AR: Setup > Transactions > Transaction 
Types). 

Enable the Additional Information for Hungary globalization flexfield by setting these 
profile options in the System Profile Values window (System Administrator: Profile > 
System):

Additional Information: See Oracle Financials for Hungary User’s 
Guide.

Requirement Explanation

Reference manual? Oracle Financials for Hungary User’s Guide

Do before using? Hungarian Receivables Open Items Revaluation report

TUMS Step Key?  JE_ENABLE_HUNGARIAN_GDF

Set this profile option... To this value...

JG: Application Oracle Receivables

JG: Product European Localizations

JG: Territory Hungary
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Now, use the Revaluate Transaction Type field in this flexfield to manually designate 
which transaction types are revalued. 

Oracle Financials for Latin America Tasks
Complete the following Oracle Latin America tasks.

Step 1  Update Colombian journal line third-party information
This task is Required. It applies to Release 11.0 upgrades (Colombia).

In Release 11, Oracle Financials for Colombia stores journal line third-party 
information in a descriptive flexfield (JG_ZZ_RECON_LINES) in the Journals window. 
In Release 11i, this information is stored in a globalization flexfield (JG_GL_JE_LINES_
INFO) in the same window. Update the journal line third-party information to use the 
new flexfield:

1. As the System Administrator, navigate to the System Profile Values window 
(Profile > System).

2. Set the JG: Territory and GL Set of Books ID profile options at responsibility level 
for the Colombian GL Localizations responsibility. Set the JG: Territory profile 
option to Colombia. Set the GL Set of Books profile option to the appropriate set of 
books for the responsibility.

3. From the Colombian GL responsibility, run the journal lines global descriptive 
flexfield synchronization program using the Standard Request Submission 
window (Colombian Localization > Other > Requests > Run).

Projects
Review this section and complete only the tasks for the Oracle Projects products you 
have installed.

Oracle Projects Tasks
Complete the following Oracle Projects tasks.

Task List Status Country/Responsibility

1. Update Colombian journal line third-party information Required Colombia/Database Administrator, 
Application Specialist (GL)

Requirement Explanation

Reference manual? Oracle Financials for Colombia User’s Guide

Concurrent Manager? Yes

TUMS Step Key? JL_UPDATE_COLOMBIAN_JOURNAL_LINES

Note: If you use multiple sets of books, run the journal lines 
global descriptive flexfield synchronization program once for each 
set of books using a different responsibility.

Additional Information: See Entering Journal Line Third Party 
Information in Oracle Financials for Colombia User’s Guide.
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Step 1  Implement Self-Service Time    
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

If you used Personal Time and Expense (PTE) or Project Time and Expense (to enter 
timecard information), you must implement Self-Service Time and roll it out to users. 
Refer to Oracle Self-Service Time Implementation/Migration Guide Release 11i on 
OracleMetaLink.

Step 2  Implement cross charge 
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

Cross charging and Borrowed and Lent Accounting are no longer enabled by using 
profile options. If you cross-charged transactions across Operating Units or used the 
Borrowed and Lent Revenue function before the upgrade, follow the Cross Charge and 
Inter-Project Billing implementation instructions in the Oracle Projects User’s Guide to 
continue using this function.

Human Resources
Review this section and complete only the tasks for the Oracle Human Resources 
products you have installed.

Oracle Human Resources Tasks
Complete the following Oracle Human Resources tasks.

Step 1  Recreate custom Salary Proposal view
This task is Conditionally Required. It applies to Release 10.7 upgrades.

Task List Status Responsibility

1. Implement Self-Service Time Conditionally Required Application Specialist (Projects)

2. Implement cross charge Conditionally Required Application Specialist (Projects)

Requirement Explanation

Reference manual? Oracle Self-Service Time Implementation/Migration Guide, Release 11i

Do before using? Oracle Self-Service Time

Requirement Explanation

Reference manual? No

Do before using? Cross Charge

TUMS Step Key? PA_IMPLEMENT_CROSS_CHARGE

Task List Status Responsibility

1. Recreate custom Salary Proposal view Conditionally Required System Administrator

2. Drop obsolete Oracle users Recommended Database Administrator

Requirement Explanation

Reference manual? No
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You identified the custom location for the custom Salary proposals view script (PER_
SALARY_PROPOSALS_HRV) in Step 3 of the Oracle Human Resources Tasks in 
Chapter 1. After the custom changes have been applied, rerun the script to recreate the 
customized view:

UNIX:
$ cd $PER_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @peupl01v.sql

Windows:
C:\> cd %PER_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @peupl01v.sql

Step 2  Drop obsolete Oracle users
This task is Recommended. It applies to Release 10.7 upgrades.

Restricted security profiles may now be obsolete. In Release 11i, responsibilities that 
use restricted security profiles connect to the APPS Oracle user. You no longer have to 
maintain separate Oracle users for every restricted security profile. Release 10.7 
reporting Oracle users are unaffected by this change. 

To list Oracle users that were associated with restricted security profiles, run the 
following script, where <SID> is the value of $ORACLE_SID or $TWO_TASK (UNIX) 
or the value of ORACLE_SID or LOCAL (Windows).

UNIX:
$ cd $APPL_TOP/admin/<SID>/out
$ sqlplus <APPS username>/<APPS password> @$PER_TOP/admin/sql/peoldsec.sql

Windows:
C:\> cd %APPL_TOP%\admin\<SID>\out
C:\> sqlplus <APPS username>/<APPS password> @%PER_TOP%\admin\sql\peoldsec.sql

This script also indicates which Oracle users have been dropped from the database. 
The output is spooled to peoldsec.lis in the current working directory. If the Oracle 
users listed in peoldsec.lis do not contain the custom tables or views that you want to 
preserve, drop them — they are no longer used by Oracle HRMS. 

Before dropping a user whose schema contains objects, thoroughly investigate these 
objects and the implications of dropping them. Pay attention to any cascading effects. 
For example, if the user owns a table, check whether any views or procedures depend 
on that table. For example:

Do before using? Salary Administration

TUMS Step Key? PER_RECREATE_SALARY_VIEW

Requirement Explanation

Reference manual? No

Do before using? Restricted Security Profiles

Requirement Explanation
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UNIX:
$ sqlplus SYSTEM/<SYSTEM password>
SQL> DROP USER jones;
SQL> exit

Windows:
C:\> sqlplus SYSTEM/<SYSTEM password>
SQL> DROP USER jones;
SQL> exit 

To drop a user and all its schema objects (if any), you must have the DROP USER 
system privilege (typically held by a security administrator). Use either the Drop 
menu item on the Enterprise Manager/GUI, or the SQL command DROP USER.

If the user’s schema contains any schema objects, use the CASCADE option to drop 
the user and all associated objects and foreign keys that depend on the tables of the 
user. If you do not specify CASCADE and the user’s schema contains objects, an error 
message is returned and the user is not dropped.

To verify that the users have been successfully dropped, rerun peoldsec.sql at any time 
prior to dropping PER_SECURITY_PROFILES_OLD.

Oracle Payroll (U.S.) Tasks
Complete the following Oracle Payroll (U.S.) tasks.

Step 1  Check for invalid U.S. address information   
This task is Conditionally Required. It applies to Release 10.7 or 11.0 upgrades.

The Global Legislation driver (hrglobal.drv) creates pyvaladr.lst, which lists existing 
U.S. addresses (locations or personal addresses) that are invalid. The file is located in 
$APPL_TOP/admin/<SID>/out (UNIX) or %APPL_TOP%\admin\<SID>\out 
(Windows). Review the file and correct invalid address data.

To correct location addresses:
In the Location window (Work Structures > Location), query the required location and 
amend the address as required and save your work.

To correct personal addresses:
In the People window (People > Enter and Maintain), query the person and choose the 
Address button. Amend the address as required and save your work.

Additional Information: See Oracle9i Database Administrator’s 
Guide.

Task List Status Responsibility

1. Check for invalid U.S. address information Conditionally Required Database Administrator

Requirement Explanation

Reference manual? No

Do before using? A payroll or modifying existing employee tax information

TUMS Step Key? PAY_CHECK_INVALID_ADDRESSES
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After correcting data, regenerate the .lst file to verify that all addresses are valid. To 
regenerate the file, run the following script where <SID> is the value of $ORACLE_
SID or $TWO_TASK (UNIX) or the value of ORACLE_SID or LOCAL (Windows).

UNIX:
$ cd $APPL_TOP/admin/<SID>/out
$ sqlplus <APPS username>/<APPS password> @$PAY_TOP/admin/sql/pyvaladr.sql

Windows:
C:\> cd %APPL_TOP%\admin\<SID>\out
C:\> sqlplus <APPS username>/<APPS password> @%PAY_TOP%\admin\sql\pyvaladr.sql

Logistics
Review this section and complete only the tasks for the Oracle Logistics products you 
have installed.

Oracle Inventory Tasks
Complete the following Oracle Inventory tasks.

Step 1  Create indexes on flexfield segment columns - INV    
This task is Required. It applies to Release 10.7 or 11.0 upgrades.

To improve performance of key flexfields, create indexes on the segment columns. We 
recommend creating these indexes for the following key flexfields:

1. To Determine whether a concatenated index exists for the flexfield segments:

UNIX:

$ cd $INV_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @invflseg.sql

Windows:

C:\> cd %INV_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @invflseg.sql

Task List Status Responsibility

1. Create indexes on flexfield segment columns - INV Required N/A

2. Change Item Description profile option - INV Recommended System Administrator

Requirement Explanation

Reference manual? No

Do before using? Indicated key flexfields

Flexfield Base Table

System Items MTL_SYSTEM_ITEMS_B

Account Aliases MTL_GENERIC_DISPOSITIONS

Stock Locators MTL_ITEM_LOCATIONS
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This script produces invidxch.lis, which has three sections: System Items, Account 
Aliases, and Stock Locators flexfields, with the corresponding MTL_SYSTEM_ITEMS_
B, MTL_GENERIC_DISPOSITIONS, and MTL_ITEM_LOCATIONS code combination 
tables. Each section contains information about flexfield segments (segment number, 
segment name, and segment column name enabled) and table indexes (index name, 
name of the indexed column, and the position of the column in an index on a table).

2. If you determine that the concatenated index does not already exist, create a 
concatenated index on the MTL_SYSTEM_ITEMS_B table. It must include all the 
segment columns enabled for the System Items flexfield, in the same order as the 
segments in the flexfield structure definition. For example, if you have segment3, 
segment4, segment6 (in this order) enabled for the flexfield, create as follows:

UNIX:

$ sqlplus <INV username>/<INV password>
SQL> create index MTL_SYSTEM_ITEMS_B_NS3
 2 on MTL_SYSTEM_ITEMS_B
 3 (segment3,
 4  segment4,
 5  segment6);
SQL> exit

Windows:

C:\> sqlplus <INV username>/<INV password>
SQL> create index MTL_SYSTEM_ITEMS_B_NS3
 2 on MTL_SYSTEM_ITEMS_B
 3 (segment3,
 4  segment4,
 5  segment6);
SQL> exit

Name the index using the format MTL_SYSTEM_ITEMS_B_NSX, where X is the 
first active segment column. In the example, the index name is MTL_SYSTEM_
ITEMS_B_NS3. If the index already exists (as in the case of an upgrade from 10.7 
or 11.0), its name may have a format MTL_SYSTEM_ITEMS_NX.

3. Repeat the previous steps to create indexes for MTL_GENERIC_DISPOSITIONS 
(use index name format MTL_GENERIC_DISPOSITIONS_NSX) and MTL_ITEM_
LOCATIONS (use index name format MTL_ITEM_LOCATIONS_NSX).

Step 2  Change Item Description profile option - INV
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

You can build an item description (for items that have an assigned catalog group) by 
either concatenating the item catalog group name with the enabled descriptive element 
values, or by concatenating the item catalog group description with the enabled 
descriptive element values. The profile option INV:Use Catalog Name In the Item 
Description determines the method used. A value of Yes uses the catalog group name. 
No uses the catalog group description.

If your business logic mandates, during the upgrade (or at any other time), you can 
change this profile option. 

Requirement Explanation

Reference manual? No

Do before using? Items
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1. As the System Administrator, navigate to the System Profile Values window. Set 
this option at the site level.

2. If you change the profile option, update all existing descriptions for items that 
have an assigned catalog group: 

UNIX:

$ cd $INV_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @invicgds.sql

Windows:

C:\> cd %INV_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @invicgds.sql

Public Sector
Review this section and complete only the tasks for the Oracle Public Sector products 
you have installed.

 Oracle Public Sector Financials (International) Tasks
Complete the following Oracle Public Sector Financials (International) tasks.

Step 1  Migrate gross-based VAT data
This task is Conditionally Required. It applies to Release 12, 3.1, or 3.3 upgrades.

If gross-based VAT was activated in the previous version, perform this step to migrate 
this data to the new Partially Reclaimable VAT tables.

1. Enable the recoverable tax option in Oracle Payables as described in Category 2, 
Step 3 of the Oracle Payables Tasks in Chapter 2.

2. Set up recoverable taxes in Oracle Payables as described in Step 3 of Oracle 
Payables Tasks in this chapter.

3. Set up the tax code default in Payables. Navigate to the Financials Options 
window (Setup > Options > Financials). In the Tax tabbed region, select an option 
from the list of values in the Default Tax Code field. Save your work.

4. Run the following script:

Additional Information: See Profile Options in Oracle Inventory in 
Oracle Inventory User’s Guide.

Additional Information: See Overview of Item Cataloging in 
Oracle Inventory User’s Guide.

Task List Status Responsibility

1. Migrate gross-based VAT data Conditionally Required Application Specialist

2. Upgrade subledger security Conditionally Required Database Administrator/Application Specialist

Requirement Explanation

Reference manual? No

Do before using? Gross-based VAT data

TUMS Step Key? IGI_MIGRATE_RECOV_VAT_TAX_DISTRIBUTIONS
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 UNIX:

$ cd $IGI_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @igigbvuw.sql

Windows:

C:\> cd %IGI_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @igigbvuw.sql

5. Migrate Recovery Rates (optional)

To migrate Recovery Rates under a single recovery rule named "11.0.3 Upgrade - 
Recovery Rule" for each organization, run the following script, which also 
migrates associated accounting information to the flexfield structure in 11i: 

 UNIX:

$ cd $IGI_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @igigbvl.sql

Windows:

C:\> cd %IGI_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @igigbvl.sql

Step 2  Upgrade subledger security
This task is Conditionally Required. It applies to Release 12, 3.1, or 3.3 upgrades.

The following steps upgrade subledger and security setup data and setup steps. You 
must have completed all other upgrade steps before you perform this step.

1. Upgrade subledger security by running the following script:

UNIX:

$ cd $IGI_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @igiasls1.sql

Windows:

C:\> cd %IGI_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @igiasls1.sql

Note: You should verify the accuracy of the migrated accounting 
information. AP setup upgrade must have been completed 
successfully before you run this script.

Requirement Explanation

Reference manual? No

Do before using? Subledger Security

Concurrent Manager? Yes

TUMS Step Key? IGI_UPGRADE_SLS_SETUPS

Note: Perform this step only if subledger security is already in 
use. Make sure the concurrent manager is running before you 
begin, and that users are logged off.
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2. Check the log file (igiasls1.log) for errors. If any errors are reported, do not 
proceed with this upgrade step and do not use subledger security until the errors 
are fixed.

3. Apply security and create subledger security objects:

■ Log on to the application and choose the System Administrator responsibility. 

■ Choose OPSF (I) System Administration > Subledger Security > Apply 
Security.

■ Select the CREATE parameter.

■ Submit the request (check the log file for the submitted request).

4. Verify that the subledger security structure is successfully upgraded by logging on 
as system administrator and reviewing the following.

Subledger security groups:

In the Maintain Groups window (OPSF(I) System Administration > Subledger 
Security > Maintain Groups), define, re-enable, or delete security groups as 
required. Save your work.

Subledger security secure tables:

In the Maintain Tables window (OPSF(I) System Administration > Subledger 
Security > Maintain Tables), define, re-enable, or delete secure tables as required. 
Verify that all secure tables exist in the database and include the column JE_UK_
VIEW_COLUMN. Save your work.

Subledger security allocations:

In the Maintain Allocations window (OPSF(I) System Administration > Subledger 
Security > Maintain Allocations), allocate tables to or delete tables from security 
groups, disable, or re-enable tables as required. Save your work.

Note: The script prompts you to disable security groups/Secure 
userids. If you select Y, the security groups and user IDs will be 
upgraded, and the associated secured data prior to disabling will be 
secured. If you select N, the security groups and user IDs will not 
be upgraded, and the associated data will not be secured.

Additional Information: See Applying Security Procedure, 
Subledger Security Setup in the Oracle Public Sector Financials 
(International) User’s Guide.

Additional Information: See Maintaining Security Groups 
Procedure, Subledger Security Setup in Oracle Public Sector 
Financials (International) User’s Guide.

Additional Information: See Maintaining Secure Tables Procedure, 
Subledger Security Setup in Oracle Public Sector Financials 
(International) User’s Guide.

Additional Information: See Maintaining Allocations Procedure, 
Subledger Security Setup in Oracle Public Sector Financials 
(International) User’s Guide.



Public Sector

6-36 Oracle Applications Upgrading Oracle Applications

5. Upgrade subledger security data by running the following script:

UNIX:

$ cd $IGI_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @igiasls2.sql

Windows:

C:\> cd %IGI_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @igiasls2.sql

Review the output. If errors are reported, omit this security upgrade step and do 
not use the subledger security feature until you fix the errors.
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7
Finishing the Upgrade

To finish the upgrade, you must perform some final tasks that affect Oracle 
Applications as a whole — you must perform them after all system and 
product-specific steps are complete. In addition, there are some optional tasks that 
may apply only to some systems. This chapter describes these tasks in the following 
sections:

System Maintenance Tasks on page 7-1
Tasks for All Users on page 7-6
System-specific Tasks on page 7-8

System Maintenance Tasks
After you have verified the upgrade, you must perform certain "clean-up" tasks for all 
Applications products, not just those that are licensed installed or shared, since all 
database components are installed and upgraded together.

Step 1:  Drop obsolete database objects
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Note: Performing the tasks in this chapter out of order may 
reverse upgrade processes that you have previously completed.

Note: Before you perform these steps, back up the Oracle 
Applications product files and the database.

Task List Status Responsibility

1. Drop obsolete database objects Recommended Database Administrator

2. Drop MRC schema Recommended System Administrator

3. Delete obsolete product files Recommended System Administrator

4. Drop obsolete columns in Oracle Assets Recommended Database Administrator

5. Drop unnecessary indexes for Oracle Payables Recommended Database Administrator

6. Remove old subledger security schemas for Public 
Sector Financials

Recommended Database Administrator

7. Install online help Recommended System Administrator

Requirement Explanation

Reference manual? Oracle Administrator’s Guide
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To help remove obsolete objects, we supply a SQL*Plus script for many products. The 
script is $<PROD_TOP>/admin/sql/<prod>dold.sql (UNIX) or %<PROD>_
TOP%\admin\sql\<prod>dold.sql> (Windows), where <PROD> (or <prod>) 
represent the product short name. For example, PO (Purchasing). Each script lists 
obsolete objects.

Review a product script and determine if you want to drop the obsolete objects. If so, 
enter the following command, where <PROD_TOP> represents the appropriate 
product top environment variable. Pay special attention to instructions in the script for 
additional parameters.

UNIX:

$ cd $<PROD_TOP>/admin/sql
$ sqlplus <APPS username>/<APPS password> @<prod>dold.sql \
  <prod username> <prod password> <APPS username> <APPS password>

Windows:

C:\> cd %<PROD_TOP>%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @<prod>dold.sql \
     <prod username> <prod password> <APPS username> <APPS password>

For example, to run the Purchasing script:

UNIX:

$ cd $PO_TOP/admin/sql
$ sqlplus <APPS username>/<APPS password> @podold.sql \
  <PO username> <PO password> <APPS username> <APPS password>

Windows:

C:\> cd %PO_TOP%\admin\sql
C:\> sqlplus <APPS username>/<APPS password> @podold.sql \
     <PO username> <PO password> <APPS username> <APPS password>

Step 2:  Drop MRC schema 
This task is Recommended. It applies to Release 11.0 upgrades.

Users must log off? No

Caution: Do not run <prod>dold.sql until you have verified that 
the upgrade is complete and successful.

This product... ...requires these parameters

Common Country 
Features (JG)

<GL username> <GL password> <JG username> <JG password> 
<AR username> <AR password> <FA username> <FA password>

Financials for EMEA (JE) <AP username> <AP password>

Requirement Explanation

Reference manual? Oracle Administrator’s Guide

Users must log off? No

Requirement Explanation
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Based on the changes to the MRC architecture, the MRC_APPS schema is no longer 
needed. All programs and reports that used APPS_MRC have been migrated to work 
from the APPS schema. Dropping the APPS_MRC schema frees space and reduces 
overhead during patch applications.

To drop this schema, run the following script as the SYSTEM user:

UNIX:

$ cd $APPL_TOP/admin
$ sqlplus <SYSTEM username>/<SYSTEM password> @addrpmrc.sql \
  <APPLSYS username> SAFE

Windows:

C:\> cd %APPL_TOP%\admin
C:\> sqlplus <SYSTEM username>/<SYSTEM password> @addrpmrc.sql \
     <APPLSYS username> SAFE

Step 3:  Delete obsolete product files 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Delete the product files for the previous release (if you have not done so already). You 
may want to retain report output files or customized programs. Output files are stored 
in the old log and output subdirectories under each product’s top directory, under the 
log and output directories you created, or under a common directory. To remove 
obsolete files for an old release, change to the top directory of that release and enter 
the following command:

UNIX:

$ rm -rf <old APPL_TOP>

Here is an example:

$ rm -rf /d01/appl/r10

Windows:

C:\> del /s /q <old APPL_TOP>

Here is an example:

C:\> del /s /q \APPL110

Step 4:  Drop obsolete columns in Oracle Assets 
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Requirement Explanation

Reference manual? Oracle Applications System Administrator’s Guide - Security; Oracle Applications 
Concepts

Users must log off? No

Note: If you are upgrading from 10.7SC, you can delete all 
obsolete client-side product files at this time.

Requirement Explanation

Reference manual? Oracle8i SQL Reference Manual
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To conform to multilingual changes, a number of tables have been renamed to indicate 
they are base tables (_B) and their descriptive columns have been copied to a new table 
with the same base name, plus a _TL suffix to indicate they are translated tables. The 
descriptive columns in the base table are set to unused, so you cannot view them. To 
drop these obsolete columns, run the following script. It requires BATCHSIZE as a 
parameter.

UNIX:

$ cd $FA_TOP/admin/sql
$ sqlplus <FA username>/<FA password> @facoldr.sql

Windows:

C:\> cd %FA_TOP%\admin\sql
C:\> sqlplus <FA username>/<FA password> @facoldr.sql

To make sure the data in the column to be dropped has been copied correctly from the 
base table to the translated table, confirm that the number of rows in both tables is 
equal. You can do this by running a select count in SQL*Plus from the base table and 
the translated table. 

Also, you can select the column name in the translated table of the column that will be 
dropped from the base table to make sure that there is data in that column. For 
example, the upgrade drops the Description column from the FA_ADDITIONS_B 
table. Select Description from FA_ADDITIONS_TL and confirm that the column has 
been correctly populated.

Step 5:  Drop unnecessary indexes for Oracle Payables
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

Users must log off? Yes

Table name in prior 
release

Base table with dropped 
column

Translated with copied 
column

Column name to be 
dropped

FA_ADDITIONS FA_ADDITIONS_B FA_ADDITIONS_TL description

FA_CATEGORIES FA_CATEGORIES_B FA_CATEGORIES_TL description

FA_LOOKUPS FA_LOOKUPS_B FA_LOOKUPS_TL description

FA_LOOKUPS FA_LOOKUPS_B FA_LOOKUPS_TL meaning

FA_LOOKUP_TYPES FA_LOOKUP_TYPES_B FA_LOOKUP_TYPES_TL description

FA_LOOKUP_TYPES FA_LOOKUP_TYPES_B FA_LOOKUP_TYPES_TL meaning

FA_RX_ATTRSETS FA_RX_ATTRSETS_B FA_RX_ATTRSETS_TL user_attribute_set

FA_RX_REP_COLUMNS FA_RX_REP_COLUMNS_B FA_RX_REP_COLUMNS_TL attribute_name

Requirement Explanation

Reference manual? Oracle Payables User’s Guide

Do before using? Oracle Applications

Requirement Explanation
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If all operating units use Accrual Basis Accounting, run the following script to drop 
the indexes on the CASH_POSTED_FLAG columns in AP_INVOICE_
DISTRIBUTIONS and AP_INVOICE_PAYMENTS.

UNIX:

$ cd $AP_TOP/admin/sql
$ sqlplus <AP username>/<AP password> @apaccr.sql

Windows:

C:\> cd %AP_TOP%\admin\sql
C:\> sqlplus <AP username>/<AP password> @apaccr.sql

If all operating units use Cash Basis Accounting, run the following script to drop the 
indexes on the ACCRUAL_POSTED_FLAG columns in AP_INVOICE_
DISTRIBUTIONS and AP_INVOICE_PAYMENTS:

UNIX:

$ cd $AP_TOP/admin/sql
$ sqlplus <AP username>/<AP password> @apcash.sql

Windows:

C:\> cd %AP_TOP%\admin\sql
C:\> sqlplus <AP username>/<AP password> @apcash.sql

Step 6:  Remove old subledger security schemas for Public Sector Financials
This task is Recommended. It applies to Release 12, 3.1, 3.3 upgrades.

You must have already run igidold.sql (as described in Step 1 in this section) before 
you continue.

If you used subledger security in a previous version of Public Sector Financials 
(International), you should remove any additional secure schemas that were created. 
Running igidold.sql in Step 1 dynamically created a script to drop these additional 
schemas. If the script is empty, you can omit this step.

If there are additional schemas, run the following script to drop them. This is 
potentially a long-running process. It could take up to 2 hours to drop each listed user.

UNIX:

$ cd $IGI_TOP/admin/sql
$ sqlplus <SYSTEM uername>/<SYSTEM password> @igidropschema.sql

Windows:

C:\> cd $IGI_TOP\admin\sql

Note: Do not perform this step if 1) at least one of the operating 
units uses Combined Basis Accounting, or 2) if you have at least 
one operating unit that uses Cash Basis Accounting and at least one 
operating unit that uses Accrual Basis Accounting.

Requirement Explanation

Reference manual? No

Users must log off? No
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C:\> sqlplus <SYSTEM uername>/<SYSTEM password> @igidropschema.sql

Step 7:  Install online help
This task is Recommended. It applies to Release 10.7 or 11.0 upgrades.

To install online help, download patch 3275245 from OracleMetaLink and apply it to 
your system. Read the readme file carefully, and following any special instructions you 
find there.

Tasks for All Users
All users must perform the tasks in this section to finish the upgrade.

Understand System Administration Tasks
Make sure you are completely familiar with the information in the Oracle Applications 
System Administrator’s Documentation Set. In addition, always check OracleMetaLink for 
the latest product information.

Understand Oracle Applications Maintenance Tasks
Make sure you are completely familiar with the information in both volumes of the 
Maintaining Oracle Applications Documentation Set. Oracle Applications Maintenance 
Utilities and Oracle Applications Maintenance Procedures contain important details about 
administration utilities, as well as instructions on how to perform manual 
maintenance tasks.

Implement New Product and Country-specific Functionality
Refer to the implementation or setup guides (or implementation or setup section of the 
user’s guides) associated with the Oracle Applications products in your system for 
instructions on implementing or setting up new products and features. Refer to 
OracleMetaLink for other product-specific issues. 

Resize the Database
The size of the production database depends on the products that you have licensed 
and the additional features (such as multiple languages or multiple organizations) that 
you have configured in your system. Refer to the product-specific documentation.

Change Passwords
The default passwords for the SYS account and SYSTEM account of the Oracle 
Applications database are change_on_install and manager, respectively. To maintain 
database security and restrict access to these accounts, change these passwords.

Requirement Explanation

Reference manual? No

Users must log off? No

Note: The password for both SYS and SYSTEM in the Vision 
Demo is manager. 
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In addition, change the default passwords for the Applications product accounts in the 
production and test databases.

Maintain Snapshot Information
Snapshots give a picture of selected APPS-related files in a given APPL_TOP. They 
record details for each file in the APPL_TOP (like file name and file version). They 
may also record summary information about patches that have been applied to the 
APPL_TOP. You can use snapshots to compare two different APPL_TOPs or the same 
APPL_TOP at different times, and to track the current status of an APPL_TOP.

You must take a snapshot of each APPL_TOP before applying any patches so that the 
prerequisite patch checking feature in AutoPatch will function correctly. To update the 
Snapshot information and set up the prerequisite patch checking feature, follow these 
steps:

1. From the AD Administration main menu, select the Maintain Applications Files 
menu. Run the “Maintain snapshot information” task.

2. Under Snapshot Options, choose “Manage Snapshots within this Application 
System.”

3. Select “Refresh the Current View of this APPL_TOP in the database.”

4. Repeat this step for each APPL_TOP in your system.

Running this task takes one to two hours for each APPL_TOP. However, it does not 
require that users log off. You need to run it only once for each APPL_TOP. After that, 
AutoPatch automatically updates the current view snapshot for each APPL_TOP.

Back Up Oracle Applications
Have the operating system administrator back up the Oracle Applications product 
files, including COMMON_TOP, 8.0.6 technology components, and the iAS technology 
components. Have the database administrator back up the Oracle Applications 
database and Oracle home components.

Review Security Practices
Review the recommended security processes documented in Best Practices for Securing 
Oracle E-Business Suite - v2.1 on OracleMetaLink. In particular, if you have any 
computers requiring direct access to the E-Business Suite database that are not 
registered nodes in AutoConfig (such as OAM clients), you must explicitly grant 
access as documented in sections 2.15 and 2.16.

Additional Information: See Managing User Privileges and Roles 
in Oracle9i Database Administrator’s Guide.

Additional Information: See Applications DBA Duties in Oracle 
Applications System Administrator’s Guide - Security. See also Oracle 
Applications Concepts.

Additional Information: See Maintain Applications Files Tasks in 
Oracle Applications Maintenance Utilities.
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Log On to Oracle Applications
Start Oracle Applications and access all Oracle E-Business Suite products from the 
E-Business Suite Home page, which you access from the Oracle Applications Login 
page, located at the following URL:

http://<host name>.<domain name>:<HTTP port>/oa_servlets/AppsLogin

For example:

http://oraapps1.oracle.com:8000/oa_servlets/AppsLogin

The system administrator should log in the first time using the sysadmin login account 
that is pre-configured in the Applications installation. Use the System Administrator 
responsibility to launch an Applications Forms session where the system 
administrator can complete the implementation steps.

System-specific Tasks
The tasks in this section are conditionally required — you perform only the ones that 
apply to your system. 

Run Tablespace Migration Utility
If you ran adgncons.sql in Category 2 to set up tablespaces using the new Oracle 
Applications Tablespace Model (OATM), the upgrade process created the new 
tablespaces and populated them with all the new Release 11i objects.

You must now migrate your pre-Release 11i objects to these new tablespaces by 
running the OATM Migration Utility. See Tablespace Model in Overview and 
Requirements for more information. See also OracleMetaLink document 248857.1.

Register Additional Products
All existing products, country-specific functionalities, and languages have been 
upgraded. However, if you have added products (that were not licensed before the 
upgrade) to your system, you must register them now. Likewise, if you are now using 
country-specific functionalities or languages that you were not using before the 
upgrade, you must register these components now. See Registering Applications 
Products in Oracle Applications Maintenance Procedures for complete information.

Configure the Oracle Workflow Java-based Notification Mailer
If you plan to use the Oracle Workflow java-based Notifications Mailer, you must 
complete additional setup and implementation steps. See Configuring the Oracle 
Workflow 2.6 Java-based Notification Mailer with Oracle Applications 11i (OracleMetaLink 
Document ID: 231286.1) for complete information.

Note: You can also access the E-Business Suite Home page from 
the Rapid Install Portal. See Access the Rapid Install Portal in 
Chapter 1 of Installing Oracle Applications.

Additional Information: See Appendix F in the Oracle Applications 
System Administrator’s Guide - Security. See also E-Business Suite 
Home in Oracle Applications Concepts.
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Set Up and Implement Oracle Discoverer End User Layer (EUL)
If you are using any of the products in the following list, you must complete 
additional setup and implementation steps for Discoverer 4i EUL.

Follow the instructions in Using Discoverer 4i with Oracle Applications 11i 
(OracleMetaLink Document ID: 139516.1) to set up and configure the Discoverer EUL. 
The following products require additional security steps, as described in the associated 
OracleMetaLink document.

Set Up and Implement Oracle Embedded Data Warehouse (EDW)
If you have licensed Oracle Embedded Data Warehouse (EDW), you must complete 
additional setup and implementation steps before using this product. Refer to About 
Oracle E-Business Intelligence Embedded Data Warehouse Patchset D, 11iEDW.D 
(OracleMetaLink Document ID: 258899.1) for complete information.

Product Short Name Product

abm Activity Based Management

ams Oracle Marketing

bis Business Intelligence System

bix Interaction Center Intelligence

cn Oracle Sales Compensation

eni Engineering Intelligence

fii Financial Intelligence

hri Human Resource Intelligence

isc Supply Chain Intelligence

okc Oracle Contracts

oki Oracle Contracts Intelligence

opi Operations Intelligence

pjm Oracle Project Manufacturing

pjr Oracle Project Resource Management

pmi Process Manufacturing Intelligence

poa Purchasing Intelligence

psb Oracle Public Sector Budgeting

Product Documentation

Oracle Project Resource 
Management (PJR)

Post Installation Documentation Update for PJR.C 
Customer Using Discoverer 4i (OracleMetaLink Doc ID: 
183491.1)

Oracle Marketing Online (AMS) Oracle Marketing Online Post Upgrade Steps for Oracle 
Discoverer (OracleMetaLink Doc ID: 187070.1)

Oracle Contracts (OKC/OKI) Discoverer 4i End User Layer (EUL) Maintenance for 
Oracle Contracts 11i (OracleMetaLink Doc ID: 187508.1)
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Convert Custom Message Dictionary Functions
Remove the following Message Dictionary functions from the custom code:

Convert Database to Multiple Organizations (Multi-Org)
The Rapid Install Vision Demo database is enabled for Multi-Org. However, the 
production and test databases are not. If you want Multi-Org architecture in the 
production or test environments, refer to the instructions for converting to Multi-Org 
in Oracle Applications Maintenance Procedures.

Convert to Multiple Reporting Currencies (MRC)
In this release, it is no longer necessary to convert to Multiple Reporting Currencies. It 
has been incorporated into the APPS schema so the APPS_MRC schema is no longer 
required. This change, which is transparent to end-users, improves processing 
efficiency and reduces maintenance. Patches need be applied only once (in the APPS 
schema), making it unnecessary to synchronize objects between schemas.

Function Action

fddgcs/fddgme There is no longer a cascading stack or a message explanation. These functions are obsolete.

fddtoken Replace with afdtoken. Requires fddutl.h header file. The syntax is:

boolean afdtoken(/*_ text *token_name, text *token_value _*/);

fddname Replace with afdname. Takes two arguments (the fddname function takes only the message name). 
Requires fddutl.h header file. The syntax is:

boolean afdname(/*_ text *applsname, text *msg_name _*/);

fddget We strongly recommend that you convert to afdget. The new interface allows you to pass a buffer 
and buffer size. The old interface assumed the existence of a fixed-size global variable that is internal 
to the function. Requires fddutl.h header file. The syntax is:

boolean afdget(/*_ text *msg_buf, size_t buf_size _*/);

fddmsg Convert to afderror or afdshow. We strongly recommend using these functions explicitly so that you 
get the intended display behavior (because the new message system display is based on the function 
called, not on message properties). Requires fddutl.h header file. The syntax is:

boolean afderror(/*_ void _*/);

Additional Information: See Oracle Application Object 
Library/Workflow Technical Reference Manual, Release 10. See also 
Oracle Applications Developer’s Guide, Release 10.7 or 11.

Additional Information: See Multiple Organizations in Oracle 
Applications.

Additional Information: See Multiple Reporting Currencies in Oracle 
Applications.
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renaming custom objects (db), 1-3
sizing, 7-6
upgrading to current release (db), 4-2

Database Administrator
description of, xi

database information
gathering (db), 3-38

database initialization
required parameters, xxiv

database size
estimating, xx

datafix script
running (PA), 2-29

dates
verifying formats (PO), 5-47

Definer Rights
declaring, 4-7

deliveries/departures
closing (ONT), 2-35

Depot Repair
data in interface tables (CS), 3-27

directory file protection
changing (FND), 4-14

directory group
changing, 4-14

Discoverer
set up steps for, 7-9

discrete jobs
closing (WIP), 1-16

Distribute Burden process
running (GMS), 3-15

documentation
list of, xviii

documentation library
contents, xiii

downtime
reducing, xxii

E
EasiPath Migration Method

about, xiv
E-Business 11i Upgrade Assistant

about, xxi
E-Business Suite Home

accessing page, 7-8
EFT

partitioning system formats (JG), 3-10
paying Danish invoices (JE), 2-20
updating Swedish payment formats (JE), 2-20

electronic mail
for concurrent managers (FND), 4-11

Electronic Technical Reference Manual (eTRM), xxiii
Embedded Data Warehouse

setting up, 7-9
EMM Advantage

about, xiv
End User Layer

setting up, 7-9
environment

setting up, 2-2
environment variables

examples of, 2-2
setting (env), 2-2

event billing
FIFO marking (PA), 5-32

Event Queue
confirming set up (ONT), 5-55

exchange rate migration script
running (HR/PAY), 5-33

Expire End Dated Instances
scheduling (ONT), 5-57

F
facoldr.sql, 7-4
family consolidated upgrade patches

applying, xviii
FastFormula definitions

updating (HR), 1-13
FCUPs

applying, xviii
file privilege

altering for concurrent manager files (FND), 4-14
file systems

laying down, 2-2
finishing steps

conditionally required, 7-8
definition of, xii

FlexBuilder
in this release, xxix
indicating use of (FLX), 2-6

FlexBuilder rules
using (FLX), 2-6

flexfields
converting date values (FND), 4-10
creating column indexes (AR), 5-8
creating contexts/segments (AR), 5-13
enabling for Hungary (JE), 6-26
fixing cross-validation rules (FND), 4-9
modifying existing (JA), 6-19
segment columns

creating indexes on (INV), 6-31
setting up definitions (ONT), 5-42
updating attributes (JA), 6-20
upgrading dates, 4-10
upgrading dates (JG), 4-19

.fmb files
copying to AU_TOP (AOL), 6-4

FND_DESCR_FLEX_CONTEXTS
updating custom calls to (AOL), 6-3

FND_HISTOGRAM_COLS table, 4-6
FND_LOOKUPS

updating custom calls to (AOL), 6-3
FND_PRODUCT_INSTALLATIONS table, 4-6
FND_STATS

using, 3-38
fndcpesr.exe, 4-12
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FNDMDCVT program (AOL), 6-4
forms

copying custom library (AOL), 6-4
future-dated payment

choosing method for (AP), 2-13
setting up account (AP), 6-13

fv107obj.sql, 3-21
fv110obj.sql, 3-21
fvupditv.sql, 5-50

G
geocodes data

updating (HR), 1-14
GIS subsidiaries

reviewing (GL), 6-10
GL

defining tax assignments (AR), 6-15
gluacsum.sql, 6-9
glurtmrt.sql, 5-3
glurtrpp.sql, 2-8
glurtrpt.sql, 5-3
gmsup115.drv, 4-20
gmsupaud.sql, 3-14

H
hard limit funded agreements

correcting (PA), 2-23
hash join processing

memory for, xxii
hash_area_size parameter

setting for an upgrade, xxii

I
ibyupgrd.sql, 6-16
igidropschema.sql, 7-5
igigbvuw.sql, 6-34
igiitrbu.sql, 2-41
igipreu.sql, 2-40
implementation tasks

performing, 6-1
indexes

dropping (AP), 7-4
re-enabling custom (db), 4-7
verifying custom privileges (db), 2-4

init.ora
hash_area_size, xxii
parallel_max_servers, xxiii

Install Base
correcting data (CS), 3-24
registering (OKS), 5-53
tablespace for (CS), 3-28

installed products
about, xxiv
updating, 4-3

intercompany balancing
setting up (GL), 6-11

interMedia
default tablespace schema (db), 3-37

shared library path (db), 3-37
temporary tablespace (db), 3-37

Internal Trading charges
completing (IGI), 2-40

inventory organizations
associating tax information (JL), 5-21
validating data (ONT), 2-37

inventory valuation reports
running (INV), 3-18
verifying (INV), 5-39

invflseg.sql, 6-31
inviogds.sql, 6-33
Invoice Import Interface

purging expense reports (AP), 3-6
purging invoices (AP), 3-6

invoices
cancelling/re-entering (JL), 5-22
setting up rounding account (PA), 5-27

Invoker Rights
declaring (db), 4-7

invtxnpg.sql, 2-31
IS Manager

description of, xi
Item Validation Org settings

reviewing (ONT), 2-36

J
jacarmpr.sql, 2-20
jacaupgr.sql, 2-19
jamlsmck.sql, 2-16
jasgupg1.sql, 6-18, 6-19
jasgupg2.sql, 6-18
jathpupg.sql, 6-20
jatwupg1.sql, 2-16
jatwupg2.spl, 2-17
jatwupg3.sql, 4-18
jatwupg4.sql, 4-19
jatwupg5.sql, 2-18
jatwupg6.sql, 2-18
jatwupg7.sql, 2-19
Java Development Kit

requirements, xix
JAWS

about, xii
jehurvat.sql, 6-26
jeitapid.sql, 6-25
JESEPBAI.sql, 2-20
JESEPBSI.sql, 2-20
JESEPBUT.sql, 2-20
JESEPPOI.sql, 2-20
JESEPPOU.sql, 2-20
jgzzfaap.sql, 6-22
jgzzper1.sql, 3-10
jgzzper2.sql, 3-10
jgzzupgd.sql, 4-19
JL_BR_LOOKUPS

duplicate rows in (JL), 2-21
jlbrsusl.sql, 2-21
jlmlsmck.sql, 2-22
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jlzztu01.sql, 5-20
jlzztu02.sql, 5-21
journal line

updating 3rd-party information (Columbia), 6-27
journal posting

setting function security for (GL), 6-11
jtftkmts.sql, 4-21

L
languages

changing status of, xxvi
space requirements, xxvi

licensed products
about, xxv
updating, 4-3

linking records
GL and AP (AP), 6-14
GL and Payables (AP), 6-14
GL and Receivables (AR), 6-15

local extent management
converting to (db), 3-33

logging on
to Oracle Applications, 7-8

login
verifying operating system (db), 1-2

long-running processes
about, xxii

lookup codes
creating new (JL), 5-16
modifying truncated (JA), 4-17
recording (JA), 2-15

M
maintenance mode

definition of, xxv
disabling, 4-2

Maintenance Pack
when to use, xvii

maintenance tasks
understanding, 7-6

mass additions
posting (PA), 1-11

mass funds check/reservation
reviewing parameters (GL), 6-10

material subelement
defining default for (CST), 5-37

memory
requirements, xx

menus
updating custom (JE), 5-16
updating custom (JG), 5-14

Message Dictionary
converting functions in (AOL), 7-10
custom messages (AOL), 6-4

messages
converting character-mode (AOL), 6-4

migration driver
running (GMS), 4-20

MLS dates
correcting (PA), 2-22

MRC
changes to schema, xxv
converting database to, 7-10
create of modify data (AP), 5-7
create of modify data (AR), 5-14
dropping schema (MRC), 7-2
exchange rates in (AP), 3-5
performing AR/AP tasks, 5-4
schema, 4-8
transferring data to GL (AP), 3-7

MRP
modifying profile options (PO), 3-19
setting profile options (PO), 5-46

MRPSLNUP.sql, 5-38
multilingual support

maintaining tables (db), 1-2
Multi-Org

converting database to, 7-10
profile options for, xxv

multiple supplier banks
upgrading supplier site bank data for (AP), 2-12

Multiple Worksite reporting
completing (PAY), 1-15

N
Natural Account tax codes

defining (GL), 6-15
NCA

upgrading from, xvii
negative amount events

correcting (PA), 3-11
Net Services

setting up (db), 3-34
NLS

installing translated software, 4-3
non-adjusting negative amount items

correcting (PA), 2-24
non-Global Demo databases

invalid data in (AK), 3-2
Notification Approver profile option

setting up (ONT), 5-42
notifications

upgrading (PO), 5-44

O
OATM

running, 7-8
objects

dropping (db), 7-1
dropping obsolete (FV), 3-20
integrating custom (db), 4-7
renaming custom (db), 1-3

OFA-compliant Model
using, 3-34, 3-42

Offset taxes
setting up (AP), 6-12
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OKS00STU.sql, 5-52
OKS00TZU.sql, 5-52
online education

about, xiv
online help

installing, 7-6
installing (db), 4-3

ontexc05.sql, 2-36
ontexc06, 5-43
ontexc07.sql, 2-34
ontexc08.sql, 2-38
ontup255.sql, 5-43
ontupg48.sql, 5-40
ontupg49.sql, 5-41
Open Interface

clearing tables (PO), 2-38
importing and purging invoices (AP), 3-5

optimization
definition of, xxiv

Oracle Forms 4.5
upgrading (AOL), 1-5

Oracle Learning Network
about, xiv

ORACLE schema
identifying potential conflicts (FND), 3-30
resetting passwords (db), 4-5

Oracle Store
URL, xiii

Oracle Support
contacting, xiv

Oracle Tablespace Model
definition of, xxv
migrating to, xxvi
using, 3-34, 3-42

Oracle users
dropping obsolete (HR), 6-29

ORACLE_HOME
created by Rapid Install, xviii

OracleMetaLink
about, xiv

order creation/manipulation
setting up responsibilities (ONT), 5-40

Order Entry cycles
omitted from upgrade (ONT), 2-37

Order Entry Interface programs
running (ONT), 2-32

Order Entry Service Interface
clearing (CS), 3-25

Order Import program
running (ONT), 2-32

orders
closing eligible (ONT), 2-33
reviewing status (ONT), 2-33

organization code
definition of (INV), 2-31

organizational payment method
associating with a set of books (HR/PAY)), 5-34

organizations
associating names with pre-existing definitions 

(ALR), 6-6

reviewing (PA), 5-23
reviewing default accounts (INV), 5-39

OTLR
report for (HR), 5-35

Overtime Calculation program
converting to PL/SQL (PA), 5-26

P
pa11u506.sql, 5-27
pa620118.sql, 2-24
pa630505.sql, 5-32
pa634580.sql, 3-11
pa652811.sql, 2-25
pa661335.sql, 2-24
pa858651.sql, 2-28
pa882573.sql, 2-29
pacrttab.sql, 2-27
pacstrev.sql, 2-29
painv.sql, 2-27
parallel query server processes

determining, xxiii
parallel_max_servers parameter

setting for an upgrade, xxiii
pardlrpt.sql, 2-26
pardlupd.sql, 2-27
passwords

changing for database, 7-6
patch 1257205, 2-9
patch 1268797, 3-38
patch 1561962, 6-19
patch 1570300, 2-6
patch 1658488, 2-20
patch 1746184, 2-9
patch 3262062, 3-22, 3-24
patch 3262064, 3-22, 3-24
patch 3262067, 3-22, 3-24
patch 3275245, 7-6
patch 3394567, 3-23, 3-29
patch 3510628, 3-23, 3-29
patch 3510630, 3-23, 3-29
patch 3835781, 3-37
patch 451137, 1-5
patch 634580, 3-11
patch 668409, 1-6
patch 747306, 2-13
patch 786842, 5-21
patch 839884, 5-22
patches

applying (CS), 3-24
applying (db), 3-37
applying (env), 2-3
applying (OSM), 3-21

patxnerr.sql, 2-23
patxnsql.sql, 2-23
paupgor2.sql, 5-24
Payables data

transferring to GL (AP), 3-7
payees and payment systems

configuring (iPay), 2-15
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payment batches
completing outstanding (AP), 1-6

payment formats
remodifying (AP), 5-6

peoldsec.sql, 6-29
period rates

reviewing (GL), 6-9
peupl01v.sql, 6-29
physical inventories in process

completing (INV), 3-17
pick slips

closing (ONT), 2-35
picking batches

closing (ONT), 2-35
Planning Manager

starting (MRP), 5-38
plxmlparser_v1_0_2.zip, 3-41
pockrvdt.sql, 5-48
pocntpoh.sql, 2-39
pocntrcv.sql, 2-39
pocntreq.sql, 2-39
podold.sql, 7-2
position

updating custom (HR), 1-13
post-upgrade steps

definition of, xii
preparatory scripts

running (db), 3-35, 3-38
prepayment terms

setting up (AP), 5-7
pre-upgrade steps

definition of, xii
Pricing upgrade errors

viewing (ONT), 5-43
processing constraints

setting up (ONT), 5-42
product files

backing up, 4-8, 7-7
deleting, 7-3

product tablespace
creating new, 3-33
resizing existing, 3-33

products
implementing new, 7-6
registering additional, 7-8

product-specific tasks
performing, xviii, 6-1

profile options
setting (CS), 3-25
setting (FND), 4-10
setting (OSM), 3-22

Project Management Method, xiv
project status

updating values for (PA), 5-24
Public Sector Applications products

upgrading, xxviii
purge cutoff date

definition of (INV), 2-31
pyrtmig.sql, 5-34
pyvaladr.sql, 6-31

R
Rapid Install

configuring server processes, xviii
role in upgrade, xvii
running before upgrade (env), 2-2
starting server processes (db), 4-4
when to use, xviii

rcvrmaup.sql, 5-49
realized gains, losses, and rounding accounts 

(AR), 1-8
recommended step

definition of, xiii
Reconciliation Open Interface

backing up customized objects (CE), 1-6
reinstalling customized objects (CE), 6-6

recoverable tax
enabling (AP), 2-13

recovery rules
print listings (JA), 2-19

registry settings
preserving on Windows platforms, xxvi, 2-1

Release Content Documents (RCD), xxiii
reports

supported, xxviii
updating custom (HR), 1-12

request groups
assigning to responsibilities (JA), 6-22

required step
definition of, xiii

Reset, 4-5
responsibilities

migrating FND (OSM), 5-51
switching to new (PSA), 5-49
updating/verifying custom (FND), 4-12

Revenue Budgets
correcting (PA), 2-30

revenue distributions
correcting bill amount data (PA), 2-26

reversing items
correcting (PA), 2-27
correcting billable flag data (PA), 2-28

RMA
verifying upgrade (PO), 5-48

rollback segments
determining size of, xx
setting for normal use (db), 4-6
verify sizing (db), 3-39

rows per commit
definition of (INV), 2-31

rule-based optimization
definition of, xxiv

rules
associating (FlexBuilder), 4-17

S
salary proposal view

customized script for (HR), 1-13
reapply customization to script (HR), 6-28

sales orders history cutoff date
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setting up, 5-37
sales orders/invoices

updating (JL), 5-18
schemas

integrating custom (db), 4-7
scripts

restricting access to (FND), 4-15
security practices

reviewing, 7-7
security schemas

removing old (IGI), 7-5
seed data

dropping obsolete (IGI), 2-40
seeded item types

updating (Workflow), 3-3
Segment Value Inheritance

preserving GL account codes (GL), 6-7
Self-Service Time

implementing (PA), 6-28
server processes

configuring (db), 4-4
starting (db), 4-4
starting and configuring, xviii

setup data verification scripts
running (OSM), 3-22

setup tasks
performing, 6-1

shared products
about, xxiv

Shipping Interface programs
running (ONT), 2-35

SmartClient
upgrading from, xvii

snapshot information
maintaining, 7-7

SQL*Plus options
checking (db), 3-39

srw directory
changing name of (AOL), 6-4

step conditions
definition of, xii

step summaries
how to use, xiii

subledger security
upgrading (igi), 6-34

subledgers
upgrading Brazilian (JL), 2-21

summarization model
upgrading to (PA), 1-11

SYS account password
defaults for, 7-6

SYSADMIN
enabling (FND), 3-31

SYSTEM account password
defaults for, 7-6

system administration steps
understanding, 7-6

System Administrator
description of, xi

system requirements

for an upgrade, xviii

T
tables

upgrading (Labor Dist), 5-35
tablespace

minimum for SYSTEM, xx
minimum for TEMP, xx
new model, xxv
requirements, xx
rollback segments, xx
setting up (db), 3-33
SYSTEM, xx
TEMP, xxiii
temporary, xx

Tablespace Model
running, 7-8

tax code
enabling (JA), 6-19

tax groups
associating with tax categories (JL), 5-21

tax information
populating (AX), 5-5
updating custom (PAY-US), 1-14

tax rebate
print listings (JA), 2-19

Tax Reconciliation report (AR), 3-9
tax registration numbers

moving (JA), 2-17, 4-18
tax structure

renaming custom (AR), 1-7
tax system options

setting (JL), 5-17
tax transactions

reconciling (AR), 3-9
tax types

updating (JA), 6-18
tax vendor

updating flexfield information (AR), 5-12
tax vendor extension

creating custom views (AR), 5-10
saving (AR), 1-7

taxable amounts
updating (JE), 6-25

taxes
set up recoverable (AP), 6-13

Taxware
additional upgrade issues (AR), 1-8, 5-12

technical appraisals
re-archiving (JL), 5-22
restoring (JL), 1-9

Technical Specialist
description of, xi

temporary and interface tables
processing data in (INV), 3-18

test upgrade
when to perform, xxi

The Upgrade Manual Script
running, xviii, 1-1
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using, xxi
tiebacks

completing (PA), 1-10
Time and Labor

corrective actions for (HR), 5-35
time zones

updating (OKS), 5-52
timecards

in PTE (PA), 3-11
timing statistics

baseline, xxi
training

about, xiv
transaction control extension

adding parameters (PA), 5-29
transaction history

purging (INV), 2-31
Transaction Interface table

clearing (PA), 1-11
updating (PA), 5-31

transaction managers
activating for Multi-Org (PO), 5-44

transaction types
reviewing upgraded (ONT), 5-41

transactions
printing completed (JL), 1-9
select for upgrade (ONT), 2-38
summarizing and transferring (PSP), 1-15
translated (AX), 2-10
updating (IBY), 6-16

transfers
completing (PA), 1-10

triggers
dropping event alert (ALR), 3-1
re-creating event alert (ALR), 6-6
re-enabling custom (db), 4-7

txn_fix.lst, 2-23
typographic conventions

about, xv

U
u3140000.drv, 4-2
umask command

using (FND), 4-14
uncosted transactions

standard costing
inventory only (CST), 3-16

uniform invoice information
moving (JA), 2-16

uniform numbers
moving (JA), 2-17, 4-18
recording (JA), 2-18

UNIX Edition group
creating (FND), 4-13

Upgrade Assistance Program
definition of, xxi

Upgrade Assistant Spreadsheet
using, xxi

upgrade error report

generating (ONT), 5-43
upgrade tasks

list of, xviii
upgrade.out, 5-46
user responsibility assignments

reviewing (FND), 6-2

V
VAT

compliance (GL), 6-15
migrating gross-based data (IGI), 6-33
upgrading transactions (Hungary), 6-25

VAT Reconciliation report (AR), 3-9
Vertex

additional upgrade issues (AR), 1-8, 5-12
updating geocodes (HR), 1-14

W
warehouse name information

adding to transactions (JL), 5-21
wfrmitt.sql, 3-4
Windows platforms

preserving registry settings, xxvi
upgrading issues, xxvi

WIP Value reports
running (CST), 3-16
verifying balances (CST), 5-36

Workflow
completing installation of (FlexBuilder), 4-16
upgrading to 2.0.3 (FND), 1-5

workflow
setting up (ONT), 5-54

Workflow Builder
completing installation of (FlexBuilder), 4-16

Workflow item attributes
updating (ONT), 5-42

Workflow Notification Mailer
configuring, 7-8
configuring (FND), 4-9
setting up approver (ONT), 5-42

wshbdord.sql, 2-35
wshpre00.sql, 2-37

X
XML Parser

installing (db), 3-40
XML SQL Utility

installing (db), 3-40
XSU12_ver1_2_1.zip, 3-41
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